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EXPIRE INVENTORY (Manually start inventory expiration processing)

1219

EXPORT commands

1222
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INSERT MACHINE (Insert machine characteristics information or recovery instructions) 1297

ISSUE MESSAGE (Issue a message from a server script) 1298
LABEL LIBVOLUME (Label a library volume) 1299
LOAD DEFALERTTRIGGERS (Load the default set of alert triggers) 1304
LOCK commands 1305
LOCK ADMIN (Lock out an administrator) 1305
LOCK NODE (Lock out a client node) 1306
LOCK PROFILE (Lock a profile) 1307
MACRO (Invoke a macro) 1308
MIGRATE STGPOOL (Migrate storage pool to next storage pool) 1309
MOVE commands 1311
MOVE CONTAINER (Move a container) 1311
MOVE DATA (Move files on a storage pool volume) 1313
MOVE DRMEDIA (Move disaster recovery media offsite and back onsite) 1316
MOVE GRPMEMBER (Move a server group member) 1329
MOVE MEDIA (Move sequential-access storage pool media) 1329
MOVE NODEDATA (Move data by node in a sequential access storage pool) 1335
File spaces for one or more nodes or a collocation group 1336
Selected file spaces of a single node 1338
NOTIFY SUBSCRIBERS (Notify managed servers to update profiles) 1341
PERFORM LIBACTION (Define or delete all drives and paths for a library) 1342
PING SERVER (Test the connection between servers) 1346
PREPARE (Create a recovery plan file) 1346
PROTECT STGPOOL (Protect data that belongs to a storage pool) 1352
QUERY commands 1357
QUERY ACTLOG (Query the activity log) 1358
QUERY ADMIN (Display administrator information) 1363
QUERY ALERTTRIGGER (Query the list of defined alert triggers) 1367
QUERY ALERTSTATUS (Query the status of an alert) 1368
QUERY ASSOCIATION (Query client node associations with a schedule) 1372
QUERY AUDITOCCUPANCY (Query client node storage utilization) 1373
QUERY BACKUPSET (Query a backup set) 1374
QUERY BACKUPSETCONTENTS (Query contents of a backup set) 1378
QUERY CLEANUP (Query the cleanup that is required in a source storage pool) 1380
QUERY CLOPTSET (Query a client option set) 1381
QUERY COLLOCGROUP (Query a collocation group) 1383
QUERY CONTAINER (Display container information) 1385
QUERY CONTENT (Query the contents of a storage pool volume) 1388
QUERY CONVERSION (Query conversion status of a storage pool) 1394
QUERY COPYGROUP (Query copy groups) 1395
QUERY DAMAGED (Query damaged in a directory-container or cloud-container storage pool) 1398
QUERY DATAMOVER (Display data mover definitions) 1401
QUERY DB (Display database information) 1404
QUERY DBSPACE (Display database storage space) 1406
QUERY DEDUPSTATS (Query data deduplication statistics) 1407
QUERY DEVCLASS (Display information on one or more device classes) 1413
QUERY DIRSPACE (Query storage utilization of FILE directories) 1417
QUERY DOMAIN (Query a policy domain) 1418
QUERY DRIVE (Query information about a drive) 1420
QUERY DRMEDIA (Query disaster recovery media) 1423
QUERY DRMSTATUS (Query disaster recovery manager system parameters) 1430
QUERY ENABLED (Query enabled events) 1432
QUERY EVENT (Query scheduled and completed events) 1434
QUERY EVENT (Display client schedules) 1434
QUERY EVENT (Display administrative event schedules) 1440

QUERY EVENTRULES (Query rules for server or client events) 1443




QUERY EVENTSERVER (Query the event server)

1445

QUERY EXPORT (Query for active or suspended export operations)

1445

QUERY EXTENTUPDATES (Query updated data extents)

1450

QUERY FILESPACE (Query one or more file spaces)

1451

QUERY FSCOUNTS (Query number of objects)

1456

QUERY LIBRARY (Query a library)

1458

QUERY LIBVOLUME (Query a library volume)

1460

QUERY LICENSE (Display license information)

1462

QUERY LOG (Display information about the recovery log)

1465

QUERY MACHINE (Query machine information)

1467

QUERY MEDIA (Query sequential-access storage pool media)

1469

QUERY MGMTCLASS (Query a management class)

1474

QUERY MONITORSETTINGS (Query the configuration settings for monitoring alerts and server status)
QUERY MONITORSTATUS (Query the monitoring status)

1476
1478

QUERY MOUNT (Display information on mounted sequential access volumes)

1482

QUERY NASBACKUP (Query NAS backup images)

1483

QUERY NODE (Query nodes)

1487

QUERY NODEDATA (Query client data in volumes)

1496

QUERY NODEGROUP (Query a node group)

1498

QUERY OCCUPANCY (Query client file spaces in storage pools)

1499

QUERY OPTION (Query server options)

1502

QUERY PATH (Display a path definition)

1504

QUERY POLICYSET (Query a policy set)

1507

QUERY PROCESS (Query one or more server processes)

1509

QUERY PROFILE (Query a profile)

1513

QUERY PROTECTSTATUS (Query the status of storage pool protection)

1515

QUERY PROXYNODE (Query proxy authority for a client node)

1517

QUERY PVUESTIMATE (Display processor value unit estimate)

1518

QUERY RECOVERYMEDIA (Query recovery media)

1521

QUERY REPLICATION (Query node replication processes)

1523

QUERY REPLNODE (Display information about replication status for a client node)

1531

QUERY REPLRULE (Query replication rules)

1534

QUERY REPLSERVER (Query a replication server)

1535

QUERY REQUEST (Query one or more pending mount requests)

1537

QUERY RESTORE (Query restartable restore sessions)

1538

QUERY RPFCONTENT (Query recovery plan file contents stored on a target server)

1540

QUERY RPFILE (Query recovery plan file information stored on a target server)

1541

QUERY SAN (Query the devices on the SAN)

1543

QUERY SCHEDULE (Query schedules)

1545

QUERY SCHEDULE (Query client schedules)

1546

QUERY SCHEDULE (Query an administrative schedule)

1549

QUERY SCRATCHPADENTRY (Query a scratch pad entry)

1551

QUERY SCRIPT (Query IBM Spectrum Protect scripts)

1552

QUERY SERVER (Query a server)

1555

QUERY SERVERGROUP (Query a server group)

1558

QUERY SESSION (Query client sessions)

1559

QUERY SHREDSTATUS (Query shredding status )

1563

QUERY SPACETRIGGER (Query the space triggers)

1564

QUERY STATUS (Query system parameters)

1565

QUERY STATUSTHRESHOLD (Query status monitoring thresholds)

1574

QUERY STGPOOL (Query storage pools)

1576

QUERY STGPOOLDIRECTORY (Query a storage pool directory)

1590

QUERY STGRULE (Display storage rule information)

1592

QUERY SUBSCRIBER (Display subscriber information)

1596

QUERY SUBSCRIPTION (Display subscription information)

1597

QUERY SYSTEM (Query the system configuration and capacity)

1598




QUERY TAPEALERTMSG (Display status of SET TAPEALERTMSG command)

1600

QUERY TOC (Display table of contents for a backup image)

1600

QUERY VIRTUALFSMAPPING (Query a virtual file space mapping)

1602

QUERY VOLHISTORY (Display sequential volume history information)

1603

QUERY VOLUME (Query storage pool volumes)

1609

QUIT (End the interactive mode of the administrative client)

1616

RECLAIM STGPOOL (Reclaim volumes in a sequential-access storage pool)

1616

RECONCILE VOLUMES (Reconcile differences in the virtual volume definitions)

1618

REGISTER commands

1620

REGISTER ADMIN (Register an administrator ID)

1620

REGISTER LICENSE (Register a new license)

1624

REGISTER NODE (Register a node)

1625

REMOVE commands

1639

REMOVE ADMIN (Delete an administrative user ID)

1639

REMOVE DAMAGED (Remove damaged data from a source storage pool)

1640

REMOVE NODE (Delete a node or an associated machine node)

1641

REMOVE REPLNODE (Remove a client node from replication)

1642

REMOVE REPLSERVER (Remove a replication server)

1643

RENAME commands

1644

RENAME ADMIN (Rename an administrator)

1644

RENAME FILESPACE (Rename a client file space on the server)

1645

RENAME NODE (Rename a node)

1648

RENAME SCRIPT (Rename an IBM Spectrum Protect script)

1649

RENAME SERVERGROUP (Rename a server group)

1650

RENAME STGPOOL (Change the name of a storage pool)

1650

REPAIR STGPOOL (Repair a directory-container storage pool)

1651

REPLICATE NODE (Replicate data in file spaces that belong to a client node)

1653

REPLY (Allow a request to continue processing)

1661

RESET PASSEXP (Reset password expiration)

1662

RESTART EXPORT (Restart a suspended export operation)

1663

RESTORE commands

1664

RESTORE NODE (Restore a NAS node)

1664

RESTORE STGPOOL (Restore storage pool data from a copy pool or an active-data pool)

1668

RESTORE VOLUME (Restore primary volume data from a copy pool or an active-data pool)
REVOKE commands

1671

1674

REVOKE AUTHORITY (Remove administrator authority)

1674

REVOKE PROXYNODE (Revoke proxy authority for a client node)

1676

ROLLBACK (Rollback uncommitted changes in a macro)

1677

RUN (Run an IBM Spectrum Protect script)

1678

SELECT (Perform an SQL query of the IBM Spectrum Protect database)

1680

SET commands

1688

SET ACCOUNTING (Set accounting records on or off)

1689

SET ACTLOGRETENTION (Set the retention period or the size of the activity log)

1690

SET ALERTACTIVEDURATION (Set the duration of an active alert)

1691

SET ALERTCLOSEDDURATION (Set the duration of a closed alert)

1692

SET ALERTEMAIL (Set the alert monitor to email alerts to administrators)

1693

SET ALERTEMAILFROMADDR (Set the email address of the sender)

1693

SET ALERTEMAILSMTPHOST (Set the SMTP mail server host name)

1694

SET ALERTEMAILSMTPPORT (Set the SMTP mail server host port)

1695

SET ALERTSUMMARYTOADMINS (Set the list of administrators to receive alert summaries by email )

SET ALERTINACTIVEDURATION (Set the duration of an inactive alert)

1695
1696

SET ALERTMONITOR (Set the alert monitor to on or off)

1697

SET ALERTUPDATEINTERVAL (Set how often the alert monitor updates and prunes alerts)
SET ARCHIVERETENTIONPROTECTION (Activate data retention protection)

1698

1698

SET ARREPLRULEDEFAULT (Set the server replication rule for archive data)

1699

SET BKREPLRULEDEFAULT (Set the server replication rule for backup data)

1701




SET CLIENTACTDURATION (Set the duration period for the client action)

1702

SET CONFIGMANAGER (Specify a configuration manager)

1703

SET CONFIGREFRESH (Set managed server configuration refresh)

1704

SET CONTEXTMESSAGING (Set message context reporting on or off)

1705

SET CPUINFOREFRESH (Refresh interval for the client workstation information scan)

1705

SET CROSSDEFINE (Specifies whether to cross-define servers)

1706

SET DBRECOVERY (Set the device class for automatic backups)

1706

SET DEDUPVERIFICATIONLEVEL (Set the percentage of extents to verify)

1708

SET DEFAULTAUTHENTICATION (Set the default authentication method for REGISTER NODE and REGISTER ADMIN

commands)
SET DEPLOYPKGMGR (Enable the deployment package manager)

~1710

1710

SET DEPLOYREPOSITORY (Set the download path for client deployment packages)

1711

SET DEPLOYMAXPKGS (Set the maximum number of client deployment packages to store)

1712

SET DISSIMILARPOLICIES (Enable the policies on the target replication server to manage replicated data)

SET DRMACTIVEDATASTGPOOL (Specify the active-data pools to be managed by DRM)

1713
1714

SET DRMCHECKLABEL (Specify label checking)

1714

SET DRMCMDFILENAME (Specify the name of a file to contain commands)

1715

SET DRMCOPYCONTAINERSTGPOOL (Specify the container-copy storage pools to be processed by DRM commands) 171¢

SET DRMCOPYSTGPOOL (Specify the copy storage pools to be managed by DRM)

1717

SET DRMCOURIERNAME (Specify the courier name)

1718

SET DRMDBBACKUPEXPIREDAYS (Specify DB backup series expiration)

1718

SET DRMFILEPROCESS (Specify file processing)

1719

SET DRMINSTRPREFIX (Specify the prefix for recovery instructions file names)

1720

SET DRMNOTMOUNTABLENAME (Specify the not mountable location name)

1722

SET DRMPLANPREFIX (Specify a prefix for recovery plan file names)

1722

SET DRMPLANVPOSTFIX (Specify replacement volume names)

1724

SET DRMPRIMSTGPOOL (Specify the primary storage pools to be managed by DRM)

1725

SET DRMRPFEXPIREDAYS (Set criteria for recovery plan file expiration)

1726

SET DRMVAULTNAME (Specify the vault name)

1727

SET EVENTRETENTION (Set the retention period for event records)

1727

SET FAILOVERHLADDRESS (Set a failover high level address)

1728

SET INVALIDPWLIMIT (Set the number of invalid logon attempts)

1729

SET LDAPPASSWORD (Set the LDAP password for the server)

1730

SET LDAPUSER (Specify an ID for an LDAP directory server)

1731

SET LICENSEAUDITPERIOD (Set license audit period)

1731

SET MAXCMDRETRIES (Set the maximum number of command retries)

1732

SET MAXSCHEDSESSIONS (Set maximum scheduled sessions)

1733

SET MINPWLENGTH (Set minimum password length)

1734

SET MONITOREDSERVERGROUP (Set the group of monitored servers)

1735

SET MONITORINGADMIN (Set the name of the monitoring administrator)

1735

SET NODEATRISKINTERVAL (Specifies at-risk mode for an individual node)

1736

SET PASSEXP (Set password expiration date)

1738

SET PRODUCTOFFERING (Set the product offering that is licensed to your enterprise)

1739

SET QUERYSCHEDPERIOD (Set query period for polling client nodes)

1740

SET RANDOMIZE (Set randomization of scheduled start times)

1741

SET REPLRECOVERDAMAGED (Specify whether damaged files are recovered from a replication server)
SET REPLRETENTION (Set the retention period for replication records)

1742
1744

SET REPLSERVER (Set the target replication server)

1745

SET RETRYPERIOD (Set time between retry attempts)

1746

SET SCHEDMODES (Select a central scheduling mode)

1746

SET SCRATCHPADRETENTION (Set scratch pad retention time)

1747

SET SERVERHLADDRESS (Set the high-level address of a server)

1748

SET SERVERLLADDRESS (Set the low-level address of a server)

1749

SET SERVERNAME (Specify the server name)

1749

SET SERVERPASSWORD (Set password for server)

1750

SET SPREPLRULEDEFAULT (Set the server replication rule for space-managed data)

1751




SET STATUSATRISKINTERVAL (Specifies whether to enable client at-risk activity interval evaluation) 1752

SET STATUSMONITOR (Specifies whether to enable status monitoring) 1753
SET STATUSREFRESHINTERVAL (Set refresh interval for status monitoring) 1754
SET STATUSSKIPASFAILURE (Specifies whether to use client at-risk skipped files as failure evaluation) 1755
SET SUBFILE (Set subfile backup for client nodes) 1756
SET SUMMARYRETENTION (Set number of days to keep data in activity summary table) 1757
SET TAPEALERTMSG (Set tape alert messages on or off) 1758
SET TOCLOADRETENTION (Set load retention period for table of contents) 1759
SET VMATRISKINTERVAL (Specifies the at-risk mode for an individual VM filespace) 1759
SETOPT (Set a server option for dynamic update) 1761
SHRED DATA (Shred data) 1762
SUSPEND EXPORT (Suspend a currently running export operation) 1764
UNLOCK commands 1765
UNLOCK ADMIN (Unlock an administrator) 1765
UNLOCK NODE (Unlock a client node) 1766
UNLOCK PROFILE (Unlock a profile) 1767
UPDATE commands 1767
UPDATE ALERTTRIGGER (Update a defined alert trigger) 1768
UPDATE ALERTSTATUS (Update the status of an alert) 1770
UPDATE ADMIN (Update an administrator) 1771
UPDATE BACKUPSET (Update a retention value assigned to a backup set) 1775
UPDATE CLIENTOPT (Update a client option sequence number) 1778
UPDATE CLOPTSET (Update a client option set description) 1779
UPDATE COLLOCGROUP (Update a collocation group) 1780
UPDATE COPYGROUP (Update a copy group) 1781
UPDATE COPYGROUP (Update a backup copy group) 1781
UPDATE COPYGROUP (Update a defined archive copy group) 1784
UPDATE DATAMOVER (Update a data mover) 1786
UPDATE DEVCLASS (Update the attributes of a device class) 1787
3590 1788
3592 1791
4MM 1796
8MM 1799
Centera 1803
DLT 1805
Ecartridge 1809
File 1813
Generictape 1817
LTO 1818
NAS 1823
Removablefile 1825
Server 1826
VolSafe 1828
UPDATE DEVCLASS - z/0S media server (Update device class for z/0OS media server) 1830
3590, for z/OS media server 1831
3592, for z/OS media server 1834
ECARTRIDGE, for z/OS media server 1838
FILE, for z/OS media server 1841
UPDATE DOMAIN (Update a policy domain) 1843
UPDATE DRIVE (Update a drive) 1845
UPDATE FILESPACE (Update file-space node-replication rules) 1848
UPDATE LIBRARY (Update a library) 1851
349X 1852
ACSLS 1854
EXTERNAL 1856

FILE 1856




MANUAL 1857

SCSI 1858
SHARED 1860
VTL 1861
UPDATE LIBVOLUME (Change the status of a storage volume) 1863
UPDATE MACHINE (Update machine information) 1864
UPDATE MGMTCLASS (Update a management class) 1865
UPDATE NODE (Update node attributes) 1867
UPDATE NODEGROUP (Update a node group) 1881
UPDATE PATH (Change a path) 1882
Destination is a drive 1882
Destination is a library 1886
Destination is a ZOSMEDIA library 1888
UPDATE POLICYSET (Update a policy set description) 1889
UPDATE PROFILE (Update a profile description) 1890
UPDATE RECOVERYMEDIA (Update recovery media) 1891
UPDATE REPLRULE (Update replication rules) 1892
UPDATE SCHEDULE (Update a schedule) 1893
UPDATE SCHEDULE (Update a client schedule) 1894
UPDATE SCHEDULE (Update an administrative schedule) 1903
UPDATE SCRATCHPADENTRY (Update a scratch pad entry) 1910
UPDATE SCRIPT (Update an IBM Spectrum Protect script) 1911
UPDATE SERVER (Update a server defined for server-to-server communications) 1913
UPDATE SERVERGROUP (Update a server group description) 1917
UPDATE SPACETRIGGER (Update the space triggers) 1918
UPDATE STATUSTHRESHOLD (Update a status monitoring threshold) 1920
UPDATE STGPOOL (Update a storage pool) 1922
Cloud-container storage pool 1924
Directory-container storage pool 1927
Container-copy storage pool 1930
Primary random-access pool 1932
Primary sequential-access pool 1939
Copy pool 1950
Active-data pool 1955
UPDATE STGPOOLDIRECTORY (Update a storage pool directory) 1959
UPDATE STGRULE (Update a storage rule) 1961
UPDATE STGRULE (Update a rule for auditing a storage pool) 1962
UPDATE STGRULE (Update a storage rule for generating data deduplication statistics) 1963
UPDATE STGRULE (Update a storage rule for reclaiming cloud containers) 1966
UPDATE STGRULE (Update a storage rule for tiering) 1967
UPDATE VIRTUALFSMAPPING (Update a virtual file space mapping) 1968
UPDATE VOLHISTORY (Update sequential volume history information) 1970
UPDATE VOLUME (Change a storage pool volume) 1971
VALIDATE commands 1974
VALIDATE ASPERA (Validate an Aspera FASP configuration) 1974
VALIDATE CLOUD (Validate cloud credentials) 1977
VALIDATE LANFREE (Validate LAN-Free paths) 1979
VALIDATE POLICYSET (Verify a policy set) 1980
VALIDATE REPLICATION (Validate replication for a client node) 1982
VALIDATE REPLPOLICY (Verify the policies on the target replication server) 1985
VARY (Bring a random access volume online or offline) 1987
Server options 1988
Modifying server options 1995
Types of server options 1995
Server communication options 1996

Server storage options 1997




Client-server options 1998
Date, number, time, and language options 1999
Database options 1999
Data transfer options 2000
Message options 2000
Event logging options 2000
Security options and licensing options 2001
Miscellaneous options 2001
3494SHARED 2002
ACSACCESSID 2002
ACSLOCKDRIVE 2003
ACSQUICKINIT 2003
ACSTIMEOUTX 2004
ACTIVELOGDIRECTORY 2004
ACTIVELOGSIZE 2005
ADMINCOMMTIMEOUT 2005
ADMINIDLETIMEOUT 2006
ADMINONCLIENTPORT 2006
ADSMGROUPNAME 2006
ALIASHALT 2007
ALLOWDESAUTH 2007
ALLOWREORGINDEX 2008
ALLOWREORGTABLE 2008
ARCHFAILOVERLOGDIRECTORY 2009
ARCHLOGCOMPRESS 2009
ARCHLOGDIRECTORY 2010
ARCHLOGUSEDTHRESHOLD 2010
ASSISTVCRRECOVERY 2010
AUDITSTORAGE 2011
BACKUPINITIATIONROOT 2011
CHECKTAPEPOS 2012
CLIENTDEDUPTXNLIMIT 2013
CLIENTDEPLOYCATALOGURL 2014
CLIENTDEPLOYUSELOCALCATALOG 2014
COMMMETHOD 2015
COMMTIMEOUT 2015
CONTAINERRESOURCETIMEOUT 2016
DATEFORMAT 2016
DBDIAGLOGSIZE 2017
DBDIAGPATHFSTHRESHOLD 2018
DBMEMPERCENT 2018
DBMTCPPORT 2019
DEDUPREQUIRESBACKUP 2019
DEDUPTIER2FILESIZE 2020
DEDUPTIER3FILESIZE 2020
DEVCONFIG 2021
DISABLEREORGTABLE 2022
DISABLESCHEDS 2022
DISPLAYLFINFO 2022
DNSLOOKUP 2023
DRIVEACQUIRERETRY 2024
ENABLENASDEDUP 2024
EVENTSERVER 2025
EXPINTERVAL 2025
EXPQUIET 2026
FASPBEGPORT

2026




FASPENDPORT 2026
FASPTARGETRATE 2027
FFDCLOGLEVEL 2028
FFDCLOGNAME 2028
FFDCMAXLOGSIZE 2029
FFDCNUMLOGS 2029
FILEEXIT 2030
FILETEXTEXIT 2030
FIPSMODE 2031
FSUSEDTHRESHOLD 2031
IDLETIMEOUT 2032
KEEPALIVE 2032
KEEPALIVETIME 2033
KEEPALIVEINTERVAL 2033
LANGUAGE 2034
LDAPCACHEDURATION 2036
LDAPURL 2037
MAXSESSIONS 2038
MESSAGEFORMAT 2038
MIRRORLOGDIRECTORY 2038
MOVEBATCHSIZE 2039
MOVESIZETHRESH 2039
MSGINTERVAL 2040
NAMEDPIPENAME 2040
NDMPCONNECTIONTIMEOUT 2040
NDMPCONTROLPORT 2041
NDMPENABLEKEEPALIVE 2041
NDMPKEEPIDLEMINUTES 2042
NDMPPORTRANGE 2042
NDMPPREFDATAINTERFACE 2043
NOPREEMPT 2043
NORETRIEVEDATE 2044
NPAUDITFAILURE 2044
NPAUDITSUCCESS 2045
NPBUFFERSIZE 2045
NUMBERFORMAT 2045
NUMOPENVOLSALLOWED 2046
PUSHSTATUS 2047
QUERYAUTH 2047
RECLAIMDELAY 2048
RECLAIMPERIOD 2048
REORGBEGINTIME 2049
REORGDURATION 2049
REPORTRETRIEVE 2050
REPLBATCHSIZE 2050
REPLSIZETHRESH 2051
REQSYSAUTHOUTFILE 2051
RESOURCETIMEQUT 2052
RESTHTTPSPORT 2052
RESTOREINTERVAL 2053
RETENTIONEXTENSION 2053
SANDISCOVERY 2054
SANDISCOVERYTIMEOUT 2055
SANREFRESHTIME 2055
SEARCHMPQUEUE 2056
SECUREPIPES

2056




SERVERDEDUPTXNLIMIT 2056

SHMPORT 2057
SHREDDING 2058
SNMPHEARTBEATINTERVAL 2058
SNMPMESSAGECATEGORY 2058
SNMPSUBAGENT 2059
SNMPSUBAGENTHOST 2060
SNMPSUBAGENTPORT 2060
SSLFIPSMODE 2060
SSLINITTIMEOUT 2061
SSLTCPADMINPORT 2061
SSLTCPPORT 2062
TCPADMINPORT 2063
TCPBUFSIZE 2063
TCPNODELAY 2064
TCPPORT 2064
TCPWINDOWSIZE 2065
TECBEGINEVENTLOGGING 2065
TECHOST 2066
TECPORT 2066
TECUTFSEVENT 2066
THROUGHPUTDATATHRESHOLD 2067
THROUGHPUTTIMETHRESHOLD 2067
TIMEFORMAT 2068
TXNGROUPMAX 2068
UNIQUETDPTECEVENTS 2069
UNIQUETECEVENTS 2070
USEREXIT 2070
VERBCHECK 2071
VOLUMEHISTORY 2071
Server utilities 2071
DSMMAXSG (Increase the block size for writing data) 2072
DSMSERYV (Start the server) 2073
Server startup script: rc.dsmserv 2075
Server startup script: dsmserv.rc 2075
DSMSERV DISPLAY DBSPACE (Display information about database storage space) 2076
DSMSERV DISPLAY LOG (Display recovery log information) 2077
DSMSERV EXTEND DBSPACE (Increase space for the database) 2079
DSMSERV FORMAT (Format the database and log) 2080
DSMSERV INSERTDB (Move a server database into an empty database) 2082
DSMSERV LOADFORMAT (Format a database) 2084
DSMSERV REMOVEDB (Remove a database) 2085
DSMSERV RESTORE DB (Restore the database) 2087
DSMSERV RESTORE DB (Restore a database to its most current state) 2087
DSMSERV RESTORE DB (Restore a database to a point-in-time) 2089
DSMSERV UPDATE (Create registry entries for a server instance) 2093
DSMULOG (Capture IBM Spectrum Protect server messages to a user log file) 2093
Device utilities 2094
AIX and Linux: dsmsanlist (Display information about devices) 2094
Linux: autoconf (Auto configure devices) 2095
Windows: tsmdlst (Display information about devices) 2097
Server scripts and macros for automation 2098
Server scripts 2098
Defining a server script 2099
Running commands in parallel or serially 2099

Continuing commands across multiple command lines 2100




Including substitution variables in a script 2101
Including logic flow statements in a script 2101
Specifying the IF clause 2101
Specifying the EXIT statement 2102
Specifying the GOTO statement 2102

Using SELECT commands in a script 2102
Updating a script 2103
Appending a new command 2103
Replacing an existing command 2104
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Deleting a command from a server script 2104
Querying a server script to create another server script 2104
Running a server script 2105
Administrative client macros 2105
Writing commands in a macro 2106
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Including substitution variables in a macro 2107
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Return codes for use in IBM Spectrum Protect scripts 2109
PDF files 2111
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Wydajnosé 2112
Rozwiazywanie probleméw 2112
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Introduction to messages 2112
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Example one for QUERY EVENT command 2114
Example two for DEFINE VOLUME command 2114
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Dokumentacja produktu IBM Spectrum Protect
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Rodzina produktéw IBM Spectrum Protect uzywa najnowszego standardu W3C WAI-ARIA 1.0 do zachowania zgodnosci z
przepisami US Section 508 i Web Content Accessibility Guidelines (WCAG) 2.0. Aby skorzystac z utatwien dostepu, nalezy uzyc
najnowszej wersji lektora ekranowego w potaczeniu z najnowsza przegladarkg WWW obstugiwang przez ten produkt.

Dokumentacja produktu w Centrum Wiedzy IBM obstuguje utatwienia dostepu. Funkcje utatwien dostepu w Centrum Wiedzy IBM
zostaty opisane w sekcji Utatwienia dostepu w Centrum Wiedzy IBM.

Nawigowanie przy uzyciu klawiatury

Ten produkt uzywa standardowych klawiszy nawigacyjnych.

Informacje dotyczace interfejsow

Interfejs uzytkownika produktu nie stosuje elementow, ktore migaja z czestotliwoscia od 2 do 55 razy na sekunde.

Internetowy interfejs uzytkownika wykorzystuje arkusze stylow CSS do wyswietlania tresci. Aplikacja pozwala uzytkownikom z
wada wzroku na uzywanie innych ustawien wyswietlania, w tym trybu wyswietlania o wysokim kontrascie. Uzytkownik moze
kontrolowac wielko$¢ czcionki za pomoca urzadzenia lub ustawien przegladarki WWW.

Interfejsy uzytkownika zawierajg elementy nawigacyjne WAI-ARIA, ktére umozliwiajg szybkie przechodzenie miedzy obszarami
funkcjonalnymi aplikacji.

Oprogramowanie dostawcy

Rodzina produktow IBM Spectrum Protect zawiera oprogramowanie pochodzace od innych dostawcdw, ktére nie jest objete
umowa licencyjng firmy IBM. Firma IBM nie udziela jakichkolwiek gwarancji w zakresie utatwien dostepu w tych produktach.
Skontaktuj sie z dostawcg, aby uzyskac informacje o utatwieniach dostepu w tych produktach.

Informacje pokrewne na temat utatwien dostepu

Oprécz standardowych serwisow WWW dziatéw pomocy telefonicznej i wsparcia firma IBM wprowadzita ustuge telefonu
tekstowego (TTY) dla niestyszacych lub niedostyszacych klientéw pozwalajaca uzyskac dostep do ustug handlowych i wsparcia:

Ustuga TTY
800-IBM-3383 (800-426-3383)
(w Ameryce Potnocnej)

Wiecej informacji na temat zaangazowania firmy IBM w upowszechnianie utatwien dostepu mozna znalez¢ w sekcji IBM
Accessibility .

Pakiety produktow i produkty pokrewne

IBM Spectrum Storage Suite i produkty pokrewne rozbudowuja funkcje podstawowego produktu IBM Spectrum Protect.

Pakiety produktow i licencjonowanie

Produkty IBM Spectrum Protect i IBM Spectrum Protect Extended Edition oferujg podstawowe komponenty pozwalajgce na
automatyzacje i centralne zarzadzanie operacjami tworzenia i odtwarzania kopii zapasowych. Komponenty serwera oraz klienta
kopii zapasowych i archiwalnych zawierajg podstawowe funkcje, takie jak tworzenie i odtwarzanie kopii zapasowych oraz
archiwizowanie i odtwarzanie plikow, katalogdw oraz obrazow dyskowych.

Dokumentacja produktu zawiera informacje dotyczace produktéw IBM Spectrum Protect i IBM Spectrum Protect Extended
Edition.

Pakiety produktow, ktére tacza IBM Spectrum Protect z produktami pokrewnymi, moga umozliwiac prostsze kupowanie i
zarzadzanie oprogramowaniem. Pakiety zawierajg produkty, ktére moga spetniaé szereg wymagan dotyczacych ochrony danych i
odtwarzania, udostepniajac uproszczony model licencjonowania.

Wybierz zestaw produktow spetniajgcych wymagania biznesowe:

¢ Informacje na temat zestawow produktow IBM Spectrum Protect zawiera nota techniczna 7048916.

2 IBM Spectrum Protect Knowledge Center Version 8.1.5


http://www.w3.org/TR/wai-aria/
http://www.access-board.gov/guidelines-and-standards/communications-and-it/about-the-section-508-standards/section-508-standards
http://www.w3.org/TR/WCAG20/
http://www.ibm.com/support/knowledgecenter/about/releasenotes.html#accessibility
http://www.ibm.com/able
http://www.ibm.com/support/docview.wss?uid=swg27048916

e Informacje na temat produktu IBM Spectrum Storage Suite, ktory zawiera produkt IBM Spectrum Protect i inne produkty,
podano w sekcji IBM Spectrum Storage Suite.

Produkty pokrewne

Produkt IBM Spectrum Protect mozna rozbudowad, dodajac funkcje dostepne w produktach pokrewnych.

Produkt

Kluczowe korzysci

Odsytacze

IBM® Cloud Object Storage

Udostepnia platforme stuzacg do
przechowywania nieustrukturyzowanych
danych, z woluminami o wielkoéci od
petabajtow do eksabajtow.

e Dowiedz sie wiecej i kup

IBM Spectrum Control

Pozwala na zarzadzanie danymi
analitycznymi.

e Dowiedz sie wiecej i kup
e Dokumentacja produktu

IBM Spectrum Copy Data Management

Ten produkt kataloguje obrazy stanu
NetApp i VMware w celu utatwienia
zarzadzaniem z wykorzystaniem rol i
odtwarzaniem danych z kopii
zapasowych.

e Dowiedz sie wiecej i kup
e Dokumentacja produktu

IBM Spectrum Protect High Speed Data
Transfer

Ten produkt pozwala na uzycie
technologii FASP (Fast Adaptive Secure
Protocol) pozwalajacej na zwigkszenie
szybkosci przesytania danych w
$rodowisku, w ktorym wykryto problemy
z wydajnoscia sieci WAN.

e Dowiedz sie wiecej i kup

e Okreslenie, czy technologia Aspera
FASP moze zoptymalizowac
przesytanie danych w uzywanym
$rodowisku

IBM Spectrum Protect for Data Retention

Zapewnia dtugoterminowg ochrone w
przypadku archiwizowania rekordow
biznesowych, plikéw lub danych.

Archiwizowanie danych zgodnie z
obowiagzujacymi przepisami wymaga
dodatkowych zabezpieczen
umozliwiajgcych zapewnienie czasu
przechowywania danych. Dzieki temu
mozna uzyska¢ pewnos$c, ze dane nie
zostang usuniete przedwczesénie
(nieumyslnie lub intencjonalnie). Aby
spetni¢ wymagania, IBM Spectrum
Protect for Data Retention zapewnia
dodatkowg ochrone danych
archiwizowanych przez produkt IBM
Spectrum Protect.

e Dowiedz sie wiecej i kup

e Dokumentacja produktu
Wskazowka: Dokumentacja dla
tego produktu jest zawarta w
dokumentacji produktu IBM
Spectrum Protect.

IBM Spectrum Protect Plus

Zapewnia ochrone danych i wysoka
dostepnosc dla srodowisk wirtualnych.
Mozna go wdrozy¢ w ciggu kilku minut i
obja¢ srodowisko ochrong w czasie
ponizej godziny. Mozna uzy¢ wersji
autonomicznej produktu IBM Spectrum
Protect Plus lub zintegrowac go z
uzywanym srodowiskiem IBM Spectrum
Protect w celu dtugoterminowego
przechowywania danych i zapewnienia
nadzoru w sposob skalowalny i wydajny.
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Produkt

Kluczowe korzysci

Odsytacze

IBM Spectrum Protect Snapshot

Produkt chroni dane dzieki zintegrowanej
funkcji tworzenia i odtwarzania kopii
zapasowej obrazu stanu (z
rozpoznawaniem aplikacji).

Dane przechowywane przez aplikacje
IBM DB2, SAP, Oracle, Microsoft
Exchange i Microsoft SQL Server moga
by¢ chronione przez produkt IBM
Spectrum Protect Snapshot. Dzigki temu
mozna tworzy¢ i zarzadzac¢ obrazami
stanu na poziomie woluminow dla
systemow plikow i aplikacji
niestandardowych. Mozna okresli¢, czy
produkt IBM Spectrum Protect Snapshot
ma by¢ zintegrowany z produktem IBM
Spectrum Protect.

e Dowiedz sie wiecej i kup
e Dokumentacja produktu

IBM Spectrum Protect for Databases

Chroni dane zapisane w bazach danych
Oracle i Microsoft SQL dzieki
zautomatyzowanym zadaniom,
narzedziom i interfejsom. To
oprogramowanie tworzy na biezgco
spoéjne i scentralizowane kopie zapasowe,
chroniac istotne dane, jednoczesnie
minimalizujac koszty dziatania.
Wskazowka: Obstuga otwartych baz
danych IBM DB2 i IBM Informix jest
zapewniana przez serwery IBM Spectrum
Protect. Do tworzenia kopii zapasowych
tych baz danych nie trzeba instalowac¢
produktu IBM Spectrum Protect for
Databases. Wiecej informacji zawiera
dokumentacja produktow DB2 i Informix.

e Dowiedz sie wiecej i kup
e Dokumentacja produktu

IBM Spectrum Protect for Enterprise
Resource Planning

Udostepnia ochrone danych systemu
SAP.

e Dowiedz sie wiecej i kup
e Dokumentacja produktu

IBM Spectrum Protect for Mail

Automatyzuje ochrone danych, dzieki
czemu kopie zapasowe sg tworzone bez
zamykania serwerow Microsoft Exchange
lub IBM Domino.

e Dowiedz sie wiecej i kup
e Dokumentacja produktu

IBM Spectrum Protect for Space
Management

Produkt hierarchicznego zarzadzania
pamiecig masowa, ktory zmniejsza koszty
pamieci masowej dla rzadko uzywanych
informacji, bez modyfikowania aplikacji i
zmiany sposobu pracy uzytkownikéw. Ten
produkt jest dostepny dla systemdw
operacyjnych IBM AIXi Linux.

e Dowiedz sie wiecej i kup
e Dokumentacja produktu

IBM Spectrum Protect HSM for Windows

Produkt hierarchicznego zarzadzania
pamiecig masowa, ktéry zmniejsza koszty
pamieci masowej dla rzadko uzywanych
informacji, bez modyfikowania aplikacji i
zmiany sposobu pracy uzytkownikow. Ten
produkt jest dostepny dla systemu
operacyjnego Windows.

e Dowiedz sie wiecej i kup
e Dokumentacja produktu
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Produkt

Kluczowe korzysci

Odsytacze

IBM Spectrum Protect for SAN

Wspotpracuje z serwerami i komputerami
klienckimi, przesytajac dane w sieci
pamieci masowej (SAN) zamiast w sieci
LAN. Ten produkt jest agentem pamieci
masowej, ktéry umozliwia tworzenie i
odtwarzanie kopii zapasowych bez
obcigzania sieci LAN.

e Dowiedz sie wiecej i kup
e Dokumentacja produktu

Wersja dokumentacji produktu:
Dokumentacja produktu IBM Tivoli
Storage Manager for SAN 7.1 jest rowniez
aktualna dla rodziny produktow IBM
Spectrum Protect 8.1.

IBM Spectrum Protect for Virtual
Environments

Zapewnia ochrone dostosowang do
wirtualnych $rodowisk VMware i Hyper-V.

e Dowiedz sie wiecej i kup
e Dokumentacja produktu

IBM Spectrum Scale

Udostepnia skalowalng pamieé masowg
dla nieustrukturyzowanych danych.

e Dowiedz sie wiecej i kup
e Dokumentacja produktu

IBM Tivoli Storage Manager for z/OS
Media

Zarzadza zasobami dyskowymi i
tasmowymi w systemie z/0S dla
serwerdéw IBM Spectrum Protect
dziatajgcych w systemach AIX lub Linux
na platformie System z.

e Dokumentacja produktu

Pliki PDF

Gotowe pliki PDF mozna pobrac z Centrum Wiedzy IBM® lub z serwisu FTP.

Gotowe pliki PDF

W podanych nizej sekcjach zamieszczono pliki PDF dostepne dla tej wersji:

e Rozwiazania ochrony danych
e Serwery

Pakiet plikow PDF

Pobierz pakiet, ktory zawiera wszystkie pliki PDF dla tego wydania:

ftp://public.dhe.ibm.com/software/products/ISP/current/

Aktualizacje w tej wersiji

Zapoznaj sie z nowymi funkcjami i udoskonaleniami produktow, aby okresli¢ potencjalne korzysci dla operacji zarzagdzania
pamiecig masowa. Uwagi do wydania zawierajg odsytacze, do ktorych mozna uzyskac dostep w celu uzyskania waznych informacji
przed rozpoczeciem instalacji lub aktualizacji produktéw i komponentow.

Komponent

Podsumowanie aktualizacji

Uwagi do wydania dla wersji 8.1

Komponenty serwera | Aktualizacje

Uwagi do wydania

e Program Beta

Program Beta produktu IBM Spectrum Protect pozwala na wglad w funkcje tworzonego produktu i umozliwia przesytanie
opinii majacych wptyw na projekt produktu. Dzieki temu programowi mozna przetestowac produkt we wtasnym srodowisku
i przekaza¢ uwagi bezposrednio do programistéw.

IBM Spectrum Protect concepts

IBM Spectrum Protect™ provides a comprehensive data protection environment.

e IBM Spectrum Protect overview

IBM Spectrum Protect provides centralized, automated data protection that helps to reduce data loss and manage
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compliance with data retention and availability requirements.
e Data storage concepts in IBM Spectrum Protect

IBM Spectrum Protect provides functions to store data in a range of device and media storage.
e Data protection strategies with IBM Spectrum Protect

IBM Spectrum Protect provides ways for you to implement various data protection strategies.

IBM Spectrum Protect overview

IBM Spectrum Protect™ provides centralized, automated data protection that helps to reduce data loss and manage compliance
with data retention and availability requirements.

e Data protection components
The data protection solutions that IBM Spectrum Protect provides consist of a server, client systems and applications, and
storage media. IBM Spectrum Protect provides management interfaces for monitoring and reporting the data protection
status.

e Data protection services
IBM Spectrum Protect provides data protection services to store and recover data from various types of clients. The data
protection services are implemented through policies that are defined on the server. You can use client scheduling to
automate the data protection services.

e Processes for managing data protection with IBM Spectrum Protect
The IBM Spectrum Protect server inventory has a key role in the processes for data protection. You define policies that the
server uses to manage data storage.

e User interfaces for the IBM Spectrum Protect environment
For monitoring and configuration tasks, IBM Spectrum Protect provides various interfaces, including the Operations Center,
a command-line interface, and an SQL administrative interface.

Data protection components

The data protection solutions that IBM Spectrum Protect™ provides consist of a server, client systems and applications, and
storage media. IBM Spectrum Protect provides management interfaces for monitoring and reporting the data protection status.

Server

Client systems send data to the server to be stored as backups or archived data. The server includes an inventory, which is a
repository of information about client data.

The inventory includes the following components:

Database
Information about each file, logical volume, or database that the server backs up, archives, or migrates is stored in the
server database. The server database also contains information about the policy and schedules for data protection
services.

Recovery log
Records of database transactions are kept in this log. The database uses the recovery log to ensure data consistency in the
database.

Client systems and applications

Clients are applications, virtual machines, and systems that must be protected. The clients send data to the server, as shown in
Figure 1.

Figure 1. Components in the data protection solution
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Client software
For IBM Spectrum Protect to protect client data, the appropriate software must be installed on the client system and the
client must be registered with the server.

Client nodes
A client node is equivalent to a computer, virtual machine, or application, such as a backup-archive client that is installed on
a workstation for file system backups. Each client node must be registered with the server. Multiple nodes can be registered
on a single computer.

Storage media

The server stores client data to storage media. The following types of media are used:
Storage devices

The server can write data to hard disk drives, disk arrays and subsystems, stand-alone tape drives, tape libraries, and other
types of random-access and sequential-access storage. Storage devices can be connected directly to the server or
connected through a local area network (LAN) or a storage area network (SAN).

Storage pools

Storage devices that are connected to the server are grouped into storage pools. Each storage pool represents a set of
storage devices of the same media type, such as disk or tape drives. IBM Spectrum Protect stores all of the client data in
storage pools. You can organize storage pools into a hierarchy, so that data storage can transfer from disk storage to lower-
cost storage such as tape devices.

Data protection services

IBM Spectrum Protect™ provides data protection services to store and recover data from various types of clients. The data
protection services are implemented through policies that are defined on the server. You can use client scheduling to automate
the data protection services.

Types of data protection services

IBM Spectrum Protect provides services to store and recover client data as shown in Figure 1.

Figure 1. Data protection services
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IBM Spectrum Protect provides the following types of data protection services:

IBM Spectrum Protect Knowledge Center Version 8.1.5 7



Back up and restore services

You run a backup process to create a copy of a data object that can be used for recovery if the original data object is lost. A
data object can be afile, a directory, or a user-defined data object, such as a database.

To minimize the use of system resources during the backup operation, IBM Spectrum Protect uses the progressive
incremental backup method. For this backup method, a first full backup of all data objects is created and in subsequent
backup operations only changed data is moved to storage. Compared to incremental and differential backup methods that
require taking periodic full backups, the progressive incremental backup method provides the following benefits:

e Reduces data redundancy
e Uses less network bandwidth
e Requires less storage pool space

To further reduce storage capacity requirements and network bandwidth usage, IBM Spectrum Protect includes data
deduplication for data backups. The data deduplication technique removes duplicate data extents from backups.

You run a restore process to copy an object from a storage pool to the client. You can restore a single file, all files in a
directory, or all of the data on a computer.

Archive and retrieve services

You use the archive service to preserve data that must be stored for a long time, such as for regulatory compliance. The
archive service provides the following features:

e When you archive data, you specify how long the data must be stored.

e You can request that files and directories are copied to long-term storage on media. For example, you might choose
to store this data on a tape device, which can reduce the cost of storage.

e You can specify that the original files are erased from the client after the files are archived.

The retrieve service provides the following features:

e When you retrieve data, the data is copied from a storage pool to a client node.
e The retrieve operation does not affect the archive copy in the storage pool.

Migrate and recall services
You use migrate and recall services to manage space on client systems. The goal of space management is to maximize
available media capacity for new data and to minimize access time to data. You can migrate data to server storage to
maintain sufficient free storage space on a local file system. You can store migrated data in the following ways:

e On disk storage for long-term storage
e Inavirtual tape library (VTL) for fast recall of files

You can recall files to the client node on demand, either automatically or selectively.

Types of client data that can be protected

You can protect data for the following types of clients with IBM Spectrum Protect:

Application clients
IBM Spectrum Protect can protect data for specific products or applications. These clients are called application clients. To
protect the structured data for these clients, in other words the data in database fields, you must back up components that
are specific to the application. IBM Spectrum Protect can protect the following applications:

e IBM Spectrum Protect for Enterprise Resource Planning clients:
o Data Protection for SAP HANA
o Data Protection for SAP for DB2®
o Data Protection for SAP for Oracle
e IBM Spectrum Protect for Databases clients:
o Data Protection for Microsoft SQL server
o Data Protection for Oracle
e IBM Spectrum Protect for Mail clients:
o Data Protection for IBM® Domino®
o Data Protection for Microsoft Exchange Server

Virtual machines
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Virtual machines that are backed up by using application client software that is installed on the virtual machine. In the IBM
Spectrum Protect environment, a virtual machine can be protected by the IBM Spectrum Protect for Virtual Environments.

System clients
The following IBM Spectrum Protect clients are called system clients:
e All clients that back up data in files and directories, in other words unstructured data, such as backup-archive clients

and API clients that are installed on workstations.

e Aserverthatis included in a server-to-server virtual volume configuration.
e Avirtual machine that is backed up by using backup-archive client software that is installed on the virtual machine.

Processes for managing data protection with IBM Spectrum Protect

The IBM Spectrum Protect™ server inventory has a key role in the processes for data protection. You define policies that the

server uses to manage data storage.

Data management process

Figure 1 shows the IBM Spectrum Protect data management process.

Figure 1. Data management process
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IBM Spectrum Protect uses policies to control how the server stores and manages data objects on various types of storage

devices and media. You associate a client with a policy domain that contains one active policy set. When a client backs up,
archives, or migrates a file, the file is bound to a management class in the active policy set of the policy domain. The management

class and the backup and archive copy groups specify where files are stored and how they are managed. If you set up server

storage in a hierarchy, you can migrate files to different storage pools.

Inventory components
The following inventory components are key to the operation of the server:

Server database
client data, called metadata. Information about client data includes the file name, file size, file owner, management class,

The server database contains information about client data and server operations. The database stores information about
copy group, and location of the file in server storage. The database includes the following information that is necessary for

the operation of the server:
e Definitions of client nodes and administrators
e Policies and schedules
e Server settings
e Records of server operations, such as activity logs and event records

e Intermediate results for administrative queries

Recovery log

The server records database transactions in the recovery log. The recovery log helps to ensure that a failure does not leave
the database in an inconsistent state. The recovery log is also used to maintain consistency across server start operations.

The recovery log consists of the following logs:
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Active log
This log records current transactions on the server. This information is required to start the server and database after
a disaster.

Log mirror (optional)
The active log mirror is a copy of the active log that can be used if the active log files cannot be read. All changes that
are made to the active log are also written to a log mirror. You can set up one active log mirror.

Archive log
The archive log contains copies of closed log files that were in the active log. The archive log is included in database
backups and is used for recovery of the server database. Archive log files that are included in a database backup are
automatically pruned after a full database backup cycle is complete. The archive log must have enough space to
store the log files for database backups.

Archive failover log (optional)
The archive failover log, also called a secondary archive log, is the directory that the server uses to store archive log
files when the archive log directory is full.

Policy-based data management

In the IBM Spectrum Protect environment, a policy for data protection management contains rules that determine how client data
is stored and managed. The primary purpose of a policy is to implement the following data management objectives:

e Control which storage pool client data is initially stored in
e Define retention criteria that controls how many copies of objects are stored
e Define how long copies of objects are retained

Policy-based data management helps you to focus on the business requirements for protecting data rather than on managing
storage devices and media. Administrators define policies and assign client nodes to a policy domain.

Depending on your business needs, you can have one policy or many. In a business organization, for example, different
departments with different types of data can have customized storage management plans. Policies can be updated, and the
updates can be applied to data that is already managed.

When you install IBM Spectrum Protect, a default policy that is named STANDARD is already defined. The STANDARD policy
provides basic backup protection for user workstations. To provide different levels of service for different clients, you can add to
the default policy or create a new policy.

You create policies by defining the following policy components:

Policy domain
The policy domain is the primary organizational method of grouping client nodes that share common rules for data
management. Although a client node can be defined to more than one server, the client node can be defined to only one
policy domain on each server.

Policy set
A policy set is a number of policies that are grouped so that the policy for the client nodes in the domain can be activated or
deactivated as required. An administrator uses a policy set to implement different management classes based on business
and user needs. A policy domain can contain multiple policy sets, but only one policy set can be active in the domain. Each
policy set contains a default management class and any number of extra management classes.

Management class

A management class is a policy object that you can bind to each category of data to specify how the server manages the
data. There can be one or more management classes. One management class is assigned to be the default management
class that is used by clients unless they specifically override the default to use a specific management class.

The management class can contain a backup copy group, an archive copy group, and space management attributes. A copy
group determines how the server manages backup versions or archived copies of the file. The space management
attributes determine whether the file is eligible for migration by the space manager client to server storage, and under what
conditions the file is migrated.

Copy group
A copy group is a set of attributes in a management class that controls the following factors:

e Where the server stores versions of backed up files or archive copies

How long the server keeps versions of backed up files or archive copies

How many versions of backup copies are retained

e What method to use to generate versions of backed up files or archive copies
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Security management

IBM Spectrum Protect includes security features for registration of administrators and users. After administrators are registered,
they must be granted authority by being assigned one or more administrative privilege classes. An administrator with system
privilege can perform any server function. Administrators with policy, storage, operator, or node privileges can perform subsets of
server functions. The server can be accessed by using the following methods, each controlled with a password:

e Administrator access to manage the server
e Client access to nodes to store and retrieve data

Also included are features that can help to ensure security when clients connect to the server. Depending on business
requirements, as an administrator, you can choose one of the following client registration methods:

Open registration
When the client first connects to the server, the user is requested for a node name, password, and contact information.
Open registration provides the user with following default settings:

e The client node is assigned to the STANDARD policy domain.

e The user can define whether files are compressed to decrease the amount of data that is sent over networks and the
space that is occupied by the data in storage.

e The user can delete archived copies of files from server storage, but not backup versions of files.

Closed registration
Closed registration is the default method for client registration to the server. For this type of registration, an administrator
registers all clients. The administrator can implement the following settings:

e Assign the node to any policy domain
e Determine whether the user can use compression or not, or if the user can choose
e Control whether the user can delete backed up files or archived files

You can add more protection for your data and passwords by using Secure Sockets Layer (SSL). SSL is the standard technology
that you use to create encrypted sessions for servers and clients, and provides a secure channel to communicate over open
communication paths. With SSL, the identity of the server is verified by using digital certificates. If you authenticate with a
Lightweight Directory Access Protocol (LDAP) server, passwords between the server and the LDAP server are protected by
Transport Layer Security (TLS). The TLS protocol is the successor to the SSL protocol. When a server and client communicate, TLS
ensures that third parties cannot intercept messages.

User interfaces for the IBM Spectrum Protect environment

For monitoring and configuration tasks, IBM Spectrum Protect™ provides various interfaces, including the Operations Center, a
command-line interface, and an SQL administrative interface.

Interfaces for data storage management

The Operations Center is the primary interface for administrators to monitor and administer servers. A key benefit of the
Operations Center is that you can monitor multiple servers, as shown in Figure 1. You can also monitor and administer IBM
Spectrum Protect from a command-line administrative interface.

Figure 1. User interfaces for data storage management
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You use the following interfaces to interact with IBM Spectrum Protect:

Operations Center

The Operations Center provides web and mobile access to status information about the IBM Spectrum Protect
environment. You can use the Operations Center to complete monitoring and certain administration tasks, for example:

e You can monitor multiple servers and clients.

e You can monitor the transaction activity for specific components in the data path, such as the server database, the
recovery log, storage devices, and storage pools.

Command-Lline interface
You can use a command-Lline interface to run administration tasks for servers. You can access the command-line interface
through either the IBM Spectrum Protect administrative client or the Operations Center.

Access to information in the server database by using SQL statements

You can use SQL SELECT statements to query the server database and display the results. Third-party SQL tools are
available to aid administrators in database management.

Interfaces for client activity management

IBM Spectrum Protect provides the following types of interfaces for managing client activity:

e An application programming interface (API)
Graphical user interfaces for clients

Browser interface for the backup-archive client
Command-Lline interfaces for clients

Data storage concepts in IBM Spectrum Protect

IBM Spectrum Protect™ provides functions to store data in a range of device and media storage.

To make storage devices available to the server, you must attach the storage devices and map storage pools to device classes,
libraries, and drives.

e Types of storage devices

You can use various storage devices with IBM Spectrum Protect to meet specific data protection goals.
e Data storage in storage pools

Logical storage pools are the principal components in the IBM Spectrum Protect model of data storage. You can optimize
the usage of storage devices by manipulating the properties of storage pools and volumes.
e Data transport to storage across networks

The IBM Spectrum Protect environment provides ways to securely move data to storage across various types of networks
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and configurations.

Types of storage devices

You can use various storage devices with IBM Spectrum Protect™ to meet specific data protection goals.

Storage devices and storage objects

The IBM Spectrum Protect server can connect to a combination of manual and automated storage devices. You can connect the
following types of storage devices to IBM Spectrum Protect:

Disk devices that are directly attached, SAN-attached, or network attached
Physical tape devices that are either manually operated or automated
Virtual tape devices

Cloud object storage

IBM Spectrum Protect represents physical storage devices and media with storage objects that you define in the server database.
Storage objects classify available storage resources and manage migration from one storage pool to another. Table 1 describes
the storage objects in the server storage environment.

Table 1. Storage objects and representations

Storage object What the object represents

Volume A discrete unit of storage on disk, tape, or other storage media.
Each volume is associated with a single storage pool.

Storage pool A set of storage volumes or containers that is the destination
that is used to store client data. IBM Spectrum Protect uses
the following types of storage pool:

e Directory-container storage pools

e Cloud-container storage pools

e Sequential-access storage pools that are associated
with a device class

e Random-access storage pools that are associated with a

device class
Container A data storage location, for example, a file, directory, or device.
Container storage pool A primary storage pool that a server uses to store data. Data is

stored in containers in file system directories or in cloud
storage. Data is deduplicated, if necessary, as the server writes
data to the storage pool.

Device class The type of storage device that can use the volumes that are
defined in a sequential-access or random-access storage pool.
Each device class of removable media type is associated with a
single library.

Library A storage device. For example, a library can represent a stand-
alone drive, a set of stand-alone drives, a multiple-drive
automated device, or a set of drives that is controlled by a
media manager.

Drive An object of a tape library device that provides the capability to
read and write data to tape library media. Each drive is
associated with a single library.

Path The specification of the data source and the device destination.
Before a storage device can be used, a path must be defined
between the device and the source server that is moving data.
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Storage object

What the object represents

Data mover

A SAN-attached device that is used to transfer client data. A
data mover is used only in a data transfer where the server is
not present, such as in a Network Data Management Protocol
(NDMP) environment. Data movers transfer data between
storage devices without using significant server, client, or
network resources.

Server

A server that is managed by another IBM Spectrum Protect
server.

The administrator defines the storage objects in the

Figure 1. Storage objects

Logical layer
Chbjects defined on the server

logical layer of the server, as illustrated in Figure 1.

Physical layer
Slorage devices

|
Volume I Represents

L J

- E Unit of storage
on storage
= | media

Storage pools

=lar=)
<E°

L

Data stored in
contaner directories
=1 on disk storage

Diec:mn;nntainer

Diata stored in
containers in
cloud starage

—

W

Clou :I-;n;tainer

Callecton of volumes
" on dsk slorage

Device ==Y
class
M

Random access

Fa
Collectian of valumes
on lape sharage media

Sequential access

W

Virtual tage volumes or
n sequential file volumes
-] ondsk

L J

Hardware
l storage devices

Library [~ [ gl
Drives E

Definition of the source server
and destination device far data

L ]

E—wl

a SAN-gttached device that

- transfers client data

TIlGEH-e)

Server relationships such as starage
apents; library manager and library
client; replication source and target

Disk devices

You can store client data on disk devices with the following types of volumes:

e Directories in directory-container storage pools

e Random-access volumes of device type DISK

e Sequential-access volumes of device type FILE

IBM Spectrum Protect offers the following features when you use directory-container storage pools for data storage:

* You can apply data deduplication and disk caching techniques to maximize data storage usage.

14 IBM Spectrum Protect Knowledge Center Version 8.1.5




e You can retrieve data from disk much faster than you can retrieve data from tape storage.

Physical tape devices

In a physical tape library, the storage capacity is defined in terms of the total number of volumes in the library. Physical tape
devices can be used for the following activities:

e Storing client data that is backed up, archived, or migrated from client nodes
e Storing database backups
e Exporting data to another server or offsite storage

Moving data to tape provides the following benefits:

e You can keep data for clients on a disk device at the same time that the data is moved to tape.

e You can improve tape drive performance by streaming the data migration from disk to tape.

e You can spread out the times when the drives are in use to improve the efficiency of the tape drives.

e You can move data on tape to off-site vaults.

e You can limit power consumption because tape devices do not consume power after data is written to tape.
e You can apply encryption that is provided by the tape drive hardware to protect the data on tape.

Compared to equivalent disk and virtual tape storage, the unit cost to store data tends to be much less for physical tape devices.

Virtual tape libraries

A virtual tape library (VTL) does not use physical tape media. When you use VTL storage, you emulate the access mechanisms of
tape hardware. In a VTL, you can define volumes and drives to provide greater flexibility for the storage environment. The storage
capacity of a VTL is defined in terms of total available disk space. You can increase or decrease the number and size of volumes on
disk.

Defining a VTL to the IBM Spectrum Protect server can improve performance because the server handles mount point processing
for VTLs differently than for real tape libraries. Although the logical limitations of tape devices are still present, the physical
limitations for tape hardware are not applicable to a VTL thus affording better scalability. You can use the IBM Spectrum Protect
VTL when the following conditions are met:

e Only one type and generation of drive and media is emulated in the VTL.
e Every server and storage agent with access to the VTL has paths that are defined for all drives in the library.

Data storage in storage pools

Logical storage pools are the principal components in the IBM Spectrum Protect™ model of data storage. You can optimize the
usage of storage devices by manipulating the properties of storage pools and volumes.

Types of storage pools

The group of storage pools that you set up for the server is called server storage. You can define the following types of storage
pools in server storage:

Primary storage pools
A named set of volumes that the server uses to store backup versions of files, archive copies of files, and files that are
migrated from client nodes.

Copy storage pools
A named set of volumes that contain copies of files that reside in primary storage pools. Copy storage pools are used only
to back up the data that is stored in primary storage pools. A copy storage pool cannot be a destination for a backup copy
group, an archive copy group, or a management class for space-managed files.

Container-copy storage pools
A named set of volumes that contain a copy of data extents that reside in directory-container storage pools. Container-copy
storage pools are used only to protect the data that is stored in directory-container storage pools.

Active-data storage pools
A named set of storage pool volumes that contain only active versions of client backup data.

Primary storage pools
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When you restore, retrieve, recall, or export file data, the requested file is obtained from a primary storage pool. Depending on the
type of primary storage pool, the storage pools can be onsite or offsite. You can arrange primary storage pools in a storage
hierarchy so that data can be transferred from disk storage to lower-cost storage such as tape devices. Figure 1 illustrates the
concept of primary storage pools.

Figure 1. Primary storage pools
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You can define the following types of primary storage pool:

Directory-container storage pools
A storage pool that the server uses to store data in containers in storage pool directories. Data that is stored in a directory-
container storage pool can use either inline data deduplication, client-side data deduplication, inline compression, or
client-side compression. Inline data deduplication or inline compression reduces data at the time it is stored.
Tip: Data that is compressed first cannot be deduplicated, however, deduplicated data can be compressed.

By using directory-container storage pools, you remove the need for volume reclamation, which improves server
performance and reduces the cost of storage hardware. You can protect and repair data in directory-container storage
pools at the level of the storage pool. You can tier data that is stored in a directory-container storage pool to a cloud-
container storage pool.

Restriction: You cannot use any of the following functions with directory-container storage pools:

e Migration

e Reclamation
Aggregation
Collocation
Simultaneous-write
Storage pool backup
e Virtual volumes

Cloud-container storage pools

A storage pool that a server uses to store data in cloud storage. The cloud storage can be on premises or off premises. The
cloud-container storage pools that are provided by IBM Spectrum Protect can store data to cloud storage that is object-
based. By storing data in cloud-container storage pools, you can exploit the cost per unit advantages that clouds offer along
with the scaling capabilities that cloud storage provides. You can use cloud tiering to lower costs by moving data from disk
storage to a cloud-container storage pool. IBM Spectrum Protect manages the credentials, security, read and write I/Os,
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and the lifecycle for data that is stored to the cloud. When cloud-container storage pools are implemented on the server,
you can write directly to the cloud by configuring a cloud-container storage pool with the cloud credentials. Data that is
stored in a cloud-container storage pool uses both inline data deduplication and inline compression. The server writes
deduplicated, compressed, and encrypted data directly to the cloud. You can back up and restore data or archive and
retrieve data directly from the cloud-container storage pool.

You can define the following types of cloud-container storage pools:

On premises
You can use the on premises type of cloud-container storage pool to store data in a private cloud, for more security
and maximum control over your data. The disadvantages of a private cloud are higher costs due to hardware
requirements and onsite maintenance.

Off premises
You can use the off premises type of cloud-container storage pool to store data in a public cloud. The advantage of
using a public cloud is that you can achieve lower costs than for a private cloud, for example by eliminating
maintenance. However, you must balance this benefit against possible performance issues due to connection speeds
and reduced control over your data.

Storage pools that are associated with device classes
You can define a primary storage pool to use the following types of storage devices:

DISK device class
In a DISK device type of storage pool, data is stored in random access disk blocks. You can use caching in DISK
storage pools to increase client restore performance with some limitations on server processing. Space allocation
and tracking by blocks uses more database storage space and requires more processing power than allocation and
tracking by volume.

FILE device class
In a FILE device type of storage pool, files are stored in sequential volumes for better sequential performance than
for storage in disk blocks. To the server, these files have the characteristics of a tape volume so that this type of
storage pool is better suited for migration to tape. FILE volumes are useful for electronic vaulting, where data is
transferred electronically to a remote site rather than by physical shipment of tape. In general, this type of storage
pool is preferred over DISK storage pools.

The server uses the following default random-access primary storage pools:

ARCHIVEPOOL

In the STANDARD policy, this storage pool is the destination for files that are archived from client nodes.
BACKUPPOOL

In the STANDARD policy, this storage pool is the destination for files that are backed up from client nodes.
SPACEMGPOOL

This storage pool is for space-managed files that are migrated from IBM Spectrum Protect for Space Management

client nodes.

Copy storage pools

Copy storage pools contain active and inactive versions of data that is backed up from primary storage pools. A directory-
container storage pool cannot be used as a copy storage pool. In addition, data from a directory-container storage pool cannot be
copied into a copy storage pool. To protect directory-container storage pools, copy the data to a container-copy storage pool.
Figure 2 illustrates the concept of copy storage pools.

Figure 2. Copy storage pools
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Copy storage pools provide a means of recovering from disasters or media failures. For example, when a client attempts to
retrieve a damaged file from the primary storage pool, and the storage pool is unavailable or the file in the storage pool is
corrupted, the client can restore the data from the copy storage pool.

You can move the volumes of copy storage pools offsite and still have the server track the volumes. Moving these volumes offsite
provides a means of recovering from an onsite disaster. A copy storage pool can use sequential-access storage only, such as a
tape device class or FILE device class.

Container-copy storage pools

A server can protect a directory-container storage pool by storing copies of the data in a container-copy storage pool. Data in
container-copy storage pools is stored on tape volumes, which can be stored onsite or offsite. Damaged data in directory-
container storage pools can be repaired by using deduplicated extents in container-copy storage pools. Container-copy storage
pools provide an alternative to using a replication server to protect data in a directory-container storage pool.

Restriction: If all server data is lost, container-copy storage pools alone do not provide the same level of protection as replication:

e With replication, you can directly restore client data from the target server if the source server is unavailable.
e With container-copy storage pools, you must first restore the server from a database backup and then repair directory-
container storage pools from tape volumes.

Figure 3 illustrates the concept of container-copy storage pools.

Figure 3. Container-copy storage pools
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Depending on your system configuration, you can create protection schedules to simultaneously copy the directory-container
storage pool data to onsite or offsite container-copy storage pools to meet your requirements:

e Ifreplication is enabled, you can create one offsite container-copy pool. The offsite copy can be used to provide extra
protection in a replicated environment.
e Ifreplication is not enabled, you can create one onsite and one offsite container-copy storage pool.

Depending on the resources and requirements of your site, the ability to copy directory-container storage pools to tape has the
following benefits:

e You avoid maintaining another server and more disk storage space.

e Data is copied to storage pools that are defined on the server. Performance is not dependent on, or affected by, the network
connection between servers.

¢ You can satisfy regulatory and business requirements for offsite tape copies.

Active-data storage pools

An active-data pool contains only active versions of client backup data. In this case, the server does not have to position past
inactive files that do not have to be restored. A directory-container storage pool cannot be used as an active-data storage pool.
You use active-data pools to improve the efficiency of data storage and restore operations. For example, this type of storage pool
can help you to achieve the following objectives:

e Increase the speed of client data restore operations

e Reduce the number of onsite or offsite storage volumes

e Reduce the amount of data that is transferred when you copy or restore files that are vaulted electronically in a remote
location
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Data that is migrated by hierarchical storage management (HSM) clients and archive data are not permitted in active-data pools.
As updated versions of backup data are stored in active-data pools, older versions are removed as the remaining data is
consolidated from many sequential-access volumes onto fewer, new sequential-access volumes. Figure 4 illustrates the concept
of active-data storage pools.
Figure 4. Active-data storage pools
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Active-data pools can use any type of sequential-access storage. However, the benefits of an active-data pool depend on the
device type that is associated with the pool. For example, active-data pools that are associated with a FILE device class are ideal
for fast client restore operations because of the following reasons:

e FILE volumes do not have to be physically mounted
e C(Client sessions that are restoring from FILE volumes in an active-data pool can access the volumes concurrently, which
improves restore performance

Related information:
™ Directory-container storage pools FAQs
[ Cloud-container storage pools FAQs

Data transport to storage across networks

The IBM Spectrum Protect™ environment provides ways to securely move data to storage across various types of networks and
configurations.

Network configurations for storage devices

IBM Spectrum Protect provides methods for configuring clients and servers on a local area network (LAN), on a storage area
network (SAN), LAN-free data movement, and as network-attached storage.

Data backup operations over a LAN
Figure 1 shows the data path for IBM Spectrum Protect backup operations over a LAN.
Figure 1. IBM Spectrum Protect backup operations over a LAN
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In a LAN configuration, one or more tape libraries are associated with a single IBM Spectrum Protect server. In this type of
configuration, client data, electronic mail, terminal connection, application program, and device control information must
all be handled by the same network. Device control information and client backup and restore data flow across the LAN.

Data backup operations over a SAN
Figure 2 shows the data path for IBM Spectrum Protect backup operations over a SAN.
Figure 2. IBM Spectrum Protect backup operations over a SAN
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A SAN is a dedicated storage network that can improve system performance. On a SAN, you can consolidate storage and
relieve the distance, scalability, and bandwidth limitations of LANs and wide area networks (WANSs). By using IBM Spectrum
Protect in a SAN, you can take advantage of the following functions:

e Share storage devices among multiple IBM Spectrum Protect servers. Devices that use the GENERICTAPE device
type are not included.

e Move data from a client system directly to storage devices without using the LAN. LAN-free data movement requires
the installation of a storage agent on the client system. The storage agent is available with the IBM Spectrum Protect
for SAN product.

Through the storage agent, the client can directly back up and restore data to a tape library or shared file system
such as GPFS™. The IBM Spectrum Protect server maintains the server database and recovery log, and acts as the
library manager to control device operations. The storage agent on the client handles the data transfer to the device
on the SAN. This implementation frees bandwidth on the LAN that would otherwise be used for client data
movement.

e Share tape drives and libraries that are supported by the IBM Spectrum Protect server.
e Consolidate multiple clients under a single client node name in a General Parallel File System (GPFS) cluster.

Network-attached storage
Network-attached storage (NAS) file servers are dedicated storage servers whose operating systems are optimized for file-
serving functions. NAS file servers typically interact with IBM Spectrum Protect through industry-standard network
protocols, such as network data management protocol (NDMP) or as primary storage for random-access or sequential
access storage pools. IBM Spectrum Protect provides the following basic types of configurations that use NDMP for backing
up and managing NAS file servers:

e IBM Spectrum Protect backs up a NAS file server to a library device that is directly attached to the NAS file server.
The NAS file server, which can be remote from the IBM Spectrum Protect server, transfers backup data directly to a
drive in a SCSI-attached tape library. Data is stored in NDMP-formatted storage pools, which can be backed up to
storage media that can be moved offsite for protection in case of an onsite disaster.

e IBM Spectrum Protect backs up a NAS file server over the LAN to a storage-pool hierarchy. In this type of
configuration, you can store NAS data directly to disk, either random access or sequential access, and then migrate
the data to tape. You can also use this type of configuration for system replication. Data can also be backed up to
storage media that can be moved offsite. The advantage of this type of configuration is that you have all of the data
management features associated with a storage pool hierarchy.

e The IBM Spectrum Protect client reads the data from the NAS system by using NFS or CIFS protocols and sends the
data to the server to be stored.

Storage management

You manage the devices and media that are used to store client data through the IBM Spectrum Protect server. The server
integrates storage management with the policies that you define for managing client data in the following areas:

Types of devices for server storage
With IBM Spectrum Protect, you can use directly attached devices and network-attached devices for server storage. IBM
Spectrum Protect represents physical storage devices and media with administrator-defined storage objects.

Data migration through the storage hierarchy
For primary storage pools other than directory-container storage pools, you can organize the storage pools into one or more
hierarchical structures. This storage hierarchy provides flexibility in a number of ways. For example, you can set a policy to
back up data to disks for faster backup operations. The IBM Spectrum Protect server can then automatically migrate data
from disk to tape.
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Removal of expired data
The policy that you define controls when client data automatically expires from the IBM Spectrum Protect server. To
remove data that is eligible for expiration, a server expiration process marks data as expired and deletes metadata for the
expired data from the database. The space that is occupied by the expired data is then available for new data. You can
control the frequency of the expiration process by using a server option.

Media reuse by reclamation
As server policies automatically expire data, the media where the data is stored accumulates unused space. For storage
media other than directory-container storage pools or random disk storage pools, the IBM Spectrum Protect server
implements reclamation, a process that frees media for reuse without traditional tape rotation. Reclamation automatically
defragments media by consolidating unexpired data onto other media when the free space on media reaches a defined
level. The reclaimed media can then be used again by the server. Reclamation allows media to be automatically circulated
through the storage management process and minimize the number of media that are required.

Consolidating backed up client data

By grouping the client data that is backed up, you can minimize the number of media mounts required for client recovery. The IBM
Spectrum Protect server provides the following methods for grouping client files on storage media other than directory-container
storage pools:

Collocating client data

The IBM Spectrum Protect server can collocate client data, in other words store client data on a few volumes instead of
spreading the data across many volumes. Collocation by client minimizes the number of volumes that are required to back
up and restore client data. Data collocation might increase the number of volume mounts because each client might have a
dedicated volume instead of data storage from several clients in the same volume.

You can set the server to collocate client data when the data is initially placed in server storage. In a storage hierarchy, you
can collocate the data when the server migrates the data from the initial storage pool to the next storage pool in the storage
hierarchy. You can collocate by client, by file space per client, or by a group of clients. Your selection depends on the size of
the file spaces that are stored and restore requirements.

Associating active-data pools with various devices

Active-data pools are useful for fast restoration of client data. Benefits include a reduction in the number of onsite or offsite
storage volumes, or reducing bandwidth when you copy or restore files that are vaulted electronically in a remote location.
Active-data pools that use removable media, such as tape, offer similar benefits. Although tape devices must be mounted,
the server does not have to position past inactive files. However, the primary benefit of using removable media in active-
data pools is that the number of volumes that are used for onsite and offsite storage is reduced. If you store datato a
remote location, you can minimize the amount of data that must be transferred by copying and restoring only active data.

Creating a backup set

A backup set contains all of the active backed-up files that exist for that client in server storage. The backup set is portable
and is retained for the time that you specify. A backup set is in addition to the backups that are already stored and requires
extra media.

Moving data for a client node

You can consolidate data for a client node by moving the data within server storage. You can move a backup set to different
media, where the backup set is retained until the time that you specify. Consolidating data can help to improve efficiency
during client restore or retrieve operations.

Data protection strategies with IBM Spectrum Protect

IBM Spectrum Protect™ provides ways for you to implement various data protection strategies.

You can configure IBM Spectrum Protect to send data to storage devices that are on the local site or on a remote site. To maximize
data protection, you can configure replication to a remote server.

e Strategies to minimize the use of storage space for backups
To minimize the amount of storage space that is required, IBM Spectrum Protect backs up data by using the data
deduplication and progressive incremental backup techniques.

e Strategies for disaster protection
IBM Spectrum Protect provides strategies to protect data if a disaster occurs. These strategies include node replication to a
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remote site, storage pool protection, database backups, moving backup tapes offsite, and device replication to a standby
server.

e Strategies for disaster recovery with IBM Spectrum Protect
IBM Spectrum Protect provides several ways to recover the server if the database or storage pools fail.

Strategies to minimize the use of storage space for backups

To minimize the amount of storage space that is required, IBM Spectrum Protect™ backs up data by using the data deduplication
and progressive incremental backup techniques.

Data deduplication

When the IBM Spectrum Protect server receives data from a client, the server identifies duplicate data extents and stores unique
instances of the data extents in a directory-container storage pool. The data deduplication technique improves storage utilization
and eliminates the need for a dedicated data deduplication appliance.

Figure 1. Data deduplication process
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If the same byte pattern occurs many times, data deduplication greatly reduces the amount of data that must be stored or
transferred. In addition to whole files, IBM Spectrum Protect can also deduplicate parts of files that are common with parts of
other files.

IBM Spectrum Protect provides the following types of data deduplication:

Server-side data deduplication
The server identifies duplicate data extents and moves the data to a directory-container storage pool. The server-side
process uses inline data deduplication, where data is deduplicated at the same time that the data is written to a directory-
container storage pool. Deduplicated data can also be stored in other types of storage pools. Inline data deduplication on
the server provides the following benefits:

e Eliminates the need for reclamation
e Reduces the space that is occupied by the stored data

Client-side data deduplication
With this method, processing is distributed between the server and the client during a backup process. The client and the
server identify and remove duplicate data to save storage space on the server. In client-side data deduplication, only
compressed, deduplicated data is sent to the server. The server stores the data in the compressed format that is provided
by the client. Client-side data deduplication provides the following benefits:

e Reduces the amount of data that is sent over the local area network (LAN)
e Eliminates extra processing power and time that is required to remove duplicate data on the server
e Improves database performance because the client-side data deduplication is also inline

You can combine both client-side and server-side data deduplication in the same production environment. The ability to

deduplicate data on either the client or the server provides flexibility in terms of resource utilization, policy management, and data
protection.

Compression
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Use inline compression to reduce the amount of space that is stored in container storage pools. Data is compressed as it is
written to the container storage pool.
Restriction: The IBM Spectrum Protect server cannot compress encrypted data.

Progressive incremental backup

In a progressive incremental backup process, the server monitors client activity and backs up any files that change since the initial
full backup. Entire files are backed up, so that the server does not need to reference base versions of the files. This backup
technique eliminates the need for multiple full backups of client data thus saving network resources and storage space.

Strategies for disaster protection

IBM Spectrum Protect™ provides strategies to protect data if a disaster occurs. These strategies include node replication to a
remote site, storage pool protection, database backups, moving backup tapes offsite, and device replication to a standby server.

Replication to a remote site

Node replication is the process of incrementally copying data from one server to another server. The server from which client data
is replicated is called a source replication server. The server to which client data is replicated is called a target replication server.
For the purposes of disaster protection, the target replication server is on a remote site. A replication server can function as a
source server, a target server, or both. You use replication processing to maintain the same level of files on the source and the
target servers.

Node replication provides for immediate availability of data through failover. Although node replication protects most of the
metadata, this approach does not provide adequate protection for database damage. You can provide more comprehensive
protection by using storage pools to store data backups.

Advantages

e Failover so that data is available immediately if a disaster occurs.
Incremental replication, which results in fast transmission of data.
Electronic transfer

Protects both data and most metadata

Disadvantages

e Both data and metadata must be recovered.
e Data on the source server must be replicated again from the remote site.

Figure 1 shows the node replication process to a remote site.

Figure 1. Node replication process
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When client data is replicated, data that is not on the target server is copied to the target server. When replicated data exceeds the
retention limit, the target server automatically removes the data from the source server. To maximize data protection, you
synchronize the local server and the remote server; for example, Site B replicates data from Site A and Site A replicates data from
Site B. As part of replication processing, client data that was deleted from the source server is also deleted from the target server.

IBM Spectrum Protect provides the following replication functions:

* You can define policies for the target server in the following ways:
o Identical policies on the source server and target server
o Different policies on the source server and target server to meet different business requirements.
If a disaster occurs and the source server is not available, clients can recover data from the target server. If the source
server cannot be recovered, you can direct clients to store data on the target server. When an outage occurs, the clients
that are backed up to the source server can automatically fail over to restore their data from the target server.
e You can use replication processing to recover damaged files from storage pools. You must replicate the client data to the
target server before the file damage occurs. Subsequent replication processes detect damaged files on the source server
and replace the files with undamaged files from the target server.

Role of replication in disaster protection

If a disaster occurs, you can recover replicated data from the remote site and maintain the same level of files on the source and
target servers. You use replication to achieve the following objectives:

e Control network throughput by scheduling node replication at specific times
e Recover data after a site loss.
e Recover damaged files on the source server.

Storage pool protection

As part of a disaster recovery strategy, ensure that a backup copy of data in storage pools is available at a remote site.
Advantages

e Fast recovery and rebuild of the source system.
Disadvantages

e Only data is protected; metadata is not protected.

e For each storage pool, you must define the storage medium.
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You use different techniques to protect against the permanent loss of data that is stored in container storage pools and in FILE
and DISK storage pools.

Directory-container storage pools

If you do not need to replicate all the data that is contained in a client node, you use container-copy storage pools to
protect some directory-container storage pools. By protecting a directory-container storage pool, you do not use resources
that replicate existing data and metadata, which improves server performance.

The preferred method is to protect the directory-container storage pool before you replicate the client node. When node
replication is started, the data extents that are already replicated through storage pool protection are skipped, which
reduces the replication processing time. If the data in a directory-container storage pool becomes damaged, you can repair
the data from a copy in a container-copy storage pool.

Container-copy storage pools

You protect directory-container storage pools by copying the data in the directory-container storage pool to container-copy
storage pools. Use container-copy storage pools to create up to two tape copies of a directory-container storage pool. The
tape copies can be stored onsite or offsite. Damaged data in directory-container storage pools can be repaired by using
container-copy storage pools. Container-copy storage pools provide an alternative to using a replication server to protect
data in a directory-container storage pool.

Storage pools that are associated with FILE and DISK device classes

For storage pools that are associated with FILE and DISK device classes, you use node replication to maintain a node-
consistent copy of the data at the target server. The data copy can be directly restored from the target server to the storage
pools.

Database backups

You use database backups to recover your system following database damage. Also, database backup operations must be used to
prevent DB2 from running out of archive log space. Database backup operations are not part of node replication. A database
backup can be full, incremental, or snapshot. To provide for disaster recovery, a copy of the database backups must be stored
offsite. To restore the database, you must have the backup volumes for the database. You can restore the database from backup
volumes by either a point-in-time restore or a most current restore operation.

Point-in-time restore
Use point-in-time restore operations for situations such as disaster recovery or to remove the effects of errors that can
cause inconsistencies in the database. Restore operations for the database that use snapshot backups are a form of point-
in-time restore operation. The point-in-time restore operation includes the following actions:

e Removes and re-creates the active log directory and archive log directory that are specified in the dsmserv.opt file.

e Restores the database image from backup volumes to the database directories that are recorded in a database
backup or to new directories.

e Restores archive logs from backup volumes to the overflow directory.

e Uses log information from the overflow directory up to a specified point in time.

Most current restore
If you want to recover the database to the time when the database was lost, recover the database to the most current state.
The most current restore operation includes the following actions:

e Restores a database image from the backup volumes to the database directories that are recorded in a database
backup or to new directories.

e Restores archive logs from backup volumes to the overflow directory.

e Uses log information from the overflow directory and archive logs from archive log directory.

The most current restore does not remove and re-create the active log directory or archive log directory.

Alternative methods for disaster protection

In addition to replication, storage pool protection, and database backups, you can also use the following methods to protect data
and implement disaster recovery with IBM Spectrum Protect:

Sending backup tapes to a remote site
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Data is backed up to tape at scheduled times by the source server. The tapes are sent to a remote site. If a disaster occurs,
the tapes are returned to the site of the source server and the data is restored on the source clients. Offsite copies of data
on backup tape can also help you to recover from ransomware attacks.

Multisite appliance replication to a standby server
In the multisite appliance configuration, the source appliance is replicated to a remote server in a SAN architecture. In this
configuration, if the client hardware at the original site is damaged, the source device can be replicated from the standby
server at the remote site. This configuration provides disk-based backup and restore operations.

Comparison of protection configuration strategies

Consider the following potential data-loss scenarios:

e Database data is damaged: protect against loss of data in the database by using onsite database backup.
e Storage pool data is damaged: protect against loss of data in storage pools by using onsite copy storage pools or node
replication.

e Disaster scenario where both the onsite database and storage pools are lost: protect against a full disaster by using node
replication and both off-site database backup and storage pool backup copies.

The following possible configurations address the most common data protection scenarios:
Configurations for damage protection only

e Implement database backup operations onsite with an optional container-copy storage pool onsite to protect data in
directory-container storage pools.

e Implement database backup operations onsite and node replication onsite.
Configurations for disaster recovery and damage protection

e Implement database backup operations offsite with container-copy storage pools offsite to protect data in directory-
container storage pools.

e Implement database backup operations onsite and node replication offsite with an optional container-copy storage
pool onsite for faster recovery of damaged data.

Strategies for disaster recovery with IBM Spectrum Protect

IBM Spectrum Protect™ provides several ways to recover the server if the database or storage pools fail.

Automatic failover for disaster recovery

Automatic failover is an operation that switches to a standby system if a software, hardware, or network interruption occurs.
Automatic failover is used with node replication to recover data after a system failure. Figure 1 shows the IBM Spectrum Protect
automatic failover process.

Figure 1. Automatic failover process

26 IBM Spectrum Protect Knowledge Center Version 8.1.5



Applications, virtual machines, Applications, virtual machines,

systems systems

. ) .

Failover restore operation Failover restore operation

from server at Site B from server at Site A

- -
1] . - 1]

-~ _ - - -
- —_— -

- -

Mormal back up to and
restore from server at Site A

Mormal back up to and
restore from server at Site B

Mode replication

- &

Imventory Inventory

Server Server

Storage devices Site A Site B Storage devices

Automatic failover for data recovery occurs if the source replication server is unavailable because of a disaster or a system outage.
During normal operations, when the client accesses a source replication server, the client receives connection information for the
target replication server. The client node stores the failover connection information in the client options file.

During client restore operations, the server automatically changes clients from the source replication server to the target
replication server and back again. Only one server per node can be used for failover protection at any time. When a new client
operation is started, the client attempts to connect to the source replication server. The client resumes operations on the source
server if the source replication server is available.

To use automatic failover for replicated client nodes, the source replication server, the target replication server, and the client
must be at the V7.1 level or later. If any of the servers are at an earlier level, automatic failover is disabled and you must rely on a
manual failover process.

Recovery of IBM Spectrum Protect components

The server database, recovery log, and storage pools are critical to the operation of IBM Spectrum Protect and must be protected.
If the database is unusable, the entire server is unavailable and recovering data that is managed by the server might be difficult or
impossible.

Even without the database, fragments of data or complete files might be read from storage pool volumes that are not encrypted
and security can be compromised. Therefore, you must always back up the database. Also, always encrypt sensitive data by using
the client or the storage device, unless the storage media is physically secured.

IBM Spectrum Protect provides several data protection methods, which include backing up storage pools and the database. For
example, you can define schedules so that the following operations occur:

e After the initial full backup of your storage pools, incremental storage pool backups are run every night.
e Incremental database backups are run every night.
e Full database backups are run once a week.

For tape-based environments, you can use disaster recovery manager (DRM) to assist you in many of the tasks that are associated
with protecting and recovering data. DRM is available with IBM Spectrum Protect Extended Edition.

Preventive actions for recovery

Recovery is based on the following preventive actions:

e Mirroring, by which the server maintains a copy of the active log
e Backing up the database
e Backing up the storage pools
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Auditing storage pools for damaged files and recovery of damaged files when necessary

e Backing up the device configuration and volume history files

Validating the data in storage pools by using cyclic redundancy checking

Storing the cert.kdb file in a safe place to ensure that the Secure Sockets Layer (SSL) is secure

If you are using tape for storage, you can also create a disaster recovery plan to guide you through the recovery process by using
DRM. You can use the disaster recovery plan for audit purposes to certify the recoverability of the server. The disaster recovery
methods of DRM are based on taking the following actions:

e Creating a disaster recovery plan file for the server

e Backing up server data to tape

e Sending the server backup data to a remote site or to another server

e Storing client system information

e Defining and tracking the storage media that is used for storing and recovering client data

IBM Spectrum Protect data protection solutions

IBM Spectrum Protect™ servers and clients provide data protection solutions for the most common business and compliance
requirements.

e Selecting a data protection solution for your environment
To help you to deploy a data protection environment, review information about best practice IBM Spectrum Protect
configurations, and select the best solution for your business needs.
e Single-site disk solution
This data protection solution provides cost-effective data storage at a single site with minimal hardware setup.
e Multisite disk solution
This data protection solution provides replication at multiple sites so that each server protects data for the other site.
e Tape solution
This data protection solution provides storage to tape media, a flexible and affordable option for long-term data retention.
e Solutions documentation in PDF files
Prebuilt PDF files for IBM Spectrum Protect data protection solutions are available for you to download.

Selecting a data protection solution for your environment

To help you to deploy a data protection environment, review information about best practice IBM Spectrum Protect™
configurations, and select the best solution for your business needs.

e Disk-based implementation of a data protection solution for a single site
This disk-based implementation of a data protection solution with IBM Spectrum Protect uses inline data deduplication and
provides protection for data on a single site.

e Disk-based implementation of a data protection solution for multiple sites
This disk-based implementation of a data protection solution with IBM Spectrum Protect uses inline data deduplication and
replication at two sites.

e Appliance-based implementation of a data protection solution for multiple sites
This implementation of a multi-site IBM Spectrum Protect data protection solution uses appliance-based data
deduplication and replication. A standby server is configured at a second site to recover data if the primary server is
unavailable.

e Tape-based implementation of a data protection solution
This implementation of a data protection solution with IBM Spectrum Protect uses one or more tape storage devices to
back up data. Tape backup provides low-cost scalability that is optimized for long-term retention.

e Comparison of data protection solutions
Compare the key features for each IBM Spectrum Protect solution to determine which configuration best meets your data
protection requirements. Then, review the available documentation to implement the solution.

e Roadmap for implementing a data protection solution
Plan and implement the most suitable data protection solution for your business environment with IBM Spectrum Protect.

Disk-based implementation of a data protection solution for a single site

This disk-based implementation of a data protection solution with IBM Spectrum Protect™ uses inline data deduplication and
provides protection for data on a single site.
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This data protection solution provides the following benefits:

e Server system and storage hardware at a single site

Cost-effective use of storage through the data deduplication feature

e Space-efficient solution with minimal hardware setup

e Minimal implementation that requires installation and configuration for only one server and supporting storage hardware

In this solution, the client sends data to the IBM Spectrum Protect server, where the data is deduplicated and stored in a
directory-container storage pool that is implemented in disk storage. Data from the inventory is also backed up to disk storage.
This solution is suitable for entry-level environments for which a second copy of data is not required.

Related reference:
Comparison of data protection solutions
Roadmap for implementing a data protection solution

Disk-based implementation of a data protection solution for multiple
sites

This disk-based implementation of a data protection solution with IBM Spectrum Protect™ uses inline data deduplication and
replication at two sites.
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This data protection solution provides the following benefits:

e Replication can be configured at both sites so that each server protects data for the other site

e Offsite data storage for each location is simplified

e Bandwidth is used efficiently because only deduplicated data is replicated between the sites

e Clients can automatically fail over to a target replication server if the source replication server is unavailable

In this solution, clients send data to the source server, where the data is deduplicated and stored in a directory-container storage
pool that is implemented in disk storage. The data is replicated to the storage pool on the target server for each site. This solution
is suitable for environments that require disaster protection. If mutual replication is configured, clients at both sites can use
failover recovery for continued backups and data recovery from the available server on the other site.

Related reference:
Comparison of data protection solutions
Roadmap for implementing a data protection solution

Appliance-based implementation of a data protection solution for
multiple sites

This implementation of a multi-site IBM Spectrum Protect™ data protection solution uses appliance-based data deduplication and
replication. A standby server is configured at a second site to recover data if the primary server is unavailable.
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This data protection solution provides the following benefits:

e Performance is optimized for backups on high-speed storage area networks (SAN) and for use with IBM Spectrum Protect
for SAN, when clients back up directly to SAN-attached virtual tape devices.

e Fast, appliance-based replication frees the server from having to track replication metadata in the server database.

e Bandwidth and storage space are used efficiently because only deduplicated data is replicated between the sites.

e A standby environment provides for disaster recovery, but does not require the amount of resources that are needed for a
fully active site.

In this data protection configuration, the server uses hardware appliances to deduplicate and replicate data. The appliance at Site
A deduplicates data and then replicates the data to the appliance at Site B for disaster protection. If a failure at Site A occurs, you
make the standby server active by restoring the most recent database backup, and by activating the replicated copy of data.

For more information about configuring virtual tape libraries, see Configuring virtual tape libraries.

Related reference:
Comparison of data protection solutions
Roadmap for implementing a data protection solution

Tape-based implementation of a data protection solution

This implementation of a data protection solution with IBM Spectrum Protect™ uses one or more tape storage devices to back up
data. Tape backup provides low-cost scalability that is optimized for long-term retention.
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This data protection solution provides the following benefits:

e Performance is optimized for backup operations on high-speed storage area networks (SAN) directly to tape for large data

types and for long-term retention of data.

e Data availability is optimized by storing copies of data at offsite locations for disaster recovery. If you enable the disaster
recovery management (DRM) function and a disaster occurs, DRM helps to streamline the process of recovering your

servers.

e Data security is optimized because copies of data are stored offsite on tape devices that are not connected to the internet.
Ransomware attacks rely on internet connections; therefore, offsite storage can help to protect against such attacks.
e Low-cost scalability is achieved by reducing the need for additional disk hardware and lowering energy costs.

Related concepts:

Selecting a tape device driver

Related tasks:

Creating data backup strategies

Managing volume inventory

Related reference:

Comparison of data protection solutions
Installing and configuring tape device drivers

Comparison of data protection solutions

Compare the key features for each IBM Spectrum Protect™ solution to determine which configuration best meets your data
protection requirements. Then, review the available documentation to implement the solution.
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What to do next

Review available documentation for the solutions in Roadmap for implementing a data protection solution.
Related reference:

Disk-based implementation of a data protection solution for a single site

Disk-based implementation of a data protection solution for multiple sites

Appliance-based implementation of a data protection solution for multiple sites

Tape-based implementation of a data protection solution

Roadmap for implementing a data protection solution

Plan and implement the most suitable data protection solution for your business environment with IBM Spectrum Protect™.

Single-site disk solution

For steps that describe how to plan for, implement, monitor, and operate a single-site disk solution, see Single-site disk solution.

Multisite disk solution

For steps that describe how to plan for, implement, monitor, and operate a multisite disk solution, see Multisite disk solution.

Tape solution

For steps that describe how to plan for, implement, monitor, and operate a tape device solution, see Tape solution.

Multisite appliance solution

For an overview of the tasks that are required to implement a multisite appliance solution, review the following steps:

1. Begin planning for the solution by reviewing information at the following links:
o AIX: Capacity planning
o Linux: Capacity planning
o Windows: Capacity planning
2. Install the server and optionally, the Operations Center. Review information at the following links:
o Installing and upgrading the server
o Installing and upgrading the Operations Center
3. Configure the server for storage in a virtual tape library.
o Managing virtual tape libraries
o Attaching tape devices for the server

For guidance about improving system performance, see Configuration best practices.

4. Configure policies to protect your data. Review the information in Customizing policies.

. Set up client schedules. Review the information in Scheduling backup and archive operations.

6. Install and configure clients. To determine the type of client software that you need, review the information in Adding
clients for details.

7. Configure monitoring for your system. Review the information in Monitoring storage solutions.

[63]

Related reference:

Comparison of data protection solutions

Disk-based implementation of a data protection solution for a single site
Disk-based implementation of a data protection solution for multiple sites
Appliance-based implementation of a data protection solution for multiple sites
Tape-based implementation of a data protection solution

Single-site disk solution

This data protection solution provides cost-effective data storage at a single site with minimal hardware setup.

e Planning for a single-site disk data protection solution
Plan for a data protection implementation that includes a server at a single site that uses data deduplication.
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e Single-site disk implementation of a data protection solution
The single-site disk solution is configured at one site and uses data deduplication.

e Monitoring a single-site disk solution
After you implement a single-site disk solution with IBM Spectrum Protect, monitor the solution for correct operation. By
monitoring the solution daily and periodically, you can identify existing and potential issues. The information that you
gather can be used to troubleshoot problems and optimize system performance.

e Managing operations for a single-site disk solution
Use this information to manage operations for a single-site disk solution with IBM Spectrum Protect that includes a server
and uses data deduplication for a single location.

Planning for a single-site disk data protection solution

Plan for a data protection implementation that includes a server at a single site that uses data deduplication.

Implementation options

You can configure the server for a single-site disk solution in the following ways:

Configure the server by using the Operations Center and administrative commands
This documentation provides steps to configure a range of storage systems and the server software for your solution.
Configuration tasks are completed by using wizards and options in the Operations Center and IBM Spectrum Protect™
commands. For information about getting started, see the Planning roadmap.

Configure the server by using automated scripts
For detailed guidance on implementing a single-site disk solution with specific IBM® Storwize® storage systems, and by
using automated scripts to configure the server, see the IBM Spectrum Protect blueprints. The documentation and scripts
are available on IBM developerWorks® at: IBM Spectrum Protect Blueprints.

The blueprint documentation does not include steps for installing and configuring the Operations Center, or setting up
secure communications by using Transport Security Layer (TLS). An option for using Elastic Storage Server, based on IBM
Spectrum Scale™ technology, is included.

Planning roadmap

Plan for the single-site disk solution by reviewing the architecture layout in the following figure and then completing the roadmap
tasks that follow the diagram.

) ) _ () Single-site architecture () Cost effective
Single-site disk
[ () Space efficient () Simpler implementation
Applications, virtual machines, Server

systems

L

Disk storage for deduplicated
data and inventory backup

The following steps are required to plan for a single-site disk environment.
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1. Select your system size.
2. Meet system requirements for hardware and software.
3. Record values for your system configuration in the planning worksheets.
4. Plan for storage.
5. Plan for security.
a. Plan for administrator roles.
b. Plan for secure communications.
c. Plan for storage of encrypted data.
d. Plan for firewall access.

Selecting a system size

Select the size of the IBM Spectrum Protect™ server based on the amount of data that you manage and the systems to be
protected.

About this task

You can use the information in the table to determine the size of the server that is required, based on the amount of data that you
manage.

The following table describes the volume of data that a server manages. This amount includes all versions. The daily amount of
data is how much new data you back up each day. Both the total managed data and daily amount of new data are measured as the
size before any data reduction.

Table 1. Determining the size of the server

Total managed data Daily amount of new data to back up | Required server size
60TB-240TB Up to 10 TB per day Small

196 TB-784TB 10 - 20 TB per day Medium

1000 TB - 4000 TB 20 - 100 TB per day Large

The daily backup values in the table are based on test results with 128 MB sized objects, which are used by IBM Spectrum Protect

for Virtual Environments. Workloads that consist of objects that are smaller than 128 KB might not be able to achieve these daily
limits.

System requirements for a single-site disk solution

After you select the IBM Spectrum Protect™ solution that best fits your data protection requirements, review the system
requirements to plan for implementation of the data protection solution.

Ensure that your system meets the hardware and software prerequisites for the size of server that you plan to use.

e Hardware requirements
Hardware requirements for your IBM Spectrum Protect solution are based on system size. Choose equivalent or better
components than those items that are listed to ensure optimum performance for your environment.

e Software requirements

Documentation for the single-site disk IBM Spectrum Protect solution includes installation and configuration tasks for the
following operating systems. You must meet the minimum software requirements that are listed.

Related information:
[+ 1BM Spectrum Protect Supported Operating Systems

Hardware requirements

Hardware requirements for your IBM Spectrum Protect™ solution are based on system size. Choose equivalent or better
components than those items that are listed to ensure optimum performance for your environment.

For a definition of system sizes, see t_ssdisk_select_size.html.

The following table includes minimum hardware requirements for the server and storage, based on the size of the server that you
plan to build. If you are using local partitions (LPARs) or work partitions (WPARs), adjust the network requirements to take
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account of the partition sizes.

Use the information in the following table as a starting point. For the most up-to-date information about hardware requirements
and specifications for the server and storage, see the IBM Spectrum Protect Blueprints.

Hardware component

Small system

Medium system

Large system

Server processor

W 6 processor cores,
3.42 GHz or faster

| Linux | Windows KIS
processor cores, 1.7 GHz or
faster

I 1 0 processor cores,
3.42 GHz or faster

| Linux | Windows _jpJo]
processor cores, 2.2 GHz or
faster

ITTEN ) 0 processor cores,
3.42 GHz

| Linux | Windows JiW
processor cores, 2.2 GHz or
faster

Server memory

64 GB RAM

128 GB RAM

256 GB RAM

the database, plus
space for Operations
Center records

e 67 TB deduplicated
directory-container
storage pool

the database, plus
space for Operations
Center records

e 207.9 TB deduplicated
directory-container
storage pool

Network e 10 GB Ethernet (1 port) e 10 GB Ethernet (2 e 10 GB Ethernet (4
e 8 GB Fibre Channel ports) ports)
adapter (2 ports) e 8 GB Fibre Channel e 8 GB Fibre Channel
adapter (2 ports) adapter (4 ports)
Storage e 1.45TB SSD disks for e 2,53 TB SSD disks for e 6.54 TB SSD disks for

the database, plus
space for Operations
Center records

e 1049.67TB
deduplicated directory-
container storage pool

Estimating database space requirements for the Operations Center

Hardware requirements for the Operations Center are included in the preceding table, except for the database and archive log
space (inventory) that the Operations Center uses to hold records for managed clients.

If you do not plan to install the Operations Center on the same system as the server, you can estimate system requirements
separately. To calculate system requirements for the Operations Center, see the system requirements calculator in technote

1641684.

Managing the Operations Center on the server is a workload that requires extra space for database operations. The amount of
space depends on the number of clients that are monitored on a server. Review the following guidelines to estimate how much

space your server requires.

Database space

The Operations Center uses approximately 1.2 GB of database space for every 1000 clients that are monitored on a server.
For example, consider a hub server with 2000 clients that also manages three spoke servers, each with 1500 clients. This
configuration has a total of 6500 clients across the four servers and requires approximately 8.4 GB of database space. This
value is calculated by rounding the 6500 clients up to the next closest 1000, which is 7000:

7 x 1.2 GB=8.4 GB

Archive log space
The Operations Center uses approximately 8 GB of archive log space every 24 hours, for every 1000 clients. In the example
of 6500 clients across the hub server and the spoke servers, 56 GB of archive log space is used over a 24-hour period for
the hub server.
For each spoke server in the example, the archive log space that is used over 24 hours is approximately 16 GB. These
estimates are based on the default status collection interval of 5 minutes. If you reduce the collection interval from once
every 5 minutes to once every 3 minutes, the space requirements increase. The following examples show the approximate
increase in the log space requirement with a collection interval of once every 3 minutes:

e Hub server: 56 GB to approximately 94 GB
e Each spoke server: 16 GB to approximately 28 GB

Increase the archive log space so that you have sufficient space available to support the Operations Center, without
affecting the existing server operations.
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Software requirements

Documentation for the single-site disk IBM Spectrum Protect™ solution includes installation and configuration tasks for the
following operating systems. You must meet the minimum software requirements that are listed.

For information about software requirements for IBM® lin_tape device drivers, refer to the IBM Tape Device Drivers Installation

and User's Guide.

AIX systems

Type of software

Minimum software requirements

Operating system

IBM AIX® 7.1

For more information about operating system requirements, see AIX: Minimum system
requirements for AIX systems.

Gunzip utility

The gunzip utility must be available on your system before you install or upgrade the IBM
Spectrum Protect server. Ensure that the gunzip utility is installed and the path to it is set in
the PATH environment variable.

File system type

JFS2 file systems

AIX systems can cache a large amount of file system data, which can reduce memory that is
required for server and IBM DB2® processes. To avoid paging with the AIX server, use the
rbrw mount option for the JFS2 file system. Less memory is used for the file system cache
and more is available for IBM Spectrum Protect.

Do not use the file system mount options, Concurrent I/O (CIO), and Direct I/O (DIO), for file
systems that contain the IBM Spectrum Protect database, logs, or storage pool volumes.
These options can cause performance degradation of many server operations. IBM Spectrum
Protect and DB2 can still use DIO where it is beneficial to do so, but IBM Spectrum Protect
does not require the mount options to selectively take advantage of these techniques.

Other software

Korn Shell (ksh)

Linux systems

Type of software

Minimum software requirements

Operating system

Red Hat Enterprise Linux 7 (x86_64)

Libraries

GNU C libraries, Version 2.3.3-98.38 or later that is installed on the IBM Spectrum Protect
system.
Red Hat Enterprise Linux Servers:

e libaio
e libstdc++.50.6 (32-bit and 64-bit packages are required)
e numactl.x86_64

File system type

Format database-related file systems with ext3 or ext4.

For storage pool-related file systems, use XFS.

Other software

Korn Shell (ksh)

Windows systems

Type of software

Minimum software requirements

Operating system

Microsoft Windows Server 2012 R2 (64-bit) or Windows Server 2016

File system type

NTFS
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Type of software

Minimum software requirements

Other software

account

Windows 2012 R2 or Windows 2016 with .NET Framework 3.5 is installed and enabled.
The following User Account Control policies must be disabled:

e User Account Control: Admin Approval Mode for the Built-in Administrator

e User Account Control: Run all administrators in Admin Approval Mode

Related tasks:

[* Setting AIX network options

Planning worksheets

Use the planning worksheets to record values that you use to set up your system and configure the IBM Spectrum Protect™ server.

Use the best practice default values that are listed in the worksheets.

Each worksheet helps you prepare for different parts of the system configuration by using best practice values:

Server system preconfiguration
Use the preconfiguration worksheets to plan for the file systems and directories that you create when you configure file
systems for IBM Spectrum Protect during system setup. All directories that you create for the server must be empty.

Server configuration

Use the configuration worksheets when you configure the server. Default values are suggested for most items, except

where noted.

AIX®
Table 1. Worksheet for preconfiguration of an AIX server system
Item Default value Your value Minimum directory size Notes
TCP/IP port address | 1500 Not applicable Ensure that this port

for communications
with the server

is available when you
install and configure
the operating system

The port number can
be a numberin the
range 1024 - 32767.

Directory for the
server instance

/home/tsminstl/tsminstl

50GB

If you change the
value for the server
instance directory
from the default, also
modify the DB2®
instance owner value
in Table 2.

installation

Directory for server |/ Available space that is

installation required for the directory:
5GB

Directory for server | /usr Available space that is

installation required for the directory:
5GB

Directory for server | /var Available space that is

installation required for the directory:
5GB

Directory for server |/tmp Available space that is

required for the directory:

5GB
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Item

Default value

Your value

Minimum directory size

Notes

Directory for server
installation

/opt

Available space that is
required for the directory:
10 GB

Directory for the
active log

/tsminst1/TSMalog

e Small and medium:
140 GB
e large: 300 GB

When you create the
active log during the
initial configuration of
the server, set the
size to 128 GB.

Directory for the
archive log

/tsminst1/TSMarchlog

e Small: 1 TB
e Medium:2TB
e large:4TB

Directories for the
database

/tsminst1/TSMdbspace00
/tsminst1/TSMdbspace0l
/tsminst1/TSMdbspace02
/tsminst1/TSMdbspace03

Minimum total space for
all directories:

e Small: At least 1 TB

e Medium: At least 2
TB

e large: Atleast4TB

Create a minimum
number of file
systems for the
database, depending
on the size of your
system:

e Small: At least
4 file systems

e Medium: At
least 4 file
systems

e large: At least
8 file systems

Directories for
storage

/tsminst1/TSMfileO0
/tsminst1/TSMfile01
/tsminst1/TSMfile02
/tsminst1/TSMfile03

Minimum total space for
all directories:

e Small: At least 38
B

e Medium: At least
180TB

e Large: At least 500
B

Create a minimum
number of file
systems for storage,
depending on the size
of your system:

e Small: At least
10 file systems

e Medium: At
least 20 file
systems

e large: At least
40 file systems

40 IBM Spectrum Protect Knowledge Center Version 8.1.5




Item

Default value

Your value

Minimum directory size

Notes

Directories for
database backup

/tsminst1/TSMbkup00
/tsminst1/TSMbkup01
/tsminst1/TSMbkup02
/tsminst1/TSMbkup03

Minimum total space for
all directories:

e Small: At least 3 TB

e Medium: At least 10
TB

e Large: At least 16
TB

Create a minimum
number of file
systems for backing
up the database,
depending on the size
of your system:

e Small: At least

2 file systems

e Medium: At
least 4 file
systems

e large: At least
4 file systems,
but preferably
6

The first database
backup directory is
also used for the
archive log failover
directory and a
second copy of the
volume history and
device configuration
files.

Table 2. Worksheet for IBM Spectrum Protect configuration

Item Default value Your value Notes

DB2 instance owner tsminstl If you changed the value for
the server instance directory in
Table 1 from the default, also
modify the value for the DB2
instance owner.

DB2 instance owner passwOrd Select a different value for the

password instance owner password than
the default. Ensure that you
record this value in a secure
location.

Primary group for the [tsmsrvrs

DB2 instance owner

Server name

The default value for the server
name is the system host name.

Server password passwOrd Select a different value for the
server password than the
default. Ensure that you record
this value in a secure location.

Administrator ID: user [admin

ID for the server

instance

Administrator ID passwOrd Select a different value for the

password

administrator password than
the default. Ensure that you

record this value in a secure
location.
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Item

Default value

Your value

Notes

Schedule start time

22:00

The default schedule start
time begins the client
workload phase, which is
predominantly the client
backup and archive activities.
During the client workload
phase, server resources
support client operations.
Normally, these operations are
completed during the nightly
schedule window.

Schedules for server
maintenance operations are
defined to begin 10 hours after
the start of the client backup
window.

Linux

Table 3. Worksheet for preconfiguration of a Linux server system

Item

Default value

Your value

Minimum directory size

Notes

TCP/IP port address
for communications
with the server

1500

Not applicable

Ensure that this port
is available when you
install and configure
the operating system

The port number can
be a number in the
range 1024 - 32767.

Directory for the
server instance

/home/tsminstl/tsminstl

25GB

If you change the
value for the server
instance directory
from the default, also
modify the DB2
instance owner value
in Table 4.

Directory for the
active log

/tsminst1/TSMalog

e Small and medium:

140 GB
e large: 300 GB

Directory for the
archive log

/tsminst1/TSMarchlog

e Small: 1 TB
e Medium:2TB
e large:4TB
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Item

Default value

Your value

Minimum directory size

Notes

Directories for the
database

/tsminst1/TSMdbspace00
/tsminst1/TSMdbspace01
/tsminst1/TSMdbspace02
/tsminst1/TSMdbspace03

Minimum total space for
all directories:

e Small: At least 1 TB

e Medium: At least 2
B

e Large: Atleast4TB

Create a minimum
number of file
systems for the
database, depending
on the size of your
system:

e Small: At least
4 file systems

e Medium: At
least 4 file
systems

e large: At least
8 file systems

Directories for
storage

/tsminst1/TSMfile00
/tsminst1/TSMfile01
/tsminst1/TSMfile02
/tsminst1/TSMfile03

Minimum total space for
all directories:

e Small: At least 38
TB

e Medium: At least
180 TB

e large: At least 500
TB

Create a minimum
number of file
systems for storage,
depending on the size
of your system:

e Small: At least
10 file systems

e Medium: At
least 20 file
systems

e large: At least
40 file systems

Directories for
database backup

/tsminst1/TSMbkup00
/tsminst1/TSMbkup01
/tsminst1/TSMbkup02
/tsminst1/TSMbkup03

Minimum total space for
all directories:

e Small: At least 3 TB

e Medium: At least 10
TB

e Large: At least 16
TB

Create a minimum
number of file
systems for backing
up the database,
depending on the size
of your system:

e Small: At least
2 file systems

e Medium: At
least 4 file
systems

e large: At least
4 file systems,
but preferably
6

The first database
backup directory is
also used for the
archive log failover
directory and a
second copy of the
volume history and
device configuration
files.

Table 4. Worksheet for IBM Spectrum Protect configuration

Item

Default value

Your value

Notes

IBM Spectrum Protect Knowledge Center Version 8.1.5 43




DB2 instance owner

Item Default value Your value Notes

DB2 instance owner tsminstl If you changed the value for
the server instance directory in
Table 3 from the default, also
modify the value for the DB2
instance owner.

DB2 instance owner passwOrd Select a different value for the

password instance owner password than
the default. Ensure that you
record this value in a secure
location.

Primary group for the [tsmsrvrs

Server name

The default value for the server
name is the system host name.

Server password passwOrd Select a different value for the
server password than the
default. Ensure that you record
this value in a secure location.

Administrator ID: user |admin

ID for the server

instance

Administrator ID passwOrd Select a different value for the

password administrator password than
the default. Ensure that you
record this value in a secure
location.

Schedule start time 22:00 The default schedule start

time begins the client
workload phase, which is
predominantly the client
backup and archive activities.
During the client workload
phase, server resources
support client operations.
Normally, these operations are
completed during the nightly
schedule window.

Schedules for server
maintenance operations are
defined to begin 10 hours after
the start of the client backup
window.

Windows

Because many volumes are created for the server, configure the server by using the Windows feature of mapping disk volumes to
directories rather than to drive letters.

For example, C:\tsminst1\TSMdbpsace00 is a mount point to a volume with its own space. The volume is mapped to a directory
under the C: drive, but does not take up space from the C: drive. The exception is the server instance directory, C:\tsminstl1, which
can be a mount point or a regular directory.

Table 5. Worksheet for preconfiguration of a Windows server system

Item

Default value

Your value

Notes

Minimum directory size
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Item Default value Your value Minimum directory size | Notes

TCP/IP port address | 1500 Not applicable Ensure that this port

for communications is available when you

with the server install and configure
the operating system
The port number can
be a number in the
range 1024 - 32767.

Directory for the C:\tsminst1 25GB If you change the

server instance

value for the server
instance directory
from the default, also
modify the DB2
instance owner value
in Table 6.

Directory for the
active log

C:\tsminst1\TSMalog

e Small and medium:
140 GB
e large: 300 GB

Directory for the
archive log

C:\tsminst1\TSMarchlog

e Small: 1 TB
e Medium:2TB
e large:4TB

Directories for the
database

C:\tsminst1\TSMdbspace00
C:\tsminst1\TSMdbspace0l
C:\tsminst1\TSMdbspace02
C:\tsminst1\TSMdbspace03

Minimum total space for
all directories:

e Small: At least 1 TB

e Medium: At least 2
TB

e Large: Atleast4TB

Create a minimum
number of file
systems for the
database, depending
on the size of your
system:

e Small: At least
4 file systems

e Medium: At
least 4 file
systems

e large: At least
8 file systems

Directories for
storage

C:\tsminst1\TSMfile00
C:\tsminst1\TSMfileO1
C:\tsminst1\TSMfile02
C:\tsminst1\TSMfile03

Minimum total space for
all directories:

e Small: At least 38
TB

e Medium: At least
180 TB

e Large: At least 500
TB

Create a minimum
number of file
systems for storage,
depending on the size
of your system:

e Small: At least
10 file systems

e Medium: At
least 20 file
systems

e large: At least
40 file systems
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Item

Default value

Your value

Minimum directory size

Notes

Directories for
database backup

C:\tsminst1\TSMbkup00
C:\tsminst1\TSMbkup01
C:\tsminst1\TSMbkup02
C:\tsminst1\TSMbkup03

Minimum total space for
all directories:

e Small: At least 3 TB

e Medium: At least 10
B

e large: At least 16
B

Create a minimum
number of file
systems for backing
up the database,
depending on the size
of your system:

e Small: At least

2 file systems

e Medium: At
least 4 file
systems

e large: At least
4 file systems,
but preferably
6

The first database
backup directory is
also used for the
archive log failover
directory and a
second copy of the
volume history and
device configuration
files.

Table 6. Worksheet for IBM Spectrum Protect configuration

Item

Default value

Your value

Notes

DB2 instance owner

tsminstl

If you changed the value for
the server instance directory in
Table 5 from the default, also
modify the value for the DB2
instance owner.

DB2 instance owner
password

pAssWOrd

Select a different value for the
instance owner password than
the default. Ensure that you
record this value in a secure
location.

Server name

The default value for the server
name is the system host name.

password

Server password passwOrd Select a different value for the
server password than the
default. Ensure that you record
this value in a secure location.

Administrator ID: user [admin

ID for the server

instance

Administrator ID passwOrd Select a different value for the

administrator password than
the default. Ensure that you

record this value in a secure
location.
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Item Default value Your value Notes

Schedule start time 22:00 The default schedule start
time begins the client
workload phase, which is
predominantly the client
backup and archive activities.
During the client workload
phase, server resources
support client operations.
Normally, these operations are
completed during the nightly
schedule window.

Schedules for server
maintenance operations are
defined to begin 10 hours after
the start of the client backup
window.

Planning for storage

Choose the most effective storage technology for IBM Spectrum Protect™ components to ensure efficient server performance and
operations.

Storage hardware devices have different capacity and performance characteristics, which determine how they can be used
effectively with IBM Spectrum Protect. For general guidance on selecting the appropriate storage hardware and set up for your
solution, review the following guidelines.

Database and active log

e Use a fast disk for the IBM Spectrum Protect database and active log, for example with the following characteristics:
o High performance, 15k rpm disk with Fibre Channel or serial-attached SCSI (SAS) interface
o Solid-state disk (SSD)

e Isolate the active log from the database unless you use SSD or flash hardware

e When you create arrays for the database, use RAID level 5

Storage pool

e You can use less expensive and slower disks for the storage pool
e The storage pool can share disks for the archive log and database backup storage
e Use RAID level 6 for storage pool arrays to add protection against double drive failures when you use large disk types

e Planning the storage arrays
Prepare for disk storage configuration by planning for RAID arrays and volumes, according to the size of your IBM Spectrum
Protect system.

Related reference:
[ Storage system requirements and reducing the risk of data corruption

Planning for security

Plan to protect the security of systems in the IBM Spectrum Protect™ solution with access and authentication controls, and
consider encrypting data and password transmission.

For guidelines about protecting your storage environment against ransomware attacks, and recovering your storage environment if
an attack occurs, see Protecting the storage environment against ransomware.

e Planning for administrator roles

Define the authority levels that you want to assign to administrators who have access to the IBM Spectrum Protect solution.
e Planning for secure communications

Plan for protecting communications among the IBM Spectrum Protect solution components.
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e Planning for storage of encrypted data

Determine whether your company requires stored data to be encrypted, and choose the option that best suits your needs.
e Planning firewall access

Determine the firewalls that are set and the ports that must be open for the IBM Spectrum Protect solution to work.

Planning for administrator roles

Define the authority levels that you want to assign to administrators who have access to the IBM Spectrum Protect™ solution.
You can assign one of the following levels of authority to administrators:

System
Administrators with system authority have the highest level of authority. Administrators with this level of authority can
complete any task. They can manage all policy domains and storage pools, and grant authority to other administrators.
Policy
Administrators who have policy authority can manage all of the tasks that are related to policy management. This privilege
can be unrestricted, or can be restricted to specific policy domains.
Storage
Administrators who have storage authority can allocate and control storage resources for the server.
Operator
Administrators who have operator authority can control the immediate operation of the server and the availability of
storage media such as tape libraries and drives.

The scenarios in Table 1 provide examples about why you might want to assign varying levels of authority so that administrators
can perform tasks:
Table 1. Scenarios for administrator roles

Scenario Type of administrator ID to set up

An administrator at a small company manages the server and is e System authority: 1 administrator ID
responsible for all server activities.

An administrator for multiple servers also manages the overall e System authority on all servers: 1 administrator ID for
system. Several other administrators manage their own storage the overall system administrator
pools. e Storage authority for designated storage pools: 1

administrator ID for each of the other administrators

An administrator manages 2 servers. Another person helps e System authority on both servers: 2 administrator IDs
with the administration tasks. Two assistants are responsible e Operator authority: 2 administrator IDs for the

for helping to ensure that important systems are backed up. assistants with access to the server that each person is
Each assistant is responsible for monitoring the scheduled responsible for

backups on one of the IBM Spectrum Protect servers.

Planning for secure communications

Plan for protecting communications among the IBM Spectrum Protect™ solution components.

Determine the level of protection that is required for your data, based on regulations and business requirements under which your
company operates.

If your business requires a high level of security for passwords and data transmission, plan on implementing secure
communication with Transport Layer Security (TLS) or Secure Sockets Layer (SSL) protocols.

TLS and SSL provide secure communications between the server and client, but can affect system performance. To improve
system performance, use TLS for authentication without encrypting object data. To specify whether the server uses TLS 1.2 for the
entire session or only for authentication, see the SSL client option for client-to-server communication, and the UPDATE
SERVER=SSL parameter for server-to-server communication. Beginning in V8.1.2, TLS is used for authentication by default. If you
decide to use TLS to encrypt entire sessions, use the protocol only for sessions where it is necessary and add processor resources
on the server to manage the increase in network traffic. You can also try other options. For example, some networking devices
such as routers and switches provide the TLS or SSL function.

You can use TLS and SSL to protect some or all of the different possible communication paths, for example:
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e Operations Center: browser to hub; hub to spoke
e Client to server
e Server to server: node replication

Related tasks:
* Securing communications

Planning for storage of encrypted data

Determine whether your company requires stored data to be encrypted, and choose the option that best suits your needs.

If your company requires the data in storage pools to be encrypted, then you have the option of using IBM Spectrum Protect™
encryption, or an external device such as tape for encryption.

If you choose IBM Spectrum Protect to encrypt the data, extra computing resources are required at the client that might affect the
performance of backup and restore processes.

Related information:
[* technote 1963635

Planning firewall access

Determine the firewalls that are set and the ports that must be open for the IBM Spectrum Protect™ solution to work.
Table 1 describes the ports that are used by the server, client, and Operations Center.

Table 1. Ports that are used by the server, client, and Operations Center

Item Default Direction Description
Base port 1500 Outbound/inbound | Each server instance requires a unique port. You can specify an
(TCPPORT) alternative port number instead of using the default. The

TCPPORT option listens for both TCP/IP and SSL-enabled
sessions from the client. For administrative client traffic, you can
use the TCPADMINPORT and ADMINONCLIENTPORT options to
set port values.

SSL-only port No default Outbound/inbound | This port is used if you want to restrict communication on the port
(SSLTCPPORT) to SSL-enabled sessions only. To support both SSL and non-SSL
communications, use the TCPPORT or TCPADMINPORT options.

SMB 45 Inbound/outbound | This port is used by configuration wizards that communicate by
using native protocols with multiple hosts.

SSH 22 Inbound/outbound | This port is used by configuration wizards that communicate by
using native protocols with multiple hosts.

SMTP 25 Outbound This port is used to send email alerts from the server.

NDMP No default Inbound/outbound | The server must be able to open an outbound NDMP control port
connection to the NAS device. The outbound control port is the
Low-Level Address in the data mover definition for the NAS
device.

During an NDMP filer-to-server restore, the server must be able to
open an outbound NDMP data connection to the NAS device. The
data connection port that is used during a restore can be
configured on the NAS device.

During NDMP filer-to-server backups, the NAS device must be
able to open outbound data connections to the server and the
server must be able to accept inbound NDMP data connections.
You can use the server option NDMPPORTRANGE to restrict the
set of ports available for use as NDMP data connections. You can
configure a firewall for connections to these ports.
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Item

Default

Direction

Description

Replication

No default

Outbound/inbound

The port and protocol for the outbound port for replication are set
by the DEFINE SERVER command that is used to set up
replication.

The inbound ports for replication are the TCP ports and SSL ports
that the source server names in the DEFINE SERVER command.

service port

Client schedule Client port: 1501 | Outbound The client listens on the port that is named and communicates

port the port number to the server. The server contacts the client if
server prompted scheduling is used. You can specify an
alternative port number in the client options file.

Long running KEEPALIVE Outbound When the KEEPALIVE option is enabled, keepalive packets are

sessions setting: YES sent during client-server sessions to prevent the firewall software
from closing long-running, inactive connections.

Operations Center |HTTPS: 11090 Inbound These ports are used for the Operations Center web browser. You
can specify an alternative port number.

Client Client port: 9028 | Inbound The client management service port must be accessible from the

management Operations Center. Ensure that firewalls cannot prevent

connections. The client management service uses the TCP port of
the server for the client node for authentication by using an
administrative session.

Single-site disk implementation of a data protection solution

The single-site disk solution is configured at one site and uses data deduplication.

Implementation roadmap

The following steps are required to set up the IBM Spectrum Protect™ single-site disk environment.

1. Set up the system.
a. Configure the storage hardware and set up storage arrays for your environment size.
b. Install the server operating system.
c. Configure multipath I/0.
d. Create the user ID for the server instance.
e. Prepare file systems for IBM Spectrum Protect.

2. Install the server and Operations Center.

3. Configure the server and Operations Center.
a. Complete the initial configuration of the server.
b. Set server options.

— 0@ O OO0

4. Install and configure clients.
a. Register and assign clients to schedules.

b. Install and verify the client management service.

. Configure Secure Sockets Layer for the server and client.
. Configure the Operations Center.

. Register your IBM Spectrum Protect license.
. Configure data deduplication.

. Define data retention rules for your business.
. Define server maintenance schedules.

. Define client schedules.

c. Configure the Operations Center to use the client management service.
5. Complete the implementation.

Setting up the system

To set up the system, you must first configure your disk storage hardware and the server system for IBM Spectrum Protect™.
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e Configuring the storage hardware
To configure your storage hardware, review general guidance for disk systems and IBM Spectrum Protect.

e Installing the server operating system
Install the operating system on the server system and ensure that IBM Spectrum Protect server requirements are met.
Adjust operating system settings as directed.

e Configuring multipath I/O
You can enable and configure multipathing for disk storage. Use the documentation that is provided with your hardware for
detailed instructions.

e Creating the user ID for the server
Create the user ID that owns the IBM Spectrum Protect server instance. You specify this user ID when you create the server
instance during initial configuration of the server.

e Preparing file systems for the server
You must complete file system configuration for the disk storage to be used by the server.

Configuring the storage hardware

To configure your storage hardware, review general guidance for disk systems and IBM Spectrum Protect™.

Procedure

1. Provide a connection between the server and the storage devices by following these guidelines:
o Use a switch or direct connection for Fibre Channel connections.
o Consider the number of ports that are connected and account for the amount of bandwidth that is needed.
o Consider the number of ports on the server and the number of host ports on the disk system that are connected.
2. Verify that device drivers and firmware for the server system, adapters, and operating system are current and at the
recommended levels.
3. Configure storage arrays. Make sure that you planned properly to ensure optimal performance. See Planning for storage for
more information.
4. Ensure that the server system has access to disk volumes that are created. Complete the following steps:
a. If the system is connected to a Fibre Channel switch, zone the server to see the disks.
b. Map all of the volumes to tell the disk system that this specific server is allowed to see each disk.

Installing the server operating system

Install the operating system on the server system and ensure that IBM Spectrum Protect™ server requirements are met. Adjust
operating system settings as directed.

e Installing on AIX systems
Complete the following steps to install AIX® on the server system.
e Installing on Linux systems
Complete the following steps to install Linux x86_64 on the server system.
e Installing on Windows systems
Install Microsoft Windows Server 2012 Standard Edition on the server system and prepare the system for installation and
configuration of the IBM Spectrum Protect server.

Installing on AIX systems

Complete the following steps to install AIX® on the server system.

Procedure

1. Install AIX Version 7.1, TL4, SP2, or later according to the manufacturer instructions.
2. Configure your TCP/IP settings according to the operating system installation instructions.
3. Open the /etc/hosts file and complete the following actions:

o Update the file to include the IP address and host name for the server. For example:

192.0.2.7 server.yourdomain.com server
o Verify that the file contains an entry for localhost with an address of 127.0.0.1. For example:

127.0.0.1 localhost
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10.

11.

. Enable AIX I/O completion ports by issuing the following command:

chdev -1 iocpO -P

Server performance can be affected by the Olson time zone definition.

. To optimize performance, change your system time zone format from Olson to POSIX. Use the following command format

to update the time zone setting;:

chtz=local timezone,date/time,date/time

For example, if you lived in Tucson, Arizona, where Mountain Standard Time is used, you would issue the following
command to change to the POSIX format:

chtz MST7MDT,M3.2.0/2:00:00,M11.1.0/2:00:00

. Add an entry in the .profile of the instance user so that the following environment is set:

export MALLOCOPTIONS=multiheap:16

Tip: If the instance user is not available, complete this step later, when the instance user becomes available.

. Set the system to create full application core files. Issue the following command:

chdev -1 sysO -a fullcore=true -P

. For communications with the server and Operations Center, make sure that the following ports are open on any firewalls

that might exist:
o For communications with the server, open port 1500.
o For secure communications with the Operations Center, open port 11090 on the hub server.

If you are not using the default port values, make sure that the ports that you are using are open.

. Enable TCP high-performance enhancements. Issue the following command:

no -p -o rfcl323=1

For optimal throughput and reliability, bond four 10 Gb Ethernet ports together. Use the System Management Interface Tool
(SMIT) to bond the ports together by using Etherchannel. The following settings were used during testing:

mode 8023ad

auto recovery yes Enable automatic recovery after failover

backup adapter NONE Adapter used when whole channel fails

hash mode src_dst port Determines how outgoing adapter is chosen

interval long Determines interval value for IEEE
802.3ad mode

mode 8023ad EtherChannel mode of operation

netaddr 0 Address to ping

noloss failover yes Enable lossless failover after ping
failure

num retries 3 Times to retry ping before failing

retry time 1 Wait time (in seconds) between pings

use alt addr no Enable Alternate EtherChannel Address

use jumbo_ frame no Enable Gigabit Ethernet Jumbo Frames

Verify that user process resource limits, also known as ulimits, are set according to guidelines in Table 1. If ulimit values are
not set correctly, you might experience server instability or a failure of the server to respond.
Table 1. User limits (ulimit) values

User limit type Setting Value Command to query value
Maximum size of core files core Unlimited ulimit -Hc

created

Maximum size of a data data Unlimited ulimit -Hd

segment for a process

Maximum file size fsize Unlimited ulimit -Hf
Maximum number of open nofile 65536 ulimit -Hn
files

Maximum amount of cpu Unlimited ulimit -Ht

processor time in seconds
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User limit type Setting Value Command to query value

Maximum number of user nproc 16384 ulimit -Hu
processes

If you need to modify any user limit values, follow the instructions in the documentation for your operating system.

Installing on Linux systems

Complete the following steps to install Linux x86_64 on the server system.

Before you begin

The operating system will be installed on the internal hard disks. Configure the internal hard disks by using a hardware RAID 1
array. For example, if you are configuring a small system, the two 300 GB internal disks are mirrored in RAID 1 so that a single 300
GB disk appears available to the operating system installer.

Procedure

1. Install Red Hat Enterprise Linux Version 7.1 or later, according to the manufacturer instructions. Obtain a bootable DVD that
contains Red Hat Enterprise Linux Version 7.1 and start your system from this DVD. See the following guidance for
installation options. If an item is not mentioned in the following list, leave the default selection.

a. After you start the DVD, choose Install or upgrade an existing system from the menu.
b. On the Welcome screen, select Test this media & install Red Hat Enterprise Linux 7.1.
c. Select your language and keyboard preferences.
d. Select your location to set the correct time zone.
e. Select Software Selection and then on the next screen, select Server with GUI.
f. From the installation summary page, click Installation Destination and verify the following items:
m The local 300 GB disk is selected as the installation target.
= Under Other Storage Options, Automatically configure partitioning is selected.
Click Done.
g. Click Begin Installation. After the installation starts, set the root password for your root user account.
After the installation is completed, restart the system and log in as the root user. Issue the df command to verify your basic
partitioning. For example, on a test system, the initial partitioning produced the following result:

[root@tvapp02]# df -h

Filesystem Size Used Avail Use% Mounted on
/dev/mapper/rhel-root 50G 3.0G 48G 6% /

devtmpfs 32G 0 32G 0% /dev

tmpfs 32G 92K 32G 1% /dev/shm

tmpfs 32G 8.8M 32G 1% /run

tmpfs 32G 0 32G 0% /sys/fs/cgroup
/dev/mapper/rhel-home 220G 37M 220G 1% /home
/dev/sdal 497M 124M 373M 25% /boot

2. Configure your TCP/IP settings according to the operating system installation instructions.
For optimal throughput and reliability, consider bonding multiple network ports together. This can be accomplished by
creating a Link Aggregation Control Protocol (LACP) network connection, which aggregates several subordinate ports into a
single logical connection. The preferred method is to use a bond mode of 802.3ad, miimon setting of 100, and a
xmit_hash_policy setting of layer3+4.
Restriction: To use an LACP network connection, you must have a network switch that supports LACP.

For additional instructions about configuring bonded network connections with Red Hat Enterprise Linux Version 7, see
Create a Channel Bonding Interface.

3. Open the /etc/hosts file and complete the following actions:
o Update the file to include the IP address and host name for the server. For example:

192.0.2.7 server.yourdomain.com server
o Verify that the file contains an entry for localhost with an address of 127.0.0.1. For example:

127.0.0.1 localhost

4. Install components that are required for the server installation. Complete the following steps to create a Yellowdog Updater
Modified (YUM) repository and install the prerequisite packages.

IBM Spectrum Protect Knowledge Center Version 8.1.5 53


https://access.redhat.com/documentation/en-US/Red_Hat_Enterprise_Linux/7/html/Networking_Guide/sec-Network_Bonding_Using_the_Command_Line_Interface.html#sec-Create_a_Channel_Bonding_Interface

a. Mount your Red Hat Enterprise Linux installation DVD to a system directory. For example, to mount it to the /mnt
directory, issue the following command:

mount -t 1s09660 -o ro /dev/cdrom /mnt

b. Verify that the DVD mounted by issuing the mount command. You should see output similar to the following
example:

/dev/sr0 on /mnt type 1509660

o]

Change to the YUM repository directory by issuing the following command:
cd /etc/yum/repos.d

If the repos.d directory does not exist, create it.
d. List directory contents:

ls rhel-source.repo
e. Rename the original repo file by issuing the mv command. For example:

mv rhel-source.repo rhel-source.repo.orig

—

. Create a new repo file by using a text editor. For example, to use the vi editor, issue the following command:

vi rhel71 dvd.repo

g. Add the following lines to the new repo file. The baseurl parameter specifies your directory mount point:

[rhel71 dvd]

name=DVD Redhat Enterprise Linux 7.1
baseurl=file:///mnt

enabled=1

gpgcheck=0

h. Install the prerequisite package ksh.x86_64, by issuing the yum command. For example:

yum install ksh.x86 64

Exception: You do not need to install the compat-libstdc++-33-3.2.3-69.el6.i686 and libstdc++.i686 libraries for
Red Hat Enterprise Linux Version 7.1.
5. When the software installation is complete, you can restore the original YUM repository values by completing the following
steps:
a. Unmount the Red Hat Enterprise Linux installation DVD by issuing the following command:

unmount /mnt

b. Change to the YUM repository directory by issuing the following command:

cd /etc/yum/repos.d

c. Rename the repo file that you created:

mv rhel71 dvd.repo rhel7l dvd.repo.orig
d. Rename the original file to the original name:
mv rhel-source.repo.orig rhel-source.repo

6. Determine whether kernel parameter changes are required. Complete the following steps:

a. Use the sysctl -a command to list the parameter values.

b. Analyze the results by using the guidelines in Table 1 to determine whether any changes are required.

c. If changes are required, set the parameters in the /etc/sysctl.conf file. The file changes are applied when the system

is started.

Tip: Automatically adjust kernel parameter settings and eliminate the need for manual updates to these settings. On Linux,
the DB2°® database software automatically adjusts interprocess communication (IPC) kernel parameter values to the
preferred settings. For more information about kernel parameter settings, search for Linux kernel parameters in the IBM
DB2 Version 11.1 product documentation.

Table 1. Linux kernel parameter optimum settings
Parameter Description
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Parameter

Description

kernel.shmmni

The maximum number of segments.

kernel.shmmax

The maximum size of a shared memory segment (bytes).

This parameter must be set before automatically starting the
IBM Spectrum Protect™ server on system startup.

kernel.shmall

The maximum allocation of shared memory pages (pages).

kernel.sem

There are four values for the kernel.sem
parameter.

(SEMMSL)

The maximum semaphores per array.

(SEMMNS)

The maximum semaphores per system.

(SEMOPM)

The maximum operations per semaphore call.

(SEMMNI)

The maximum number of arrays.

kernel.msgmni

The maximum number of system-wide message queues.

kernel.msgmax

The maximum size of messages (bytes).

kernel.msgmnb

The default maximum size of queue (bytes).

kernel.randomize_va_space

The kernel.randomize_va_space parameter configures the
use of memory ASLR for the kernel. Disable ASLR because it
can cause errors for the DB2 software. To learn more details
about the Linux ASLR and DB2, see technote 1365583.

vm.swappiness

The vm.swappiness parameter defines whether the kernel
can swap application memory out of physical random access
memory (RAM). For more information about kernel
parameters, see the DB2 product information.

vm.overcommit_memory

The vm.overcommit_memory parameter influences how
much virtual memory the kernel permits allocating. For more
information about kernel parameters, see the DB2 product
information.

7. Open firewall ports to communicate with the server. Complete the following steps:
a. Determine the zone that is used by the network interface. The zone is public, by default.

Issue the following command:

# firewall-cmd --get-active-zones

public
interfaces: ens4f0

b. To use the default port address for communications with the server, open TCP/IP port 1500 in the Linux firewall.

Issue the following command:

firewall-cmd --zone=public --add-port=1500/tcp --permanent

If you want to use a value other than the default, you can specify a number in the range 1024 - 32767. If you open a

port other than the default, you will need to specify that port when you run the configuration script.

c. If you plan to use this system as a hub, open port 11090, which is the default port for secure (https)

communications.
Issue the following command:

firewall-cmd --zone=public --add-port=11090/tcp --permanent

d. Reload the firewall definitions for the changes to take effect.

Issue the following command:
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firewall-cmd --reload

8. Verify that user process resource limits, also known as ulimits, are set according to guidelines in Table 2. If ulimit values are
not set correctly, you might experience server instability or a failure of the server to respond.
Table 2. User limits (ulimit) values

User limit type Setting Value Command to query value
Maximum size of core files core Unlimited ulimit -Hc

created

Maximum size of a data data Unlimited ulimit -Hd

segment for a process

Maximum file size fsize Unlimited ulimit -Hf
Maximum number of open nofile 65536 ulimit -Hn
files

Maximum amount of cpu Unlimited ulimit -Ht

processor time in seconds

Maximum number of user nproc 16384 ulimit -Hu
processes

If you need to modify any user limit values, follow the instructions in the documentation for your operating system.

Installing on Windows systems

Install Microsoft Windows Server 2012 Standard Edition on the server system and prepare the system for installation and
configuration of the IBM Spectrum Protect™ server.

Procedure

1. Install Windows Server 2016 Standard Edition, according to the manufacturer instructions.
2. Change the Windows account control policies by completing the following steps.
a. Open the Local Security Policy editor by running secpol.msc.
b. Click Local Policies > Security Options and ensure that the following User Account Control policies are disabled:
= Admin Approval Mode for the Built-in Administrator account
= Run all administrators in Admin Approval Mode
. Configure your TCP/IP settings according to installation instructions for the operating system.
4. Apply Windows updates and enable optional features by completing the following steps:
a. Apply the latest Windows Server 2016 updates.
b. Install and enable the Windows 2012 R2 feature Microsoft .NET Framework 3.5 from the Windows Server Manager.
c. If required, update the FC and Ethernet HBA device drivers to newer levels.
d. Install the multipath I/O driver that is appropriate for the disk system that you are using.
5. Open the default TCP/IP port, 1500, for communications with the IBM Spectrum Protect server. For example, issue the
following command:

w

netsh advfirewall firewall add rule name="Backup server port 1500"
dir=in action=allow protocol=TCP localport=1500

6. On the Operations Center hub server, open the default port for secure (https) communications with the Operations Center.
The port number is 11090. For example, issue the following command:

netsh advfirewall firewall add rule name="Operations Center port 11090"
dir=in action=allow protocol=TCP localport=11090

Configuring multipath 1/0

You can enable and configure multipathing for disk storage. Use the documentation that is provided with your hardware for
detailed instructions.

e AIX systems
e Linux systems
e Windows systems
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AIX systems

Procedure

1. Determine the Fibre Channel port address that you must use for the host definition on the disk subsystem. Issue the lscfg
command for every port.
o Onsmall and medium systems, issue the following commands:

lscfg -vps -1 fcsO | grep "Network Address"
lscfg -vps -1 fcsl | grep "Network Address"

o On large systems, issue the following commands:

lscfg -vps -1 fcsO
lscfg -vps -1 fcsl
lscfg -vps -1 fcs2
lscfg -vps -1 fcs3

grep "Network Address"
grep "Network Address"
grep "Network Address"

|
I
I
| grep "Network Address"

2. Ensure that the following AIX® file sets are installed:
o devices.common.IBM.mpio.rte
o devices.fcp.disk.array.rte
o devices.fcp.disk.rte
3. Issue the cfgmgr command to have AIX rescan the hardware and discover available disks. For example:

cfgmgr
4. To list the available disks, issue the following command:

lsdev -Ccdisk

You should see output similar to the following:
hdisk0 Available 00-00-00 SAS Disk Drive
hdiskl Available 00-00-00 SAS Disk Drive
hdisk2 Available 01-00-00 SAS Disk Drive
hdisk3 Available 01-00-00 SAS Disk Drive

hdisk4 Available 06-01-02 MPIO IBM 2076 FC Disk
hdisk5 Available 07-01-02 MPIO IBM 2076 FC Disk

5. Use the output from the Isdev command to identify and list device IDs for each disk device.

For example, a device ID could be hdisk4. Save the list of device IDs to use when you create file systems for the IBM
Spectrum Protect™ server.

6. Correlate the SCSI device IDs to specific disk LUNs from the disk system by listing detailed information about all physical
volumes in the system. Issue the following command:

lspv -u
On an IBM® Storwize® system, the following information is an example of what is shown for each device:

hdisk4 00£f8cf083fd97327 None active
332136005076300810105780000000000003004214503IBMfcp

In the example, 60050763008101057800000000000030 is the UID for the volume, as reported by the Storwize
management interface.
To verify disk size in megabytes and compare the value with what is listed for the system, issue the following command:

bootinfo -s hdisk4

Linux systems

Procedure

1. Edit the /etc/multipath.conf file to enable multipathing for Linux hosts. If the multipath.conf file does not exist, you can
create it by issuing the following command:
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mpathconf --enable

The following parameters were set in multipath.conf for testing on an IBM Storwize® system:

defaults {
user friendly names no

}

devices {
device {
vendor "IBM "
product "2145"
path grouping policy group by prio
user friendly names no
path selector "round-robin 0"
prio "alua"
path checker "tur"
failback "immediate"
no path retry 5
rr weight uniform
rr min io rg "1"
dev_loss_tmo 120

}

2. Set the multipath option to start when the system is started. Issue the following commands:

systemctl enable multipathd.service
systemctl start multipathd.service

3. To verify that disks are visible to the operating system and are managed by multipath, issue the following command:

multipath -1

4. Ensure that each device is listed and that it has as many paths as you expect. You can use size and device ID information to
identify which disks are listed.

For example, the following output shows that a 2 TB disk has two path groups and four active paths. The 2 TB size confirms

that the disk corresponds to a pool file system. Use part of the long device ID number (12, in this example) to search for the
volume on the disk-system management interface.

[root@tapsrv0l codel# multipath -1
36005076802810c509800000000000012 dm-43 IBM,2145
size=2.0T features='l queue if no path' hwhandler='0' wp=rw
|-+- policy='round-robin 0' prio=0 status=active
| |- 2:0:1:18 sdcw 70:64 active undef running
| "= 4:0:0:18 sdgb 131:112 active undef running
‘—+- policy='round-robin 0' prio=0 status=enabled
|- 1:0:1:18 sdat 66:208 active undef running
- 3:0:0:18 sddy 128:0 active undef running

a. If needed, correct disk LUN host assignments and force a bus rescan. For example:

echo "- - -" > /sys/class/scsi _host/host0/scan
echo "- - -" > /sys/class/scsi host/hostl/scan
echo "- - -" > /sys/class/scsi host/host2/scan

You can also restart the system to rescan disk LUN host assignments.
b. Confirm that disks are now available for multipath I/0 by reissuing the multipath -l command.
5. Use the multipath output to identify and list device IDs for each disk device.

For example, the device ID for your 2 TB disk is 36005076802810c509800000000000012.

Save the list of device IDs to use in the next step.

Windows systems

Procedure

1. Ensure that the Multipath I/0 feature is installed. If needed, install additional vendor-specific multipath drivers.
2. To verify that disks are visible to the operating system and are managed by multipath I/0, issue the following command:
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c:\program files\IBM\SDDDSM\datapath.exe query device

3. Review the multipath output and ensure that each device is listed and that it has as many paths as you expect. You can use
size and device serial information to identify which disks are listed.
For example, by using part of the long device serial number (34, in this example) you can search for the volume on the disk-
system management interface. The 2 TB size confirms that the disk corresponds to a storage pool file system.

DEV#: 4 DEVICE NAME: Disk5 PartO TYPE: 2145 POLICY: OPTIMIZED

SERIAL: 60050763008101057800000000000034 LUN SIZE: 2.0TB

Path# Adapter/Hard Disk State Mode Select Errors
0 Scsi Port2 Bus0/Disk5 Part0 OPEN NORMAL 0 0
1 Scsi Port2 Bus0/Disk5 Part0 OPEN NORMAL 27176 0
2 Scsi Port3 Bus0/Disk5 PartO OPEN NORMAL 28494 0
3 Scsi Port3 Bus0/Disk5 PartO OPEN NORMAL 0 0

4. Create a list of disk device IDs by using the serial numbers that are returned from the multipath output in the previous step.
For example, the device ID for your 2 TB disk is 60050763008101057800000000000034
Save the list of device IDs to use in the next step.

5. To bring new disks online and clear the read-only attribute, run diskpart.exe with the following commands. Repeat for each
of the disks:

diskpart
select Disk 1
online disk
attribute disk clear readonly
select Disk 2
online disk
attribute disk clear readonly
< Ll >
select Disk 49
online disk
attribute disk clear readonly
exit

Creating the user ID for the server

Create the user ID that owns the IBM Spectrum Protect™ server instance. You specify this user ID when you create the server
instance during initial configuration of the server.

About this task

You can specify only lowercase letters (a-z), numerals (0-9), and the underscore character ( _) for the user ID. The user ID and
group name must comply with the following rules:

e The length must be 8 characters or fewer.
e The user ID and group name cannot start with ibm, sql, sys, or a numeral.
e The user ID and group name cannot be user, admin, guest, public, local, or any SQL reserved word.

Procedure

1. Use operating system commands to create a user ID.
o NN ENTTTEM Create a group and user ID in the home directory of the user that owns the server instance.

For example, to create the user ID tsminst1 in group tsmsrvrs with a password of tsminst1, issue the following
commands from an administrative user ID:

mkgroup 1d=1001 tsmsrvrs
mkuser 1d=1002 pgrp=tsmsrvrs home=/home/tsminstl tsminstl
passwd tsminstl
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groupadd tsmsrvrs
useradd -d /home/tsminstl -m -g tsmsrvrs -s /bin/bash tsminstl
passwd tsminstl

Log off, and then log in to your system. Change to the user account that you created. Use an interactive login
program, such as telnet, so that you are prompted for the password and can change it if necessary.

o IIITMCreate a user ID and then add the new ID to the Administrators group. For example, to create the user ID
tsminstl, issue the following command:

net user tsminstl * /add

After you create and verify a password for the new user, add the user ID to the Administrators group by issuing the
following commands:

net localgroup Administrators tsminstl /add
net localgroup DB2ADMNS tsminstl /add

2. Log off the new user ID.

Preparing file systems for the server

You must complete file system configuration for the disk storage to be used by the server.

e Preparing file systems on AIX systems
You must create volume groups, logical volumes, and file systems for the server by using the AIX® Logical Volume Manager.
e Preparing file systems on Linux systems
You must format ext4 or xfs file systems on each of the disk LUNs to be used by the IBM Spectrum Protect server.
e Preparing file systems on Windows systems
You must format New Technology File System (NTFS) file systems on each of the disk LUNs to be used by the IBM
Spectrum Protect server.

Preparing file systems on AIX systems

You must create volume groups, logical volumes, and file systems for the server by using the AIX® Logical Volume Manager.

Procedure

1. Increase the queue depth and maximum transfer size for all of the available hdiskX disks. Issue the following commands
for each disk:

chdev -1 hdisk4 -a max transfer=0x100000
chdev -1 hdisk4 -a queue depth=32

chdev -1 hdisk4 -a reserve policy=no_reserve
chdev -1 hdisk4 -a algorithm=round robin

Do not run these commands for operating system internal disks, for example, hdiskO.

2. Create volume groups for the IBM Spectrum Protect™ database, active log, archive log, database backup, and storage pool.
Issue the mkvg command, specifying the device IDs for corresponding disks that you previously identified.
For example, if the device names hdisk4, hdisk5, and hdisk6 correspond to database disks, include them in the database
volume group and so on.
System size: The following commands are based on the medium system configuration. For small and large systems, you
must adjust the syntax as required.

mkvg -S -y tsmdb hdisk2 hdisk3 hdisk4

mkvg -S -y tsmactlog hdisk5

mkvg -S -y tsmarchlog hdisk6

mkvg -S -y tsmdbback hdisk7 hdisk8 hdisk9 hdisklO0

mkvg -S -y tsmstgpool hdiskll hdiskl2 hdisk13 hdiskl4 ... hdisk49

3. Determine the physical volume names and the number of free physical partitions to use when you create logical volumes.
Issue the lsvg for each volume group that you created in the previous step.
For example:

lsvg -p tsmdb
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The output is similar to the following. The FREE PPs column represents the free physical partitions:

tsmdb:

PV _NAME PV STATE TOTAL PPs FREE PPs FREE DISTRIBUTION
hdisk4 active 1631 1631 327..326..326..326..326
hdisk5 active 1631 1631 327..326..326..326..326
hdisk6 active 1631 1631 327..326..326..326..326

4. Create logical volumes in each volume group by using the mklv command. The volume size, volume group, and device
names vary, depending on the size of your system and variations in your disk configuration.
For example, to create the volumes for the IBM Spectrum Protect database on a medium system, issue the following
commands:

mklv -y tsmdb00 -t jfs2 -u 1 -x 1631 tsmdb 1631 hdisk2
mklv -y tsmdb0l -t jfs2 -u 1 -x 1631 tsmdb 1631 hdisk3
mklv -y tsmdb02 -t jfs2 -u 1 -x 1631 tsmdb 1631 hdisk4

5. Format file systems in each logical volume by using the crfs command.
For example, to format file systems for the database on a medium system, issue the following commands:

crfs -v jfs2 -d tsmdb00 -p rw -a logname=INLINE -a options=rbrw
-a agblksize=4096 -m /tsminstl/TSMdbspace00 -A yes
crfs -v jfs2 -d tsmdb0l -p rw -a logname=INLINE -a options=rbrw
-a agblksize=4096 -m /tsminstl/TSMdbspace0l -A yes
crfs -v jfs2 -d tsmdb02 -p rw -a logname=INLINE -a options=rbrw
-a agblksize=4096 -m /tsminstl/TSMdbspace02 -A yes

6. Mount all of the newly created file systems by issuing the following command:

mount -a

7. List all file systems by issuing the df command. Verify that file systems are mounted at the correct LUN and correct mount
point. Also, verify the available space.
The following example of command output shows that the amount of used space is typically 1%:

tapsrv07> df -g /tsminstl/*

Filesystem GB blocks Free %Used Tused %Iused Mounted on
/dev/tsmact00 195.12 194.59 1% 4 1% /tsminstl/TSMalog

8. Verify that the user ID you created in Creating the user ID for the server has read and write access to the directories for the
server.

Preparing file systems on Linux systems

You must format ext4 or xfs file systems on each of the disk LUNs to be used by the IBM Spectrum Protect™ server.

Procedure

1. Using the list of device IDs that you generated previously, issue the mkfs command to create and format a file system for
each storage LUN device. Specify the device ID in the command. See the following examples. For the database, format ext4
file systems:

mkfs -t extd -T largefile -m 2 /dev/mapper/36005076802810c509800000000000012

For storage pool LUNs, format xfs file systems:

mkfs -t xfs /dev/mapper/3600507630081010578000000000002c3
You might issue the mkfs command as many as 50 times, depending on how many different devices you have.
2. Create mount point directories for file systems.

Issue the mkdir command for each directory that you must create. Use the directory values that you recorded in the
planning worksheets.

For example, to create the server instance directory by using the default value, issue the following command:

mkdir /tsminstl
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Repeat the mkdir command for each file system.

3. Add an entry in the /etc/fstab file for each file system so that file systems are mounted automatically when the server is
started.
For example:

/dev/mapper/36005076802810c509800000000000012 /tsminstl/TSMdbspace00 ext4 defaults 0 O

4. Mount the file systems that you added to the /etc/fstab file by issuing the mount -a command.

5. List all file systems by issuing the df command. Verify that file systems are mounted at the correct LUN and correct mount
point. Also, verify the available space.
The following example on an IBM® Storwize® system shows that the amount of used space is typically 1%:

[root@tapsrv04 ~1# df -h /tsminstl/*

Filesystem Size Used Avail Use% Mounted on
/dev/mapper/360050763008101057800000000000003 134G 188M 132G 1% /tsminstl/TSMalog

6. Verify that the user ID you created in Creating the user ID for the server has read and write access to the directories for the
IBM Spectrum Protect server.

Preparing file systems on Windows systems

You must format New Technology File System (NTFS) file systems on each of the disk LUNs to be used by the IBM Spectrum
Protect™ server.

Procedure

1. Create mount point directories for file systems.
Issue the md command for each directory that you must create. Use the directory values that you recorded in the planning
worksheets. For example, to create the server instance directory by using the default value, issue the following command:

md c:\tsminstl

Repeat the md command for each file system.
2. Create a volume for every disk LUN that is mapped to a directory under the server instance directory by using the Windows
volume manager.

Go to Server Manager > File and Storage Services and complete the following steps for each disk that corresponds to the
LUN mapping that was created in the previous step:

a. Bring the disk online.

b. Initialize the disk to the GPT basic type, which is the default.

c. Create a simple volume that occupies all of the space on the disk. Format the file system by using NTFS, and assign a
label that matches the purpose of the volume, such as TSMfile00. Do not assign the new volume to a drive letter.
Instead, map the volume to a directory under the instance directory, such as C:\tsminst1\TSMfile00.
Tip: Determine the volume label and directory mapping labels based on the size of the disk that is reported.

3. Verify that file systems are mounted at the correct LUN and correct mount point. List all file systems by issuing the
mountvol command and then review the output. For example:

\\?\Volume {8ffb9678-3216-474c-a021-20e420816a92}\
C:\tsminst1\TSMdbspace00\

4. After the disk configuration is complete, restart the system.

What to do next

You can confirm the amount of free space for each volume by using Windows Explorer.

Installing the server and Operations Center

Use the IBM® Installation Manager graphical wizard to install the components.

e Installing on AIX and Linux systems
Install the IBM Spectrum Protect™ server and the Operations Center on the same system.
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e Installing on Windows systems
Install the IBM Spectrum Protect server and the Operations Center on the same system.

Installing on AIX® and Linux systems

Install the IBM Spectrum Protect™ server and the Operations Center on the same system.

Before you begin

Verify that the operating system is set to the language that you require. By default, the language of the operating system is the
language of the installation wizard.

Procedure

1. I e rify that the required RPM files are installed on your system.
See Installing prerequisite RPM files for the graphical wizard for details.

2. Before you download the installation package, verify that you have enough space to store the installation files when they
are extracted from the product package. For space requirements, see the download document at technote 4042992.
. Go to Passport Advantage® and download the package file to an empty directory of your choice.
4. Ensure that executable permission is set for the package. If necessary, change the file permissions by issuing the following
command:

w

chmod a+x package name.bin
5. Extract the package by issuing the following command:
./package name.bin

where package_name is the name of the downloaded file.
6. IITEINE nsure that the following command is enabled so that the wizards work properly:

lsuser

By default, the command is enabled.
7. Change to the directory where you placed the executable file.
8. Start the installation wizard by issuing the following command:

./install.sh

When you select the packages to install, choose both the server and Operations Center.

What to do next

e If errors occur during the installation process, the errors are recorded in log files that are stored in the IBM Installation
Manager logs directory.

To view installation log files from the Installation Manager tool, click File > View Log. To collect these log files from the
Installation Manager tool, click Help > Export Data for Problem Analysis.

e After you install the server and before you customize it for your use, go to the IBM Spectrum Protect support site. Click
Support and downloads and apply any applicable fixes.

e Installing prerequisite RPM files for the graphical wizard
RPM files are required for the IBM Installation Manager graphical wizard.

Related tasks:
* Other methods for installing IBM Spectrum Protect components (AIX)
* Other methods for installing IBM Spectrum Protect components (Linux)

Installing on Windows systems

Install the IBM Spectrum Protect™ server and the Operations Center on the same system.
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Before you begin

Make sure that the following prerequisites are met:

Verify that the operating system is set to the language that you require. By default, the language of the operating system is
the language of the installation wizard.
Ensure that the user ID that you plan to use during the installation is a user with local Administrator authority.

Procedure

1.

a b wN

Before you download the installation package, verify that you have enough space to store the installation files when they
are extracted from the product package. For space requirements, see the download document at technote 4042993.

. Go to Passport Advantage® and download the package file to an empty directory of your choice.

. Change to the directory where you placed the executable file.

. Double-click the executable file to extract to the current directory.

. In the directory where the installation files were extracted, start the installation wizard by double-clicking the install.bat

file. When you select the packages to install, choose both the server and Operations Center.

What to do next

If errors occur during the installation process, the errors are recorded in log files that are stored in the IBM® Installation
Manager logs directory.

To view installation log files from the Installation Manager tool, click File > View Log. To collect these log files from the
Installation Manager tool, click Help > Export Data for Problem Analysis.

After you install the server and before you customize it for your use, go to the IBM Spectrum Protect support site. Click
Support and downloads and apply any applicable fixes.

Related tasks:
* Other methods for installing IBM Spectrum Protect components

Configuring the server and the Operations Center

After you install the components, complete the configuration for the IBM Spectrum Protect™ server and the Operations Center.

Configuring the server instance

Use the IBM Spectrum Protect server instance configuration wizard to complete the initial configuration of the server.
Installing the backup-archive client

As a best practice, install the IBM Spectrum Protect backup-archive client on the server system so that the administrative
command-line client and scheduler are available.

Setting options for the server

Review the server options file that is installed with the IBM Spectrum Protect server to verify that the correct values are set
for your system.

Configuring secure communications with Transport Layer Security

To encrypt data and secure communications in your environment, Secure Sockets Layer (SSL) or Transport Layer Security
(TLS) is enabled on the IBM Spectrum Protect server and backup-archive client. An SSL certificate is used to verify
communication requests between the server and client.

Configuring the Operations Center

After you install the Operations Center, complete the following configuration steps to start managing your storage
environment.

Registering the product license

To register your license for the IBM Spectrum Protect product, use the REGISTER LICENSE command.

Configuring data deduplication

Create a directory-container storage pool and at least one directory to use inline data deduplication.

Defining data retention rules for your business

After you create a directory-container storage pool for data deduplication, update the default server policy to use the new
storage pool. The Add Storage Pool wizard opens the Services page in the Operations Center to complete this task.
Defining schedules for server maintenance activities

Create schedules for each server maintenance operation by using the DEFINE SCHEDULE command in the Operations
Center command builder.
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e Defining client schedules
Use the Operations Center to create schedules for client operations.

Configuring the server instance

Use the IBM Spectrum Protect™ server instance configuration wizard to complete the initial configuration of the server.

Before you begin

Ensure that the following requirements are met:
x| Linux |

e The system where you installed IBM Spectrum Protect must have the X Window System client. You must also be running an
X Window System server on your desktop.

® The system must have the Secure Shell (SSH) protocol enabled. Ensure that the port is set to the default value, 22, and that
the port is not blocked by a firewall. You must enable password authentication in the sshd_config file in the
/etc/ssh/directory. Also, ensure that the SSH daemon service has access rights to connect to the system by using the
localhost value.

e You must be able to log in to IBM Spectrum Protect with the user ID that you created for the server instance, by using the
SSH protocol. When you use the wizard, you must provide this user ID and password to access that system.

e If you changed any settings in the preceding steps, restart the server before you proceed with the configuration wizard.

T MV erify that the remote registry service is started by completing the following steps:

1. Click Start > Administrative Tools > Services. In the Services window, select Remote Registry. If it is not started, click Start.
2. Ensure that port 137, 139, and 445 are not blocked by a firewall:
a. Click Start > Control Panel > Windows Firewall.
b. Select Advanced Settings.
c. Select Inbound Rules.
d. Select New Rule.
e. Create a port rule for TCP ports 137, 139, and 445 to allow connections for domain and private networks.
3. Configure the user account control by accessing the local security policy options and completing the following steps.
a. Click Start > Administrative Tools > Local Security Policy. Expand Local Policies > Security Options.
b. If not already enabled, enable the built-in administrator account by selecting Accounts: Administrator account status
> Enable > OK.
c. If not already disabled, disable user account control for all Windows administrators by selecting User Account
Control: Run all administrators in Admin Approval Mode > Disable > OK.
d. If not already disabled, disable the User Account Control for the built-in Administrator account by selecting User
Account Control: Admin Approval Mode for the Built-in Administrator Account > Disable > OK.
4. If you changed any settings in the preceding steps, restart the server before you proceed with the configuration wizard.

About this task

The wizard can be stopped and restarted, but the server is not operational until the entire configuration process is complete.

Procedure

1. Start the local version of the wizard.
o NN ENTITEM Open the dsmicfgx program in the /opt/tivoli/tsm/server/bin directory. This wizard can be only
run as a root user.
o IMITTTTMClick Start > All Programs > IBM Spectrum Protect > Configuration Wizard.
2. Follow the instructions to complete the configuration. Use the information that you recorded in Planning worksheets during
IBM Spectrum Protect system set up to specify directories and options in the wizard.

RN NTTTTEM O the Server Information window, set the server to start automatically by using the instance user ID
when the system boots.

I MBY using the configuration wizard, the server is set to start automatically when rebooted.

Installing the backup-archive client
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As a best practice, install the IBM Spectrum Protect™ backup-archive client on the server system so that the administrative
command-line client and scheduler are available.

Procedure

To install the backup-archive client, follow the installation instructions for your operating system.

e Install UNIX and Linux backup-archive clients
e Installing the Windows client for the first time

Setting options for the server

Review the server options file that is installed with the IBM Spectrum Protect™ server to verify that the correct values are set for
your system.

Procedure

1. Go to the server instance directory and open the dsmserv.opt file.
2. Review the values in the following table and verify your server option settings, based on system size.

Server option Small system value Medium system value Large system value

ACTIVELOGDIRECTORY Directory path that was Directory path that was Directory path that was
specified during specified during specified during
configuration configuration configuration

ACTIVELOGSIZE 131072 131072 262144

ARCHLOGCOMPRESS Yes No No

ARCHLOGDIRECTORY Directory path that was Directory path that was Directory path that was
specified during specified during specified during
configuration configuration configuration

COMMMETHOD TCPIP TCPIP TCPIP

COMMTIMEOUT 3600 3600 3600

DEDUPREQUIRESBACKUP No No No

DEVCONFIG devconf.dat devconf.dat devconf.dat

EXPINTERVAL 0 0 0

IDLETIMEOUT 60 60 60

MAXSESSIONS 250 500 1000

NUMOPENVOLSALLOWED 20 20 20

TCPADMINPORT 1500 1500 1500

TCPPORT 1500 1500 1500

VOLUMEHISTORY volhist.dat volhist.dat volhist.dat

Update server option settings if necessary, to match the values in the table. To make updates, close the dsmserv.opt file
and use the SETOPT command from the administrative command-Lline interface to set the options.
For example, to update the IDLETIMEOUT option to 60, issue the following command:

setopt idletimeout 60

table.

3. To configure secure communications for the server, clients, and the Operations Center, verify the options in the following

Server option

All system sizes

SSLFIPSMODE

NO

TCPPORT

Specify the port number on which the server waits for requests for TCP/IP and
SSL-enabled sessions from the client.
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All system sizes

Specify the port address on which the server waits for requests for TCP/IP and
SSL-enabled sessions from the command-line administrative client.

Server option

TCPADMINPORT

If any of the option values must be updated, edit the dsmserv.opt file by using the following guidelines:

o Remove the asterisk at the beginning of a line to enable an option.
o On each line, enter only one option and the specified value for the option.

o If an option occurs in multiple entries in the file, the server uses the last entry.
Save your changes and close the file. If you edit the dsmserv.opt file directly, you must restart the server for the changes to

take effect.

Related reference:
[ Server options reference
* SETOPT (Set a server option for dynamic update)

Configuring secure communications with Transport Layer Security

To encrypt data and secure communications in your environment, Secure Sockets Layer (SSL) or Transport Layer Security (TLS) is
enabled on the IBM Spectrum Protect™ server and backup-archive client. An SSL certificate is used to verify communication

requests between the server and client.

About this task

As shown in the following figure, you can manually configure secure communications between the server and backup-archive

client by setting options in the server and client options files, and then transferring the self-signed certificate that is generated on

the server to the client. Alternatively, you can obtain and transfer a unique certificate that is signed by a certificate authority (CA).
Backup-archive client

Server

E Secure communications

Client opticns file

Server options file
Import cert256.arm
5l yes

tcpadminport

tcpport = value of
tcpport on the
SETVEr

tcppart

For more information about configuring the server and clients for SSL or TLS communications, see Configuring storage agents,
servers, clients, and the Operations Center to connect to the server by using SSL.

Configuring the Operations Center

After you install the Operations Center, complete the following configuration steps to start managing your storage environment.

Before you begin

When you connect to the Operations Center for the first time, you must provide the following information:

e Connection information for the server that you want to designate as a hub server
e Login credentials for an administrator ID that is defined for that server

Procedure

1. Designate the hub server. In a web browser, enter the following address:
https://hostname: secure port/oc

where:
o hostname represents the name of the computer where the Operations Center is installed

o secure_port represents the port number that the Operations Center uses for HTTPS communication on that

computer
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For example, if your host name is tsm.storage.mylocation.com and you are using the default secure port for the Operations
Center, which is 11090, the address is:

https://tsm.storage.mylocation.com:11090/0oc

When you log in to the Operations Center for the first time, a wizard guides you through an initial configuration to set up a
new administrator with system authority on the server.

2. Set up secure communications between the Operations Center and the hub server by configuring the Secure Sockets Layer
(SSL) protocol.

Follow the instructions in Securing communications between the Operations Center and the hub server.

3. Optional: To receive a daily email report that summarizes system status, configure your email settings in the Operations
Center.

Follow the instructions in Tracking system status by using email reports.

e Securing communications between the Operations Center and the hub server
To secure communications between the Operations Center and the hub server, add the Transport Layer Security (TLS)
certificate of the hub server to the truststore file of the Operations Center.

Registering the product license

To register your license for the IBM Spectrum Protect™ product, use the REGISTER LICENSE command.

About this task

Licenses are stored in enrollment certificate files, which contain licensing information for the product. The enrollment certificate
files are on the installation media, and are placed on the server during installation. When you register the product, the licenses are
stored in a NODELOCK file within the current directory.

Procedure

Register a license by specifying the name of the enrollment certificate file that contains the license. To use the Operations Center
command builder for this task, complete the following steps.

1. Open the Operations Center.

2. Open the Operations Center command builder by hovering over the settings icon E and clicking Command Builder.
3. Issue the REGISTER LICENSE command. For example, to register a base IBM Spectrum Protect license, issue the following
command:

register license file=tsmbasic.lic

What to do next

Save the installation media that contains your enrollment certificate files. You might need to register your license again if, for
example, one of the following conditions occur:

e The server is moved to a different computer.

e The NODELOCK file is corrupted. The server stores license information in the NODELOCK file, which is in the directory from
which the server is started.

o ITITEMI you change the processor chip that is associated with the server on which the server is installed.

Related reference:
[* REGISTER LICENSE (Register a new license)

Configuring data deduplication

Create a directory-container storage pool and at least one directory to use inline data deduplication.

Before you begin
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Use the storage pool directory information that you recorded in Planning worksheets for this task.

Procedure

. Open the Operations Center.
On the Operations Center menu bar, hover over Storage.
. From the list that is displayed, click Storage Pools.
. Click the +Storage Pool button.
. Complete the steps in the Add Storage Pool wizard:
o To use inline data deduplication, select a Directory storage pool under Container-based storage.
o When you configure directories for the directory-container storage pool, specify the directory paths that you created
for storage during system setup.
6. After you configure the new directory-container storage pool, click Close & View Policies to update a management class
and start using the storage pool.

ONwWN PR

Defining data retention rules for your business

After you create a directory-container storage pool for data deduplication, update the default server policy to use the new storage
pool. The Add Storage Pool wizard opens the Services page in the Operations Center to complete this task.

Procedure

1. On the Services page of the Operations Center, select the STANDARD domain and click Details.
2. On the Summary page for the policy domain, click the Policy Sets tab. The Policy Sets page indicates the name of the active
policy set and lists all of the management classes for that policy set.
3. Click the Configure toggle, and make the following changes:
o Change the backup destination for the STANDARD management class to the directory-container storage pool.
o Change the value for the Backups column to No limit.
o Change the retention period. Set the Keep Extra Backups column to 30 days or more, depending on your business
requirements.
4. Save your changes and click the Configure toggle again so that the policy set is no longer editable.
5. Activate the policy set by clicking Activate.

Related tasks:
Specifying rules for backing up and archiving client data

Defining schedules for server maintenance activities

Create schedules for each server maintenance operation by using the DEFINE SCHEDULE command in the Operations Center
command builder.

About this task

Schedule server maintenance operations to run after client backup operations. You can control the timing of schedules by setting
the start time in combination with the duration time for each operation.

The following example shows how you can schedule server maintenance operations in combination with the client backup
schedule for a single-site disk solution.

Operation Schedule

Client backup Starts at 22:00.

Processing for database and disaster e The database backup operation starts at 11:00, or 13 hours after the beginning
recovery files of the client backup operation. This process runs until completion.

e Device configuration information and volume history backup operations start at
17:00, or 6 hours after the start of the database backup operation.

e Volume history deletion starts at 20:00, or 9 hours after the start of the
database backup operation.

Inventory expiration Starts at 12:00, or 14 hours after the beginning of the client backup operation. This
process runs until completion.
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Procedure

After you configure the device class for the database backup operations, create schedules for database backup and other required
maintenance operations by using the DEFINE SCHEDULE command. Depending on the size of your environment, you might need
to adjust the start times for each schedule in the example.

1. Define a device class for the backup operations. For example, use the DEFINE DEVCLASS command to create a device class
that is named DBBACK_FILEDEV:

define devclass dbback filedev devtype=file
directory=db backup directories

where db_backup_directories is a list of the directories that you created for the database backup.
TN T For example, if you have four directories for database backups, starting with /tsminst1/TSMbkup00,
issue the following command:

define devclass dbback filedev devtype=file
directory=/tsminstl/TSMbkup00,
/tsminstl/TSMbkup0l, /tsminstl/TSMbkup02,
/tsminstl/TSMbkup0O3"

T M For example, if you have four directories for database backups, starting with C:\tsminst1\TSMbkup00, issue the
following command:

define devclass dbback filedev devtype=file
directory="c:\tsminst1\TSMbkup00,
c:\tsminstl1\TSMbkupO01l, c:\tsminstl\TSMbkup02,
c:\tsminstl\TSMbkup03"

2. Set the device class for automatic database backup operations. Use the SET DBRECOVERY command to specify the device
class that you created in the preceding step. For example, if the device class is dbback_filedeyv, issue the following
command:

set dbrecovery dbback filedev

3. Create schedules for the maintenance operations by using the DEFINE SCHEDULE command. See the following table for
the required operations with examples of the commands.

Operation Example command

Back up the database. Create a schedule to run the BACKUP DB command. If you are
configuring a small system, set the COMPRESS parameter to YES.

For example, on a small system, issue the following command to create
a backup schedule that uses the new device class:

define schedule DBBACKUP type=admin cmd="backup db

devclass=dbback filedev type=full numstreams=3
wait=yes

compress=yes" active=yes desc="Back up the
database."

startdate=today starttime=11:00:00 duration=45
durunits=minutes

Back up the device configuration Create a schedule to run the BACKUP DEVCONFIG command:

information.
define schedule DEVCONFIGBKUP type=admin cmd="backup
devconfig
filenames=devconfig.dat" active=yes desc="Backup the
device
configuration file." startdate=today
starttime=17:00:00
duration=45 durunits=minutes
Back up the volume history. Create a schedule to run the BACKUP VOLHISTORY command:
define schedule VOLHISTBKUP type=admin cmd="backup
volhistory
filenames=volhist.dat" active=yes desc="Back up the
volume

history." startdate=today starttime=17:00:00
duration=45
durunits=minutes
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Operation Example command

Remove older versions of database | Create a schedule to run the DELETE VOLHISTORY command:
backups that are no longer required.
define schedule DELVOLHIST type=admin cmd="delete
volhistory

type=dbb todate=today-6 totime=now" active=yes
desc="Remove

old database backups." startdate=today
starttime=20:00:00

duration=45 durunits=minutes

Remove objects that exceed their Create a schedule to run the EXPIRE INVENTORY command.
allowed retention. Set the RESOURCE parameter based on the system size that you are
configuring:

o Small systems: 10

o Medium systems: 30

o Large systems: 40
For example, on a medium-sized system, issue the following command
to create a schedule that is named EXPINVENTORY:

define schedule EXPINVENTORY type=admin cmd="expire
inventory

wait=yes resource=30 duration=120" active=yes
desc="Remove expired

objects." startdate=today starttime=12:00:00
duration=45

durunits=minutes

What to do next

After you create schedules for the server maintenance tasks, you can view them in the Operations Center by completing the
following steps:

1. On the Operations Center menu bar, hover over Servers.
2. Click Maintenance.

Related reference:
[* DEFINE SCHEDULE (Define a schedule for an administrative command)

Defining client schedules

Use the Operations Center to create schedules for client operations.

Procedure

1. On the Operations Center menu bar, hover over Clients.

2. Click Schedules.

3. Click +Schedule.

4. Complete the steps in the Create Schedule wizard. Set client backup schedules to start at 22:00, based on the server
maintenance activities that you scheduled in Defining schedules for server maintenance activities.

Installing and configuring backup-archive clients

Following the successful setup of your IBM Spectrum Protect™ server system, install and configure client software to begin
backing up data.

Procedure

To install the backup-archive client, follow the installation instructions for your operating system.

e Install UNIX and Linux backup-archive clients
e Installing the Windows client for the first time
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What to do next

Register and assign your clients to schedules.

e Registering and assigning clients to schedules
Add and register your clients through the Operations Center by using the Add Client wizard.

e Installing the client management service
Install the client management service for backup-archive clients that run on Linux and Windows operating systems. The
client management service collects diagnostic information about backup-archive clients and makes the information
available to the Operations Center for basic monitoring capability.

Registering and assigning clients to schedules

Add and register your clients through the Operations Center by using the Add Client wizard.

Before you begin

Determine whether the client requires an administrative user ID with client owner authority over the client node. To determine
which clients require an administrative user ID, see technote 7048963.

Restriction: For some types of clients, the client node name and the administrative user ID must match. You cannot authenticate
those clients by using the Lightweight Directory Access Protocol authentication method that was introduced in V7.1.7. For details
about this authentication method, sometimes referred to as integrated mode, see Authenticating users by using an Active
Directory database.

Procedure

To register a client, complete one of the following actions.

e If the client requires an administrative user ID, register the client by using the REGISTER NODE command and specify the
USERID parameter:

register node node name password userid=node name

where node_name specifies the node name and password specifies the node password. For details, see Register a node.
e If the client does not require an administrative user ID, register the client by using the Operations Center Add Client wizard.
Complete the following steps:
a. On the Operations Center menu bar, click Clients.
b. In the Clients table, click +Client.
c. Complete the steps in the Add Client wizard:
i. Specify that redundant data can be eliminated on both the client and server. In the Client-side data
deduplication area, select the Enable check box.
ii. In the Configuration window, copy the TCPSERVERADDRESS, TCPPORT, NODENAME, and DEDUPLICATION
option values.
Tip: Record the option values and keep them in a safe place. After you complete the client registration and
install the software on the client node, use the values to configure the client.
iii. Follow the instructions in the wizard to specify the policy domain, schedule, and option set.
iv. Set how risks are displayed for the client by specifying the at-risk setting.
v. Click Add Client.

Installing the client management service

Install the client management service for backup-archive clients that run on Linux and Windows operating systems. The client
management service collects diagnostic information about backup-archive clients and makes the information available to the
Operations Center for basic monitoring capability.

Procedure

Install the client management service on the same computer as the backup-archive client by completing the following steps:

1. Download the installation package for the client management service from an IBM® download site such as IBM Passport
Advantage® or IBM Fix Central. Look for a file name that is similar to <version>-IBM Spectrum Protect-CMS-
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operating system.bin.

2. Create a directory on the client system that you want to manage, and copy the installation package there.

. Extract the contents of the installation package file.

4. Run the installation batch file from the directory where you extracted the installation and associated files. This is the
directory that you created in step 2.

5. To install the client management service, follow the instructions in the IBM Installation Manager wizard. If IBM Installation
Manager is not already installed on the client system, you must select both IBM Installation Manager and IBM Spectrum
Protect™ Client Management Services.

w

e Verifying that the client management service is installed correctly
Before you use the client management service to collect diagnostic information about a backup-archive client, you can
verify that the client management service is correctly installed and configured.

e Configuring the Operations Center to use the client management service
If you did not use the default configuration for the client management service, you must configure the Operations Center to
access the client management service.

Related tasks:
L Configuring the client management service for custom client installations

Verifying that the client management service is installed correctly

Before you use the client management service to collect diagnostic information about a backup-archive client, you can verify that
the client management service is correctly installed and configured.

Procedure

On the client system, at the command line, run the following commands to view the configuration of the client management
service:

e On Linux client systems, issue the following command:
client install dir/cms/bin/CmsConfig.sh list

where client_install_dir is the directory where the backup-archive client is installed. For example, with the default client
installation, issue the following command:

/opt/tivoli/tsm/cms/bin/CmsConfig.sh list
The output is similar to the following text:

Listing CMS configuration
serverl.example.com:1500 NO SSL HOSTNAME
Capabilities: [LOG_QUERY]

Opt Path: /opt/tivoli/tsm/client/ba/bin/dsm.sys

Log File: /opt/tivoli/tsm/client/ba/bin/dsmerror.log
en US MM/dd/yyyy HH:mm:ss Windows-1252

Log File: /opt/tivoli/tsm/client/ba/bin/dsmsched.log
en US MM/dd/yyyy HH:mm:ss Windows-1252

e On Windows client systems, issue the following command:
client install dir\cms\bin\CmsConfig.bat list

where client_install_dir is the directory where the backup-archive client is installed. For example, with the default client
installation, issue the following command:

C:\"Program Files"\Tivoli\TSM\cms\bin\CmsConfig.bat list
The output is similar to the following text:

Listing CMS configuration

serverl.example.com:1500 NO SSL HOSTNAME

Capabilities: [LOG QUERY]
Opt Path: C:\Program Files\Tivoli\TSM\baclient\dsm.opt
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Log File: C:\Program Files\Tivoli\TSM\baclient\dsmerror.log
en US MM/dd/yyyy HH:mm:ss Windows-1252

Log File: C:\Program Files\Tivoli\TSM\baclient\dsmsched.log
en US MM/dd/yyyy HH:mm:ss Windows-1252

If the client management service is correctly installed and configured, the output displays the location of the error log file.
The output text is extracted from the following configuration file:

e On Linux client systems:

client install dir/cms/Liberty/usr/servers/cmsServer/client-configuration.xml
e On Windows client systems:

client install dir\cms\Liberty\usr\servers\cmsServer\client-configuration.xml

If the output does not contain any entries, you must configure the client-configuration.xml file. For instructions to configure this
file, see Configuring the client management service for custom client installations. You can use the CmsConfig verify command to
verify that a node definition is correctly created in the client-configuration.xml file.

Configuring the Operations Center to use the client management service

If you did not use the default configuration for the client management service, you must configure the Operations Center to access
the client management service.

Before you begin

Ensure that the client management service is installed and started on the client system. Verify whether the default configuration is
used. The default configuration is not used if either of the following conditions is met:

e The client management service does not use the default port number, 9028.
e The backup-archive client is not accessed by the same IP address as the client system where the backup-archive client is
installed. For example, a different IP address might be used in the following situations:

o The computer system has two network cards. The backup-archive client is configured to communicate on one
network, while the client management service communicates on the other network.

o The client system is configured with the Dynamic Host Configuration Protocol (DHCP). As a result, the client system
is dynamically assigned an IP address, which is saved on the server during the previous backup-archive client
operation. When the client system is restarted, the client system might be assigned a different IP address. To ensure
that the Operations Center can always find the client system, you specify a fully qualified domain name.

Procedure

To configure the Operations Center to use the client management service, complete the following steps:

1. On the Clients page of the Operations Center, select the client.

2. Click Details > Properties.

3. In the Remote diagnostics URL field in the General section, specify the URL for the client management service on the client
system. The address must start with https. The following table shows examples of the remote diagnostics URL.

Type of URL Example

With DNS host name and default port, 9028 | https://server.example.com

With DNS host name and non-default port | https://server.example.com:1599

With IP address and non-default port https://192.0.2.0:1599
4. Click Save.

What to do next

You can access client diagnostic information such as client log files from the Diagnosis tab in the Operations Center.

Completing the implementation
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After the IBM Spectrum Protect™ solution is configured and running, test backup operations and set up monitoring to ensure that
everything runs smoothly.

Procedure

1. Test backup operations to verify that your data is protected in the way that you expect.
a. On the Clients page of the Operations Center, select the clients that you want to back up, and click Back Up.
b. On the Servers page of the Operations Center, select the server for which you want to back up the database. Click
Back Up, and follow the instructions in the Back Up Database window.
c. Verify that the backup operations completed successfully with no warning or error messages.
Tip: Alternatively, you can use the backup-archive client GUI to back up client data and you can backup the server
database by issuing BACKUP DB command from an administrative command-Line.
2. Set up monitoring for your solution by following the instructions in Monitoring a single-site disk solution.

Monitoring a single-site disk solution

After you implement a single-site disk solution with IBM Spectrum Protect™, monitor the solution for correct operation. By
monitoring the solution daily and periodically, you can identify existing and potential issues. The information that you gather can
be used to troubleshoot problems and optimize system performance.

About this task

The preferred way to monitor a solution is by using the Operations Center, which provides overall and detailed system status in a
graphical user interface. In addition, you can configure the Operations Center to generate a daily email report that summarizes
system status.

In some cases, you might want to use advanced monitoring tools to complete specific monitoring or troubleshooting tasks.

Tip: If you plan to diagnose issues with backup-archive clients on Linux or Windows operating systems, install IBM Spectrum
Protect client management services on each computer where a backup-archive client is installed. In this way, you can ensure that
the Diagnose button is available in the Operations Center for diagnosing issues with backup-archive clients. To install the client
management service, follow the instructions in Installing the client management service.

Procedure

1. Complete daily monitoring tasks. For instructions, see Daily monitoring checklist.

2. Complete periodic monitoring tasks. For instructions, see Periodic monitoring checklist.

3. To verify that your IBM Spectrum Protect solution complies with licensing requirements, follow the instructions in Verify
license compliance.

4. To set up Operations Center to generate email status reports, see Tracking system status by using email reports

What to do next

Resolve any issues that you detect. To resolve an issue by changing the configuration of your solution, follow the instructions in
Managing operations for a single-site disk solution. The following resources are also available:

e To resolve performance issues, see Performance.
e To resolve other types of issues, see Troubleshooting,.

Daily monitoring checklist

To ensure that you are completing the daily monitoring tasks for your IBM Spectrum Protect™ solution, review the daily monitoring
checklist.

Complete the daily monitoring tasks from the Operations Center Overview page. You can access the Overview page by opening the
Operations Center and clicking Overviews.

The following figure shows the location for completing each task.
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Tip: To run administrative commands for advanced monitoring tasks, use the Operations Center command builder. The command
builder provides a type-ahead function to guide you as you enter commands. To open the command builder, go to the Operations

Center Overview page. On the menu bar, hover over the settings icon

and click Command Builder.

The following table lists the daily monitoring tasks and provides instructions for completing each task.

Table 1. Daily monitoring tasks

Task

Basic procedures

Advanced procedures and troubleshooting
information
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Task

Basic procedures

Advanced procedures and troubleshooting
information

Watch for security
notifications, which can
indicate a ransomware
attack.

If a potential ransomware attack is detected
in the IBM Spectrum Protect environment, a
security notification message is displayed in
the foreground of the Operations Center. For
more information, click the message to open
the Security Notifications page.

On the Security Notifications page, you can take the
following actions:

e View notification details by client.
Restriction: In Operations Center Version
8.1.5, notifications are available only for
backup-archive clients.

e Acknowledge a security notification by
selecting it and clicking Acknowledge. When
you acknowledge a security notification, a
check mark is added to the Acknowledged
column of the Security Notifications page for
the selected client. The standard by which a
notification is acknowledged is determined by
your organization. A check mark might mean
that you investigated the issue and
determined that it is a false positive. Or it
might mean that a problem exists and is being
resolved.

e Assign a security notification to an
administrator by selecting the security
notification and clicking Assign. To view the
assignment, the administrator must sign in to
the Operations Center and click Overviews >
Security. If you are not certain whether the
administrator regularly monitors the Security
Notifications page, notify the administrator
about the assignment.

e If the notification is a false positive, you can
select the security notification and click Reset.
The security notification is deleted. Historical
data that is used for baseline comparisons
with the most recent backup operation is
deleted. A new baseline is calculated going
forward.

o Determine whether
clients are at risk of
being unprotected due to
failed or missed backup
operations.

To verify whether clients are at risk, in the
Clients area, look for an At risk notification. To
view details, click the Clients area.

Attention: If the At risk percentage is much
greater than usual, it might indicate a
ransomware attack. A ransomware attack can
cause backup operations to fail, thus placing
clients at risk. For example, if the percentage
of clients at risk is normally between 5% and
10%, but the percentage increases to 40% or
50%, investigate the cause.

If you installed the client management service
on a backup-archive client, you can view and
analyze the client error and schedule logs by
completing the following steps:

1. In the Clients table, select the client
and click Details.
2. To diagnose an issue, click Diagnosis.

For clients that do not have the client management
service installed, access the client system to review
the client error logs.
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Task

Basic procedures

Advanced procedures and troubleshooting
information

9 Determine whether
client-related or server-
related errors require
attention.

To determine the severity of any reported
alerts, in the Alerts area, hover over the
columns.

To view additional information about alerts, complete
the following steps:

1. Click the Alerts area.

2. In the Alerts table, select an alert.

3. In the Activity Log pane, review the messages.
The pane displays related messages that were
issued before and after the selected alert
occurred.

0 Determine whether
servers that are
managed by the
Operations Center are
available to provide data
protection services to
clients.

. To verify whether servers are at risk, in

the Servers area, look for an
Unavailable notification.

. To view additional information, click the

Servers area.

. Select a server in the Servers table and

click Details.

Tip: If you detect an issue that is related to server
properties, update the server properties:

1. In the Servers table, select a server and click
Details.
2. To update server properties, click Properties.

o Determine whether
sufficient space is
available for the server
inventory, which consists
of the server database,
active log, and archive

log.

. Click the Servers area.
. In the Status column of the table, view

the status of the server and resolve any
issues:

o Normal * Sufficient space is
available for the server
database, active log, and archive
log.

o Critical @ Insufficient space is
available for the server
database, active log, or archive
log. You must add space
immediately, or the data
protection services that are
provided by the server will be
interrupted.

o Warning ‘* The server database,
active log, or archive log is
running out of space. If this
condition persists, you must add
space.

o Unavailable @ Status cannot be
obtained. Ensure that the server
is running, and that there are no
network issues. This status is
also shown if the monitoring
administrator ID is locked or
otherwise unavailable on the
server. This ID is named IBM-
OC-hub_server_name.

o Unmonitored € Unmonitored
servers are defined to the hub
server, but are not configured for
management by the Operations
Center. To configure an
unmonitored server, select the
server, and click Monitor Spoke.

You can also look for related alerts on the Alerts
page. For additional instructions about
troubleshooting, see Resolving server problems.

78 IBM Spectrum Protect Knowledge Center Version 8.1.5



http://www.ibm.com/support/knowledgecenter/SSEQVQ_8.1.0/tshoot/r_pdg_rsolvsrvrprobs.html

Task

Basic procedures

Advanced procedures and troubleshooting
information

6 Verify server
database backup
operations.

To determine when a server was most
recently backed up, complete the following
steps:

1. Click the Servers area.
2. In the Servers table, review the Last
Database Backup column.

To obtain more detailed information about backup
operations, complete the following steps:

1. In the Servers table, select a row and click
Details.

2. In the DB Backup area, hover over the check
marks to review information about backup
operations.

If a database was not backed up recently (for
example, in the last 24 hours), you can start a backup
operation:

1. On the Operations Center Overview page, click
the Servers area.
2. In the table, select a server and click Back Up.

To determine whether the server database is
configured for automatic backup operations,
complete the following steps:

1. On the menu bar, hover over the settings icon

and click Command Builder.
2. Issue the QUERY DB command:

query db f=d

3. In the output, review the Full Device
Class Name field. If a device class is
specified, the server is configured for
automatic database backups.

0 Monitor other server
maintenance tasks.
Server maintenance
tasks can include running
administrative command
schedules, maintenance
scripts, and related
commands.

To search for information about processes
that failed because of server issues, complete
the following steps:

1. Click Servers > Maintenance.

2. To obtain the two-week history of a
process, view the History column.

3. To obtain more information about a
scheduled process, hover over the
check box that is associated with the
process.

For more information about monitoring processes
and resolving issues, see the Operations Center
online help.
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Task

Basic procedures

Advanced procedures and troubleshooting
information

o Verify that the
amount of data that was
recently sent to and from
servers is within the
expected range.

e To obtain an overview of activity in the
last 24 hours, view the Activity area.

e To compare activity in the last 24 hours
with activity in the previous 24 hours,
review the figures in the Current and
Previous areas.

e If more data was sent to the server than you
expected, determine which clients are backing
up more data and investigate the cause. It is
possible that client-side data deduplication is
not working correctly.

Attention: If the amount of backed-up data is
significantly larger than usual, it might indicate
a ransomware attack. When ransomware
encrypts data, the system perceives the data
as being changed, and the changed data is
backed up. Thus, backup volumes become
larger. To determine which clients are
affected, click the Applications, Virtual, or
Systems tabs.

e If less data was sent to the server than you
expected, investigate whether client backup
operations are proceeding on schedule.
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Task

Basic procedures

Advanced procedures and troubleshooting
information

0 Verify that storage
pools are available to
back up client data.

1. If problems are indicated in the Storage
& Data Availability area, click Pools to
view the details:

o Ifthe Critical @ status is
displayed, insufficient space is
available in the storage pool, or
its access status is unavailable.
Attention: If the status is critical,
investigate the cause:

= If the data deduplication
rate for a storage pool
drops significantly, it
might indicate a
ransomware attack.
During a ransomware
attack, data is encrypted
and cannot be
deduplicated. To verify
the data deduplication
rate, in the Storage Pools
table, review the value in
the % Savings column.

» If a storage pool
unexpectedly becomes
100% utilized, it might
indicate a ransomware
attack. To verify the
utilization, review the
value in the Capacity
Used column. Hover over
the values to see the
percentages of used and
free space.

o If the Warning ‘' status is
displayed, the storage pool is
running out of space, or its
access status is read-only.

2. To view the used, free, and total space
for your selected storage pool, hover
over the entries in the Capacity Used
column.

To view the storage-pool capacity that was used over
the past two weeks, select a row in the Storage Pools

table and click Details.
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Task

Basic procedures

Advanced procedures and troubleshooting
information

0 Verify that storage
devices are available for
backup operations.

In the Storage & Data Availability area, in the
Volumes section, under the capacity bars,
review the status that is reported next to
Devices. If a Critical @ or Warning % status is
displayed for any device, investigate the issue.
To view details, click Devices.

Disk devices might have a critical or warning status
for the following reasons:

e For DISK device classes, volumes might be
offline or have a read-only access status. The
Disk Storage column of the Disk Devices table
shows the state of volumes.

e For FILE device classes that are not shared,
directories might be offline. Also, insufficient
free space might be available for allocating
scratch volumes. The Disk Storage column of
the Disk Devices table shows the state of
directories.

e For FILE device classes that are shared, drives
might be unavailable. A drive is unavailable if it
is offline, if it stopped responding to the
server, or if its path is offline. Other columns of
the Disk Devices table show the state of the
drives and paths.

Periodic monitoring checklist

To help ensure that your IBM Spectrum Protect™ solution operates correctly, complete the tasks in the periodic monitoring
checklist. Schedule periodic tasks frequently enough so that you can detect potential issues before they become problematic.

Tip: To run administrative commands for advanced monitoring tasks, use the Operations Center command builder. The command
builder provides a type-ahead function to guide you as you enter commands. To open the command builder, go to the Operations

Center Overview page. On the menu bar, hover over the settings icon and click Command Builder.
Table 1. Periodic monitoring tasks

Task

Basic procedures

Advanced procedures and troubleshooting
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Task

Basic procedures

Advanced procedures and troubleshooting

Monitor system performance.

Determine the length of time that is
required for client backup operations:

1.

On the Operations Center
Overview page, click Clients. Find
the server that is associated with
the client.

. Click Servers. Select the server

and click Details.

. To view the duration of

completed tasks in the last 24
hours, click Completed Tasks.

. To view the duration of tasks that

were completed more than 24
hours ago, use the QUERY
ACTLOG command. Follow the
instructions in .

. If the duration of client backup

operations is increasing and the
reasons are not clear, investigate
the cause.

If you installed the client management
service on a backup-archive client, you
can diagnose performance issues for
the backup-archive client by completing
the following steps:

. On the Operations Center

Overview page, click Clients.

. Select a backup-archive client

and click Details.

. To retrieve client logs, click

Diagnosis.

For instructions about reducing the time that it takes
for the client to back up data to the server, see
Resolving common client performance problems.

Look for performance bottlenecks. For instructions,
see Identifying performance bottlenecks.

For information about identifying and resolving other
performance issues, see Performance.

Determine the disk savings that
are provided by data
deduplication.

. On the Operations Center

Overview page, click Pools.

. Select a pool and click Quick

Look.

. In the Data Deduplication area,

view the Space saved row.

For advanced monitoring, to obtain detailed statistics
about the data-deduplication process for a specific
directory-container storage pool or cloud-container
storage pool, complete the following steps:

1. On the Operations Center Overview page,

hover over the settings icon &l and click
Command Builder.

2. Obtain a statistical report by issuing the
GENERATE DEDUPSTATS command. Follow
the instructions in GENERATE DEDUPSTATS
(Generate data deduplication statistics for a
directory-container storage pool).

3. View the statistical report by issuing the
QUERY DEDUPSTATS command. Follow the
instructions in QUERY DEDUPSTATS (Query
data deduplication statistics).
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Task

Basic procedures

Advanced procedures and troubleshooting

Verify that current backup files
for device configuration and
volume history information are
saved.

Access your storage locations to ensure
that the files are available. The
preferred method is to save the backup
files to two locations.

To locate the volume history and device
configuration files, complete the
following steps:

1. On the Operations Center
Overview page, hover over the

settings icon 6l and click
Command Builder.

2. To locate the volume history and
device configuration files, issue
the following commands:

query option volhistory

query option devconfig

3. In the output, review the Option
Setting column to find the file
locations.

If a disaster occurs, both the volume
history file and the device configuration
file are required to restore the server
database.
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Task

Basic procedures

Advanced procedures and troubleshooting

Determine whether sufficient
space is available for the
instance directory file system.

Verify that at least 20% of free space is
available in the instance directory file
system. Take the action that is
appropriate for your operating system:

o ITENTO view available
space in the file system, on the
operating system command line,
issue the following command:

df -g instance directory

where instance_directory
specifies the instance directory.
o T To view available
space in the file system, on the
operating system command line,
issue the following command:

df -h instance directory

where instance_directory
specifies the instance directory.
o INTTTMIN the Windows
Explorer program, right-click the
file system and click Properties.
View the capacity information.

The preferred location of the instance
directory depends on the operating
system where the server is installed:

x| Linuc

/home/tsminstl/tsminstl
o INIITTTEMC:\tsminstl

Tip: If you completed a planning
worksheet, the location of the instance
directory is recorded in the worksheet.

Identify unexpected client
activity.

To monitor client activity to determine
whether data volumes exceed expected
amounts, complete the following steps:

1. On the Operations Center
Overview page, click the Clients
area.

2. To view activity over the past two
weeks, double-click any client.

3. To view the number of bytes sent
to the client, click the Properties
tab.

4, In the Last Session area, view the
Sent to client row.

When you double-click a client in the Clients table,
the Activity over 2 Weeks area displays the amount
of data that the client sent to the server each day.

Periodically review the SQL activity summary table,
which contains statistics about client sessions. To
compare current activity with previous activity, use
an SQL SELECT statement. If the level of activity is
significantly different from previous activity, it might
indicate a ransomware attack.

Periodically review the activity log. Look for ANE
messages that indicate how many files were backed
up and inspected. Compare current data
deduplication rates with previous rates. If an
unusually high number of files were backed up, or
the rate of data deduplication unexpectedly drops to
0, it might indicate a ransomware attack.
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Task Basic procedures Advanced procedures and troubleshooting
Monitor storage pool growth 1. On the Operations Center Tips:
over time. Overview page, click the Pools

area. ¢ To specify the time period that must elapse

before all deduplicated extents are removed
from a directory-container storage pool or
cloud-container storage pool after they are no
longer referenced by the inventory, complete
the following steps:

1. On the Storage Pools page of the
Operations Center, select the storage
pool.

2. Click Details > Properties.

3. Specify the duration in the Delay
period for container reuse field.

e To determine data deduplication performance
for directory-container and cloud-container
storage pools, use the GENERATE
DEDUPSTATS command.

e To view data deduplication statistics for a
storage pool, complete the following steps:

1. On the Storage Pools page of the
Operations Center, select the storage
pool.

2. Click Details > Properties.

2. To view the capacity that was
used over the last two weeks,
select a pool and click Details.

Alternatively, use the QUERY
EXTENTUPDATES command to display
information about updates to data extents in
directory-container or cloud-container storage
pools. The command output can help you
determine which data extents are no longer
referenced and which ones are eligible to be
deleted from the system. In the output,
monitor the number of data extents that are
eligible to be deleted from the system. This
metric has a direct correlation to the amount
of free space that will be available within the
container storage pool.

e Todisplay the amount of physical space that is
occupied by a file space after the removal of
the data deduplication savings, use the select
* from occupancy command. The command
output includes the LOGICAL_MB value.
LOGICAL_MB is the amount of space that is
used by the file space.

Tip: You can receive a warning message if a client
operation runs longer than expected. Complete the
following steps:

Evaluate the timing of client On the Operations Center Overview
schedules. Ensure that the start | page, click Clients > Schedules.
and end times of client
schedules meet your business
needs.

In the Schedules table, the Start
column displays the configured start 1. On the Operations Center Overview page,

time for the scheduled operation. To
see when the most recent operation
was started, hover over the clock icon.

hover over Clients and click Schedules.

2. Select a schedule and click Details.

3. View the details of a schedule by clicking the
blue arrow next to the row.

4. In the Run time alert field, specify the time
when a warning message will be issued if the
scheduled operation is not completed.

5. Click Save.
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Task Basic procedures Advanced procedures and troubleshooting

Evaluate the timing of On the Operations Center Overview Tip: If a maintenance task is running too long,
maintenance tasks. Ensure that | page, click Servers > Maintenance. change the start time or the maximum run time.
the start and end times of Complete the following steps:

maintenance tasks meet your | In the Maintenance table, review the

business needs. information in the Last Run Time 1. On the Operations Center Overview page,

column. To see when the last
maintenance task was started, hover
over the clock icon.

hover over the settings icon and click
Command Builder.

2. To change the start time or maximum run time
for a task, issue the UPDATE SCHEDULE
command. For instructions, see UPDATE
SCHEDULE (Update a client schedule).

Related reference:

B+ QUERY ACTLOG (Query the activity log)

[ UPDATE STGPOOL (Update a storage pool)

I:"QU ERY EXTENTUPDATES (Query updated data extents)

Verifying license compliance

Verify that your IBM Spectrum Protect™ solution complies with the provisions of your licensing agreement. By verifying
compliance regularly, you can track trends in data growth or processor value unit (PVU) usage. Use this information to plan for
future license purchasing.

About this task

The method that you use to verify that your solution complies with license terms varies depending on the provisions of your IBM
Spectrum Protect licensing agreement.

Front-end capacity licensing
The front-end model determines license requirements based on the amount of primary data that is reported as being
backed up by clients. Clients include applications, virtual machines, and systems.

Back-end capacity licensing
The back-end model determines license requirements based on the terabytes of data that are stored in primary storage
pools and repositories.
Tips:

e To ensure the accuracy of front-end and back-end capacity estimates, install the most recent version of the client
software on each client node.
e The front-end and back-end capacity information in the Operations Center is for planning and estimation purposes.

PVU licensing
The PVU model is based on the use of PVUs by server devices.
Important: The PVU calculations that are provided by IBM Spectrum Protect are considered estimates and are not legally
binding. The PVU licensing information that is reported by IBM Spectrum Protect is not considered an acceptable substitute
for the IBM® License Metric Tool.

For the most recent information about licensing models, see the information about product details and licenses at the IBM
Spectrum Protect product family website. If you have questions or concerns about licensing requirements, contact your IBM
Spectrum Protect software provider.

Procedure

To monitor license compliance, complete the steps that correspond to the provisions of your licensing agreement.

Tip: The Operations Center provides an email report that summarizes front-end and back-end capacity usage. Reports can be sent
automatically to one or more recipients regularly. To configure and manage email reports, click Reports on the Operations Center
menu bar.

Option Description
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Option Description

Front-end model a. On the Operations Center menu bar, hover over the settings icon Bkl and click Licensing.
The front-end capacity estimate is displayed on the Front-end Usage page.

b. If a value is displayed in the Not Reporting column, click the number to identify clients that did
not report capacity usage.

c. To estimate capacity for clients that did not report capacity usage, go to the following FTP site,
which provides measuring tools and instructions:

ftp://public.dhe.ibm.com/storage/tivoli-storage-
management/front_end_capacity_measurement_tools

To measure front-end capacity by script, complete the instructions in the most recently
available licensing guide.

d. Add the Operations Center estimate and any estimates that you obtained by using a script.
e. Verify that the estimated capacity complies with your licensing agreement.

Back-end model Restriction: If the source and target replication servers do not use the same policy settings, you
cannot use the Operations Center to monitor back-end capacity usage for replicated clients. For
information about how to estimate capacity usage for these clients, see technote 1656476.

a. On the Operations Center menu bar, hover over the settings icon and click Licensing.
b. Click the Back-end tab.
c. Verify that the estimated amount of data complies with your licensing agreement.

PVU model For information about how to assess compliance with PVU licensing terms, see Assessing
compliance with the PVU licensing model.

Tracking system status by using email reports

Set up the Operations Center to generate email reports that summarize system status. You can configure a mail server connection,
change report settings, and optionally create custom reports.

Before you begin

Before you set up email reports, ensure that the following requirements are met:

e A Simple Mail Transfer Protocol (SMTP) host server is available to send and receive reports by email. The SMTP server must
be configured as an open mail relay. You must also ensure that the IBM Spectrum Protect™ server that sends email
messages has access to the SMTP server. If the Operations Center is installed on a separate computer, that computer does
not require access to the SMTP server.

e To set up email reports, you must have system privilege for the server.

e To specify the recipients, you can enter one or more email addresses or administrator IDs. If you plan to enter an
administrator ID, the ID must be registered on the hub server and must have an email address that is associated with it. To
specify an email address for an administrator, use the EMAILADDRESS parameter of the UPDATE ADMIN command.

About this task

You can configure the Operations Center to send a general operations report, a license compliance report, and one or more
custom reports. You create custom reports by selecting a template from a set of commonly used report templates or by entering
SQL SELECT statements to query managed servers.

Procedure

To set up and manage email reports, complete the following steps:

1. On the Operations Center menu bar, click Reports.
2. If an email server connection is not yet configured, click Configure Mail Server and complete the fields. After you configure
the mail server, the general operations report and license compliance report are enabled.
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3. To change report settings, select a report, click Details, and update the form.
4. Optional: To add a custom report, click + Report, and complete the fields.
Tip: To immediately run and send a report, select the report and click Send.

Results

Enabled reports are sent according to the specified settings.
Related reference:

[ UPDATE ADMIN (Update an administrator)

Managing operations for a single-site disk solution

Use this information to manage operations for a single-site disk solution with IBM Spectrum Protect™ that includes a server and
uses data deduplication for a single location.

e Managing the Operations Center
The Operations Center provides web and mobile access to status information about the IBM Spectrum Protect
environment. You can use the Operations Center to monitor multiple servers and to complete some administrative tasks.
The Operations Center also provides web access to the IBM Spectrum Protect command line.

e Protecting applications, virtual machines, and systems
The server protects data for clients, which can include applications, virtual machines, and systems. To start protecting
client data, register the client node with the server and select a backup schedule to protect the client data.

e Managing data storage
Manage your data for efficiency and add supported devices and media to the server to store client data.

e Securing the IBM Spectrum Protect server
Secure the IBM Spectrum Protect server and data by controlling access to servers and client nodes, encrypting data, and
maintaining secure access levels and passwords.

e Stopping and starting the server
Before you complete maintenance or reconfiguration tasks, stop the server. Then, start the server in maintenance mode.
When you are finished with the maintenance or reconfiguration tasks, restart the server in production mode.

e Planning to upgrade the server
When a fix pack or interim fix becomes available, you can upgrade the IBM Spectrum Protect server to take advantage of
product improvements. Servers and clients can be upgraded at different times. Ensure that you complete the planning
steps before you upgrade the server.

e Preparing for an outage or system update
Prepare IBM Spectrum Protect to maintain your system in a consistent state during a planned power outage or system
update.

e Implementing a disaster recovery plan
Implement a disaster recovery strategy to recover your applications if a disaster occurs and to ensure high server
availability.

e Recovering from system outages
For IBM Spectrum Protect single-site disk solutions, you can recover the inventory locally only and restore the database to
protect your data.

Managing the Operations Center

The Operations Center provides web and mobile access to status information about the IBM Spectrum Protect™ environment. You
can use the Operations Center to monitor multiple servers and to complete some administrative tasks. The Operations Center also
provides web access to the IBM Spectrum Protect command line.

e Adding and removing spoke servers
In a multiple-server environment, you can connect the other servers, called spoke servers, to the hub server.

e Starting and stopping the web server
The web server of the Operations Center runs as a service and starts automatically. You might have to stop and start the
web server, for example, to make configuration changes.

e Restarting the initial configuration wizard
You might need to restart the initial configuration wizard of the Operations Center, for example, to make configuration
changes.

e Changing the hub server
You can use the Operations Center to remove the hub server of IBM Spectrum Protect, and configure another hub server.
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e Restoring the configuration to the preconfiguration state
If certain problems occur, you might want to restore the Operations Center configuration to the preconfigured state where
the IBM Spectrum Protect servers are not defined as hub or spoke servers.

Adding and removing spoke servers

In a multiple-server environment, you can connect the other servers, called spoke servers, to the hub server.

About this task

The spoke servers send alerts and status information to the hub server. The Operations Center shows you a consolidated view of
alerts and status information for the hub server and any spoke servers.

e Adding a spoke server

After you configure the hub server for the Operations Center, you can add one or more spoke servers to the hub server.
e Removing a spoke server

You can remove a spoke server from the Operations Center.

Adding a spoke server

After you configure the hub server for the Operations Center, you can add one or more spoke servers to the hub server.

Before you begin

Communication between the spoke server and the hub server must be secured by using the Transport Layer Security (TLS)
protocol. To secure communication, add the certificate of the spoke server to the truststore file of the hub server.

Procedure

1. In the Operations Center menu bar, click Servers. The Servers page opens.

In the table on the Servers page, a server might have a status of "Unmonitored." This status means that although an
administrator defined this server to the hub server by using the DEFINE SERVER command, the server is not yet configured
as a spoke server.

2. Complete one of the following steps:
o Click the server to highlight it, and in the table menu bar, click Monitor Spoke.
o If the server that you want to add is not shown in the table, and secure SSL/TLS communication is not required, click
+ Spoke in the table menu bar.
3. Provide the necessary information, and complete the steps in the spoke configuration wizard.
Tip: If the event-record retention period of the server is less than 14 days, the period is automatically reset to 14 days if you
configure the server as a spoke server.

Removing a spoke server

You can remove a spoke server from the Operations Center.

About this task

You might need to remove a spoke server in the following situations, for example:

® You want to move the spoke server from one hub server to another hub server.
e You want to decommission the spoke server.

Procedure

To remove the spoke server from the group of servers that are managed by the hub server, complete the following steps:

1. From the IBM Spectrum Protect™ command line, issue the following command on the hub server:

QUERY MONITORSETTINGS
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2. From the output of the command, copy the name that is in the Monitored Group field.
3. Issue the following command on the hub server, where group_name represents the name of the monitored group, and
member_name represents the name of the spoke server:

DELETE GRPMEMBER group name member name

4. Optional: If you want to move the spoke server from one hub server to another hub server, do noet complete this step.
Otherwise, you can disable alerting and monitoring on the spoke server by issuing the following commands on the spoke
server:

SET STATUSMONITOR OFF
SET ALERTMONITOR OFF

5. Optional: If the spoke server definition is used for other purposes, such as enterprise configuration, command routing,
storing virtual volumes, or library management, do not complete this step. Otherwise, you can delete the spoke server
definition on the hub server by issuing the following command on the hub server:

DELETE SERVER spoke server name

Tip: If a server definition is deleted immediately after the server is removed from the monitored group, status information
for the server can remain in the Operations Center indefinitely.

To avoid this issue, wait until the status collection interval passes before you delete the server definition. The status
collection interval is shown on the Settings page of the Operations Center.

Starting and stopping the web server

The web server of the Operations Center runs as a service and starts automatically. You might have to stop and start the web
server, for example, to make configuration changes.

Procedure

1. Stop the web server.
o ITENFrom the /installation_dir/ui/utils directory, where installation_dir represents the directory where the
Operations Center is installed, issue the following command:

./stopserver.sh
o IMEITEMIssue the following command:
service opscenter.rc stop

o INITITTMFrom the Services window, stop the IBM Spectrum Protect™ Operations Center service.
2. Start the web server.
o ITENFrom the /installation_dir/ui/utils directory, where installation_dir represents the directory where the
Operations Center is installed, issue the following command:

./startserver.sh
o IEITMMIssue the following commands:
Start the server:
service opscenter.rc start
Restart the server:
service opscenter.rc restart
Determine whether the server is running:
service opscenter.rc status

o INITTTMFrom the Services window, start the IBM Spectrum Protect Operations Center service.

Restarting the initial configuration wizard
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You might need to restart the initial configuration wizard of the Operations Center, for example, to make configuration changes.

Before you begin

To change the following settings, use the Settings page in the Operations Center rather than restarting the initial configuration
wizard:

e The frequency at which status data is refreshed
e The duration that alerts remain active, inactive, or closed
e The conditions that indicate that clients are at risk

The Operations Center help includes more information about how to change these settings.

About this task

To restart the initial configuration wizard, you must delete a properties file that includes information about the hub server
connection. However, any alerting, monitoring, at-risk, or multiserver settings that were configured for the hub server are not
deleted. These settings are used as the default settings in the configuration wizard when the wizard restarts.

Procedure

1. Stop the Operations Center web server.
2. On the computer where the Operations Center is installed, go to the following directory, where installation_dir represents
the directory in which the Operations Center is installed:
o TN NNTTTEM nstallation_dir/ui/Liberty/usr/servers/guiServer
o NI Minstallation_dir\ui\Liberty\usr\servers\guiServer
For example:
o NN NTTTEN opt/tivoli/tsm/ui/Liberty/usr/servers/guiServer
o IIITTMc:\Program Files\Tivoli\TSM\ui\Liberty\usr\servers\guiServer
. In the guiServer directory, delete the serverConnection.properties file.
. Start the Operations Center web server.
. Open the Operations Center.
. Use the configuration wizard to reconfigure the Operations Center. Specify a new password for the monitoring administrator
ID.
7. On any spoke servers that were previously connected to the hub server, update the password for the monitoring
administrator ID by issuing the following command from the IBM Spectrum Protect™ command-Lline interface:

[ XN I SN OV)

UPDATE ADMIN IBM-OC-hub server name new password

Restriction: Do not change any other settings for this administrator ID. After you specify the initial password, this password
is managed automatically by the Operations Center.

Changing the hub server

You can use the Operations Center to remove the hub server of IBM Spectrum Protect™, and configure another hub server.

Procedure

1. Restart the initial configuration wizard of the Operations Center. As part of this procedure, you delete the existing hub
server connection.
2. Use the wizard to configure the Operations Center to connect to the new hub server.

Related tasks:
Restarting the initial configuration wizard

Restoring the configuration to the preconfiguration state

If certain problems occur, you might want to restore the Operations Center configuration to the preconfigured state where the IBM
Spectrum Protect™ servers are not defined as hub or spoke servers.

Procedure
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To restore the configuration, complete the following steps:

1. Stop the Operations Center web server.
2. Unconfigure the hub server by completing the following steps:
a. On the hub server, issue the following commands:

SET MONITORINGADMIN ""

SET MONITOREDSERVERGROUP ""

SET STATUSMONITOR OFF

SET ALERTMONITOR OFF

REMOVE ADMIN IBM-OC-hub_ server name

Tip: IBM-OC-hub_server name represents the monitoring administrator ID that was automatically created when
you initially configured the hub server.
b. Reset the password for the hub server by issuing the following command on the hub server:

SET SERVERPASSWORD ""

Attention: Do not complete this step if the hub server is configured with other servers for other purposes, such as
library sharing, exporting and importing of data, or node replication.
3. Unconfigure any spoke servers by completing the following steps:
a. On the hub server, to determine whether any spoke servers remain as members of the server group, issue the
following command:

QUERY SERVERGROUP IBM-OC-hub server name

Tip: IBM-OC-hub_server name represents the name of the monitored server group that was automatically created
when you configured the first spoke server. This server group name is also the same as the monitoring administrator
ID that was automatically created when you initially configured the hub server.

b. On the hub server, to delete spoke servers from the server group, issue the following command for each spoke
server:

DELETE GRPMEMBER IBM-OC-hub server name spoke server name

c. After all spoke servers are deleted from the server group, issue the following commands on the hub server:

DELETE SERVERGROUP IBM-OC-hub server name
SET MONITOREDSERVERGROUP ""

d. On each spoke server, issue the following commands:

REMOVE ADMIN IBM-OC-hub_ server name
SETOPT PUSHSTATUS NO
SET ALERTMONITOR OFF
SET STATUSMONITOR OFF

e. On each spoke server, delete the definition of the hub server by issuing the following command:
DELETE SERVER hub_ server name

Attention: Do not complete this step if the definition is used for other purposes, such as library sharing, exporting
and importing of data, or node replication.
. On the hub server, delete the definition of each spoke server by issuing the following command:

—

DELETE SERVER spoke server name

Attention: Do not complete this step if the server definition is used for other purposes, such as library sharing,
exporting and importing of data, or node replication.
4. Restore the default settings on each server by issuing the following commands:

SET STATUSREFRESHINTERVAL 5

SET ALERTUPDATEINTERVAL 10

SET ALERTACTIVEDURATION 480

SET ALERTINACTIVEDURATION 480

SET ALERTCLOSEDDURATION 60

SET STATUSATRISKINTERVAL TYPE=AP INTERVAL=24
SET STATUSATRISKINTERVAL TYPE=VM INTERVAL=24
SET STATUSATRISKINTERVAL TYPE=SY INTERVAL=24
SET STATUSSKIPASFAILURE YES TYPE=ALL

5. Restart the initial configuration wizard of the Operations Center.
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Related tasks:
Restarting the initial configuration wizard
Starting and stopping the web server

Protecting applications, virtual machines, and systems

The server protects data for clients, which can include applications, virtual machines, and systems. To start protecting client data,
register the client node with the server and select a backup schedule to protect the client data.

e Adding clients
After you implement a data protection solution with IBM Spectrum Protect, you can expand the solution by adding clients.
e Managing client operations
You can evaluate and resolve errors that are related to a backup-archive client by using the Operations Center, which
provides suggestions for resolving errors. For errors on other types of clients, you must examine the error logs on the client
and review the product documentation.
e Managing client upgrades
When a fix pack or interim fix becomes available for a client, you can upgrade the client to take advantage of product
improvements. Servers and clients can be upgraded at different times and can be at different levels with some restrictions.
e Decommissioning a client node
If a client node is no longer required, you can start a process to remove it from the production environment. For example, if
a workstation was backing up data to the IBM Spectrum Protect server, but the workstation is no longer used, you can
decommission the workstation.
e Deactivating data to free storage space
In some cases, you can deactivate data that is stored on the IBM Spectrum Protect server. When you run the deactivation
process, any backup data that was stored before the specified date and time is deactivated and will be deleted as it expires.
In this way, you can free space on the server.

Adding clients

After you implement a data protection solution with IBM Spectrum Protect™, you can expand the solution by adding clients.

About this task

The procedure describes basic steps for adding a client. For more specific instructions about configuring clients, see the
documentation for the product that you install on the client node. You can have the following types of client nodes:

Application client nodes
Application client nodes include email servers, databases, and other applications. For example, any of the following
applications can be an application client node:

e IBM Spectrum Protect Snapshot

IBM Spectrum Protect for Databases

IBM Spectrum Protect for Enterprise Resource Planning
IBM Spectrum Protect for Mail

IBM Spectrum Protect for Virtual Environments

System client nodes
System client nodes include workstations, network-attached storage (NAS) file servers, and API clients.

Virtual machine client nodes
Virtual machine client nodes consist of an individual guest host within a hypervisor. Each virtual machine is represented as
a file space.

Procedure

To add a client, complete the following steps:

1. Select the software to install on the client node and plan the installation. Follow the instructions in Selecting the client
software and planning the installation.

2. Specify how to back up and archive client data. Follow the instructions in Specifying rules for backing up and archiving
client data.

3. Specify when to back up and archive client data. Follow the instructions in Scheduling backup and archive operations.
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4. To allow the client to connect to the server, register the client. Follow the instructions in Registering clients.
5. To start protecting a client node, install and configure the selected software on the client node. Follow the instructions in
Installing and configuring clients.

Selecting the client software and planning the installation

Different types of data require different types of protection. Identify the type of data that you must protect and select the
appropriate software.

About this task

The preferred practice is to install the backup-archive client on all client nodes so that you can configure and start the client
acceptor on the client node. The client acceptor is designed to efficiently run scheduled operations.

The client acceptor runs schedules for the following products: the backup-archive client, IBM Spectrum Protect™ for Databases,
IBM Spectrum Protect for Enterprise Resource Planning, IBM Spectrum Protect for Mail, and IBM Spectrum Protect for Virtual
Environments. If you install a product for which the client acceptor does not run schedules, you must follow the configuration
instructions in the product documentation to ensure that scheduled operations can occur.

Procedure

Based on your goal, select the products to install and review the installation instructions.
Tip: If you install the client software now, you must also complete the client configuration tasks that are described in Installing
and configuring clients before you can use the client.

Goal Product and description Installation instructions
Protect a file The backup-archive client backs up and e Backup-archive client requirements
server or archives files and directories from file e Install UNIX and Linux backup-archive
workstation servers and workstations to storage. You can clients
also restore and retrieve backup versions e Installing the Windows client for the first
and archived copies of files. time
Protect IBM Spectrum Protect Snapshot protects e Installing and upgrading IBM Spectrum
applications with [ data with integrated, application-aware Protect Snapshot for UNIX and Linux
snapshot backup [snapshot backup and restore capabilities. e Installing and upgrading IBM Spectrum
and restore You can protect data that is stored by IBM Protect Snapshot for VMware
capabilities DB2¢® database software and SAP, Oracle, e Installing and upgrading IBM Spectrum
Microsoft Exchange, and Microsoft SQL Protect Snapshot for Windows
Server applications.
Protect an email |IBM Spectrum Protect for Mail: Data e Installation of Data Protection for IBM
application on an | Protection for IBM® Domino automates data Domino on a UNIX, AIX, or Linux system
IBM Domino® protection so that backups are completed (vV7.1.0)
server without shutting down IBM Domino servers. e Installation of Data Protection for IBM

Domino on a Windows system (V7.1.0)

Protect an email |IBM Spectrum Protect for Mail: Data Installing, upgrading, and migrating IBM
application on a Protection for Microsoft Exchange Server Spectrum Protect for Mail: Data Protection for
Microsoft automates data protection so that backups [ Microsoft Exchange Server

Exchange server |are completed without shutting down
Microsoft Exchange servers.

Protect an IBM The application programming interface (API) | Installing the IBM Spectrum Protect backup-
DB2 database of the backup-archive client can be used to | archive clients (UNIX, Linux, and Windows)
back up DB2 data to the IBM Spectrum
Protect server.

Protect an IBM The API of the backup-archive client can be |Installing the IBM Spectrum Protect backup-
Informix® used to back up Informix data to the IBM archive clients (UNIX, Linux, and Windows)
database Spectrum Protect server.
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Goal Product and description Installation instructions

Protect a IBM Spectrum Protect for Databases: Data | Installing Data Protection for SQL Server on
Microsoft SQL Protection for Microsoft SQL Server protects | Windows Server Core
database Microsoft SQL data.
Protect an Oracle |IBM Spectrum Protect for Databases: Data | Data Protection for Oracle installation
database Protection for Oracle protects Oracle data.
Protect an SAP IBM Spectrum Protect for Enterprise e Installing IBM Spectrum Protect for
environment Resource Planning: Data Protection for SAP Enterprise Resource Planning: Data
provides protection that is customized for Protection for SAP for DB2
SAP environments. The product is designed e Installing IBM Spectrum Protect for
to improve the availability of SAP database Enterprise Resource Planning: Data
servers and reduce administration workload. Protection for SAP for Oracle
Protect avirtual |IBM Spectrum Protect for Virtual e Installing Data Protection for Microsoft
machine Environments provides protection that is Hyper-V
tailored for Microsoft Hyper-V and VMware e Installing and upgrading Data Protection
virtual environments. You can use IBM for VMware
Spectrum Protect for Virtual Environments e Installing the IBM Spectrum Protect
to create incremental forever backups that backup-archive clients (UNIX, Linux, and
are stored on a centralized server, create Windows)

backup policies, and restore virtual
machines or individual files.

Alternatively, use the backup-archive client
to back up and restore a full VMware or
Microsoft Hyper-V virtual machine. You can
also back up and restore files or directories
from a VMware virtual machine.

Tip: To use the client for space management, you can install IBM Spectrum Protect for Space Management or IBM Spectrum
Protect HSM for Windows.

Specifying rules for backing up and archiving client data

Before you add a client, ensure that appropriate rules are specified for backup and archive operations for the client data. During
the client registration process, you assign the client node to a policy domain, which has the rules that control how and when client
data is stored.

Before you begin

Determine how to proceed:

e If you are familiar with the policies that are configured for your solution and you know that they do not require changes,
continue with Scheduling backup and archive operations.
e If you are not familiar with the policies, follow the steps in this procedure.

About this task

Policies affect how much data is stored over time, and how long data is retained and available for clients to restore. To meet
objectives for data protection, you can update the default policy and create your own policies. A policy includes the following
rules:

e How and when files are backed up and archived to server storage.
e The number of copies of a file and the length of time copies are kept in server storage.

During the client registration process, you assign a client to a policy domain. The policy for a specific client is determined by the
rules in the policy domain to which the client is assigned. In the policy domain, the rules that are in effect are in the active policy
set.

When a client backs up or archives a file, the file is bound to a management class in the active policy set of the policy domain. A
management class is the key set of rules for managing client data. The backup and archive operations on the client use the
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settings in the default management class of the policy domain unless you further customize policy. A policy can be customized by
defining more management classes and assigning their use through client options.

Client options can be specified in a local, editable file on the client system and in a client option set on the server. The options in
the client option set on the server can override or add to the options in the local client option file.

Procedure

1. Review the policies that are configured for your solution by following the instructions in Viewing policies.

2. If you need to make minor changes to meet data retention requirements, follow the instructions in Editing policies.

3. Optional: If you need to create policy domains or make extensive changes to policies to meet data retention requirements,
see Customizing policies.

Viewing policies

View policies to determine whether they must be edited to meet your requirements.

Procedure

1. To view the active policy set for a policy domain, complete the following steps:
a. On the Services page of the Operations Center, select a policy domain and click Details.
b. On the Summary page for the policy domain, click the Policy Sets tab.
Tip: To help ensure that you can recover data after a ransomware attack, apply the following guidelines:
= Ensure that the value in the Backups column is a minimum of 2. The preferred value is 3, 4, or more.
= Ensure that the value in the Keep Extra Backups column is a minimum of 14 days. The preferred value is 30 or
more days.
= Ensure that the value in the Keep Archives column is a minimum of 30 days.
If IBM Spectrum Protect™ for Space Management software is installed on the client, ensure that data is backed up
before you migrate it. On the DEFINE MGMTCLASS or UPDATE MGMTCLASS command, specify
MIGREQUIRESBKUP=YES. Then, follow the guidelines in the tip.
2. To view inactive policy sets for a policy domain, complete the following steps:
a. On the Policy Sets page, click the Configure toggle. You can now view and edit the policy sets that are inactive.
b. Scroll through the inactive policy sets by using the forward and back arrows. When you view an inactive policy set,
the settings that differentiate the inactive policy set from the active policy set are highlighted.
c. Click the Configure toggle. The policy sets are no longer editable.

Editing policies

To change the rules that apply to a policy domain, edit the active policy set for the policy domain. You can also activate a different
policy set for a domain.

Before you begin

Changes to policy can affect data retention. Ensure that you continue to back up data that is essential to your organization so that
you can restore that data if a disaster occurs. Also, ensure that your system has sufficient storage space for planned backup
operations.

About this task

You edit a policy set by changing one or more management classes within the policy set. If you edit the active policy set, the
changes are not available to clients unless you reactivate the policy set. To make the edited policy set available to clients, activate
the policy set.

Although you can define multiple policy sets for a policy domain, only one policy set can be active. When you activate a different
policy set, it replaces the currently active policy set.

To learn about preferred practices for defining policies, see Customizing policies.

Procedure
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1. On the Services page of the Operations Center, select a policy domain and click Details.
2. On the Summary page for the policy domain, click the Policy Sets tab.

The Policy Sets page indicates the name of the active policy set and lists all of the management classes for that policy set.

3. Click the Configure toggle. The policy set is editable.
4. Optional: To edit a policy set that is not active, click the forward and back arrows to locate the policy set.
5. Edit the policy set by completing any of the following actions:

Option Description

Add a management class a. In the Policy Sets table, click +Management Class.

b. To specify the rules for backing up and archiving data, complete the fields in the
Add Management Class window.

c. To make the management class the default management class, select the Make
default check box.

d. Click Add.

Delete a management class |In the Management Class column, click -.
Tip: To delete the default management class, you must first assign a different
management class as the default.

Make a management class | In the Default column for the management class, click the radio button.

the default management Tip: The default management class manages client files when another management class
class is not assigned to, or appropriate for managing, a file. To ensure that clients can always
back up and archive files, choose a default management class that contains rules for both
backing up and archiving files.

Modify a management class | To change the properties of a management class, update the fields in the table.

6. Click Save.
Attention: When you activate a new policy set, data might be lost. Data that is protected under one policy set might not be
protected under another policy set. Therefore, before you activate a policy set, ensure that the differences between the
previous policy set and the new policy set do not cause data to be lost.

7. Click Activate. A summary of the differences between the active policy set and the new policy set is displayed. Ensure that
the changes in the new policy set are consistent with your data retention requirements by completing the following steps:

a. Review the differences between corresponding management classes in the two policy sets, and consider the
consequences for client files. Client files that are bound to management classes in the active policy set will be bound
to the management classes with the same names in the new policy set.

b. Identify management classes in the active policy set that do not have counterparts in the new policy set, and
consider the consequences for client files. Client files that are bound to these management classes will be managed
by the default management class in the new policy set.

c. If the changes to be implemented by the policy set are acceptable, select the I understand that these updates can
cause data loss check box and click Activate.

Scheduling backup and archive operations

Before you register a new client with the server, ensure that a schedule is available to specify when backup and archive operations
take place. During the registration process, you assign a schedule to the client.

Before you begin

Determine how to proceed:

e If you are familiar with the schedules that are configured for the solution and you know that they do not require
modification, continue with Registering clients.
e If you are not familiar with the schedules or the schedules require modification, follow the steps in this procedure.

About this task

Typically, backup operations for all clients must be completed daily. Schedule client and server workloads to achieve the best
performance for your storage environment. To avoid the overlap of client and server operations, consider scheduling client backup
and archive operations so that they run at night. If client and server operations overlap or are not given enough time and resources
to be processed, you might experience decreased system performance, failed operations, and other issues.
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Procedure

1. Review available schedules by hovering over Clients on the Operations Center menu bar. Click Schedules.
2. Optional: Modify or create a schedule by completing the following steps:

Option Description

Modify a a. In the Schedules view, select the schedule and click Details.

schedule b. On the Schedule Details page, view details by clicking the blue arrows at the beginning of the
rows.

c. Modify the settings in the schedule, and click Save.

Create a In the Schedules view, click +Schedule and complete the steps to create a schedule.
schedule

3. Optional: To configure schedule settings that are not visible in the Operations Center, use a server command. For example,
you might want to schedule a client operation that backs up a specific directory and assigns it to a management class other
than the default.

a. On the Overview page of the Operations Center, hover over the settings icon and click Command Builder.

b. Issue the DEFINE SCHEDULE command to create a schedule or the UPDATE SCHEDULE command to modify a
schedule. For more information about the commands, see DEFINE SCHEDULE (Define a schedule for an
administrative command) or UPDATE SCHEDULE (Update a client schedule).

Related tasks:
* Tuning the schedule for daily operations

Registering clients

Register a client to ensure that the client can connect to the server, and the server can protect client data.

Before you begin

Determine whether the client requires an administrative user ID with client owner authority over the client node. To determine
which clients require an administrative user ID, see technote 7048963.

Restriction: For some types of clients, the client node name and the administrative user ID must match. You cannot authenticate
those clients by using the Lightweight Directory Access Protocol authentication method that was introduced in V7.1.7. For details
about this authentication method, sometimes referred to as integrated mode, see Authenticating users by using an Active
Directory database.

Procedure

To register a client, complete one of the following actions.

e If the client requires an administrative user ID, register the client by using the REGISTER NODE command and specify the
USERID parameter:

register node node name password userid=node name

where node_name specifies the node name and password specifies the node password. For details, see Register a node.
e If the client does not require an administrative user ID, register the client by using the Operations Center Add Client wizard.
Complete the following steps:
a. On the Operations Center menu bar, click Clients.
b. In the Clients table, click +Client.
c. Complete the steps in the Add Client wizard:
i. Specify that redundant data can be eliminated on both the client and server. In the Client-side data
deduplication area, select the Enable check box.
ii. In the Configuration window, copy the TCPSERVERADDRESS, TCPPORT, NODENAME, and DEDUPLICATION
option values.
Tip: Record the option values and keep them in a safe place. After you complete the client registration and
install the software on the client node, use the values to configure the client.
iii. Follow the instructions in the wizard to specify the policy domain, schedule, and option set.
iv. Set how risks are displayed for the client by specifying the at-risk setting.
v. Click Add Client.
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Related reference:

[ Tcpserveraddress option
[ Tcpport option

* Nodename option

[ Deduplication option

Installing and configuring clients

To start protecting a client node, you must install and configure the selected software.

Procedure

If you already installed the software, start at step 2.

1. Take one of the following actions:
o To install software on an application or client node, follow the instructions.

Software Link to instructions
IBM Spectrum Protect™ backup- = Install UNIX and Linux backup-archive clients
archive client = Installing the Windows client for the first time

Tip: You can also update existing clients by using the Operations Center. For
instructions, see Scheduling client updates.

IBM Spectrum Protect for = Data Protection for Oracle installation
Databases = Installing Data Protection for SQL Server on Windows Server Core
IBM Spectrum Protect for Mail = Installation of Data Protection for IBM Domino on a UNIX, AIX, or

Linux system (V7.1.0)

= Installation of Data Protection for IBM Domino on a Windows system
(V7.1.0)

» Installing, upgrading, and migrating IBM Spectrum Protect for Mail:
Data Protection for Microsoft Exchange Server

IBM Spectrum Protect Snapshot = Installing and upgrading IBM Spectrum Protect Snapshot for UNIX and
Linux

= Installing and upgrading IBM Spectrum Protect Snapshot for VMware

= Installing and upgrading IBM Spectrum Protect Snapshot for Windows

IBM Spectrum Protect for = Installing IBM Spectrum Protect for Enterprise Resource Planning:

Enterprise Resource Planning Data Protection for SAP for DB2®

= Installing IBM Spectrum Protect for Enterprise Resource Planning:
Data Protection for SAP for Oracle

o To install software on a virtual machine client node, follow the instructions for the selected backup type.

Backup type Link to instructions
If you plan to create full VMware = Install UNIX and Linux backup-archive clients
backups of virtual machines, install = Installing the Windows client for the first time

and configure the IBM Spectrum
Protect backup-archive client.

If you plan to create incremental = IBM Spectrum Protect for Virtual Environments online product
forever full backups of virtual documentation

machines, install and configure IBM | Tip: You can obtain the software for IBM Spectrum Protect for Virtual
Spectrum Protect for Virtual Environments and the backup-archive client in the IBM Spectrum Protect
Environments and the backup- for Virtual Environments installation package.

archive client on the same client
node or on different client nodes.

2. To allow the client to connect to the server, add or update the values for the TCPSERVERADDRESS, TCPPORT, and
NODENAME options in the client options file. Use the values that you recorded when you registered the client (Registering
clients).

o For clients that are installed on an AIX®, Linux, or Mac OS X operating system, add the values to the client system-
options file, dsm.sys.
o For clients that are installed on a Windows operating system, add the values to the dsm.opt file.
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By default, the options files are in the installation directory.
3. If you installed a backup-archive client on a Linux or Windows operating system, install the client management service on
the client. Follow the instructions in Installing the client management service.
4. Configure the client to run scheduled operations. Follow the instructions in Configuring the client to run scheduled
operations.
5. Optional: Configure communications through a firewall. Follow the instructions in Configuring client/server communications
through a firewall.
6. Run a test backup to verify that data is protected as you planned. For example, for a backup-archive client, complete the
following steps:
a. On the Clients page of the Operations Center, select the client that you want to back up, and click Back Up.
b. Verify that the backup completes successfully and that there are no warning or error messages.
7. Monitor the results of the scheduled operations for the client in the Operations Center.

What to do next

If you need to change what is getting backed up from the client, follow the instructions in Modifying the scope of a client backup.

Configuring the client to run scheduled operations

You must configure and start a client scheduler on the client node. The client scheduler enables communication between the
client and server so that scheduled operations can occur. For example, scheduled operations typically include backing up files
from a client.

About this task

The preferred method is to install the backup-archive client on all client nodes so that you can configure and start the client
acceptor on the client node. The client acceptor is designed to efficiently run scheduled operations. The client acceptor manages
the client scheduler so that the scheduler runs only when required:

e When it is time to query the server about the next scheduled operation
e When it is time to start the next scheduled operation

By using the client acceptor, you can reduce the number of background processes on the client and help to avoid memory
retention problems.

The client acceptor runs schedules for the following products: the backup-archive client, IBM Spectrum Protect™ for Databases,
IBM Spectrum Protect for Enterprise Resource Planning, IBM Spectrum Protect for Mail, and IBM Spectrum Protect for Virtual
Environments. If you installed a product for which the client acceptor does not run schedules, follow the configuration instructions
in the product documentation to ensure that scheduled operations can occur.

If your business uses a third-party scheduling tool as standard practice, you can use that scheduling tool as an alternative to the
client acceptor. Typically, third-party scheduling tools start client programs directly by using operating system commands. To
configure a third-party scheduling tool, see the product documentation.

Procedure

To configure and start the client scheduler by using the client acceptor, follow the instructions for the operating system that is
installed on the client node:

AIX® and Oracle Solaris

a. From the backup-archive client GUI, click Edit > Client Preferences.

b. Click the Web Client tab.

c. In the Managed Services Options field, click Schedule. If you also want the client acceptor to manage the web client,
click the Both option.

d. To ensure that the scheduler can start unattended, in the dsm.sys file, set the passwordaccess option to generate.

e. To store the client node password, issue the following command and enter the client node password when
prompted:

dsmc query sess

—

. Start the client acceptor by issuing the following command on the command line:
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/usr/bin/dsmcad

g. To enable the client acceptor to start automatically after a system restart, add the following entry to the system
startup file (typically, /etc/inittab):

tsm::once:/usr/bin/dsmcad > /dev/null 2>&1 # Client Acceptor Daemon

Linux
a. From the backup-archive client GUI, click Edit > Client Preferences.
b. Click the Web Client tab.
c. In the Managed Services Options field, click Schedule. If you also want the client acceptor to manage the web client,
click the Both option.
d. To ensure that the scheduler can start unattended, in the dsm.sys file, set the passwordaccess option to generate.
e. To store the client node password, issue the following command and enter the client node password when
prompted:
dsmc query sess
f. Start the client acceptor by logging in with the root user ID and issuing the following command:
service dsmcad start
g. To enable the client acceptor to start automatically after a system restart, add the service by issuing the following
command at a shell prompt:
# chkconfig --add dsmcad
MAC 0S X
a. In the backup-archive client GUI, click Edit > Client Preferences.
b. To ensure that the scheduler can start unattended, click Authorization, select Password Generate, and click Apply.
c. To specify how services are managed, click Web Client, select Schedule, click Apply, and click OK.
d. To ensure that the generated password is saved, restart the backup-archive client.
e. Use the IBM Spectrum Protect Tools for Administrators application to start the client acceptor.
Windows
a. In the backup-archive client GUI, click Utilities > Setup Wizard > Help me configure the Client Scheduler. Click Next.
b. Read the information on the Scheduler Wizard page and click Next.
¢. On the Scheduler Task page, select Install a new or additional scheduler and click Next.
d. On the Scheduler Name and Location page, specify a name for the client scheduler that you are adding. Then, select
Use the Client Acceptor daemon (CAD) to manage the scheduler and click Next.
e. Enter the name that you want to assign to this client acceptor. The default name is Client Acceptor. Click Next.
f. Complete the configuration by stepping through the wizard.
g. Update the client options file, dsm.opt, and set the passwordaccess option to generate.
h. To store the client node password, issue the following command at the command prompt:

dsmc query sess

Enter the client node password when prompted.

. Start the client acceptor service from the Services Control page. For example, if you used the default name, start the
Client Acceptor service. Do not start the scheduler service that you specified on the Scheduler Name and Location
page. The scheduler service is started and stopped automatically by the client acceptor service as needed.

Configuring client/server communications through a firewall

If a client must communicate with a server through a firewall, you must enable client/server communications through the firewall.

Before you begin

If you used the Add Client wizard to register a client, find the option values in the client options file that you obtained during that
process. You can use the values to specify ports.

About this task
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Attention: Do not configure a firewall in a way that might cause termination of sessions that are in use by a server or storage agent.
Termination of a valid session can cause unpredictable results. Processes and sessions might appear to stop due to input/output
errors. To help exclude sessions from timeout restrictions, configure known ports for IBM Spectrum Protect™ components. Ensure
that the KEEPALIVE server option remains set to the default value of YES. In this way, you can help to ensure that client/server
communication is uninterrupted. For instructions about setting the KEEPALIVE server option, see KEEPALIVE.

Procedure

Open the following ports to allow access through the firewall:

TCP/IP port for the backup-archive client, command-line administrative client, and the client scheduler
Specify the port by using the tcpport option in the client options file. The tcpport option in the client options file must match
the TCPPORT option in the server options file. The default value is 1500. If you decide to use a value other than the default,
specify a number in the range 1024 - 32767.

HTTP port to enable communication between the web client and remote workstations
Specify the port for the remote workstation by setting the httpport option in the client options file of the remote
workstation. The default value is 1581.

TCP/IP ports for the remote workstation
The default value of 0 (zero) causes two free port numbers to be randomly assigned to the remote workstation. If you do
not want the port numbers to be randomly assigned, specify values by setting the webports option in the client options file
of the remote workstation.

TCP/IP port for administrative sessions
Specify the port on which the server waits for requests for administrative client sessions. The value of the client
tcpadminport option must match the value of the TCPADMINPORT server option. In this way, you can secure administrative
sessions within a private network.

Managing client operations

You can evaluate and resolve errors that are related to a backup-archive client by using the Operations Center, which provides
suggestions for resolving errors. For errors on other types of clients, you must examine the error logs on the client and review the
product documentation.

About this task

In some cases, you can resolve client errors by stopping and starting the client acceptor. If client nodes or administrator IDs are
locked, you can resolve the issue by unlocking the client node or administrator ID, and then resetting the password.

For detailed instructions about identifying and resolving client errors, see Resolving client problems.

e Evaluating errors in client error logs
You can resolve client errors by obtaining suggestions from the Operations Center or by reviewing error logs on the client.
e Stopping and restarting the client acceptor
If you change the configuration of your solution, you must restart the client acceptor on all client nodes where a backup-
archive client is installed.
e Resetting passwords
If a password for a client node or an administrator ID is lost or forgotten, you can reset the password. Multiple attempts to
access the system with an incorrect password can cause a client node or administrator ID to be locked. You can take steps
to resolve the issue.
¢ Modifying the scope of a client backup
When you set up client backup operations, the preferred practice is to exclude objects that you do not require. For example,
you typically want to exclude temporary files from a backup operation.

Evaluating errors in client error logs

You can resolve client errors by obtaining suggestions from the Operations Center or by reviewing error logs on the client.

Before you begin
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To resolve errors in a backup-archive client on a Linux or Windows operating system, ensure that the client management service is
installed and started. For installation instructions, see Installing the client management service. For instructions about verifying
the installation, see Verifying that the client management service is installed correctly.

Procedure

To diagnose and resolve client errors, take one of the following actions:

e If the client management service is installed on the client node, complete the following steps:
1. On the Operations Center Overview page, click Clients and select the client.
2. Click Details.
3. On the client Summary page, click the Diagnosis tab.
4. Review the retrieved log messages.
Tips:
= To show or hide the Client Logs pane, double-click the Client Logs bar.
= To resize the Client Logs pane, click and drag the Client Logs bar.

If suggestions are displayed on the Diagnosis page, select a suggestion. In the Client Logs pane, client log messages
to which the suggestion relates are highlighted.

5. Use the suggestions to resolve the problems that are indicated by the error messages.
Tip: Suggestions are provided for only a subset of client messages.
e Ifthe client management service is not installed on the client node, review the error logs for the installed client.

Stopping and restarting the client acceptor

If you change the configuration of your solution, you must restart the client acceptor on all client nodes where a backup-archive
client is installed.

About this task

In some cases, you can resolve client scheduling problems by stopping and restarting the client acceptor. The client acceptor
must be running to ensure that scheduled operations can occur on the client. For example, if you change the IP address or domain
name of the server, you must restart the client acceptor.

Procedure

Follow the instructions for the operating system that is installed on the client node:
AIX and Oracle Solaris

e To stop the client acceptor, complete the following steps:
a. Determine the process ID for the client acceptor by issuing the following command on the command line:

ps —ef | grep dsmcad
Review the output. In the following sample output, 6764 is the process ID for the client acceptor:
root 6764 1 0 16:26:35 2 0:00 /usr/bin/dsmcad
b. Issue the following command on the command line:
kill -9 PID

where PID specifies the process ID for the client acceptor.
e To start the client acceptor, issue the following command on the command line:

/usr/bin/dsmcad
Linux
e To stop the client acceptor (and not restart it), issue the following command:
# service dsmcad stop

e To stop and restart the client acceptor, issue the following command:
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# service dsmcad restart
MAC OS X
Click Applications > Utilities > Terminal.

e To stop the client acceptor, issue the following command:

/bin/launchctl unload -w com.ibm.tivoli.dsmcad

e To start the client acceptor, issue the following command:

/bin/launchctl load -w com.ibm.tivoli.dsmcad
Windows

e To stop the client acceptor service, complete the following steps:
a. Click Start > Administrative Tools > Services.
b. Double-click the client acceptor service.
c. Click Stop and OK.

e To restart the client acceptor service, complete the following steps:
a. Click Start > Administrative Tools > Services.
b. Double-click the client acceptor service.
c. Click Start and OK.

Related reference:
[ Resolving client scheduling problems

Resetting passwords

If a password for a client node or an administrator ID is lost or forgotten, you can reset the password. Multiple attempts to access
the system with an incorrect password can cause a client node or administrator ID to be locked. You can take steps to resolve the
issue.

Procedure

To resolve password issues, take one of the following actions:

e If a backup-archive client is installed on a client node, and the password is lost or forgotten, complete the following steps:
1. Generate a new password by issuing the UPDATE NODE command:

update node node name new password forcepwreset=yes

where node_name specifies the client node and new_password specifies the password that you assign.

2. Inform the client node owner about the changed password. When the owner of the client node logs in with the
specified password, a new password is generated automatically. That password is unknown to users to enhance
security.

Tip: The password is generated automatically if you previously set the passwordaccess option to generate in the
client options file.
e If an administrator is locked out because of password issues, complete the following steps:

1. To provide the administrator with access to the server, issue the UNLOCK ADMIN command. For instructions, see
UNLOCK ADMIN (Unlock an administrator).

2. Set a new password by using the UPDATE ADMIN command:

update admin admin name new password forcepwreset=yes

where admin_name specifies the name of the administrator and new_password specifies the password that you
assign.
e Ifaclient node is locked, complete the following steps:

1. Determine why the client node is locked and whether it must be unlocked. For example, if the client node is
decommissioned, the client node is being removed from the production environment. You cannot reverse the
decommission operation, and the client node remains locked. A client node also might be locked if the client data is
the subject of a legal investigation.

2. If you must unlock a client node, use the UNLOCK NODE command. For instructions, see UNLOCK NODE (Unlock a
client node).
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3. Generate a new password by issuing the UPDATE NODE command:

update node node name new password forcepwreset=yes

where node_name specifies the name of the node and new_password specifies the password that you assign.

4. Inform the client node owner about the changed password. When the owner of the client node logs in with the
specified password, a new password is generated automatically. That password is unknown to users to enhance
security.

Tip: The password is generated automatically if you previously set the passwordaccess option to generate in the
client options file.

Modifying the scope of a client backup

When you set up client backup operations, the preferred practice is to exclude objects that you do not require. For example, you
typically want to exclude temporary files from a backup operation.

About this task

When you exclude unnecessary objects from backup operations, you get better control of the amount of storage space that is
required for backup operations, and the cost of storage. Depending on your licensing package, you also might be able to limit
licensing costs.

Procedure

How you modify the scope of backup operations depends on the product that is installed on the client node:

e For a backup-archive client, you can create an include-exclude list to include or exclude a file, groups of files, or directories
from backup operations. To create an include-exclude list, follow the instructions in Creating an include-exclude list.

To ensure consistent use of an include-exclude list for all clients of one type, you can create a client option set on the server
that contains the required options. Then, you assign the client option set to each of the clients of the same type. For details,
see Controlling client operations through client option sets.

e Fora backup-archive client, you can specify the objects to include in an incremental backup operation by using the domain
option. Follow the instructions in Domain option.

e For other products, to define which objects are included in and excluded from backup operations, follow the instructions in
the product documentation.

Managing client upgrades

When a fix pack or interim fix becomes available for a client, you can upgrade the client to take advantage of product
improvements. Servers and clients can be upgraded at different times and can be at different levels with some restrictions.

Before you begin

1. Review the client/server compatibility requirements in technote 1053218. If your solution includes servers or clients at a
level that is earlier than V7.1, review the guidelines to ensure that client backup and archive operations are not disrupted.

2. Verify system requirements for the client in IBM Spectrum Protect™ Supported Operating Systems.

3. If the solution includes storage agents or library clients, review the information about storage-agent and library-client
compatibility with servers that are configured as library managers. See technote 1302789.

If you plan to upgrade a library manager and a library client, you must upgrade the library manager first.

Procedure

To upgrade the software, complete the instructions that are listed in the following table.

Software Link to instructions

IBM Spectrum Protect backup- e Scheduling client updates
archive client
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Software Link to instructions

IBM Spectrum Protect Snapshot e Installing and upgrading IBM Spectrum Protect Snapshot for UNIX and
Linux

e Installing and upgrading IBM Spectrum Protect Snapshot for VMware

e Installing and upgrading IBM Spectrum Protect Snapshot for Windows

IBM Spectrum Protect for e Upgrading Data Protection for SQL Server

Databases e Data Protection for Oracle installation

e Installing, upgrading, and migrating IBM Spectrum Protect for Mail:
Data Protection for Microsoft Exchange Server

IBM Spectrum Protect for e Upgrading IBM Spectrum Protect for Enterprise Resource Planning:

Enterprise Resource Planning Data Protection for SAP for DB2®

e Upgrading IBM Spectrum Protect for Enterprise Resource Planning:
Data Protection for SAP for Oracle

IBM Spectrum Protect for Mail e Installation of Data Protection for IBM Domino on a UNIX, AIX, or
Linux system (V7.1.0)

e Installation of Data Protection for IBM Domino on a Windows system
(V7.1.0)

e Installing, upgrading, and migrating IBM Spectrum Protect for Mail:
Data Protection for Microsoft Exchange Server

IBM Spectrum Protect for Virtual e Installing and upgrading Data Protection for VMware
Environments e Installing Data Protection for Microsoft Hyper-V

Decommissioning a client node

If a client node is no longer required, you can start a process to remove it from the production environment. For example, if a
workstation was backing up data to the IBM Spectrum Protect™ server, but the workstation is no longer used, you can
decommission the workstation.

About this task

When you start the decommission process, the server locks the client node to prevent it from accessing the server. Files that
belong to the client node are gradually deleted, and then the client node is deleted. You can decommission the following types of
client nodes:

Application client nodes
Application client nodes include email servers, databases, and other applications. For example, any of the following
applications can be an application client node:

e IBM Spectrum Protect Snapshot

e IBM Spectrum Protect for Databases

e IBM Spectrum Protect for Enterprise Resource Planning
e IBM Spectrum Protect for Mail

e IBM Spectrum Protect for Virtual Environments

System client nodes
System client nodes include workstations, network-attached storage (NAS) file servers, and API clients.

Virtual machine client nodes
Virtual machine client nodes consist of an individual guest host within a hypervisor. Each virtual machine is represented as
a file space.

The simplest method for decommissioning a client node is to use the Operations Center. The decommission process runs in the
background. If the client is configured to replicate client data, the Operations Center automatically removes the client from
replication on the source and target replication servers before it decommissions the client.

Tip: Alternatively, you can decommission a client node by issuing the DECOMMISSION NODE or DECOMMISSION VM command.
You might want to use this method in the following cases:
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e To schedule the decommission process for the future or to run a series of commands by using a script, specify the
decommission process to run in the background.

¢ To monitor the decommission process for debugging purposes, specify the decommission process to run in the foreground.
If you run the process in the foreground, you must wait for the process to be completed before you continue with other
tasks.

Procedure

Take one of the following actions:

e To decommission a client in the background by using the Operations Center, complete the following steps:
1. On the Operations Center Overview page, click Clients and select the client.
2. Click More > Decommission.
e To decommission a client node by using an administrative command, take one of the following actions:
o To decommission an application or system client node in the background, issue the DECOMMISSION NODE
command. For example, if the client node is named AUSTIN, issue the following command:

decommission node austin

o To decommission an application or system client node in the foreground, issue the DECOMMISSION NODE command
and specify the wait=yes parameter. For example, if the client node is named AUSTIN, issue the following
command:

decommission node austin wait=yes

o To decommission a virtual machine in the background, issue the DECOMMISSION VM command. For example, if the
virtual machine is named AUSTIN, the file space is 7, and the file space name is specified by the file space ID, issue
the following command:

decommission vm austin 7 nametype=fsid
If the virtual machine name includes one or more spaces, enclose the name in double quotation marks. For example:
decommission vm "austin 2" 7 nametype=fsid

o To decommission a virtual machine in the foreground, issue the DECOMMISSION VM command and specify the
wait=yes parameter. For example, issue the following command:

decommission vm austin 7 nametype=fsid wait=yes

If the virtual machine name includes one or more spaces, enclose the name in double quotation marks. For example:

decommission vm "austin 2" 7 nametype=fsid wait=yes

What to do next

Watch for error messages, which might be displayed in the user interface or in the command output, immediately after you run the

process.
You can verify that the client node is decommissioned:

1. On the Operations Center Overview page, click Clients.
2. In the Clients table, in the At risk column, review the state:
o A DECOMMISSIONED state specifies that the node is decommissioned.
o A null value specifies that the node is not decommissioned.
o A PENDING state specifies that the node is being decommissioned, or the decommission process failed.
Tip: If you want to determine the status of a pending decommission process, issue the following command:

query process

3. Review the command output:
o If status is provided for the decommission process, the process is in progress. For example:

query process

Process Process Description Process Status
Number
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3 DECOMMISSION NODE Number of backup objects deactivated
for node NODEl: 8 objects deactivated.

o If no status is provided for the decommission process, and you did not receive an error message, the process is
incomplete. A process can be incomplete if files that are associated with the node are not yet deactivated. After the
files are deactivated, run the decommission process again.

o If no status is provided for the decommission process, and you receive an error message, the process failed. Run the
decommission process again.

Related reference:
* DECOMMISSION NODE (Decommission a client node)
* DECOMMISSION VM (Decommission a virtual machine)

Deactivating data to free storage space

In some cases, you can deactivate data that is stored on the IBM Spectrum Protect™ server. When you run the deactivation
process, any backup data that was stored before the specified date and time is deactivated and will be deleted as it expires. In
this way, you can free space on the server.

About this task

Some application clients always save data to the server as active backup data. Because active backup data is not managed by
inventory expiration policies, the data is not deleted automatically, and uses server storage space indefinitely. To free the storage
space that is used by obsolete data, you can deactivate the data.

When you run the deactivation process, all active backup data that was stored before the specified date becomes inactive. The
data is deleted as it expires and cannot be restored. The deactivation feature applies only to application clients that protect Oracle
databases.

Procedure

1. From the Operations Center Overview page, click Clients.
2. In the Clients table, select one or more clients and click More > Clean Up.
Command-line method: Deactivate data by using the DEACTIVATE DATA command.

Related reference:
* DEACTIVATE DATA (Deactivate data for a client node)

Managing data storage

Manage your data for efficiency and add supported devices and media to the server to store client data.

e Auditing a storage pool container
Audit a storage pool container to check for inconsistencies between database information and a container in a storage pool.
e Managing inventory capacity
Manage the capacity of the database, active log, and archive logs to ensure that the inventory is sized for the tasks, based
on the status of the logs.
e Managing memory and processor usage
Ensure that you manage memory requirements and processor usage to ensure that the server can complete data processes
such as backup and data deduplication. Consider the impact on performance when you complete certain processes.
e Tuning scheduled activities
Schedule maintenance tasks daily to ensure that your solution operates correctly. By tuning your solution, you maximize
server resources and effectively use different functions available within your solution.

Related reference:
B+ Storage pool types

Auditing a storage pool container

Audit a storage pool container to check for inconsistencies between database information and a container in a storage pool.
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About this task

You audit a storage pool container in the following situations:

e When you issue the QUERY DAMAGED command and a problem is detected
e When the server displays messages about damaged data extents
e Your hardware reports an issue and error messages that are associated with the storage pool container are displayed

Procedure

1. To audit a storage pool container, issue the AUDIT CONTAINER command. For example, issue the following command to
audit a container, 000000000000076c.dcf:

audit container c:\tsm-storage\07\000000000000076c.dcf

2. Review the output from the ANR4891I message for information about any damaged data extents.

What to do next

If you detect problems with the storage pool container, you can restore data based on your configuration. Issue the AUDIT
CONTAINER command and specify the container name.

Related reference:
[** AUDIT CONTAINER (Verify the consistency of database information for a directory-container storage pool)
* QUERY DAMAGED (Query damaged data in a directory-container or cloud-container storage pool)

Managing inventory capacity

Manage the capacity of the database, active log, and archive logs to ensure that the inventory is sized for the tasks, based on the
status of the logs.

Before you begin

The active and archive logs have the following characteristics:

e The active log can be a maximum size of 512 GB. For more information about sizing the active log for your system, see
Planning the storage arrays.

e The archive log size is limited to the size of the file system that it is installed on. The archive log size is not maintained at a
predefined size like the active log. Archive log files are automatically deleted after they are no longer needed.

As a best practice, you can optionally create an archive failover log to store archive log files when the archive log directory is full.

Check the Operations Center to determine the component of the inventory that is full. Ensure that you stop the server before you
increase the size of one of the inventory components.

Procedure

e Toincrease the size of the database, complete the following steps:

o Create one or more directories for the database on separate drives or file systems.

o Issue the EXTEND DBSPACE command to add the directory or directories to the database. The directories must be
accessible to the instance user ID of the database manager. By default, data is redistributed across all database
directories and space is reclaimed.

Tips:
= The time that is needed to complete redistribution of data and reclaiming of space is variable, depending on
the size of your database. Make sure that you plan adequately.
= Ensure that the directories that you specify are the same size as existing directories to ensure a consistent
degree of parallelism for database operations. If one or more directories for the database are smaller than the
others, they reduce the potential for optimized parallel prefetching and distribution of the database.

o Halt and restart the server to fully use the new directories.

o Reorganize the database if necessary. Index and table reorganization for the server database can help to avoid
unexpected database growth and performance issues. For more information about reorganizing the database, see
technote 1683633.
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e To decrease the size of the database for V7.1 servers and later, issue the following DB2® commands from the server
instance directory:
Restriction: The commands can increase I/0 activity, and might affect server performance. To minimize performance
problems, wait until one command is completed before you issue the next command. The DB2 commands can be issued
when the server is running.

db2
db2

connect to tsmdbl
set schema tsmdbl

db2
db2
db2
db2
db2
db2
db2
db2
db2
db2
db2
db2
db2
db2

ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER

TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE

USERSPACE1 REDUCE MAX
IDXSPACE1l REDUCE MAX
LARGEIDXSPACEl REDUCE MAX
LARGESPACE1 REDUCE MAX
REPLTBLSPACE1 REDUCE MAX
REPLIDXSPACE1 REDUCE MAX
ARCHOBJDATASPACE REDUCE MAX
ARCHOBJIDXSPACE REDUCE MAX
BACKOBJDATASPACE REDUCE MAX
BACKOBJIDXSPACE REDUCE MAX
BFABFDATASPACE REDUCE MAX
BFABFIDXSPACE REDUCE MAX
BFBFEXTDATASPACE REDUCE MAX
BFBFEXTIDXSPACE REDUCE MAX

db2
db2
db2
db2
db2
db2
db2
db2
db2
db2

ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER

DEDUPTBLSPACE1l REDUCE MAX
DEDUPIDXSPACEl REDUCE MAX
DEDUPTBLSPACE2 REDUCE MAX
DEDUPIDXSPACE2 REDUCE MAX
DEDUPTBLSPACE3 REDUCE MAX
DEDUPIDXSPACE3 REDUCE MAX
DEDUPTBLSPACE4 REDUCE MAX
DEDUPIDXSPACE4 REDUCE MAX
DEDUPTBLSPACES REDUCE MAX
DEDUPIDXSPACES5 REDUCE MAX

TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE

e Toincrease or decrease the size of the active log, complete the following steps:

1. Ensure that the location for the active log has enough space for the increased log size. If a log mirror exists, its
location must also have enough space for the increased log size.

2. Halt the server.

3. In the dsmserv.opt file, update the ACTIVELOGSIZE option to the new size of the active log, in megabytes.
The size of an active log file is based on the value of the ACTIVELOGSIZE option. Guidelines for space requirements
are in the following table:

Table 1. How to estimate volume and file space requirements

ACTIVELOGSize option | Reserve this much free space in the active log directory, in addition to the
value ACTIVELOGSize space

16 GB-128 GB 5120 MB

129 GB - 256 GB 10240 MB

257 GB-512 GB 20480 MB

To change the active log to its maximum size of 512 GB, enter the following server option:

activelogsize 524288

. If you plan to use a new active log directory, update the directory name that is specified in the
ACTIVELOGDIRECTORY server option. The new directory must be empty and must be accessible to the user ID of
the database manager.

5. Restart the server.

e Compress the archive logs to reduce the amount of space that is required for storage. Enable dynamic compression of the

archive log by issuing the following command:

setopt archlogcompress yes

Restriction: Use caution when you enable the ARCHLOGCOMPRESS server option on systems with sustained high volume
usage and heavy workloads. Enabling this option in this system environment can cause delays in archiving log files from the
active log file system to the archive log file system. This delay can cause the active log file system to run out of space. Be
sure to monitor the available space in the active log file system after archive log compression is enabled. If the active log
directory file system usage nears out of space conditions, the ARCHLOGCOMPRESS server option must be disabled. You
can use the SETOPT command to disable archive log compression immediately without halting the server.
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Related reference:

[+ ACTIVELOGSIZE server option

* EXTEND DBSPACE (Increase space for the database)
[** SETOPT (Set a server option for dynamic update)

Managing memory and processor usage

Ensure that you manage memory requirements and processor usage to ensure that the server can complete data processes such
as backup and data deduplication. Consider the impact on performance when you complete certain processes.

Before you begin

e Ensure that your configuration uses the required hardware and software. For more information, see IBM Spectrum Protect™
Supported Operating Systems.

e For more information about managing resources such as the database and recovery log, see Planning the storage arrays.

¢ Add more system memory to determine whether there is a performance improvement. Monitor memory usage regularly to
determine whether more memory is required.

Procedure

1. Release memory from the file system cache where possible.

2. To manage the system memory that is used by each server on a system, use the DBMEMPERCENT server option. Limit the
percentage of system memory that can be used by the database manager of each server. If all servers are equally
important, use the same value for each server. If one server is a production server and other servers are test servers, set
the value for the production server to a higher value than the test servers.

3. Set the user data limit and private memory for the database to ensure that private memory is not exhausted. Exhausting
private memory can result in errors, less than optimal performance, and instability.

Tuning scheduled activities

Schedule maintenance tasks daily to ensure that your solution operates correctly. By tuning your solution, you maximize server
resources and effectively use different functions available within your solution.

Procedure

1. Monitor system performance regularly to ensure that backup and maintenance tasks are completing successfully. For more
information about monitoring, see Monitoring a single-site disk solution.
2. If the monitoring information shows that the server workload increased, you might need to review the planning information.
Review whether the capacity of the system is adequate in the following cases:
o The number of clients increases
o The amount of data that is being backed up increases
o The amount of time that is available for backups changes
3. Determine whether your solution has performance issues. Review the client schedules to check whether tasks are
completing within the scheduled time frame:
a. On the Clients page of the Operations Center, select the client.
b. Click Details.
c. From the client Summary page, review the Backed up and Replicated activity to identify any risks.
Adjust the time and frequency of client backup operations, if necessary.
4. Schedule enough time for the following maintenance tasks to complete successfully within a 24-hour period:
a. Back up the database
b. Run expiration to remove client backups and archive file copies from server storage.

Related concepts:
[ performance
Related tasks:

B Deduplicating data (V7.1.1)

Securing the IBM Spectrum Protect server
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Secure the IBM Spectrum Protect™ server and data by controlling access to servers and client nodes, encrypting data, and
maintaining secure access levels and passwords.

e Security concepts
You can protect IBM Spectrum Protect from security risks by using communication protocols, securing passwords, and
providing different access levels for administrators.

e Managing administrators
An administrator who has system authority can complete any task with the IBM Spectrum Protect server, including
assigning authority levels to other administrators. To complete some tasks, you must be granted authority by being
assigned one or more authority levels.

e Changing password requirements
You can change the minimum password limit, password length, password expiration, and enable or disable authentication
for IBM Spectrum Protect.

e Securing the server on the system
Protect the system where the IBM Spectrum Protect server runs to prevent unauthorized access.

Security concepts

You can protect IBM Spectrum Protect™ from security risks by using communication protocols, securing passwords, and providing
different access levels for administrators.

Transport Layer Security

You can use the Secure Sockets Layer (SSL) or the Transport Layer Security (TLS) protocol to provide transport layer security for a
secure connection between servers, clients, and storage agents. If you send data between the server, client, and storage agent,
use SSL or TLS to encrypt the data.

Tip: Any IBM Spectrum Protect documentation that indicates "SSL" or to "select SSL" applies to TLS.

SSL is provided by the Global Security Kit (GSKit) that is installed with the IBM Spectrum Protect server that the server, client, and
storage agent use.

Restriction: Do not use the SSL or TLS protocols for communications with a DB2® database instance that is used by any IBM
Spectrum Protect servers.

Each server, client, or storage agent that enables SSL must use a trusted self-signed certificate or obtain a unique certificate that
is signed by a certificate authority (CA). You can use your own certificates or purchase certificates from a CA. Either certificate
must be installed and added to the key database on the IBM Spectrum Protect server, client, or storage agent. The certificate is
verified by the SSL client or server that requests or initiates the SSL communication. Some CA certificates are preinstalled in the
key databases, by default.

SSL is set up independently on the IBM Spectrum Protect server, client, and storage agent.

Authority levels

With each IBM Spectrum Protect server, different administrative authority levels are available that determine the tasks that an
administrator can complete.

After registration, an administrator must be granted authority by being assigned one or more administrative authority levels. An
administrator with system authority can complete any task with the server and assign authority levels to other administrators by
using the GRANT AUTHORITY command. Administrators with policy, storage, or operator authority can complete subsets of tasks.

An administrator can register other administrator IDs, grant levels of authority to them, rename IDs, remove IDs, and lock and
unlock them from the server.

An administrator can control access to specific client nodes for root user IDs and non-root user IDs. By default, a non-root user ID
cannot back up data on the node. Use the UPDATE NODE command to change the node settings to enable backup.

Passwords

By default, the server automatically uses password authentication. With password authentication, all users must enter a password
when they access the server.
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Use Lightweight Directory Access Protocol (LDAP) to apply stricter requirements for passwords. For more information, see
Managing passwords and logon procedures (V7.1.1).

Table 1. Password authentication characteristics

Characteristic More information
Case-sensitivity Not case-sensitive.
Default password expiration 90 days.

The expiration period begins when an administrator ID or client
node is first registered to the server. If the password is not
changed within this period, the password must be changed the
next time that the user accesses the server.

Invalid password attempts You can set a limit on consecutive invalid password attempts
for all client nodes. When the limit is exceeded, the server
locks the node.

Default password length 8 characters.

The administrator can specify a minimum length. Beginning
with Version 8.1.4, the default minimum length for server
passwords changed from O to 8 characters.

Session security

Session security is the level of security that is used for communication among IBM Spectrum Protect client nodes, administrative
clients, and servers and is set by using the SESSIONSECURITY parameter.

The SESSIONSECURITY parameter can be set to one of the following values:

e The STRICT value enforces the highest level of security for communication between IBM Spectrum Protect servers, nodes,
and administrators.

e The TRANSITIONAL value specifies that the existing communication protocol is used while you update your IBM Spectrum
Protect software to V8.1.2 or later. This is the default. When SESSIONSECURITY=TRANSITIONAL, stricter security settings
are automatically enforced as higher versions of the TLS protocol are used and as the software is updated to V8.1.2 or later.
After a node, administrator, or server meets the requirements for the STRICT value, session security is automatically
updated to the STRICT value, and the entity can no longer authenticate by using a previous version of the client or earlier
TLS protocols.

Note: You are not required to update backup-archive clients to V8.1.2 or later before you upgrade servers. After you
upgrade a server to V8.1.2 or later, nodes and administrators that are using earlier versions of the software will continue to
communicate with the server by using the TRANSITIONAL value until the entity meets the requirements for the STRICT
value. Similarly, you can upgrade backup-archive clients to V8.1.2 or later before you upgrade your IBM Spectrum Protect
servers, but you are not required to upgrade servers first. Communication between servers and clients is not interrupted.

For more information about the SESSIONSECURITY parameter values, see the following commands.
Table 2. Commands used to set the
SESSIONSECURITY parameter

Entity Command

Client nodes e REGISTER NODE
e UPDATE NODE

Administrators e REGISTER ADMIN
e UPDATE ADMIN

Servers e DEFINE SERVER
e UPDATE SERVER

Administrators that authenticate by using the DSMADMC command, DSMC command, or dsm program cannot authenticate by
using an earlier version after authenticating by using V8.1.2 or later. To resolve authentication issues for administrators, see the
following tips:

Tips:
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e Ensure that all IBM Spectrum Protect software that the administrator account uses to log on is upgraded to V8.1.2 or later.
If an administrator account logs on from multiple systems, ensure that the server's certificate is installed on each system.

e After an administrator authenticates to a V8.1.2 or later server by using a V8.1.2 or later client, the administrator can
authenticate only on clients or servers that are using V8.1.2 or later. An administrator command can be issued from any

system.

e If necessary, create a separate administrator account to use only with clients and servers that are using V8.1.1 or earlier

software.

Enforce the highest level of security for communication with the IBM Spectrum Protect server by ensuring that all nodes,
administrators, and servers use STRICT session security. You can use the SELECT command to determine which servers, nodes,
and administrators are using TRANSITIONAL session security and should be updated to use STRICT session security.

Related tasks:
* Securing communications

Managing administrators

An administrator who has system authority can complete any task with the IBM Spectrum Protect™ server, including assigning
authority levels to other administrators. To complete some tasks, you must be granted authority by being assigned one or more

authority levels.

Procedure

Complete the following tasks to modify administrator settings.

Task

Procedure

Add an administrator.

To add an administrator, ADMIN1, with system authority and
specify a password, complete the following steps:

a. Register the administrator and specify Pa$#$twO as the
password by issuing the following command:

register admin adminl Pa$#S$twO

b. Grant system authority to the administrator by issuing
the following command:

grant authority adminl classes=system

Change administrative authority.

Change the authority level for an administrator, ADMINZ.

e Grant system authority to the administrator by issuing
the following command:

grant authority adminl classes=system

¢ Revoke system authority for the administrator by issuing
the following command:

revoke authority adminl classes=system

Remove administrators.

Remove an administrator, ADMIN1, from accessing the IBM
Spectrum Protect server by issuing the following command:

remove admin adminl

Temporarily prevent access to the server.

Lock or unlock an administrator by using the LOCK ADMIN or
UNLOCK ADMIN command.

Changing password requirements

You can change the minimum password limit, password length, password expiration, and enable or disable authentication for IBM

Spectrum Protect™.
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About this task

By enforcing password authentication and managing password restrictions, you protect your data and your servers from potential
security risks.

Procedure

Complete the following tasks to change password requirements for IBM Spectrum Protect servers.
Table 1. Authentication tasks for IBM Spectrum Protect servers

Task Procedure
Set a limit for invalid password attempts. a. On the Servers page in the Operations Center, select the
server.

b. Click Details, and then click the Properties tab.
c. Set the number of invalid attempts in the Invalid sign-on
attempt limit field.

The default value at installation is O.

Set a minimum length for passwords. a. On the Servers page in the Operations Center, select the
server.

b. Click Details and then click the Properties tab.

c. Set the number of characters in the Minimum password
length field.

Set the expiration period for passwords. a. On the Servers page in the Operations Center, select the
server.

b. Click Details and then click the Properties tab.

c. Set the number of days in the Password common
expiration field.

Disable password authentication. By default, the server automatically uses password
authentication. With password authentication, all users must
enter a password to access the server.

You can disable password authentication only for passwords
that authenticate with the server (LOCAL). By disabling
password authentication, you increase the security risk for the
server.

Set a default authentication method. Issue the SET DEFAULTAUTHENTICATION command. For
example, to use the server as the default authentication
method, issue the following command:

set defaultauthentication local

To update one client node to authenticate with the server,
include AUTHENTICATION=LOCAL in the UPDATE NODE
command:

update node authentication=local

Related concepts:
[ Authenticating IBM Spectrum Protect users by using an LDAP server
* Managing passwords and logon procedures (V7.1.1)

Securing the server on the system

Protect the system where the IBM Spectrum Protect™ server runs to prevent unauthorized access.

Procedure
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Ensure that unauthorized users cannot access the directories for the server database and the server instance. Keep the access
settings for these directories that you configured during implementation.

e Restricting user access to the server
Authority levels determine what an administrator can do with the IBM Spectrum Protect server. An administrator with
system authority can complete any task with the server. Administrators with policy, storage, or operator authority can
complete subsets of tasks.

e Limiting access through port restrictions
Limit access to the server by applying port restrictions.

Restricting user access to the server

Authority levels determine what an administrator can do with the IBM Spectrum Protect™ server. An administrator with system
authority can complete any task with the server. Administrators with policy, storage, or operator authority can complete subsets of
tasks.

Procedure

1. After you register an administrator by using the REGISTER ADMIN command, use the GRANT AUTHORITY command to set
the administrator's authority level. For details about setting and changing authority, see Managing administrators.
2. To control the authority of an administrator to complete some tasks, use the following two server options:

a. You can select the authority level that an administrator must have to issue QUERY and SELECT commands with the
QUERYAUTH server option. By default, no authority level is required. You can change the requirement to one of the
authority levels, including system.

b. You can specify that system authority is required for commands that cause the server to write to an external file with
the REQSYSAUTHOUTFILE server option. By default, system authority is required for such commands.

3. You can restrict data backup on a client node to only root user IDs or authorized users. For example, to limit backups to the
root user ID, issue the REGISTER NODE or UPDATE NODE command and specify the BACKUPINITIATION=root parameter:

update node backupinitiation=root

Limiting access through port restrictions

Limit access to the server by applying port restrictions.

About this task

You might have to restrict access to specific servers, based on your security requirements. The IBM Spectrum Protect™ server can
be configured to listen on four TCP/IP ports: two that can be used for either regular TCP/IP protocols or Secure Sockets Layer
(SSL)/Transport Layer Security (TLS) protocols and two that can be used only for the SSL/TLS protocol.

Procedure

You can set the server options to specify the port that you require, as listed in Table 1.
Table 1. Server options and port access

Server option Port access

TCPPORT Specifies the port number on which the server TCP/IP communication driver is to wait for
requests for client sessions. This port listens for both TCP/IP and SSL-enabled sessions. The
default value is 1500.

TCPADMINPORT Specifies the port number on which the server TCP/IP communication driver is to wait for
requests for sessions other than client sessions. This port listens for both TCP/IP and SSL-
enabled sessions. The default is the value of TCPPORT.

Use this option to separate administrative client traffic from regular client traffic that uses the
TCPPORT and SSLTCPPORT options.

SSLTCPPORT Specifies the SSL TCP/IP port address for a server. This port listens for SSL-enabled sessions
only. A default port value is not available.
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Server option Port access

SSLTCPADMINPORT Specifies the port address on which the server TCP/IP communication driver waits for requests
for SSL-enabled sessions. A default port value is not available.

Use this option to separate administrative client traffic from regular client traffic that uses the
TCPPORT and SSLTCPPORT options.

Restrictions:
The following restrictions apply when you specify the SSL-only server ports (SSLTCPPORT and SSLTCPADMINPORT):

e When you specify the server's SSL-only port for the LLADDRESS on the DEFINE SERVER or UPDATE SERVER command, you
must also specify the SSL=YES parameter.

e When you specify the server's SSL-only port for the client's TCPPORT option, you must also specify YES for the SSL client
option.

Related reference:
Planning firewall access

Stopping and starting the server

Before you complete maintenance or reconfiguration tasks, stop the server. Then, start the server in maintenance mode. When
you are finished with the maintenance or reconfiguration tasks, restart the server in production mode.

Before you begin

You must have system or operator privilege to stop and start the IBM Spectrum Protect™ server.

e Stopping the server
Before you stop the server, prepare the system by ensuring that all database backup operations are completed, and all
other processes and sessions are ended. In this way, you can safely shut down the server and ensure that data is protected.
e Starting the server for maintenance or reconfiguration tasks
Before you begin server maintenance or reconfiguration tasks, start the server in maintenance mode. When you start the
server in maintenance mode, you disable operations that might disrupt your maintenance or reconfiguration tasks.

Stopping the server

Before you stop the server, prepare the system by ensuring that all database backup operations are completed, and all other
processes and sessions are ended. In this way, you can safely shut down the server and ensure that data is protected.

About this task

When you issue the HALT command to stop the server, the following actions occur:

e All processes and client node sessions are canceled.
o All current transactions are stopped. (The transactions will be rolled back when the server is restarted.)

Procedure

To prepare the system and stop the server, complete the following steps:

1. Prevent new client node sessions from starting by issuing the DISABLE SESSIONS command:

disable sessions all

2. Determine whether any client node sessions or processes are in progress by completing the following steps:

a. On the Overview page of the Operations Center, view the Activity area for the total numbers of processes and
sessions that are currently active. If numbers differ significantly from the usual numbers that are displayed during
your daily storage-management routine, view other status indicators in the Operations Center to check whether
there is a problem.

b. View the graph in the Activity area to compare the amount of network traffic over the following periods:

= The current period, that is, the most recent 24-hour period
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m The previous period, that is, the 24 hours before the current period
If the graph for the previous period represents the expected amount of traffic, significant differences on the graph for
the current period might indicate a problem.

c. On the Servers page, select a server for which you want to view processes and sessions, and click Details. If the
server is not registered as a hub or spoke server in the Operations Center, obtain information about processes by
using administrative commands. Issue the QUERY PROCESS command to query processes and obtain information
about sessions by issuing the QUERY SESSION command.

3. Wait until the client node sessions are completed or cancel them. To cancel processes and sessions, complete the following

steps:

o On the Servers page, select a server for which you want to view processes and sessions, and click Details.

o Click the Active Tasks tab, and select one or more processes, sessions, or a combination of both that you want to
cancel.

o Click Cancel.

o If the serveris not registered as a hub or spoke server in the Operations Center, cancel sessions by using
administrative commands. Issue the CANCEL SESSION command to cancel a session and cancel processes by using
the CANCEL PROCESS command.

Tip: If the process that you want to cancel is waiting for a tape volume to be mounted, the mount request is
canceled. For example, if you issue an EXPORT, IMPORT, or MOVE DATA command, the command might initiate a
process that requires a tape volume to be mounted. However, if a tape volume is being mounted by an automated
library, the cancel operation might not take effect until the mount process is complete. Depending on your system
environment, this could take several minutes.

4. Stop the server by issuing the HALT command:

halt

Starting the server for maintenance or reconfiguration tasks

Before you begin server maintenance or reconfiguration tasks, start the server in maintenance mode. When you start the server in
maintenance mode, you disable operations that might disrupt your maintenance or reconfiguration tasks.

About this task

Start the server in maintenance mode by running the DSMSERYV utility with the MAINTENANCE parameter.

The following operations are disabled in maintenance mode:

Administrative command schedules

Client schedules

Reclamation of storage space on the server
Inventory expiration

Migration of storage pools

In addition, clients are prevented from starting sessions with the server.

Tips:
® You do not have to edit the server options file, dsmserv.opt, to start the server in maintenance mode.
e While the server is running in maintenance mode, you can manually start the storage-space reclamation, inventory
expiration, and storage-pool migration processes.
Procedure

To start the server in maintenance mode, issue the following command:

dsmserv maintenance

Tip: To view a video about starting the server in maintenance mode, see Starting a server in maintenance mode.

What to do next

To resume server operations in production mode, complete the following steps:

1. Shut down the server by issuing the HALT command:
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halt

2. Start the server by using the method that you use in production mode. Follow the instructions for your operating system:
o IMMEMNStarting the server instance
o IMIITEMStarting the server instance
o I Mstarting the server instance

Operations that were disabled during maintenance mode are reenabled.

Planning to upgrade the server

When a fix pack or interim fix becomes available, you can upgrade the IBM Spectrum Protect™ server to take advantage of product
improvements. Servers and clients can be upgraded at different times. Ensure that you complete the planning steps before you
upgrade the server.

About this task

Follow these guidelines:

e The preferred method is to upgrade the server by using the installation wizard. After you start the wizard, in the IBM
Installation Manager window, click the Update icon; do not click the Install or Modify icon.

e If upgrades are available for both the server component and the Operations Center component, select the check boxes to
upgrade both components.

Procedure

1. Review the list of fix packs and interim fixes. See technote 1239415.

2. Review product improvements, which are described in readme files.
Tip: When you obtain the installation package file from the IBM Spectrum Protect support site, you can also access the
readme file.

3. Ensure that the version that you upgrade your server to is compatible with other components, such as storage agents and
library clients. See technote 1302789.

4. If your solution includes servers or clients at a level that is earlier than V7.1, review the guidelines to ensure that client
backup and archive operations are not disrupted. See technote 1053218.

5. Review the upgrade instructions. Ensure that you back up the server database, the device configuration information, and
the volume history file.

What to do next

To install a fix pack or interim fix, follow the instructions for your operating system:

o ITENInstalling an IBM Spectrum Protect server fix pack
o ITITEMInstalling an IBM Spectrum Protect server fix pack
o I MInstalling an IBM Spectrum Protect server fix pack

Related information:
* Upgrade and Migration Process - Frequently Asked Questions

Preparing for an outage or system update

Prepare IBM Spectrum Protect™ to maintain your system in a consistent state during a planned power outage or system update.

About this task

Ensure that you schedule activities regularly to manage, protect, and maintain the server.

Procedure

1. Cancel processes and sessions that are in progress by completing the following steps:
a. In the Operations Center, on the Servers page, select a server for which you want to view processes and sessions,
and click Details.
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b. Click the Active Tasks tab, and select one or more processes, sessions, or a combination of both that you want to

cancel.
c. Click Cancel.
2. Stop the server by issuing the HALT command:

halt

Tip: You can issue the halt command from the Operations Center by hovering over the Settings icon and clicking Command
Builder. Then, select the server, type halt, and press Enter.

Implementing a disaster recovery plan

Implement a disaster recovery strategy to recover your applications if a disaster occurs and to ensure high server availability.

About this task

Determine your disaster recovery requirements by identifying the business priorities for client node recovery, the systems that you
use to recover data, and whether client nodes have connectivity to a recovery server. Use replication and storage pool protection
to protect data. You must also determine how often directory-container storage pools are protected.

e Completing recovery drills

Schedule disaster recovery drills to prepare for audits that certify the recoverability of the IBM Spectrum Protect server and
to ensure that data can be restored and operations can resume after an outage. A drill also helps you ensure that all data
can be restored and operations resumed before a critical situation occurs.

Recovering from system outages

For IBM Spectrum Protect™ single-site disk solutions, you can recover the inventory locally only and restore the database to

protect your data.

Procedure

Use one of the following methods to recover inventory to a local site, based on the type of information that is backed up.
Restriction: Because single-site disk solutions do not have a second copy of the storage pool, you cannot restore storage pools. To
review the architecture of disk solutions, see Selecting an IBM Spectrum Protect solution for your environment.

Table 1. Scenarios for recovering from a disaster

Scenario

Procedure

Your system is inaccessible and you want to locally restore to
an earlier version by using system tools.

e Use IBM Spectrum Protect to back up the server to
another server.

e Use operating system tools to back up and restore your
system to an earlier version.

An outage or disaster occurs and you want to restore your data
from backed up versions of the data.

e To back up aclient, on the TSM Clients page of the
Operations Center, select the clients that you want to
back up, and click Back Up.

e On the TSM Servers page of the Operations Center,
select the server whose database you want to back up.
Click Back Up, and follow the instructions in the Back Up
Server Database window.

To restore a storage pool from a backed-up version of
the storage pool, you must restore the database. Issue
the DSMSERV RESTORE DB command to restore the
database and associated storage pools to a backed-up
version.

e Restoring the database

You might have to restore the IBM Spectrum Protect database after a disaster. You can restore the database to the most
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current state or to a specified point in time. You must have full, incremental, or snapshot database backup volumes to
restore the database.

Related reference:
[ AUDIT CONTAINER (Verify the consistency of database information for a directory-container storage pool)
* DSMSERV RESTORE DB (Restore the database)

Multisite disk solution

This data protection solution provides replication at multiple sites so that each server protects data for the other site.

e Planning for a multisite disk data protection solution
Plan for a multisite disk data protection solution with servers at two sites that use data deduplication and replication.

e Multisite disk implementation of a data protection solution
The multisite disk solution is configured at two sites and uses data deduplication and replication.

e Monitoring a multisite disk solution
After you implement a multisite disk solution with IBM Spectrum Protect, monitor the solution to ensure correct operation.
By monitoring the solution daily and periodically, you can identify existing and potential issues. The information that you
gather can be used to troubleshoot problems and optimize system performance.

e Managing operations for a multisite disk solution
Use this information to manage operations for a multisite disk solution with IBM Spectrum Protect that includes a server
and uses data deduplication for multiple locations.

Planning for a multisite disk data protection solution

Plan for a multisite disk data protection solution with servers at two sites that use data deduplication and replication.

Implementation methods

You can configure servers for a multisite disk solution in the following ways:

Configure servers by using the Operations Center and administrative commands
You can configure a range of storage systems and the server software for your solution. Configuration tasks are completed
by using wizards and options in the Operations Center and IBM Spectrum Protect™ commands. For information about
getting started, see the Planning roadmap.

Configure the servers by using automated scripts
For detailed guidance on configuration with specific IBM® Storwize® storage systems, and by using automated scripts to
configure each server, see the IBM Spectrum Protect blueprints. The documentation and scripts are available on IBM
developerWorks® at IBM Spectrum Protect Blueprints.

The blueprint documentation does not include steps for installing and configuring the Operations Center, or setting up
secure communications by using Transport Security Layer (TLS). Replication is configured by using commands after each
server is set up. An option for using Elastic Storage Server, based on IBM Spectrum Scale™ technology, is included.

Planning roadmap

Plan for a multisite disk solution by reviewing the architecture layout in the following figure and then completing the roadmap
tasks that follow the diagram.
Figure 1. Multisite disk solution
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The following steps are required to plan properly for a multisite disk environment.

. Select your system size.
. Plan for the sites.
. Meet system requirements for hardware and software.
. Record values for your system configuration in the planning worksheets.
. Plan for storage.
. Plan for security.
a. Plan for administrator roles.
b. Plan for secure communications.
c. Plan for storage of encrypted data.
d. Plan for firewall access.

o0k WDN P

Selecting a system size

Select the size of the IBM Spectrum Protect™ server based on the amount of data that you manage and the systems to be
protected.

About this task

You can use the information in the table to determine the size of the server that is required, based on the amount of data that you
manage.

The following table describes the volume of data that a server manages. This amount includes all versions. The daily amount of
data is how much new data you back up each day. Both the total managed data and daily amount of new data are measured as the
size before any data reduction.

Table 1. Determining the size of the server

Total managed data Daily amount of new data to back up | Required server size
60TB-240TB Up to 10 TB per day Small

196 TB-784TB 10 - 20 TB per day Medium

1000 TB - 4000 TB 20 - 100 TB per day Large
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The daily backup values in the table are based on test results with 128 MB sized objects, which are used by IBM Spectrum Protect
for Virtual Environments. Workloads that consist of objects that are smaller than 128 KB might not be able to achieve these daily
limits.

Planning the sites

Review use cases and evaluate the factors to provide the most efficient data protection for the multisite disk solution for IBM
Spectrum Protect™.

Use cases

The multisite disk solution creates at least one copy of backed-up data. If the IBM Spectrum Protect servers are at separate
locations, the backed-up replica is maintained offsite.

Tip: Avoid conflicts in managing administrative IDs and client option sets by identifying the IDs and option sets that will be
replicated to the target server and the IDs and option sets that will be managed in an enterprise configuration. You cannot define
an administrative user ID for a registered node if an administrative ID exists for the same node.

Although your company might benefit from a multisite disk solution for various reasons, the most common reasons to use a
multisite disk solution include the following replication scenarios:

Replication from the primary site to the disaster recovery site

In this scenario, data that is backed up from the primary site, Site A, is replicated to a server at the secondary, disaster
recovery site, Site B. If a disaster occurs at Site A, such as failure of the server, you can use the server at Site B to recover
systems. Alternatively, you can use the server at Site A to restore primary storage pool data at Site B, such as after a disk
storage failure at Site B.

Mutual replication at two active sites

In this scenario, local data at each site is backed up by the servers at both Site A and Site B. Data that is backed up from
Site A is replicated to Site B, and backed-up data from Site B is replicated to Site A. If data that was backed up is lost at Site
A, you can use the server at Site B to recover storage pool data to the server at Site A. If Site A is no longer available, you
can recover the replicated data for Site A to a new system at Site B. You must size the server resources to ensure that either
server has sufficient capacity to back up and restore all client nodes as part of your disaster recovery plan.

Protect remote servers to the primary site

In this scenario, you configure remote servers that are relatively small to replicate data that is backed up to a larger server
at the primary site. If bandwidth is limited, it might not be practical to restore systems to the remote sites. In this case, you
might want to recover systems at the primary site before you replicate the backed-up data to the remote servers.

Factors to evaluate

Before you implement a multisite disk solution, evaluate the following factors:

Network bandwidth

The network must have sufficient bandwidth for the expected data transfers between nodes, for replication, and for the
cross-site restore operations that are required for disaster recovery. Before you proceed with testing replication
throughput, ensure that your network can handle the replication traffic. Calculate the required network bandwidth for the
steady-state requirement by applying the guidelines in Estimating network bandwidth required for replication (V7.1.1).

The network connection is often a shared resource. Plan the time of day to schedule node replication to run to avoid a
conflict with other resource users. Also, network controls might limit activity to only a portion of the bandwidth. There are
no controls in IBM Spectrum Protect to restrict network usage.

Resources for the initial replication

To set up the data protection solution across two sites, you must replicate data initially from Site A to the target server at
Site B. To ensure that the initial replication is successful, you must determine whether you have the network bandwidth,
processor resources, and time available to replicate the data. You might have to plan for replicating the initial full backups
across several days. If you cannot extend the schedule for the initial backups, you can replicate data from Site A to Site B
without using the network. For example, you can export and import the backed-up data by using media or you can
temporarily locate the source and target servers on the same site.
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Daily data ingestion

For the multisite disk solution, the daily data ingestion and total data retention must be within the capacity of the
configurations. For example, a large configuration has a data ingestion capacity of up to 100 TB per day, including node
replication. In cases where the backup requirements exceed the capacity of a single server, you can configure a solution
that uses multiple servers to achieve the required capacity.

Server configuration
The server configuration must meet or exceed the requirements for the multisite disk solution.
Single replica of backed-up data

The multisite disk solution is most efficient when a single, offsite copy of the backed-up data meets your data protection
and risk mitigation requirements. In this case, the single copy of the data is maintained off-site at the location of a
replication server.

Related reference:
System requirements for a multisite disk solution

System requirements for a multisite disk solution

After you select the IBM Spectrum Protect™ solution that best fits your data protection requirements, review the system
requirements to plan for implementation of the data protection solution.

Ensure that your system meets the hardware and software prerequisites for the size of server that you plan to use.

e Hardware requirements
Hardware requirements for your IBM Spectrum Protect solution are based on system size. Choose equivalent or better
components than those items that are listed to ensure optimum performance for your environment.

e Software requirements
Documentation for the IBM Spectrum Protect multisite disk solution includes installation and configuration tasks for the
following operating systems. You must meet the minimum software requirements that are listed.

Related information:
= 1BM Spectrum Protect Supported Operating Systems

Hardware requirements

Hardware requirements for your IBM Spectrum Protect™ solution are based on system size. Choose equivalent or better
components than those items that are listed to ensure optimum performance for your environment.

For a definition of system sizes, see t_msdisk_select_size.html.

The following table includes minimum hardware requirements for the server and storage, based on the size of the server that you
plan to build. If you are using local partitions (LPARs) or work partitions (WPARs), adjust the network requirements to take
account of the partition sizes.

Use the information in the following table as a starting point. For the most up-to-date information about hardware requirements
and specifications for the server and storage, see the IBM Spectrum Protect Blueprints.

Hardware component Small system Medium system Large system

Server processor BTN 6 processor cores, | IMZNIM0 processor cores, | IMIIMM20 processor cores,
3.42 GHz or faster 3.42 GHz or faster 3.42 GHz
| Linux | Windows ¢ [ Linux | Windows JoJy) | Linux | Windows Vil
processor cores, 1.7 GHz or processor cores, 2.2 GHz or processor cores, 2.2 GHz or
faster faster faster

Server memory 64 GB RAM 128 GB RAM 256 GB RAM
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Hardware component

Small system

Medium system

Large system

the database, plus
space for Operations
Center records

e 67 TB deduplicated
directory-container

the database, plus
space for Operations
Center records

e 207.9 TB deduplicated
directory-container

Network e 10 GB Ethernet (1 port) e 10 GB Ethernet (2 e 10 GB Ethernet (4
e 8 GB Fibre Channel ports) ports)
adapter (2 ports) e 8 GB Fibre Channel 8 GB Fibre Channel
adapter (2 ports) adapter (4 ports)
Storage e 1.45TB SSD disks for e 2.53 TB SSD disks for 6.54 TB SSD disks for

the database, plus
space for Operations
Center records
1049.67 TB
deduplicated directory-

storage pool storage pool container storage pool

Implementing the correct processor core technology

You must use the correct type of processor core technology for the server processor. For information about the type of processor
core technology, see the IBM Spectrum Protect Blueprints.

Estimating database space requirements for the Operations Center

Hardware requirements for the Operations Center are included in the preceding table, except for the database and archive log
space (inventory) that the Operations Center uses to hold records for managed clients.

If you do not plan to install the Operations Center on the same system as the server, you can estimate system requirements
separately. To calculate system requirements for the Operations Center, see the system requirements calculator in technote
1641684.

Managing the Operations Center on the server is a workload that requires extra space for database operations. The amount of
space depends on the number of clients that are monitored on a server. Review the following guidelines to estimate how much
space your server requires.

Database space
The Operations Center uses approximately 1.2 GB of database space for every 1000 clients that are monitored on a server.
For example, consider a hub server with 2000 clients that also manages three spoke servers, each with 1500 clients. This
configuration has a total of 6500 clients across the four servers and requires approximately 8.4 GB of database space. This
value is calculated by rounding the 6500 clients up to the next closest 1000, which is 7000:

7 x 1.2 GB=8.4 GB

Archive log space
The Operations Center uses approximately 8 GB of archive log space every 24 hours, for every 1000 clients. In the example
of 6500 clients across the hub server and the spoke servers, 56 GB of archive log space is used over a 24-hour period for
the hub server.
For each spoke server in the example, the archive log space that is used over 24 hours is approximately 16 GB. These
estimates are based on the default status collection interval of 5 minutes. If you reduce the collection interval from once
every 5 minutes to once every 3 minutes, the space requirements increase. The following examples show the approximate
increase in the log space requirement with a collection interval of once every 3 minutes:

e Hub server: 56 GB to approximately 94 GB
e Each spoke server: 16 GB to approximately 28 GB

Increase the archive log space so that you have sufficient space available to support the Operations Center, without
affecting the existing server operations.

Hardware requirements for the second server

If you are planning to set up your sites so that everything at the first site is replicated to the second site, hardware requirements
are identical at both sites. If you want to only replicate a subset of data to your second site, storage and network requirements
might be reduced.
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Software requirements

Documentation for the IBM Spectrum Protect™ multisite disk solution includes installation and configuration tasks for the
following operating systems. You must meet the minimum software requirements that are listed.

For information about software requirements for IBM® lin_tape device drivers, refer to the IBM Tape Device Drivers Installation
and User's Guide.

AIX systems

Type of software Minimum software requirements

Operating system IBM AIX® 7.1

For more information about operating system requirements, see AIX: Minimum system
requirements for AIX systems.

Gunzip utility The gunzip utility must be available on your system before you install or upgrade the IBM
Spectrum Protect server. Ensure that the gunzip utility is installed and the path to it is set in
the PATH environment variable.

File system type JFS2 file systems

AIX systems can cache a large amount of file system data, which can reduce memory that is
required for server and IBM DB2® processes. To avoid paging with the AIX server, use the
rbrw mount option for the JFS2 file system. Less memory is used for the file system cache
and more is available for IBM Spectrum Protect.

Do not use the file system mount options, Concurrent I/O (CIO), and Direct I/O (DIO), for file
systems that contain the IBM Spectrum Protect database, logs, or storage pool volumes.
These options can cause performance degradation of many server operations. IBM Spectrum
Protect and DB2 can still use DIO where it is beneficial to do so, but IBM Spectrum Protect
does not require the mount options to selectively take advantage of these techniques.

Other software Korn Shell (ksh)

Linux systems

Type of software Minimum software requirements

Operating system Red Hat Enterprise Linux 7 (x86_64)

Libraries GNU C libraries, Version 2.3.3-98.38 or later that is installed on the IBM Spectrum Protect
system.

Red Hat Enterprise Linux Servers:

e libaio
e libstdc++.50.6 (32-bit and 64-bit packages are required)
e numactl.x86_64

File system type Format database-related file systems with ext3 or ext4.

For storage pool-related file systems, use XFS.

Other software Korn Shell (ksh)

Windows systems

Type of software Minimum software requirements
Operating system Microsoft Windows Server 2012 R2 (64-bit) or Windows Server 2016
File system type NTFS
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Type of software

Minimum software requirements

Other software

account

Windows 2012 R2 or Windows 2016 with .NET Framework 3.5 is installed and enabled.

The following User Account Control policies must be disabled:

e User Account Control: Admin Approval Mode for the Built-in Administrator

e User Account Control: Run all administrators in Admin Approval Mode

Related tasks:

[ Setting AIX network options

Planning worksheets

Use the planning worksheets to record values that you use to set up your system and configure the IBM Spectrum Protect™ server.

Use the best practice default values that are listed in the worksheets.

Each worksheet helps you prepare for different parts of the system configuration by using best practice values:

Server system preconfiguration
Use the preconfiguration worksheets to plan for the file systems and directories that you create when you configure file
systems for IBM Spectrum Protect during system setup. All directories that you create for the server must be empty.

Server configuration

Use the configuration worksheets when you configure the server. Default values are suggested for most items, except

where noted.

AIX®
Table 1. Worksheet for preconfiguration of an AIX server system
Item Default value Your value Minimum directory size | Notes
TCP/IP port address | 1500 Not applicable Ensure that this port

for communications
with the server

is available when you
install and configure
the operating system

The port number can
be a number in the
range 1024 - 32767.

Directory for the
server instance

/home/tsminstl/tsminstl

50GB

If you change the
value for the server
instance directory
from the default, also
modify the DB2®
instance owner value
in Table 2.

installation

Directory for server |/ Available space that is

installation required for the directory:
5GB

Directory for server | /usr Available space that is

installation required for the directory:
5GB

Directory for server | /var Available space that is

required for the directory:

5GB
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Item Default value Your value Minimum directory size | Notes
Directory for server |/tmp Available space that is
installation required for the directory:
5GB
Directory for server | /opt Available space that is

installation

required for the directory:
10 GB

Directory for the
active log

/tsminst1/TSMalog

e Small and medium:
140 GB
e large: 300 GB

When you create the
active log during the
initial configuration of
the server, set the
size to 128 GB.

Directory for the
archive log

/tsminst1/TSMarchlog

e Small: 1 TB
e Medium:2TB
e large:4TB

Directories for the
database

/tsminst1/TSMdbspace00
/tsminst1/TSMdbspace01l
/tsminst1/TSMdbspace02
/tsminst1/TSMdbspace03

Minimum total space for
all directories:

e Small: At least 1 TB

e Medium: At least 2
B

e large: Atleast4TB

Create a minimum
number of file
systems for the
database, depending
on the size of your
system:

e Small: At least
4 file systems

e Medium: At
least 4 file
systems

e large: At least
8 file systems

Directories for
storage

/tsminst1/TSMfile00
/tsminst1/TSMfile01
/tsminst1/TSMfile02
/tsminst1/TSMfile03

Minimum total space for
all directories:

e Small: At least 38
TB

e Medium: At least
180 TB

e large: At least 500
TB

Create a minimum
number of file
systems for storage,
depending on the size
of your system:

e Small: At least
10 file systems

e Medium: At
least 20 file
systems

e large: At least
40 file systems
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Item

Default value

Your value

Minimum directory size

Notes

Directories for
database backup

/tsminst1/TSMbkup00
/tsminst1/TSMbkup01
/tsminst1/TSMbkup02
/tsminst1/TSMbkup03

Minimum total space for
all directories:

e Small: At least 3 TB

e Medium: At least 10
TB

e Large: At least 16
TB

Create a minimum
number of file
systems for backing
up the database,
depending on the size
of your system:

e Small: At least

2 file systems

e Medium: At
least 4 file
systems

e large: At least
4 file systems,
but preferably
6

The first database
backup directory is
also used for the
archive log failover
directory and a
second copy of the
volume history and
device configuration
files.

Table 2. Worksheet for IBM Spectrum Protect configuration

DB2 instance owner

Item Default value Your value Notes

DB2 instance owner tsminstl If you changed the value for
the server instance directory in
Table 1 from the default, also
modify the value for the DB2
instance owner.

DB2 instance owner passwOrd Select a different value for the

password instance owner password than
the default. Ensure that you
record this value in a secure
location.

Primary group for the [tsmsrvrs

Server name

The default value for the server
name is the system host name.

password

Server password passwOrd Select a different value for the
server password than the
default. Ensure that you record
this value in a secure location.

Administrator ID: user [admin

ID for the server

instance

Administrator ID passwOrd Select a different value for the

administrator password than
the default. Ensure that you

record this value in a secure
location.
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Item Default value Your value Notes

Schedule start time 22:00 The default schedule start
time begins the client
workload phase, which is
predominantly the client
backup and archive activities.
During the client workload
phase, server resources
support client operations.
Normally, these operations are
completed during the nightly
schedule window.

Schedules for server
maintenance operations are
defined to begin 10 hours after
the start of the client backup
window.

Linux
Table 3. Worksheet for preconfiguration of a Linux server system

Item Default value Your value Minimum directory size | Notes

TCP/IP port address | 1500 Not applicable Ensure that this port

for communications is available when you

with the server install and configure
the operating system
The port number can
be a number in the
range 1024 - 32767.

Directory for the /home/tsminstl/tsminstl 25GB If you change the

server instance value for the server
instance directory
from the default, also
modify the DB2
instance owner value
in Table 4.

Directory for the /tsminst1/TSMalog e Small and medium:

active log 140 GB

e large: 300 GB
Directory for the /tsminst1/TSMarchlog e Small: 1 TB
archive log ¢ Medium: 2 TB
e large:4TB
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Item

Default value

Your value

Minimum directory size

Notes

Directories for the
database

/tsminst1/TSMdbspace00
/tsminst1/TSMdbspace01
/tsminst1/TSMdbspace02
/tsminst1/TSMdbspace03

Minimum total space for
all directories:

e Small: At least 1 TB

e Medium: At least 2
B

e large: Atleast4TB

Create a minimum
number of file
systems for the
database, depending
on the size of your
system:

e Small: At least
4 file systems

e Medium: At
least 4 file
systems

e large: At least
8 file systems

Directories for
storage

/tsminst1/TSMfile00
/tsminst1/TSMfile01
/tsminst1/TSMfile02
/tsminst1/TSMfile03

Minimum total space for
all directories:

e Small: At least 38
TB

e Medium: At least
180 TB

e large: At least 500
TB

Create a minimum
number of file
systems for storage,
depending on the size
of your system:

e Small: At least
10 file systems

e Medium: At
least 20 file
systems

e large: At least
40 file systems

Directories for
database backup

/tsminst1/TSMbkup00
/tsminst1/TSMbkup01
/tsminst1/TSMbkup02
/tsminst1/TSMbkup03

Minimum total space for
all directories:

e Small: At least 3 TB

e Medium: At least 10
TB

e Large: At least 16
TB

Create a minimum
number of file
systems for backing
up the database,
depending on the size
of your system:

e Small: At least
2 file systems

e Medium: At
least 4 file
systems

e large: At least
4 file systems,
but preferably
6

The first database
backup directory is
also used for the
archive log failover
directory and a
second copy of the
volume history and
device configuration
files.

Table 4. Worksheet for IBM Spectrum Protect configuration

Item

Default value

Your value

Notes
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DB2 instance owner

Item Default value Your value Notes

DB2 instance owner tsminstl If you changed the value for
the server instance directory in
Table 3 from the default, also
modify the value for the DB2
instance owner.

DB2 instance owner passwOrd Select a different value for the

password instance owner password than
the default. Ensure that you
record this value in a secure
location.

Primary group for the [tsmsrvrs

Server name

The default value for the server
name is the system host name.

Server password passwOrd Select a different value for the
server password than the
default. Ensure that you record
this value in a secure location.

Administrator ID: user |admin

ID for the server

instance

Administrator ID passwOrd Select a different value for the

password administrator password than
the default. Ensure that you
record this value in a secure
location.

Schedule start time 22:00 The default schedule start

time begins the client
workload phase, which is
predominantly the client
backup and archive activities.
During the client workload
phase, server resources
support client operations.
Normally, these operations are
completed during the nightly
schedule window.

Schedules for server
maintenance operations are
defined to begin 10 hours after
the start of the client backup
window.

Windows

Because many volumes are created for the server, configure the server by using the Windows feature of mapping disk volumes to
directories rather than to drive letters.

For example, C:\tsminst1\TSMdbpsace00 is a mount point to a volume with its own space. The volume is mapped to a directory
under the C: drive, but does not take up space from the C: drive. The exception is the server instance directory, C:\tsminstl1, which
can be a mount point or a regular directory.

Table 5. Worksheet for preconfiguration of a Windows server system

Item Default value Your value Notes

Minimum directory size
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server instance

Item Default value Your value Minimum directory size | Notes

TCP/IP port address | 1500 Not applicable Ensure that this port

for communications is available when you

with the server install and configure
the operating system
The port number can
be a number in the
range 1024 - 32767.

Directory for the C:\tsminstl 25GB If you change the

value for the server
instance directory
from the default, also
modify the DB2
instance owner value
in Table 6.

Directory for the
active log

C:\tsminst1\TSMalog

e Small and medium:
140 GB
e large: 300 GB

Directory for the
archive log

C:\tsminst1\TSMarchlog

e Small: 1 TB
e Medium:2TB
e large:4TB

Directories for the
database

C:\tsminst1\TSMdbspace00
C:\tsminst1\TSMdbspace0l
C:\tsminst1\TSMdbspace02
C:\tsminst1\TSMdbspace03

Minimum total space for
all directories:

e Small: At least 1 TB

e Medium: At least 2
TB

e Large: Atleast4TB

Create a minimum
number of file
systems for the
database, depending
on the size of your
system:

e Small: At least
4 file systems

e Medium: At
least 4 file
systems

e large: At least
8 file systems

Directories for
storage

C:\tsminst1\TSMfile00
C:\tsminst1\TSMfileO1
C:\tsminst1\TSMfile02
C:\tsminst1\TSMfile03

Minimum total space for
all directories:

e Small: At least 38
TB

e Medium: At least
180 TB

e Large: At least 500
TB

Create a minimum
number of file
systems for storage,
depending on the size
of your system:

e Small: At least
10 file systems

e Medium: At
least 20 file
systems

e large: At least
40 file systems
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Item

Default value

Your value

Minimum directory size

Notes

Directories for
database backup

C:\tsminst1\TSMbkup00
C:\tsminst1\TSMbkup01
C:\tsminst1\TSMbkup02
C:\tsminst1\TSMbkup03

Minimum total space for
all directories:

Small: At least 3 TB
Medium: At least 10
B

Large: At least 16
B

Create a minimum
number of file
systems for backing
up the database,
depending on the size
of your system:

e Small: At least
2 file systems

e Medium: At
least 4 file
systems

e large: At least
4 file systems,
but preferably
6

The first database
backup directory is
also used for the
archive log failover
directory and a
second copy of the
volume history and
device configuration
files.

Table 6. Worksheet for IBM Spectrum Protect configuration

Item

Default value

Your value

Notes

DB2 instance owner

tsminstl

If you changed the value for
the server instance directory in
Table 5 from the default, also
modify the value for the DB2
instance owner.

DB2 instance owner
password

pAssWOrd

Select a different value for the
instance owner password than
the default. Ensure that you
record this value in a secure
location.

Server name

The default value for the server
name is the system host name.

Server password passwOrd Select a different value for the
server password than the
default. Ensure that you record
this value in a secure location.

Administrator ID: user [admin

ID for the server

instance

Administrator ID passwOrd Select a different value for the

password

administrator password than
the default. Ensure that you

record this value in a secure
location.
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Item Default value Your value Notes

Schedule start time 22:00 The default schedule start
time begins the client
workload phase, which is
predominantly the client
backup and archive activities.
During the client workload
phase, server resources
support client operations.
Normally, these operations are
completed during the nightly
schedule window.

Schedules for server
maintenance operations are
defined to begin 10 hours after
the start of the client backup
window.

Planning for storage

Choose the most effective storage technology for IBM Spectrum Protect™ components to ensure efficient server performance and
operations.

Storage hardware devices have different capacity and performance characteristics, which determine how they can be used
effectively with IBM Spectrum Protect. For general guidance on selecting the appropriate storage hardware and set up for your
solution, review the following guidelines.

Database and active log

e Use a fast disk for the IBM Spectrum Protect database and active log, for example with the following characteristics:
o High performance, 15k rpm disk with Fibre Channel or serial-attached SCSI (SAS) interface
o Solid-state disk (SSD)

e Isolate the active log from the database unless you use SSD or flash hardware

e When you create arrays for the database, use RAID level 5

Storage pool

e You can use less expensive and slower disks for the storage pool
e The storage pool can share disks for the archive log and database backup storage
e Use RAID level 6 for storage pool arrays to add protection against double drive failures when you use large disk types

e Planning the storage arrays
Prepare for disk storage configuration by planning for RAID arrays and volumes, according to the size of your IBM Spectrum
Protect system.

Related reference:
[ Storage system requirements and reducing the risk of data corruption

Planning for security

Plan to protect the security of systems in the IBM Spectrum Protect™ solution with access and authentication controls, and
consider encrypting data and password transmission.

For guidelines about protecting your storage environment against ransomware attacks, and recovering your storage environment if
an attack occurs, see Protecting the storage environment against ransomware.

e Planning for administrator roles

Define the authority levels that you want to assign to administrators who have access to the IBM Spectrum Protect solution.
e Planning for secure communications

Plan for protecting communications among the IBM Spectrum Protect solution components.
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e Planning for storage of encrypted data

Determine whether your company requires stored data to be encrypted, and choose the option that best suits your needs.
e Planning firewall access

Determine the firewalls that are set and the ports that must be open for the IBM Spectrum Protect solution to work.

Planning for administrator roles

Define the authority levels that you want to assign to administrators who have access to the IBM Spectrum Protect™ solution.
You can assign one of the following levels of authority to administrators:

System
Administrators with system authority have the highest level of authority. Administrators with this level of authority can
complete any task. They can manage all policy domains and storage pools, and grant authority to other administrators.
Policy
Administrators who have policy authority can manage all of the tasks that are related to policy management. This privilege
can be unrestricted, or can be restricted to specific policy domains.
Storage
Administrators who have storage authority can allocate and control storage resources for the server.
Operator
Administrators who have operator authority can control the immediate operation of the server and the availability of
storage media such as tape libraries and drives.

The scenarios in Table 1 provide examples about why you might want to assign varying levels of authority so that administrators
can perform tasks:
Table 1. Scenarios for administrator roles

Scenario Type of administrator ID to set up

An administrator at a small company manages the server and is e System authority: 1 administrator ID
responsible for all server activities.

An administrator for multiple servers also manages the overall e System authority on all servers: 1 administrator ID for
system. Several other administrators manage their own storage the overall system administrator
pools. e Storage authority for designated storage pools: 1

administrator ID for each of the other administrators

An administrator manages 2 servers. Another person helps e System authority on both servers: 2 administrator IDs
with the administration tasks. Two assistants are responsible e Operator authority: 2 administrator IDs for the

for helping to ensure that important systems are backed up. assistants with access to the server that each person is
Each assistant is responsible for monitoring the scheduled responsible for

backups on one of the IBM Spectrum Protect servers.

Planning for secure communications

Plan for protecting communications among the IBM Spectrum Protect™ solution components.

Determine the level of protection that is required for your data, based on regulations and business requirements under which your
company operates.

If your business requires a high level of security for passwords and data transmission, plan on implementing secure
communication with Transport Layer Security (TLS) or Secure Sockets Layer (SSL) protocols.

TLS and SSL provide secure communications between the server and client, but can affect system performance. To improve
system performance, use TLS for authentication without encrypting object data. To specify whether the server uses TLS 1.2 for the
entire session or only for authentication, see the SSL client option for client-to-server communication, and the UPDATE
SERVER=SSL parameter for server-to-server communication. Beginning in V8.1.2, TLS is used for authentication by default. If you
decide to use TLS to encrypt entire sessions, use the protocol only for sessions where it is necessary and add processor resources
on the server to manage the increase in network traffic. You can also try other options. For example, some networking devices
such as routers and switches provide the TLS or SSL function.

You can use TLS and SSL to protect some or all of the different possible communication paths, for example:
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e Operations Center: browser to hub; hub to spoke
e Client to server
e Server to server: node replication

Related tasks:
* Securing communications

Planning for storage of encrypted data

Determine whether your company requires stored data to be encrypted, and choose the option that best suits your needs.

If your company requires the data in storage pools to be encrypted, then you have the option of using IBM Spectrum Protect™
encryption, or an external device such as tape for encryption.

If you choose IBM Spectrum Protect to encrypt the data, extra computing resources are required at the client that might affect the
performance of backup and restore processes.

Related information:
* technote 1963635

Planning firewall access

Determine the firewalls that are set and the ports that must be open for the IBM Spectrum Protect™ solution to work.
Table 1 describes the ports that are used by the server, client, and Operations Center.

Table 1. Ports that are used by the server, client, and Operations Center

Item Default Direction Description
Base port 1500 Outbound/inbound | Each server instance requires a unique port. You can specify an
(TCPPORT) alternative port number instead of using the default. The

TCPPORT option listens for both TCP/IP and SSL-enabled
sessions from the client. For administrative client traffic, you can
use the TCPADMINPORT and ADMINONCLIENTPORT options to
set port values.

SSL-only port No default Outbound/inbound | This port is used if you want to restrict communication on the port
(SSLTCPPORT) to SSL-enabled sessions only. To support both SSL and non-SSL
communications, use the TCPPORT or TCPADMINPORT options.

SMB 45 Inbound/outbound | This port is used by configuration wizards that communicate by
using native protocols with multiple hosts.

SSH 22 Inbound/outbound | This port is used by configuration wizards that communicate by
using native protocols with multiple hosts.

SMTP 25 Outbound This port is used to send email alerts from the server.

NDMP No default Inbound/outbound | The server must be able to open an outbound NDMP control port
connection to the NAS device. The outbound control port is the
Low-Level Address in the data mover definition for the NAS
device.

During an NDMP filer-to-server restore, the server must be able to
open an outbound NDMP data connection to the NAS device. The
data connection port that is used during a restore can be
configured on the NAS device.

During NDMP filer-to-server backups, the NAS device must be
able to open outbound data connections to the server and the
server must be able to accept inbound NDMP data connections.
You can use the server option NDMPPORTRANGE to restrict the
set of ports available for use as NDMP data connections. You can
configure a firewall for connections to these ports.
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Item Default Direction Description

Replication No default Outbound/inbound | The port and protocol for the outbound port for replication are set
by the DEFINE SERVER command that is used to set up
replication.

The inbound ports for replication are the TCP ports and SSL ports
that the source server names in the DEFINE SERVER command.

Client schedule Client port: 1501 | Outbound The client listens on the port that is named and communicates
port the port number to the server. The server contacts the client if
server prompted scheduling is used. You can specify an
alternative port number in the client options file.

Long running KEEPALIVE Outbound When the KEEPALIVE option is enabled, keepalive packets are
sessions setting: YES sent during client-server sessions to prevent the firewall software
from closing long-running, inactive connections.

Operations Center |HTTPS: 11090 Inbound These ports are used for the Operations Center web browser. You
can specify an alternative port number.

Client Client port: 9028 | Inbound The client management service port must be accessible from the
management Operations Center. Ensure that firewalls cannot prevent
service port connections. The client management service uses the TCP port of

the server for the client node for authentication by using an
administrative session.

Multisite disk implementation of a data protection solution

The multisite disk solution is configured at two sites and uses data deduplication and replication.

Implementation roadmap

The following steps are required to set up a multisite disk environment.

1. Set up the system.
a. Configure the storage hardware and set up storage arrays for your environment size.
b. Install the server operating system.
c. Configure multipath I/0.
d. Create the user ID for the server instance.
e. Prepare file systems for IBM Spectrum Protect.
2. Install the server and Operations Center.
3. Configure the server and Operations Center.
a. Complete the initial configuration of the server.
b. Set server options.
. Configure Secure Sockets Layer for the server and client.
. Configure the Operations Center.
. Register your IBM Spectrum Protect license.
. Configure data deduplication.
. Define data retention rules for your business.
. Define server maintenance schedules.
. Define client schedules.
4. Install and configure clients.
a. Register and assign clients to schedules.
Tip: Avoid conflicts in managing administrative IDs and client option sets by identifying the IDs and option sets that
will be replicated to the target server and the IDs and option sets that will be managed in an enterprise
configuration. You cannot define an administrative user ID for a registered node if an administrative ID exists for the
same node.
b. Install and verify the client management service.
c. Configure the Operations Center to use the client management service.
5. Configure the second server.
a. Confgure for SSL communication between the hub and spoke server.
b. Add the second server as a spoke.

— 0@ O OO0
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c. Enable replication.
6. Complete the implementation.

Setting up the system

To set up the system, you must first configure your disk storage hardware and the server system for IBM Spectrum Protect™.

e Configuring the storage hardware
To configure your storage hardware, review general guidance for disk systems and IBM Spectrum Protect.

e Installing the server operating system
Install the operating system on the server system and ensure that IBM Spectrum Protect server requirements are met.
Adjust operating system settings as directed.

e Configuring multipath I/O
You can enable and configure multipathing for disk storage. Use the documentation that is provided with your hardware for
detailed instructions.

e Creating the user ID for the server
Create the user ID that owns the IBM Spectrum Protect server instance. You specify this user ID when you create the server
instance during initial configuration of the server.

e Preparing file systems for the server
You must complete file system configuration for the disk storage to be used by the server.

Configuring the storage hardware

To configure your storage hardware, review general guidance for disk systems and IBM Spectrum Protect™.

Procedure

1. Provide a connection between the server and the storage devices by following these guidelines:
o Use a switch or direct connection for Fibre Channel connections.
o Consider the number of ports that are connected and account for the amount of bandwidth that is needed.
o Consider the number of ports on the server and the number of host ports on the disk system that are connected.
2. Verify that device drivers and firmware for the server system, adapters, and operating system are current and at the
recommended levels.
3. Configure storage arrays. Make sure that you planned properly to ensure optimal performance. See Planning for storage for
more information.
4. Ensure that the server system has access to disk volumes that are created. Complete the following steps:
a. If the system is connected to a Fibre Channel switch, zone the server to see the disks.
b. Map all of the volumes to tell the disk system that this specific server is allowed to see each disk.

Related tasks:
[ Configuring storage

Installing the server operating system

Install the operating system on the server system and ensure that IBM Spectrum Protect™ server requirements are met. Adjust
operating system settings as directed.

e Installing on AIX systems
Complete the following steps to install AIX® on the server system.
e Installing on Linux systems
Complete the following steps to install Linux x86_64 on the server system.
e Installing on Windows systems
Install Microsoft Windows Server 2012 Standard Edition on the server system and prepare the system for installation and
configuration of the IBM Spectrum Protect server.

Installing on AIX systems

Complete the following steps to install AIX® on the server system.
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Procedure

N

10.

11.

. Install AIX Version 7.1, TL4, SP2, or later according to the manufacturer instructions.
. Configure your TCP/IP settings according to the operating system installation instructions.
. Open the /etc/hosts file and complete the following actions:

o Update the file to include the IP address and host name for the server. For example:
192.0.2.7 server.yourdomain.com server

o Verify that the file contains an entry for localhost with an address of 127.0.0.1. For example:

127.0.0.1 localhost

. Enable AIX I/O completion ports by issuing the following command:

chdev -1 iocpO -P

Server performance can be affected by the Olson time zone definition.

. To optimize performance, change your system time zone format from Olson to POSIX. Use the following command format

to update the time zone setting;:
chtz=local timezone,date/time,date/time

For example, if you lived in Tucson, Arizona, where Mountain Standard Time is used, you would issue the following
command to change to the POSIX format:

chtz MST7MDT,M3.2.0/2:00:00,M11.1.0/2:00:00

. Add an entry in the .profile of the instance user so that the following environment is set:

export MALLOCOPTIONS=multiheap:16

Tip: If the instance user is not available, complete this step later, when the instance user becomes available.

. Set the system to create full application core files. Issue the following command:

chdev -1 sys0O -a fullcore=true -P

. For communications with the server and Operations Center, make sure that the following ports are open on any firewalls

that might exist:
o For communications with the server, open port 1500.
o For secure communications with the Operations Center, open port 11090 on the hub server.

If you are not using the default port values, make sure that the ports that you are using are open.

. Enable TCP high-performance enhancements. Issue the following command:

no -p -o rfcl323=1

For optimal throughput and reliability, bond four 10 Gb Ethernet ports together. Use the System Management Interface Tool
(SMIT) to bond the ports together by using Etherchannel. The following settings were used during testing:

mode 8023ad

auto recovery yes Enable automatic recovery after failover

backup adapter NONE Adapter used when whole channel fails

hash mode src _dst port Determines how outgoing adapter is chosen

interval long Determines interval value for IEEE
802.3ad mode

mode 8023ad EtherChannel mode of operation

netaddr 0 Address to ping

noloss failover yes Enable lossless failover after ping
failure

num retries 3 Times to retry ping before failing

retry time 1 Wait time (in seconds) between pings

use alt addr no Enable Alternate EtherChannel Address

use_ jumbo_ frame no Enable Gigabit Ethernet Jumbo Frames

Verify that user process resource limits, also known as ulimits, are set according to guidelines in Table 1. If ulimit values are
not set correctly, you might experience server instability or a failure of the server to respond.
Table 1. User limits (ulimit) values

User limit type Setting Value Command to query value
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User limit type Setting Value Command to query value

Maximum size of core files core Unlimited ulimit -Hc
created
Maximum size of a data data Unlimited ulimit -Hd

segment for a process

Maximum file size fsize Unlimited ulimit -Hf
Maximum number of open nofile 65536 ulimit -Hn
files

Maximum amount of cpu Unlimited ulimit -Ht

processor time in seconds

Maximum number of user nproc 16384 ulimit -Hu
processes

If you need to modify any user limit values, follow the instructions in the documentation for your operating system.

Installing on Linux systems

Complete the following steps to install Linux x86_64 on the server system.

Before you begin

The operating system will be installed on the internal hard disks. Configure the internal hard disks by using a hardware RAID 1
array. For example, if you are configuring a small system, the two 300 GB internal disks are mirrored in RAID 1 so that a single 300
GB disk appears available to the operating system installer.

Procedure

1. Install Red Hat Enterprise Linux Version 7.1 or later, according to the manufacturer instructions. Obtain a bootable DVD that
contains Red Hat Enterprise Linux Version 7.1 and start your system from this DVD. See the following guidance for
installation options. If an item is not mentioned in the following list, leave the default selection.

a. After you start the DVD, choose Install or upgrade an existing system from the menu.
b. On the Welcome screen, select Test this media & install Red Hat Enterprise Linux 7.1.
c. Select your language and keyboard preferences.
d. Select your location to set the correct time zone.
e. Select Software Selection and then on the next screen, select Server with GUI.
f. From the installation summary page, click Installation Destination and verify the following items:
= The local 300 GB disk is selected as the installation target.
= Under Other Storage Options, Automatically configure partitioning is selected.
Click Done.
g. Click Begin Installation. After the installation starts, set the root password for your root user account.
After the installation is completed, restart the system and log in as the root user. Issue the df command to verify your basic
partitioning. For example, on a test system, the initial partitioning produced the following result:

[root@tvapp02]# df -h

Filesystem Size Used Avail Use$% Mounted on
/dev/mapper/rhel-root 50G 3.0G 48G 6% /

devtmpfs 32G 0 32G 0% /dev

tmpfs 32G 92K 32G 1% /dev/shm

tmpfs 32G  8.8M 32G 1% /run

tmpfs 32G 0 32G 0% /sys/fs/cgroup
/dev/mapper/rhel-home 220G 37M 220G 1% /home
/dev/sdal 497M 124M 373M 25% /boot

2. Configure your TCP/IP settings according to the operating system installation instructions.
For optimal throughput and reliability, consider bonding multiple network ports together. This can be accomplished by
creating a Link Aggregation Control Protocol (LACP) network connection, which aggregates several subordinate ports into a
single logical connection. The preferred method is to use a bond mode of 802.3ad, miimon setting of 100, and a
xmit_hash_policy setting of layer3+4.
Restriction: To use an LACP network connection, you must have a network switch that supports LACP.
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For additional instructions about configuring bonded network connections with Red Hat Enterprise Linux Version 7, see
Create a Channel Bonding Interface.

3. Open the /etc/hosts file and complete the following actions:
o Update the file to include the IP address and host nhame for the server. For example:

192.0.2.7 server.yourdomain.com server

o Verify that the file contains an entry for localhost with an address of 127.0.0.1. For example:

127.0.0.1 localhost

4. Install components that are required for the server installation. Complete the following steps to create a Yellowdog Updater
Modified (YUM) repository and install the prerequisite packages.
a. Mount your Red Hat Enterprise Linux installation DVD to a system directory. For example, to mount it to the /mnt
directory, issue the following command:

mount -t 1509660 -o ro /dev/cdrom /mnt

o

. Verify that the DVD mounted by issuing the mount command. You should see output similar to the following
example:

/dev/sr0 on /mnt type is09660

o

Change to the YUM repository directory by issuing the following command:

cd /etc/yum/repos.d

If the repos.d directory does not exist, create it.
d. List directory contents:

ls rhel-source.repo
e. Rename the original repo file by issuing the mv command. For example:

mv rhel-source.repo rhel-source.repo.orig

-

Create a new repo file by using a text editor. For example, to use the vi editor, issue the following command:

vi rhel7l dvd.repo
g. Add the following lines to the new repo file. The baseurl parameter specifies your directory mount point:
[rhel71 dvd]
name=DVD Redhat Enterprise Linux 7.1
baseurl=file:///mnt

enabled=1
gpgcheck=0

h. Install the prerequisite package ksh.x86_64, by issuing the yum command. For example:
yum install ksh.x86 64

Exception: You do not need to install the compat-libstdc++-33-3.2.3-69.el6.i686 and libstdc++.i686 libraries for
Red Hat Enterprise Linux Version 7.1.
5. When the software installation is complete, you can restore the original YUM repository values by completing the following
steps:
a. Unmount the Red Hat Enterprise Linux installation DVD by issuing the following command:

unmount /mnt

b. Change to the YUM repository directory by issuing the following command:
cd /etc/yum/repos.d

c. Rename the repo file that you created:
mv rhel71 dvd.repo rhel7l dvd.repo.orig

d. Rename the original file to the original name:

mv rhel-source.repo.orig rhel-source.repo
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6. Determine whether kernel parameter changes are required. Complete the following steps:

a. Use the sysctl -a command to list the parameter values.

b. Analyze the results by using the guidelines in Table 1 to determine whether any changes are required.

c. If changes are required, set the parameters in the /etc/sysctl.conf file. The file changes are applied when the system

is started.

Tip: Automatically adjust kernel parameter settings and eliminate the need for manual updates to these settings. On Linux,
the DB2® database software automatically adjusts interprocess communication (IPC) kernel parameter values to the
preferred settings. For more information about kernel parameter settings, search for Linux kernel parameters in the IBM
DB2 Version 11.1 product documentation.

Table 1. Linux kernel parameter optimum settings

Parameter Description
kernel.shmmni The maximum number of segments.
kernel.shmmax The maximum size of a shared memory segment (bytes).

This parameter must be set before automatically starting the
IBM Spectrum Protect™ server on system startup.

kernel.shmall The maximum allocation of shared memory pages (pages).
kernel.sem (SEMMSL)

There are four values for the kernel.sem The maximum semaphores per array.

parameter. (SEMMNS)

The maximum semaphores per system.

(SEMOPM)

The maximum operations per semaphore call.

(SEMMNI)

The maximum number of arrays.

kernel.msgmni The maximum number of system-wide message queues.
kernel.msgmax The maximum size of messages (bytes).

kernel.msgmnb The default maximum size of queue (bytes).
kernel.randomize_va_space The kernel.randomize_va_space parameter configures the

use of memory ASLR for the kernel. Disable ASLR because it
can cause errors for the DB2 software. To learn more details
about the Linux ASLR and DB2, see technote 1365583.

vm.swappiness The vm.swappiness parameter defines whether the kernel
can swap application memory out of physical random access
memory (RAM). For more information about kernel
parameters, see the DB2 product information.

vm.overcommit_memory The vm.overcommit_memory parameter influences how
much virtual memory the kernel permits allocating. For more
information about kernel parameters, see the DB2 product
information.

7. Open firewall ports to communicate with the server. Complete the following steps:
a. Determine the zone that is used by the network interface. The zone is public, by default.
Issue the following command:

# firewall-cmd --get-active-zones

public
interfaces: ens4f0

b. To use the default port address for communications with the server, open TCP/IP port 1500 in the Linux firewall.
Issue the following command:

firewall-cmd —--zone=public --add-port=1500/tcp --permanent
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If you want to use a value other than the default, you can specify a number in the range 1024 - 32767. If you open a
port other than the default, you will need to specify that port when you run the configuration script.

c. If you plan to use this system as a hub, open port 11090, which is the default port for secure (https)
communications.
Issue the following command:

firewall-cmd --zone=public --add-port=11090/tcp --permanent

d. Reload the firewall definitions for the changes to take effect.
Issue the following command:

firewall-cmd --reload

8. Verify that user process resource limits, also known as ulimits, are set according to guidelines in Table 2. If ulimit values are
not set correctly, you might experience server instability or a failure of the server to respond.

Table 2. User limits (ulimit) values

User limit type Setting Value Command to query value
Maximum size of core files core Unlimited ulimit -He

created

Maximum size of a data data Unlimited ulimit -Hd

segment for a process

Maximum file size fsize Unlimited ulimit -Hf
Maximum number of open nofile 65536 ulimit -Hn
files

Maximum amount of cpu Unlimited ulimit -Ht

processor time in seconds

Maximum number of user nproc 16384 ulimit -Hu
processes

If you need to modify any user limit values, follow the instructions in the documentation for your operating system.

Installing on Windows systems

Install Microsoft Windows Server 2012 Standard Edition on the server system and prepare the system for installation and
configuration of the IBM Spectrum Protect™ server.

Procedure

1. Install Windows Server 2016 Standard Edition, according to the manufacturer instructions.
2. Change the Windows account control policies by completing the following steps.
a. Open the Local Security Policy editor by running secpol.msc.
b. Click Local Policies > Security Options and ensure that the following User Account Control policies are disabled:
= Admin Approval Mode for the Built-in Administrator account
= Run all administrators in Admin Approval Mode
. Configure your TCP/IP settings according to installation instructions for the operating system.
4. Apply Windows updates and enable optional features by completing the following steps:
a. Apply the latest Windows Server 2016 updates.
b. Install and enable the Windows 2012 R2 feature Microsoft .NET Framework 3.5 from the Windows Server Manager.
c. If required, update the FC and Ethernet HBA device drivers to newer levels.
d. Install the multipath I/O driver that is appropriate for the disk system that you are using.
5. Open the default TCP/IP port, 1500, for communications with the IBM Spectrum Protect server. For example, issue the
following command:

w

netsh advfirewall firewall add rule name="Backup server port 1500"
dir=in action=allow protocol=TCP localport=1500

6. On the Operations Center hub server, open the default port for secure (https) communications with the Operations Center.
The port number is 11090. For example, issue the following command:
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netsh advfirewall firewall add rule name="Operations Center port 11090"
dir=in action=allow protocol=TCP localport=11090

Configuring multipath I/0

You can enable and configure multipathing for disk storage. Use the documentation that is provided with your hardware for
detailed instructions.

e AIX systems
e Linux systems
e Windows systems

AIX systems

Procedure

1. Determine the Fibre Channel port address that you must use for the host definition on the disk subsystem. Issue the lscfg
command for every port.
o Onsmall and medium systems, issue the following commands:

lscfg -vps -1 fcsO | grep "Network Address"
lscfg -vps -1 fcsl | grep "Network Address"

o On large systems, issue the following commands:

lscfg -vps -1 fcsO | grep "Network Address"
lscfg -vps -1 fcsl | grep "Network Address"
lscfg -vps -1 fcs2 | grep "Network Address"
lscfg -vps -1 fcs3 | grep "Network Address"

2. Ensure that the following AIX® file sets are installed:
o devices.common.IBM.mpio.rte
o devices.fcp.disk.array.rte
o devices.fcp.disk.rte
3. Issue the cfgmgr command to have AIX rescan the hardware and discover available disks. For example:

cfgmgr
4. To list the available disks, issue the following command:

lsdev -Ccdisk

You should see output similar to the following:

hdisk0 Available 00-00-00 SAS Disk Drive
hdiskl Available 00-00-00 SAS Disk Drive
hdisk2 Available 01-00-00 SAS Disk Drive
hdisk3 Available 01-00-00 SAS Disk Drive
hdisk4 Available 06-01-02 MPIO IBM 2076 FC Disk
hdisk5 Available 07-01-02 MPIO IBM 2076 FC Disk

5. Use the output from the Isdev command to identify and list device IDs for each disk device.

For example, a device ID could be hdisk4. Save the list of device IDs to use when you create file systems for the IBM
Spectrum Protect™ server.

6. Correlate the SCSI device IDs to specific disk LUNs from the disk system by listing detailed information about all physical
volumes in the system. Issue the following command:

lspv -u
On an IBM® Storwize® system, the following information is an example of what is shown for each device:

hdisk4 00£8cf083£fd97327 None active
332136005076300810105780000000000003004214503IBMfcp
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In the example, 60050763008101057800000000000030 is the UID for the volume, as reported by the Storwize
management interface.

To verify disk size in megabytes and compare the value with what is listed for the system, issue the following command:

bootinfo -s hdisk4

Linux systems

Procedure

1. Edit the /etc/multipath.conf file to enable multipathing for Linux hosts. If the multipath.conf file does not exist, you can
create it by issuing the following command:

mpathconf --enable

The following parameters were set in multipath.conf for testing on an IBM Storwize® system:

defaults {
user friendly names no

}

devices {
device {
vendor "IBM "
product "2145"
path grouping policy group by prio
user_friendly names no
path selector "round-robin 0"
prio "alua"
path checker "tur"
failback "immediate"
no _path retry 5
rr weight uniform
rr min io rg "1"
dev_loss_tmo 120

}

2. Set the multipath option to start when the system is started. Issue the following commands:

systemctl enable multipathd.service
systemctl start multipathd.service

3. To verify that disks are visible to the operating system and are managed by multipath, issue the following command:

multipath -1

4. Ensure that each device is listed and that it has as many paths as you expect. You can use size and device ID information to
identify which disks are listed.

For example, the following output shows that a 2 TB disk has two path groups and four active paths. The 2 TB size confirms
that the disk corresponds to a pool file system. Use part of the long device ID number (12, in this example) to search for the
volume on the disk-system management interface.

[root@tapsrv0l codel# multipath -1
36005076802810c509800000000000012 dm-43 IBM,2145
size=2.0T features='l queue if no path' hwhandler='0' wp=rw
|-+- policy='round-robin 0' prio=0 status=active
| |- 2:0:1:18 sdcw 70:64 active undef running
| "= 4:0:0:18 sdgb 131:112 active undef running
‘—+- policy='round-robin 0' prio=0 status=enabled
|- 1:0:1:18 sdat 66:208 active undef running
"= 3:0:0:18 sddy 128:0 active undef running

a. If needed, correct disk LUN host assignments and force a bus rescan. For example:

echo "- - -" > /sys/class/scsi_host/host0/scan
echo "- - -" > /sys/class/scsi _host/hostl/scan
echo "- - -" > /sys/class/scsi host/host2/scan

You can also restart the system to rescan disk LUN host assignments.
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b. Confirm that disks are now available for multipath I/O by reissuing the multipath -l command.
5. Use the multipath output to identify and list device IDs for each disk device.

For example, the device ID for your 2 TB disk is 36005076802810c509800000000000012.

Save the list of device IDs to use in the next step.

Windows systems

Procedure

1. Ensure that the Multipath I/O feature is installed. If needed, install additional vendor-specific multipath drivers.
2. To verify that disks are visible to the operating system and are managed by multipath I/0O, issue the following command:

c:\program files\IBM\SDDDSM\datapath.exe query device

3. Review the multipath output and ensure that each device is listed and that it has as many paths as you expect. You can use
size and device serial information to identify which disks are listed.
For example, by using part of the long device serial number (34, in this example) you can search for the volume on the disk-
system management interface. The 2 TB size confirms that the disk corresponds to a storage pool file system.

DEV#: 4 DEVICE NAME: Disk5 PartO TYPE: 2145 POLICY: OPTIMIZED

SERIAL: 60050763008101057800000000000034 LUN SIZE: 2.0TB

Path# Adapter/Hard Disk State Mode Select Errors
0 Scsi Port2 Bus0/Disk5 Part0 OPEN NORMAL 0 0
1 Scsi Port2 Bus0/Disk5 Part0 OPEN NORMAL 27176 0
2 Scsi Port3 Bus0/Disk5 PartO OPEN NORMAL 28494 0
3 Scsi Port3 Bus0/Disk5 PartO OPEN NORMAL 0 0

4. Create a list of disk device IDs by using the serial numbers that are returned from the multipath output in the previous step.
For example, the device ID for your 2 TB disk is 60050763008101057800000000000034
Save the list of device IDs to use in the next step.

5. To bring new disks online and clear the read-only attribute, run diskpart.exe with the following commands. Repeat for each
of the disks:

diskpart
select Disk 1
online disk
attribute disk clear readonly
select Disk 2
online disk
attribute disk clear readonly
< Ll >
select Disk 49
online disk
attribute disk clear readonly
exit

Creating the user ID for the server

Create the user ID that owns the IBM Spectrum Protect™ server instance. You specify this user ID when you create the server
instance during initial configuration of the server.

About this task

You can specify only lowercase letters (a-z), numerals (0-9), and the underscore character ( _) for the user ID. The user ID and
group name must comply with the following rules:

e The length must be 8 characters or fewer.
e The user ID and group name cannot start with ibm, sql, sys, or a numeral.
e The user ID and group name cannot be user, admin, guest, public, local, or any SQL reserved word.
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Procedure

1. Use operating system commands to create a user ID.

o

TN NI Create a group and user ID in the home directory of the user that owns the server instance.

For example, to create the user ID tsminstl in group tsmsrvrs with a password of tsminst1, issue the following
commands from an administrative user ID:

mkgroup id=1001 tsmsrvrs
mkuser id=1002 pgrp=tsmsrvrs home=/home/tsminstl tsminstl
passwd tsminstl

groupadd tsmsrvrs
useradd -d /home/tsminstl -m -g tsmsrvrs -s /bin/bash tsminstl
passwd tsminstl

Log off, and then log in to your system. Change to the user account that you created. Use an interactive login
program, such as telnet, so that you are prompted for the password and can change it if necessary.
ITT M Create a user ID and then add the new ID to the Administrators group. For example, to create the user ID
tsminstl, issue the following command:

net user tsminstl * /add
After you create and verify a password for the new user, add the user ID to the Administrators group by issuing the

following commands:

net localgroup Administrators tsminstl /add
net localgroup DB2ADMNS tsminstl /add

2. Log off the new user ID.

Preparing file systems for the server

You must complete file system configuration for the disk storage to be used by the server.

e Preparing file systems on AIX systems

You must create volume groups, logical volumes, and file systems for the server by using the AIX® Logical Volume Manager.
e Preparing file systems on Linux systems

You must format ext4 or xfs file systems on each of the disk LUNs to be used by the IBM Spectrum Protect server.
e Preparing file systems on Windows systems

You must format New Technology File System (NTFS) file systems on each of the disk LUNs to be used by the IBM

Spectr

um Protect server.

Preparing file systems on AIX systems

You must create volume groups, logical volumes, and file systems for the server by using the AIX® Logical Volume Manager.

Procedure

1. Increase the queue depth and maximum transfer size for all of the available hdiskX disks. Issue the following commands
for each disk:

chdev
chdev
chdev
chdev

Do not
2. Create

-1 hdisk4 -a max transfer=0x100000

-1 hdisk4 -a gqueue_depth=32

-1 hdisk4 -a reserve policy=no_reserve
-1 hdisk4 -a algorithm=round robin

run these commands for operating system internal disks, for example, hdiskO.
volume groups for the IBM Spectrum Protect™ database, active log, archive log, database backup, and storage pool.

Issue the mkvg command, specifying the device IDs for corresponding disks that you previously identified.
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For example, if the device names hdisk4, hdisk5, and hdiské6 correspond to database disks, include them in the database
volume group and so on.

System size: The following commands are based on the medium system configuration. For small and large systems, you
must adjust the syntax as required.

mkvg -S -y tsmdb hdisk2 hdisk3 hdisk4

mkvg -S -y tsmactlog hdisk5

mkvg -S -y tsmarchlog hdiské6

mkvg -S -y tsmdbback hdisk7 hdisk8 hdisk9 hdisklO0

mkvg -S -y tsmstgpool hdiskll hdiskl2 hdisk13 hdisk1l4 ... hdisk49

3. Determine the physical volume names and the number of free physical partitions to use when you create logical volumes.
Issue the lsvg for each volume group that you created in the previous step.
For example:

lsvg -p tsmdb

The output is similar to the following. The FREE PPs column represents the free physical partitions:

tsmdb:

PV_NAME PV STATE TOTAL PPs FREE PPs FREE DISTRIBUTION
hdisk4 active 1631 1631 327..326..326..326..326
hdisk5 active 1631 1631 327..326..326..326..326
hdisk6 active 1631 1631 327..326..326..326..326

4. Create logical volumes in each volume group by using the mklv command. The volume size, volume group, and device
names vary, depending on the size of your system and variations in your disk configuration.
For example, to create the volumes for the IBM Spectrum Protect database on a medium system, issue the following
commands:

mklv -y tsmdb00 -t jfs2 -u 1 -x 1631 tsmdb 1631 hdisk2
mklv -y tsmdb0l -t jfs2 -u 1 -x 1631 tsmdb 1631 hdisk3
mklv -y tsmdb02 -t jfs2 -u 1 -x 1631 tsmdb 1631 hdisk4

5. Format file systems in each logical volume by using the crfs command.
For example, to format file systems for the database on a medium system, issue the following commands:

crfs -v jfs2 -d tsmdb00 -p rw -a logname=INLINE -a options=rbrw
-a agblksize=4096 -m /tsminstl/TSMdbspace00 -A yes
crfs -v jfs2 -d tsmdb0l -p rw -a logname=INLINE -a options=rbrw
-a agblksize=4096 -m /tsminstl/TSMdbspacell -A yes
crfs -v jfs2 -d tsmdb02 -p rw -a logname=INLINE -a options=rbrw
-a agblksize=4096 -m /tsminstl/TSMdbspace02 -A yes

6. Mount all of the newly created file systems by issuing the following command:
mount -a

7. List all file systems by issuing the df command. Verify that file systems are mounted at the correct LUN and correct mount
point. Also, verify the available space.
The following example of command output shows that the amount of used space is typically 1%:

tapsrv07> df -g /tsminstl/*

Filesystem GB blocks Free %Used Tused %Iused Mounted on
/dev/tsmact00 195.12 194.59 1% 4 1% /tsminstl/TSMalog

8. Verify that the user ID you created in Creating the user ID for the server has read and write access to the directories for the
IBM Spectrum Protect server.

Preparing file systems on Linux systems

You must format ext4 or xfs file systems on each of the disk LUNs to be used by the IBM Spectrum Protect™ server.

Procedure

1. Using the list of device IDs that you generated previously, issue the mkfs command to create and format a file system for
each storage LUN device. Specify the device ID in the command. See the following examples. For the database, format ext4
file systems:
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mkfs -t ext4d -T largefile -m 2 /dev/mapper/36005076802810c509800000000000012

For storage pool LUNs, format xfs file systems:

mkfs -t xfs /dev/mapper/3600507630081010578000000000002¢c3

You might issue the mkfs command as many as 50 times, depending on how many different devices you have.
2. Create mount point directories for file systems.

Issue the mkdir command for each directory that you must create. Use the directory values that you recorded in the
planning worksheets.

For example, to create the server instance directory by using the default value, issue the following command:

mkdir /tsminstl

Repeat the mkdir command for each file system.

3. Add an entry in the /etc/fstab file for each file system so that file systems are mounted automatically when the server is
started.
For example:

/dev/mapper/36005076802810c509800000000000012 /tsminstl/TSMdbspace00 ext4 defaults 0 0

4. Mount the file systems that you added to the /etc/fstab file by issuing the mount -a command.

5. List all file systems by issuing the df command. Verify that file systems are mounted at the correct LUN and correct mount
point. Also, verify the available space.
The following example on an IBM® Storwize® system shows that the amount of used space is typically 1%:

[root@tapsrv04 ~]# df -h /tsminstl/*

Filesystem Size Used Avail Use% Mounted on
/dev/mapper/360050763008101057800000000000003 134G 188M 132G 1% /tsminstl/TSMalog

6. Verify that the user ID you created in Creating the user ID for the server has read and write access to the directories for IBM
Spectrum Protect.

Preparing file systems on Windows systems

You must format New Technology File System (NTFS) file systems on each of the disk LUNs to be used by the IBM Spectrum
Protect™ server.

Procedure

1. Create mount point directories for file systems.
Issue the md command for each directory that you must create. Use the directory values that you recorded in the planning
worksheets. For example, to create the server instance directory by using the default value, issue the following command:

md c:\tsminstl

Repeat the md command for each file system.
2. Create a volume for every disk LUN that is mapped to a directory under the server instance directory by using the Windows
volume manager.

Go to Server Manager > File and Storage Services and complete the following steps for each disk that corresponds to the
LUN mapping that was created in the previous step:

a. Bring the disk online.

b. Initialize the disk to the GPT basic type, which is the default.

c. Create a simple volume that occupies all of the space on the disk. Format the file system by using NTFS, and assign a
label that matches the purpose of the volume, such as TSMfile00. Do not assign the new volume to a drive letter.
Instead, map the volume to a directory under the instance directory, such as C:\tsminst1\TSMfile00.
Tip: Determine the volume label and directory mapping labels based on the size of the disk that is reported.

3. Verify that file systems are mounted at the correct LUN and correct mount point. List all file systems by issuing the
mountvol command and then review the output. For example:

\\?\Volume{8£ffb9678-3216-474c-a021-20e420816a92}\
C:\tsminst1l\TSMdbspace00\
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4, After the disk configuration is complete, restart the system.

What to do next

You can confirm the amount of free space for each volume by using Windows Explorer.

Installing the server and Operations Center

Use the IBM® Installation Manager graphical wizard to install the components.

e Installing on AIX and Linux systems

Install the IBM Spectrum Protect™ server and the Operations Center on the first server system.
e Installing on Windows systems

Install the IBM Spectrum Protect server and the Operations Center on the first server system.

Installing on AIX® and Linux systems

Install the IBM Spectrum Protect™ server and the Operations Center on the first server system.

Before you begin

Verify that the operating system is set to the language that you require. By default, the language of the operating system is the
language of the installation wizard.

Procedure

1. IS e rify that the required RPM files are installed on your system.
See Installing prerequisite RPM files for the graphical wizard for details.

2. Before you download the installation package, verify that you have enough space to store the installation files when they
are extracted from the product package. For space requirements, see the download document at technote 4042992.
. Go to Passport Advantage® and download the package file to an empty directory of your choice.
4. Ensure that executable permission is set for the package. If necessary, change the file permissions by issuing the following
command:

w

chmod a+x package name.bin
5. Extract the package by issuing the following command:

./package name.bin

where package_name is the name of the downloaded file.
6. TN E nsure that the following command is enabled so that the wizards work properly:

lsuser

By default, the command is enabled.
7. Change to the directory where you placed the executable file.
8. Start the installation wizard by issuing the following command:

./install.sh

When you select the packages to install, choose both the server and Operations Center.

What to do next

e If errors occur during the installation process, the errors are recorded in log files that are stored in the IBM Installation
Manager logs directory.

To view installation log files from the Installation Manager tool, click File > View Log. To collect these log files from the
Installation Manager tool, click Help > Export Data for Problem Analysis.
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e After you install the server and before you customize it for your use, go to the IBM Spectrum Protect support site. Click
Support and downloads and apply any applicable fixes.

e Installing prerequisite RPM files for the graphical wizard
RPM files are required for the IBM Installation Manager graphical wizard.

Related tasks:
E* Other methods for installing IBM Spectrum Protect components (AIX)
E* Other methods for installing IBM Spectrum Protect components (Linux)

Installing on Windows systems

Install the IBM Spectrum Protect™ server and the Operations Center on the first server system.

Before you begin

Make sure that the following prerequisites are met:

e Verify that the operating system is set to the language that you require. By default, the language of the operating system is
the language of the installation wizard.
e Ensure that the user ID that you plan to use during the installation is a user with local Administrator authority.

Procedure

1. Before you download the installation package, verify that you have enough space to store the installation files when they
are extracted from the product package. For space requirements, see the download document at technote 4042993.

. Go to Passport Advantage® and download the package file to an empty directory of your choice.

. Change to the directory where you placed the executable file.

. Double-click the executable file to extract to the current directory.

. In the directory where the installation files were extracted, start the installation wizard by double-clicking the install.bat
file. When you select the packages to install, choose both the server and Operations Center.

aa b wWN

What to do next

e If errors occur during the installation process, the errors are recorded in log files that are stored in the IBM® Installation
Manager logs directory.

To view installation log files from the Installation Manager tool, click File > View Log. To collect these log files from the
Installation Manager tool, click Help > Export Data for Problem Analysis.

e After you install the server and before you customize it for your use, go to the IBM Spectrum Protect support site. Click
Support and downloads and apply any applicable fixes.

Related tasks:
* Other methods for installing IBM Spectrum Protect components

Configuring the server and the Operations Center

After you install the components, complete the configuration for the IBM Spectrum Protect™ server and the Operations Center.

e Configuring the server instance
Use the IBM Spectrum Protect server instance configuration wizard to complete the initial configuration of the server.

e Installing the backup-archive client
As a best practice, install the IBM Spectrum Protect backup-archive client on the server system so that the administrative
command-line client and scheduler are available.

e Setting options for the server
Review the server options file that is installed with the IBM Spectrum Protect server to verify that the correct values are set
for your system.

e Configuring secure communications with Transport Layer Security
To encrypt data and secure communications in your environment, Secure Sockets Layer (SSL) or Transport Layer Security
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(TLS) is enabled on the IBM Spectrum Protect server and backup-archive client. An SSL certificate is used to verify
communication requests between the server and client.

e Configuring the Operations Center
After you install the Operations Center, complete the following configuration steps to start managing your storage
environment.

e Registering the product license
To register your license for the IBM Spectrum Protect product, use the REGISTER LICENSE command.

e Configuring data deduplication
Create a directory-container storage pool and at least one directory to use inline data deduplication.

e Defining data retention rules for your business
After you create a directory-container storage pool for data deduplication, update the default server policy to use the new
storage pool. The Add Storage Pool wizard opens the Services page in the Operations Center to complete this task.

e Defining schedules for server maintenance activities
Create schedules for each server maintenance operation by using the DEFINE SCHEDULE command in the Operations
Center command builder.

e Defining client schedules
Use the Operations Center to create schedules for client operations.

Configuring the server instance

Use the IBM Spectrum Protect™ server instance configuration wizard to complete the initial configuration of the server.

Before you begin

Ensure that the following requirements are met:

LA | i

e The system where you installed IBM Spectrum Protect must have the X Window System client. You must also be running an
X Window System server on your desktop.

¢ The system must have the Secure Shell (SSH) protocol enabled. Ensure that the port is set to the default value, 22, and that
the port is not blocked by a firewall. You must enable password authentication in the sshd_config file in the
/etc/ssh/directory. Also, ensure that the SSH daemon service has access rights to connect to the system by using the
localhost value.

e You must be able to log in to IBM Spectrum Protect with the user ID that you created for the server instance, by using the
SSH protocol. When you use the wizard, you must provide this user ID and password to access that system.

e Ifyou changed any settings in the preceding steps, restart the server before you proceed with the configuration wizard.

TSV erify that the remote registry service is started by completing the following steps:

1. Click Start > Administrative Tools > Services. In the Services window, select Remote Registry. If it is not started, click Start.
2. Ensure that port 137, 139, and 445 are not blocked by a firewall:
a. Click Start > Control Panel > Windows Firewall.
b. Select Advanced Settings.
c. Select Inbound Rules.
d. Select New Rule.
e. Create a port rule for TCP ports 137, 139, and 445 to allow connections for domain and private networks.
3. Configure the user account control by accessing the local security policy options and completing the following steps.
a. Click Start > Administrative Tools > Local Security Policy. Expand Local Policies > Security Options.
b. If not already enabled, enable the built-in administrator account by selecting Accounts: Administrator account status
> Enable > OK.
c. If not already disabled, disable user account control for all Windows administrators by selecting User Account
Control: Run all administrators in Admin Approval Mode > Disable > OK.
d. If not already disabled, disable the User Account Control for the built-in Administrator account by selecting User
Account Control: Admin Approval Mode for the Built-in Administrator Account > Disable > OK.
4. If you changed any settings in the preceding steps, restart the server before you proceed with the configuration wizard.

About this task

The wizard can be stopped and restarted, but the server is not operational until the entire configuration process is complete.

Procedure
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1. Start the local version of the wizard.
o NN INTITEM Open the dsmicfgx program in the Jopt/tivoli/tsm/server/bin directory. This wizard can be only
run as a root user.
o IMITTTEMClick Start > All Programs > IBM Spectrum Protect > Configuration Wizard.
2. Follow the instructions to complete the configuration. Use the information that you recorded in Planning worksheets during
IBM Spectrum Protect system set up to specify directories and options in the wizard.

TN T On the Server Information window, set the server to start automatically by using the instance user ID
when the system boots.

IITTEMBY using the configuration wizard, the server is set to start automatically when rebooted.

Installing the backup-archive client

As a best practice, install the IBM Spectrum Protect™ backup-archive client on the server system so that the administrative
command-Lline client and scheduler are available.

Procedure

To install the backup-archive client, follow the installation instructions for your operating system.

e Install UNIX and Linux backup-archive clients
e Installing the Windows client for the first time

Setting options for the server

Review the server options file that is installed with the IBM Spectrum Protect™ server to verify that the correct values are set for
your system.

Procedure

1. Go to the server instance directory and open the dsmserv.opt file.
2. Review the values in the following table and verify your server option settings, based on system size.

Server option Small system value Medium system value Large system value

ACTIVELOGDIRECTORY Directory path that was Directory path that was Directory path that was
specified during specified during specified during
configuration configuration configuration

ACTIVELOGSIZE 131072 131072 262144

ARCHLOGCOMPRESS Yes No No

ARCHLOGDIRECTORY Directory path that was Directory path that was Directory path that was
specified during specified during specified during
configuration configuration configuration

COMMMETHOD TCPIP TCPIP TCPIP

COMMTIMEOUT 3600 3600 3600

DEDUPREQUIRESBACKUP No No No

DEVCONFIG devconf.dat devconf.dat devconf.dat

EXPINTERVAL 0 0 0

IDLETIMEOUT 60 60 60

MAXSESSIONS 250 500 1000

NUMOPENVOLSALLOWED 20 20 20

TCPADMINPORT 1500 1500 1500

TCPPORT 1500 1500 1500

VOLUMEHISTORY volhist.dat volhist.dat volhist.dat
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Update server option settings if necessary, to match the values in the table. To make updates, close the dsmserv.opt file
and use the SETOPT command from the administrative command-Lline interface to set the options.
For example, to update the IDLETIMEOUT option to 60, issue the following command:

setopt idletimeout 60

3. To configure secure communications for the server, clients, and the Operations Center, verify the options in the following

table.
Server option All system sizes
SSLFIPSMODE NO
TCPPORT Specify the port number on which the server waits for requests for TCP/IP and
SSL-enabled sessions from the client.
TCPADMINPORT Specify the port address on which the server waits for requests for TCP/IP and
SSL-enabled sessions from the command-line administrative client.

If any of the option values must be updated, edit the dsmserv.opt file by using the following guidelines:
o Remove the asterisk at the beginning of a line to enable an option.
o On each line, enter only one option and the specified value for the option.
o If an option occurs in multiple entries in the file, the server uses the last entry.
Save your changes and close the file. If you edit the dsmserv.opt file directly, you must restart the server for the changes to

take effect.

Related reference:
[* Server options reference
[ SETOPT (Set a server option for dynamic update)

Configuring secure communications with Transport Layer Security

To encrypt data and secure communications in your environment, Secure Sockets Layer (SSL) or Transport Layer Security (TLS) is
enabled on the IBM Spectrum Protect™ server and backup-archive client. An SSL certificate is used to verify communication
requests between the server and client.

About this task

Beginning with IBM Spectrum Protect Version 8.1.2, SSL is enabled by default, and the IBM Spectrum Protect server and backup-
archive client are automatically configured to communicate with each other by using the TLS 1.2 protocol.

As shown in the following figure, you can manually configure secure communications between the server and backup-archive

client by setting options in the server and client options files, and then transferring the self-signed certificate that is generated on

the server to the client. Alternatively, you can obtain and transfer a unique certificate that is signed by a certificate authority (CA).
Server Backup-archive client

E Secure communications

Client opticns file

Server options file
Import cert256.arm
tcpadminport 5l yes

tcpport = value of

tcpport
PH tcpport on the
SEIVET

For more information about configuring the server and clients for SSL or TLS communications, see Configuring storage agents,
servers, clients, and the Operations Center to connect to the server by using SSL.

Configuring the Operations Center

After you install the Operations Center, complete the following configuration steps to start managing your storage environment.

Before you begin

When you connect to the Operations Center for the first time, you must provide the following information:
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e Connection information for the server that you want to designate as a hub server
e Login credentials for an administrator ID that is defined for that server

Procedure

1. Designate the hub server. In a web browser, enter the following address:

https://hostname: secure port/oc

where:
o hostname represents the name of the computer where the Operations Center is installed
o secure_port represents the port number that the Operations Center uses for HTTPS communication on that
computer
For example, if your host name is tsm.storage.mylocation.com and you are using the default secure port for the Operations
Center, which is 11090, the address is:

https://tsm.storage.mylocation.com:11090/0oc

When you log in to the Operations Center for the first time, a wizard guides you through an initial configuration to set up a
new administrator with system authority on the server.

2. Set up secure communications between the Operations Center and the hub server by configuring the Secure Sockets Layer
(SSL) protocol.

Follow the instructions in Securing communications between the Operations Center and the hub server.

3. Optional: To receive a daily email report that summarizes system status, configure your email settings in the Operations
Center.

Follow the instructions in Tracking system status by using email reports.

e Securing communications between the Operations Center and the hub server
To secure communications between the Operations Center and the hub server, add the Transport Layer Security (TLS)
certificate of the hub server to the truststore file of the Operations Center.

Registering the product license

To register your license for the IBM Spectrum Protect™ product, use the REGISTER LICENSE command.

About this task

Licenses are stored in enrollment certificate files, which contain licensing information for the product. The enrollment certificate
files are on the installation media, and are placed on the server during installation. When you register the product, the licenses are
stored in a NODELOCK file within the current directory.

Procedure

Register a license by specifying the name of the enrollment certificate file that contains the license. To use the Operations Center
command builder for this task, complete the following steps.

1. Open the Operations Center.

2. Open the Operations Center command builder by hovering over the settings icon and clicking Command Builder.
3. Issue the REGISTER LICENSE command. For example, to register a base IBM Spectrum Protect license, issue the following
command:

register license file=tsmbasic.lic

What to do next

Save the installation media that contains your enrollment certificate files. You might need to register your license again if, for
example, one of the following conditions occur:

e The server is moved to a different computer.

IBM Spectrum Protect Knowledge Center Version 8.1.5 157



e The NODELOCK file is corrupted. The server stores license information in the NODELOCK file, which is in the directory from
which the server is started.
o ITITEMI you change the processor chip that is associated with the server on which the server is installed.

Related reference:
[ REGISTER LICENSE (Register a new license)

Configuring data deduplication

Create a directory-container storage pool and at least one directory to use inline data deduplication.

Before you begin

Use the storage pool directory information that you recorded in Planning worksheets for this task.

Procedure

. Open the Operations Center.
On the Operations Center menu bar, hover over Storage.
. From the list that is displayed, click Storage Pools.
. Click the +Storage Pool button.
. Complete the steps in the Add Storage Pool wizard:
o To use inline data deduplication, select a Directory storage pool under Container-based storage.
o When you configure directories for the directory-container storage pool, specify the directory paths that you created
for storage during system setup.
6. After you configure the new directory-container storage pool, click Close & View Policies to update a management class
and start using the storage pool.

oOswWN PR

Defining data retention rules for your business

After you create a directory-container storage pool for data deduplication, update the default server policy to use the new storage
pool. The Add Storage Pool wizard opens the Services page in the Operations Center to complete this task.

Procedure

1. On the Services page of the Operations Center, select the STANDARD domain and click Details.
2. On the Summary page for the policy domain, click the Policy Sets tab. The Policy Sets page indicates the name of the active
policy set and lists all of the management classes for that policy set.
3. Click the Configure toggle, and make the following changes:
o Change the backup destination for the STANDARD management class to the directory-container storage pool.
o Change the value for the Backups column to No limit.
o Change the retention period. Set the Keep Extra Backups column to 30 days or more, depending on your business
requirements.
4. Save your changes and click the Configure toggle again so that the policy set is no longer editable.
5. Activate the policy set by clicking Activate.

Related tasks:
Specifying rules for backing up and archiving client data

Defining schedules for server maintenance activities

Create schedules for each server maintenance operation by using the DEFINE SCHEDULE command in the Operations Center
command builder.

About this task

Schedule server maintenance operations to run after client backup operations. You can control the timing of schedules by setting
the start time in combination with the duration time for each operation.
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The following example shows how you can schedule server maintenance processes in combination with the client backup
schedule for a multisite disk solution.

Operation Schedule

Client backup Starts at 22:00.

Node replication Starts at 08:00, or 10 hours after the beginning of the client backup.

Processing for database and disaster e Database backup starts at 11:00, or 13 hours after the beginning of the client
recovery files backup. This process runs until completion.

e Device configuration information and volume history backup starts at 17:00, or
6 hours after the start of the database backup.

e Volume history deletion starts at 20:00, or 9 hours after the start of the
database backup.

Inventory expiration Starts at 12:00, or 14 hours after the beginning of the client backup window. This
process runs until completion.

Procedure

After you configure the device class for the database backup operations, create schedules for database backup and other required
maintenance operations by using the DEFINE SCHEDULE command. Depending on the size of your environment, you might need
to adjust the start times for each schedule in the example.

1. Define a device class for the backup operations. For example, use the DEFINE DEVCLASS command to create a device class
that is named DBBACK_FILEDEV:

define devclass dbback filedev devtype=file
directory=db backup directories

where db_backup_directories is a list of the directories that you created for the database backup.
IR T For example, if you have four directories for database backups, starting with /tsminst1/TSMbkup00,
issue the following command:

define devclass dbback filedev devtype=file
directory=/tsminstl/TSMbkup00,
/tsminstl/TSMbkupOl, /tsminstl/TSMbkup02,
/tsminstl/TSMbkup0O3"

I For example, if you have four directories for database backups, starting with C:\tsminst1\TSMbkup00, issue the
following command:

define devclass dbback filedev devtype=file
directory="c:\tsminstl\TSMbkup00,
c:\tsminstl\TSMbkupO01l, c:\tsminstl1\TSMbkup02,
c:\tsminstl\TSMbkup03"

2. Set the device class for automatic database backup operations. Use the SET DBRECOVERY command to specify the device
class that you created in the preceding step. For example, if the device class is dbback_filedev, issue the following
command:

set dbrecovery dbback filedev

3. Create schedules for the maintenance operations by using the DEFINE SCHEDULE command. See the following table for
the required operations with examples of the commands.
Tip: You create the schedule for replication separately in a later step, when you use the Operations Center to configure
replication.

Operation Example command
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Operation Example command

Back up the database. Create a schedule to run the BACKUP DB command. If you are
configuring a small system, set the COMPRESS parameter to YES.

For example, on a small system, issue the following command to create
a backup schedule that uses the new device class:

define schedule DBBACKUP type=admin cmd="backup db

devclass=dbback filedev type=full numstreams=3
wait=yes

compress=yes" active=yes desc="Back up the
database."

startdate=today starttime=11:00:00 duration=45
durunits=minutes

Back up the device configuration Create a schedule to run the BACKUP DEVCONFIG command:

information.
define schedule DEVCONFIGBKUP type=admin cmd="backup
devconfig
filenames=devconfig.dat" active=yes desc="Backup the
device
configuration file." startdate=today
starttime=17:00:00
duration=45 durunits=minutes
Back up the volume history. Create a schedule to run the BACKUP VOLHISTORY command:
define schedule VOLHISTBKUP type=admin cmd="backup
volhistory
filenames=volhist.dat" active=yes desc="Back up the
volume

history." startdate=today starttime=17:00:00
duration=45
durunits=minutes

Remove older versions of database |Create a schedule to run the DELETE VOLHISTORY command:

backups that are no longer required. . )
define schedule DELVOLHIST type=admin cmd="delete

volhistory

type=dbb todate=today-6 totime=now" active=yes
desc="Remove

old database backups." startdate=today
starttime=20:00:00

duration=45 durunits=minutes

Remove objects that exceed their Create a schedule to run the EXPIRE INVENTORY command.
allowed retention. Set the RESOURCE parameter based on the system size that you are
configuring:

o Small systems: 10

o Medium systems: 30

o Large systems: 40
For example, on a medium-sized system, issue the following command
to create a schedule that is named EXPINVENTORY:

define schedule EXPINVENTORY type=admin cmd="expire
inventory

wait=yes resource=30 duration=120" active=yes
desc="Remove expired

objects." startdate=today starttime=12:00:00
duration=45

durunits=minutes

What to do next

After you create schedules for the server maintenance tasks, you can view them in the Operations Center by completing the
following steps:

1. On the Operations Center menu bar, hover over Servers.
2. Click Maintenance.

Related reference:
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* DEFINE SCHEDULE (Define a schedule for an administrative command)

Defining client schedules

Use the Operations Center to create schedules for client operations.

Procedure

1. On the Operations Center menu bar, hover over Clients.

2. Click Schedules.

3. Click +Schedule.

4. Complete the steps in the Create Schedule wizard. Set client backup schedules to start at 22:00, based on the server
maintenance activities that you scheduled in Defining schedules for server maintenance activities.

Installing and configuring backup-archive clients

Following the successful setup of your IBM Spectrum Protect™ server system, install and configure client software to begin
backing up data.

Procedure

To install the backup-archive client, follow the installation instructions for your operating system.

e Install UNIX and Linux backup-archive clients
e Installing the Windows client for the first time

What to do next

Register and assign your clients to schedules.

e Registering and assigning clients to schedules
Add and register your clients through the Operations Center by using the Add Client wizard.

e Installing the client management service
Install the client management service for backup-archive clients that run on Linux and Windows operating systems. The
client management service collects diagnostic information about backup-archive clients and makes the information
available to the Operations Center for basic monitoring capability.

Registering and assighing clients to schedules

Add and register your clients through the Operations Center by using the Add Client wizard.

Before you begin

Determine whether the client requires an administrative user ID with client owner authority over the client node. To determine
which clients require an administrative user ID, see technote 7048963.

Restriction: For some types of clients, the client node name and the administrative user ID must match. You cannot authenticate
those clients by using the Lightweight Directory Access Protocol authentication method that was introduced in V7.1.7. For details
about this authentication method, sometimes referred to as integrated mode, see Authenticating users by using an Active
Directory database.

Procedure

To register a client, complete one of the following actions.

e If the client requires an administrative user ID, register the client by using the REGISTER NODE command and specify the
USERID parameter:

register node node name password userid=node name

where node_name specifies the node name and password specifies the node password. For details, see Register a node.
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e If the client does not require an administrative user ID, register the client by using the Operations Center Add Client wizard.
Complete the following steps:
a. On the Operations Center menu bar, click Clients.
b. In the Clients table, click +Client.
c. Complete the steps in the Add Client wizard:
i. Specify that redundant data can be eliminated on both the client and server. In the Client-side data
deduplication area, select the Enable check box.
ii. In the Configuration window, copy the TCPSERVERADDRESS, TCPPORT, NODENAME, and DEDUPLICATION
option values.
Tip: Record the option values and keep them in a safe place. After you complete the client registration and
install the software on the client node, use the values to configure the client.
iii. Follow the instructions in the wizard to specify the policy domain, schedule, and option set.
iv. Set how risks are displayed for the client by specifying the at-risk setting.
v. Click Add Client.

Installing the client management service

Install the client management service for backup-archive clients that run on Linux and Windows operating systems. The client
management service collects diagnostic information about backup-archive clients and makes the information available to the
Operations Center for basic monitoring capability.

Procedure

Install the client management service on the same computer as the backup-archive client by completing the following steps:

1. Download the installation package for the client management service from an IBM® download site such as IBM Passport
Advantage® or IBM Fix Central. Look for a file name that is similar to <version>-IBM Spectrum Protect-CMS-
operating system.bin.

2. Create a directory on the client system that you want to manage, and copy the installation package there.

. Extract the contents of the installation package file.

4. Run the installation batch file from the directory where you extracted the installation and associated files. This is the
directory that you created in step 2.

5. To install the client management service, follow the instructions in the IBM Installation Manager wizard. If IBM Installation
Manager is not already installed on the client system, you must select both IBM Installation Manager and IBM Spectrum
Protect™ Client Management Services.

w

e Verifying that the client management service is installed correctly
Before you use the client management service to collect diagnostic information about a backup-archive client, you can
verify that the client management service is correctly installed and configured.

e Configuring the Operations Center to use the client management service
If you did not use the default configuration for the client management service, you must configure the Operations Center to
access the client management service.

Related tasks:
B+ Configuring the client management service for custom client installations

Verifying that the client management service is installed correctly

Before you use the client management service to collect diagnostic information about a backup-archive client, you can verify that
the client management service is correctly installed and configured.

Procedure

On the client system, at the command line, run the following commands to view the configuration of the client management
service:

e On Linux client systems, issue the following command:
client install dir/cms/bin/CmsConfig.sh list

where client_install_dir is the directory where the backup-archive client is installed. For example, with the default client
installation, issue the following command:
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/opt/tivoli/tsm/cms/bin/CmsConfig.sh list
The output is similar to the following text:
Listing CMS configuration
serverl.example.com:1500 NO SSL HOSTNAME
Capabilities: [LOG QUERY]
Opt Path: /opt/tivoli/tsm/client/ba/bin/dsm.sys

Log File: /opt/tivoli/tsm/client/ba/bin/dsmerror.log
en US MM/dd/yyyy HH:mm:ss Windows-1252

Log File: /opt/tivoli/tsm/client/ba/bin/dsmsched.log
en US MM/dd/yyyy HH:mm:ss Windows-1252

e On Windows client systems, issue the following command:
client install dir\cms\bin\CmsConfig.bat list

where client_install_dir is the directory where the backup-archive client is installed. For example, with the default client
installation, issue the following command:

C:\"Program Files"\Tivoli\TSM\cms\bin\CmsConfig.bat list
The output is similar to the following text:

Listing CMS configuration

serverl.example.com:1500 NO_SSL HOSTNAME

Capabilities: [LOG QUERY]

Opt Path: C:\Program Files\Tivoli\TSM\baclient\dsm.opt

Log File: C:\Program Files\Tivoli\TSM\baclient\dsmerror.log
en US MM/dd/yyyy HH:mm:ss Windows-1252

Log File: C:\Program Files\Tivoli\TSM\baclient\dsmsched.log
en US MM/dd/yyyy HH:mm:ss Windows-1252

If the client management service is correctly installed and configured, the output displays the location of the error log file.
The output text is extracted from the following configuration file:

e On Linux client systems:
client install dir/cms/Liberty/usr/servers/cmsServer/client-configuration.xml

e On Windows client systems:

client install dir\cms\Liberty\usr\servers\cmsServer\client-configuration.xml

If the output does not contain any entries, you must configure the client-configuration.xml file. For instructions to configure this
file, see Configuring the client management service for custom client installations. You can use the CmsConfig verify command to
verify that a node definition is correctly created in the client-configuration.xml file.

Configuring the Operations Center to use the client management service

If you did not use the default configuration for the client management service, you must configure the Operations Center to access
the client management service.

Before you begin

Ensure that the client management service is installed and started on the client system. Verify whether the default configuration is
used. The default configuration is not used if either of the following conditions is met:

e The client management service does not use the default port number, 9028.
e The backup-archive client is not accessed by the same IP address as the client system where the backup-archive client is
installed. For example, a different IP address might be used in the following situations:
o The computer system has two network cards. The backup-archive client is configured to communicate on one
network, while the client management service communicates on the other network.
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o The client system is configured with the Dynamic Host Configuration Protocol (DHCP). As a result, the client system
is dynamically assigned an IP address, which is saved on the server during the previous backup-archive client
operation. When the client system is restarted, the client system might be assigned a different IP address. To ensure
that the Operations Center can always find the client system, you specify a fully qualified domain name.

Procedure

To configure the Operations Center to use the client management service, complete the following steps:

1. On the Clients page of the Operations Center, select the client.

2. Click Details > Properties.

3. In the Remote diagnostics URL field in the General section, specify the URL for the client management service on the client
system. The address must start with ht tps. The following table shows examples of the remote diagnostics URL.

Type of URL Example

With DNS host name and default port, 9028 | https://server.example.com

With DNS host name and non-default port | https://server.example.com:1599

With IP address and non-default port https://192.0.2.0:1599
4. Click Save.

What to do next

You can access client diagnostic information such as client log files from the Diagnosis tab in the Operations Center.

Configuring the second server

After you complete the configuration for the first server in your system, configure the second server.

Procedure

Complete the instructions in the following sections:

1. Configure a second server that is the same as the first server by completing the instructions in the following sections:
a. Setting up the system
b. Installing the server and Operations Center

Only one server in the multisite disk solution is configured as the hub server, so you do not need to install the
Operations Center on the second server. When you select the installation packages to install on the second server,
do not select the Operations Center.

c. Configuring the server and the Operations Center
Skip the tasks for configuring the Operations Center.

d. Installing and configuring backup-archive clients
2. Configuring SSL communications between the hub server and a spoke server
3. Adding the second server as a spoke
4. Enabling replication

Configuring SSL communications between the hub server and a spoke
server

To secure communications between the hub server and a spoke server by using the Transport Layer Security (TLS) protocol, you
must define the certificate of the spoke server to the hub server.

About this task

The hub server receives status and alert information from the spoke server and shows this information in the Operations Center.
To receive the status and alert information from the spoke server, the certificate of the spoke server must be added to the
truststore file of the hub server. You must also configure the Operations Center to monitor the spoke server.
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To enable other functions of the Operations Center, such as the automatic deployment of client updates, the certificate of the hub
server must be added to the truststore file of the spoke server.

Procedure

1. Complete the following steps to define the certificate of the spoke server to the hub server:
a. On the spoke server, change to the directory of the spoke server instance.
b. Specify the required cert256.arm certificate as the default certificate in the key database file of the spoke server.
Issue the following command:

gsk8capicmd 64 -cert -setdefault -db cert.kdb -stashed
-label "TSM Server SelfSigned SHA Key"

c. Verify the certificates in the key database file of the spoke server. Issue the following command:

gsk8capicmd 64 -cert -list -db cert.kdb -stashed

d. Securely transfer the cert256.arm file of the spoke server to the hub server.

e. On the hub server, change to the directory of the hub server instance.

f. Define the spoke server certificate to the hub server. Issue the following command from the hub server instance
directory, where spoke_servername is the name of the spoke server, and spoke_cert256.arm is the file name of the
spoke server certificate:

gsk8capicmd 64 -cert -add -db cert.kdb -stashed -format ascii
-label spoke servername -file spoke cert256.arm

2. Complete the following steps to define the certificate of the hub server to the spoke server:
a. On the hub server, change to the directory of the hub server instance.
b. Specify the required cert256.arm certificate as the default certificate in the key database file of the hub server. Issue
the following command:

gsk8capicmd 64 -cert -setdefault -db cert.kdb -stashed
-label "TSM Server SelfSigned SHA Key"

c. Verify the certificates in the key database file of the spoke server. Issue the following command:

gsk8capicmd 64 -cert -list -db cert.kdb -stashed

d. Securely transfer the cert256.arm file of the hub server to the spoke server.

e. On the spoke server, change to the directory of the spoke server instance.

. Define the hub server certificate to the spoke server. Issue the following command from the spoke server instance
directory, where hub_servername is the name of the hub server, and hub_cert256.arm is the file name of the hub
server certificate:

—

gsk8capicmd 64 -cert -add -db cert.kdb -stashed -format ascii
-label hub servername -file hub cert256.arm

3. Restart the hub server and the spoke server.
4. Complete the following steps to define the spoke server to the hub server, and the hub server to the spoke server.
a. Issue the following commands on both the hub server and the spoke server:

SET SERVERPASSWORD server password

SET SERVERHLADDRESS ip address
SET SERVERLLADDRESS tcp port

b. On the hub server, issue the DEFINE SERVER command, according to the following example:

DEFINE SERVER spoke servername HLA=spoke address
LLA=spoke SSLTCPADMINPort SERVERPA=spoke serverpassword

c. On the spoke server, issue the DEFINE SERVER command, according to the following example:

DEFINE SERVER hub servername HLA=hub address
LLA=hub SSLTCPADMINPort SERVERPA=hub serverpassword

Tip: By default, server communication is encrypted except when the server is sending or receiving object data.
Object data is sent and received by using TCP/IP. By choosing not to encrypt the object data, server performance is
similar to communication over a TCP/IP session and the session is secure. To encrypt all communication with the
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specified server, even when the server is sending and receiving object data, specify the SSL=YES parameter on the
DEFINE SERVER command.
5. Complete the following steps to configure the Operations Center to monitor the spoke server:

a. On the Operations Center menu bar, click Servers. The spoke server has a status of "Unmonitored." This status
means that, although this server was defined to the hub server by using the DEFINE SERVER command, the server is
not yet configured as a spoke.

b. Click the spoke server to highlight the item, and click Monitor Spoke.

Related reference:
* DEFINE SERVER (Define a server for server-to-server communications)
I:"QU ERY OPTION (Query server options)

Adding the second server as a spoke

After you configure both servers in your environment, add the second server as a spoke to the hub server.

Procedure

1. Open the Operations Center.

2. In the Operations Center menu bar, click Servers.

3. Complete one of the following steps:
o Click the server to highlight it, and in the table menu bar, click Monitor Spoke.
o If the server that you want to add is not shown in the table, click +Spoke.

4. Complete the steps in the spoke configuration wizard.

Enabling replication

To protect your data, enable node replication in addition to protecting your storage pools.

Procedure

To enable node replication for all of the clients that are registered to the source server, complete the following steps

1. Open the Operations Center.
2. On the Operations Center menu bar, hover over Storage and click Replication.
3. On the Replication page, click +Server Pair.
4. Complete the steps in the Add Server Pair wizard:
o Set the source server as the first server that you configured for the multisite disk solution. The target server is the
second server.
o Set the node replication schedule to start 10 hours after the client backup window, based on the server maintenance
activities that you scheduled in Defining schedules for server maintenance activities.
o The wizard sets up storage pool protection schedules for you, based on the amount of data that you are protecting
and when client replication is scheduled.

What to do next

If you plan to set up mutual replication between the two sites, run the Add Server Pair wizard again and set the second server as
the source and the first server as the target.

Completing the implementation

After the IBM Spectrum Protect™ solution is configured and running, test backup operations and set up monitoring to ensure that
everything runs smoothly.

Procedure

1. Test backup operations to verify that your data is protected in the way that you expect.
a. On the Clients page of the Operations Center, select the clients that you want to back up, and click Back Up.
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b. On the Servers page of the Operations Center, select the server for which you want to back up the database. Click
Back Up, and follow the instructions in the Back Up Database window.
c. Verify that the backup operations completed successfully with no warning or error messages.
Tip: Alternatively, you can use the backup-archive client GUI to back up client data and you can backup the server
database by issuing BACKUP DB command from an administrative command-Line.
2. Set up monitoring for your solution by following the instructions in Monitoring a multisite disk solution.

Monitoring a multisite disk solution

After you implement a multisite disk solution with IBM Spectrum Protect™, monitor the solution to ensure correct operation. By
monitoring the solution daily and periodically, you can identify existing and potential issues. The information that you gather can
be used to troubleshoot problems and optimize system performance.

About this task

The preferred way to monitor a solution is by using the Operations Center, which provides overall and detailed system status in a
graphical user interface. In addition, you can configure the Operations Center to generate a daily email report that summarizes
system status.

In some cases, you might want to use advanced monitoring tools to complete specific monitoring or troubleshooting tasks.

Tip: If you plan to diagnose issues with backup-archive clients on Linux or Windows operating systems, install IBM Spectrum
Protect client management services on each computer where a backup-archive client is installed. In this way, you can ensure that
the Diagnose button is available in the Operations Center for diagnosing issues with backup-archive clients. To install the client
management service, follow the instructions in Installing the client management service.

Procedure

1. Complete daily monitoring tasks. For instructions, see Daily monitoring checklist.

2. Complete periodic monitoring tasks. For instructions, see Periodic monitoring checklist.

3. To verify that your IBM Spectrum Protect solution complies with licensing requirements, follow the instructions in Verifying
license compliance.

4. To set up Operations Center to generate email status reports, see Tracking system status by using email reports

What to do next

Resolve any issues that you detect. To resolve an issue by changing the configuration of your solution, follow the instructions in
Managing operations for a multisite disk solution. The following resources are also available:

e To resolve performance issues, see Performance.
e To resolve other types of issues, see Troubleshooting.

Daily monitoring checklist

To ensure that you are completing the daily monitoring tasks for your IBM Spectrum Protect™ solution, review the daily monitoring
checklist.

Complete the daily monitoring tasks from the Operations Center Overview page. You can access the Overview page by opening the
Operations Center and clicking Overviews.

The following figure shows the location for completing each task.
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Storage & Data Availability

Tip: To run administrative commands for advanced monitoring tasks, use the Operations Center command builder. The command
builder provides a type-ahead function to guide you as you enter commands. To open the command builder, go to the Operations

Center Overview page. On the menu bar, hover over the settings icon E and click Command Builder.

The following table lists the daily monitoring tasks and provides instructions for completing each task.

Table 1. Daily monitoring tasks

Task Basic procedures

Advanced procedures and troubleshooting
information
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Task

Basic procedures

Advanced procedures and troubleshooting
information

Watch for security
notifications, which can
indicate a ransomware
attack.

If a potential ransomware attack is detected
in the IBM Spectrum Protect environment, a
security notification message is displayed in
the foreground of the Operations Center. For
more information, click the message to open
the Security Notifications page.

On the Security Notifications page, you can take the
following actions:

e View notification details by client.
Restriction: In Operations Center Version
8.1.5, notifications are available only for
backup-archive clients.

e Acknowledge a security notification by
selecting it and clicking Acknowledge. When
you acknowledge a security notification, a
check mark is added to the Acknowledged
column of the Security Notifications page for
the selected client. The standard by which a
notification is acknowledged is determined by
your organization. A check mark might mean
that you investigated the issue and
determined that it is a false positive. Or it
might mean that a problem exists and is being
resolved.

e Assign a security notification to an
administrator by selecting the security
notification and clicking Assign. To view the
assignment, the administrator must sign in to
the Operations Center and click Overviews >
Security. If you are not certain whether the
administrator regularly monitors the Security
Notifications page, notify the administrator
about the assignment.

e If the notification is a false positive, you can
select the security notification and click Reset.
The security notification is deleted. Historical
data that is used for baseline comparisons
with the most recent backup operation is
deleted. A new baseline is calculated going
forward.

o Determine whether
clients are at risk of
being unprotected due to
failed or missed backup
operations.

To verify whether clients are at risk, in the
Clients area, look for an At risk notification. To
view details, click the Clients area.

Attention: If the At risk percentage is much
greater than usual, it might indicate a
ransomware attack. A ransomware attack can
cause backup operations to fail, thus placing
clients at risk. For example, if the percentage
of clients at risk is normally between 5% and
10%, but the percentage increases to 40% or
50%, investigate the cause.

If you installed the client management service
on a backup-archive client, you can view and
analyze the client error and schedule logs by
completing the following steps:

1. In the Clients table, select the client
and click Details.
2. To diagnose an issue, click Diagnosis.

For clients that do not have the client management
service installed, access the client system to review
the client error logs.
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Task

Basic procedures

Advanced procedures and troubleshooting
information

9 Determine whether
client-related or server-
related errors require
attention.

To determine the severity of any reported
alerts, in the Alerts area, hover over the
columns.

To view additional information about alerts, complete
the following steps:

1. Click the Alerts area.

2. In the Alerts table, select an alert.

3. In the Activity Log pane, review the messages.
The pane displays related messages that were
issued before and after the selected alert
occurred.

0 Determine whether
servers that are
managed by the
Operations Center are
available to provide data
protection services to
clients.

. To verify whether servers are at risk, in

the Servers area, look for an
Unavailable notification.

. To view additional information, click the

Servers area.

. Select a server in the Servers table and

click Details.

Tip: If you detect an issue that is related to server
properties, update the server properties:

1. In the Servers table, select a server and click
Details.
2. To update server properties, click Properties.

o Determine whether
sufficient space is
available for the server
inventory, which consists
of the server database,
active log, and archive

log.

. Click the Servers area.
. In the Status column of the table, view

the status of the server and resolve any
issues:

o Normal ™ Sufficient space is
available for the server
database, active log, and archive
log.

o Critical @ Insufficient space is
available for the server
database, active log, or archive
log. You must add space
immediately, or the data
protection services that are
provided by the server will be
interrupted.

o Warning ‘! The server database,
active log, or archive log is
running out of space. If this
condition persists, you must add
space.

o Unavailable @ Status cannot be
obtained. Ensure that the server
is running, and that there are no
network issues. This status is
also shown if the monitoring
administrator ID is locked or
otherwise unavailable on the
server. This ID is named IBM-
OC-hub_server_name.

o Unmonitored € Unmonitored
servers are defined to the hub
server, but are not configured for
management by the Operations
Center. To configure an
unmonitored server, select the
server, and click Monitor Spoke.

You can also look for related alerts on the Alerts
page. For additional instructions about
troubleshooting, see Resolving server problems.
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Task

Basic procedures

Advanced procedures and troubleshooting
information

6 Verify server
database backup
operations.

To determine when a server was most
recently backed up, complete the following
steps:

1. Click the Servers area.
2. In the Servers table, review the Last
Database Backup column.

To obtain more detailed information about backup
operations, complete the following steps:

1. In the Servers table, select a row and click
Details.

2. In the DB Backup area, hover over the check
marks to review information about backup
operations.

If a database was not backed up recently (for
example, in the last 24 hours), you can start a backup
operation:

1. On the Operations Center Overview page, click
the Servers area.
2. In the table, select a server and click Back Up.

To determine whether the server database is
configured for automatic backup operations,
complete the following steps:

1. On the menu bar, hover over the settings icon

and click Command Builder.
2. Issue the QUERY DB command:

query db f=d

3. In the output, review the Full Device
Class Name field. If a device class is
specified, the server is configured for
automatic database backups.

0 Monitor other server
maintenance tasks.
Server maintenance
tasks can include running
administrative command
schedules, maintenance
scripts, and related
commands.

To search for information about processes
that failed because of server issues, complete
the following steps:

1. Click Servers > Maintenance.

2. To obtain the two-week history of a
process, view the History column.

3. To obtain more information about a
scheduled process, hover over the
check box that is associated with the
process.

For more information about monitoring processes
and resolving issues, see the Operations Center
online help.
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Task

Basic procedures

Advanced procedures and troubleshooting
information

o Verify that the
amount of data that was
recently sent to and from
servers is within the
expected range.

e To obtain an overview of activity in the
last 24 hours, view the Activity area.

e To compare activity in the last 24 hours
with activity in the previous 24 hours,
review the figures in the Current and
Previous areas.

e If more data was sent to the server than you
expected, determine which clients are backing
up more data and investigate the cause. It is
possible that client-side data deduplication is
not working correctly.

Attention: If the amount of backed-up data is
significantly larger than usual, it might indicate
a ransomware attack. When ransomware
encrypts data, the system perceives the data
as being changed, and the changed data is
backed up. Thus, backup volumes become
larger. To determine which clients are
affected, click the Applications, Virtual, or
Systems tabs.

e If less data was sent to the server than you
expected, investigate whether client backup
operations are proceeding on schedule.
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Task

Basic procedures

Advanced procedures and troubleshooting
information

0 Verify that storage
pools are available to
back up client data.

1. If problems are indicated in the Storage
& Data Availability area, click Pools to
view the details:

o Ifthe Critical @ status is
displayed, insufficient space is
available in the storage pool, or
its access status is unavailable.
Attention: If the status is critical,
investigate the cause:

= If the data deduplication
rate for a storage pool
drops significantly, it
might indicate a
ransomware attack.
During a ransomware
attack, data is encrypted
and cannot be
deduplicated. To verify
the data deduplication
rate, in the Storage Pools
table, review the value in
the % Savings column.

» If a storage pool
unexpectedly becomes
100% utilized, it might
indicate a ransomware
attack. To verify the
utilization, review the
value in the Capacity
Used column. Hover over
the values to see the
percentages of used and
free space.

o If the Warning ‘! status is
displayed, the storage pool is
running out of space, or its
access status is read-only.

2. To view the used, free, and total space
for your selected storage pool, hover
over the entries in the Capacity Used
column.

To view the storage-pool capacity that was used over
the past two weeks, select a row in the Storage Pools

table and click Details.
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Task Basic procedures Advanced procedures and troubleshooting
information
o . In the Storage & Data Availability area, in the | Disk devices might have a critical or warning status
Verify that storage

devices are available for
backup operations.

Volumes section, under the capacity bars,
review the status that is reported next to
Devices. If a Critical @ or Warning ' status is
displayed for any device, investigate the issue.
To view details, click Devices.

for the following reasons:

e For DISK device classes, volumes might be
offline or have a read-only access status. The
Disk Storage column of the Disk Devices table
shows the state of volumes.

e For FILE device classes that are not shared,
directories might be offline. Also, insufficient
free space might be available for allocating
scratch volumes. The Disk Storage column of
the Disk Devices table shows the state of
directories.

e For FILE device classes that are shared, drives
might be unavailable. A drive is unavailable if it
is offline, if it stopped responding to the
server, or if its path is offline. Other columns of
the Disk Devices table show the state of the
drives and paths.

@ Monitor node
replication processes.

1. To obtain the overall status of node
replication processes, view the
Replication area on the Operations
Center Overview page.

2. To view information about each
replicated server pair, click the
Replication area.

Attention: If you notice an unexpected
increase in the number of replication
failures, it might indicate a ransomware
attack. Investigate the cause of the
failures.

3. To view the amount of data that was
replicated over the last two weeks and
the speed of replication, select a server
pair and click Details.

4, To view replication information for a
client, on the Operations Center
Overview page, click Clients. View the
information in the Replication Workload
column.

Attention: If you see a drastic,
unexpected increase in the replication
workload, it might indicate a
ransomware attack. Investigate the
cause of the increased workload.

For advanced monitoring, view information about
running and ended node replication processes by
using commands:

1. On the Operations Center Overview page,

hover over the settings icon and click
Command Builder.

2. Issue the QUERY REPLICATION command. For
instructions, see QUERY REPLICATION (Query
node replication processes). If the replication
operation was completed successfully, the
Total Files To Replicate value matches
the Total Files Replicated value.

To display messages that are related to a node
replication process on a source or target replication
server, complete the following steps:

1. On the Operations Center Overview page, click
Servers.

2. Select the source or target replication server
and click Details:

o To view active tasks, click Active Tasks,
select the task, and verify that the
Running status is displayed. For details,
view the related activity logs.

o To view completed tasks, click
Completed Tasks, select the task, and
ensure that the Completed status is
displayed. For details, view the related
activity logs.

Periodic monitoring checklist

To help ensure that your solution operates correctly, complete the tasks in the periodic monitoring checklist. Schedule periodic
tasks frequently enough so that you can detect potential issues before they become problematic.
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Tip: To run administrative commands for advanced monitoring tasks, use the Operations Center command builder. The command
builder provides a type-ahead function to guide you as you enter commands. To open the command builder, go to the Operations

Center Overview page. On the menu bar, hover over the settings icon gl and click Command Builder.
Table 1. Periodic monitoring tasks

Task

Basic procedures

Advanced procedures and troubleshooting

Monitor system performance.

Determine the length of time that is
required for client backup operations:

1. On the Operations Center
Overview page, click Clients. Find
the server that is associated with
the client.

2. Click Servers. Select the server
and click Details.

3. To view the duration of
completed tasks in the last 24
hours, click Completed Tasks.

4, To view the duration of tasks that
were completed more than 24
hours ago, use the QUERY
ACTLOG command. Follow the
instructions in .

5. If the duration of client backup
operations is increasing and the
reasons are not clear, investigate
the cause.

If you installed the client management
service on a backup-archive client, you
can diagnose performance issues for
the backup-archive client by completing
the following steps:

1. On the Operations Center
Overview page, click Clients.

2. Select a backup-archive client
and click Details.

3. To retrieve client logs, click
Diagnosis.

For instructions about reducing the time that it takes
for the client to back up data to the server, see
Resolving common client performance problems.

Look for performance bottlenecks. For instructions,
see Identifying performance bottlenecks.

For information about identifying and resolving other
performance issues, see Performance.

Determine the disk savings that
are provided by data
deduplication.

1. On the Operations Center
Overview page, click Pools.

2. Select a pool and click Quick
Look.

3. In the Data Deduplication area,
view the Space saved row.

For advanced monitoring, to obtain detailed statistics
about the data-deduplication process for a specific
directory-container storage pool or cloud-container
storage pool, complete the following steps:

1. On the Operations Center Overview page,

hover over the settings icon and click
Command Builder.

2. Obtain a statistical report by issuing the
GENERATE DEDUPSTATS command. Follow
the instructions in GENERATE DEDUPSTATS
(Generate data deduplication statistics for a
directory-container storage pool).

3. View the statistical report by issuing the
QUERY DEDUPSTATS command. Follow the
instructions in QUERY DEDUPSTATS (Query
data deduplication statistics).
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Task

Basic procedures

Advanced procedures and troubleshooting

Verify that current backup files
for device configuration and
volume history information are
saved.

Access your storage locations to ensure
that the files are available. The
preferred method is to save the backup
files to two locations.

To locate the volume history and device
configuration files, complete the
following steps:

1. On the Operations Center
Overview page, hover over the

settings icon and click
Command Builder.

2. To locate the volume history and
device configuration files, issue
the following commands:

query option volhistory

query option devconfig

3. In the output, review the Option
Setting column to find the file
locations.

If a disaster occurs, both the volume
history file and the device configuration
file are required to restore the server
database.
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Task

Basic procedures

Advanced procedures and troubleshooting

Determine whether sufficient
space is available for the
instance directory file system.

Verify that at least 20% of free space is
available in the instance directory file
system. Take the action that is
appropriate for your operating system:

o INTTENTO view available
space in the file system, on the
operating system command line,
issue the following command:

df -g instance directory

where instance_directory
specifies the instance directory.
o ITTEMTO view available
space in the file system, on the
operating system command line,
issue the following command:

df -h instance directory

where instance_directory
specifies the instance directory.
o INTTTMIN the Windows
Explorer program, right-click the
file system and click Properties.
View the capacity information.

The preferred location of the instance
directory depends on the operating
system where the server is installed:

O x| Linux |
/home/tsminstl/tsminstl
o INTTTTMC:\tsminstl

Tip: If you completed a planning
worksheet, the location of the instance
directory is recorded in the worksheet.

Identify unexpected client
activity.

To monitor client activity to determine
whether data volumes exceed expected
amounts, complete the following steps:

1. On the Operations Center
Overview page, click the Clients
area.

2. To view activity over the past two
weeks, double-click any client.

3. To view the number of bytes sent
to the client, click the Properties
tab.

4. In the Last Session area, view the
Sent to client row.

When you double-click a client in the Clients table,
the Activity over 2 Weeks area displays the amount
of data that the client sent to the server each day.

Periodically review the SQL activity summary table,
which contains statistics about client sessions. To
compare current activity with previous activity, use
an SQL SELECT statement. If the level of activity is
significantly different from previous activity, it might
indicate a ransomware attack.

Periodically review the activity log. Look for ANE
messages that indicate how many files were backed
up and inspected. Compare current data
deduplication rates with previous rates. If an
unusually high number of files were backed up, or
the rate of data deduplication unexpectedly drops to
0, it might indicate a ransomware attack.
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Task

Basic procedures

Advanced procedures and troubleshooting

Monitor storage pool growth
over time.

1. On the Operations Center
Overview page, click the Pools
area.

2. To view the capacity that was
used over the last two weeks,
select a pool and click Details.

Tips:

To specify the time period that must elapse
before all deduplicated extents are removed
from a directory-container storage pool or
cloud-container storage pool after they are no
longer referenced by the inventory, complete
the following steps:

1. On the Storage Pools page of the
Operations Center, select the storage
pool.

2. Click Details > Properties.

3. Specify the duration in the Delay
period for container reuse field.

To determine data deduplication performance
for directory-container and cloud-container
storage pools, use the GENERATE
DEDUPSTATS command.

To view data deduplication statistics for a
storage pool, complete the following steps:

1. On the Storage Pools page of the
Operations Center, select the storage
pool.

2. Click Details > Properties.

Alternatively, use the QUERY
EXTENTUPDATES command to display
information about updates to data extents in
directory-container or cloud-container storage
pools. The command output can help you
determine which data extents are no longer
referenced and which ones are eligible to be
deleted from the system. In the output,
monitor the number of data extents that are
eligible to be deleted from the system. This
metric has a direct correlation to the amount
of free space that will be available within the
container storage pool.

To display the amount of physical space that is
occupied by a file space after the removal of
the data deduplication savings, use the select
* from occupancy command. The command
output includes the LOGICAL_MB value.
LOGICAL_MB is the amount of space that is
used by the file space.

Evaluate the timing of client

and end times of client
schedules meet your business
needs.

schedules. Ensure that the start

On the Operations Center Overview
page, click Clients > Schedules.

In the Schedules table, the Start
column displays the configured start
time for the scheduled operation. To
see when the most recent operation
was started, hover over the clock icon.

Tip: You can receive a warning message if a client
operation runs longer than expected. Complete the
following steps:

1.

On the Operations Center Overview page,
hover over Clients and click Schedules.

. Select a schedule and click Details.
. View the details of a schedule by clicking the

blue arrow next to the row.

. In the Run time alert field, specify the time

when a warning message will be issued if the
scheduled operation is not completed.

. Click Save.
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Task Basic procedures Advanced procedures and troubleshooting

Evaluate the timing of
maintenance tasks. Ensure that
the start and end times of
maintenance tasks meet your
business needs.

On the Operations Center Overview Tip: If a maintenance task is running too long,
page, click Servers > Maintenance. change the start time or the maximum run time.

Complete the following steps:
In the Maintenance table, review the

information in the Last Run Time 1. On the Operations Center Overview page,
column. To see when the last
maintenance task was started, hover
over the clock icon.

hover over the settings icon &l and click
Command Builder.

2. To change the start time or maximum run time
for a task, issue the UPDATE SCHEDULE
command. For instructions, see UPDATE
SCHEDULE (Update a client schedule).

Related reference:

[* QUERY ACTLOG (Query the activity log)

[ UPDATE STGPOOL (Update a storage pool)

* QUERY EXTENTUPDATES (Query updated data extents)

Verifying license compliance

Verify that your IBM Spectrum Protect™ solution complies with the provisions of your licensing agreement. By verifying
compliance regularly, you can track trends in data growth or processor value unit (PVU) usage. Use this information to plan for
future license purchasing.

About this task

The method that you use to verify that your solution complies with license terms varies depending on the provisions of your IBM
Spectrum Protect licensing agreement.

Front-end capacity licensing
The front-end model determines license requirements based on the amount of primary data that is reported as being
backed up by clients. Clients include applications, virtual machines, and systems.

Back-end capacity licensing
The back-end model determines license requirements based on the terabytes of data that are stored in primary storage
pools and repositories.
Tips:

e To ensure the accuracy of front-end and back-end capacity estimates, install the most recent version of the client
software on each client node.

e The front-end and back-end capacity information in the Operations Center is for planning and estimation purposes.

PVU licensing
The PVU model is based on the use of PVUs by server devices.
Important: The PVU calculations that are provided by IBM Spectrum Protect are considered estimates and are not legally
binding. The PVU licensing information that is reported by IBM Spectrum Protect is not considered an acceptable substitute
for the IBM® License Metric Tool.

For the most recent information about licensing models, see the information about product details and licenses at the IBM

Spectrum Protect product family website. If you have questions or concerns about licensing requirements, contact your IBM
Spectrum Protect software provider.

Procedure

To monitor license compliance, complete the steps that correspond to the provisions of your licensing agreement.

Tip: The Operations Center provides an email report that summarizes front-end and back-end capacity usage. Reports can be sent
automatically to one or more recipients regularly. To configure and manage email reports, click Reports on the Operations Center
menu bar.

Option Description

IBM Spectrum Protect Knowledge Center Version 8.1.5 179



http://www.ibm.com/support/knowledgecenter/SSEQVQ_8.1.5/srv.reference/r_cmd_schedule_client_update.html
http://www.ibm.com/support/knowledgecenter/SSEQVQ_8.1.5/srv.reference/r_cmd_actlog_query.html
http://www.ibm.com/support/knowledgecenter/SSEQVQ_8.1.5/srv.reference/r_cmd_stgpool_update.html
http://www.ibm.com/support/knowledgecenter/SSEQVQ_8.1.5/srv.reference/r_cmd_extentupdates_query.html
http://www.ibm.com/systems/storage/spectrum/protect/

Option Description

Front-end model a. On the Operations Center menu bar, hover over the settings icon il and click Licensing.
The front-end capacity estimate is displayed on the Front-end Usage page.

b. If a value is displayed in the Not Reporting column, click the number to identify clients that did
not report capacity usage.

c. To estimate capacity for clients that did not report capacity usage, go to the following FTP site,
which provides measuring tools and instructions:

ftp://public.dhe.ibm.com/storage/tivoli-storage-
management/front_end_capacity_measurement_tools

To measure front-end capacity by script, complete the instructions in the most recently
available licensing guide.

d. Add the Operations Center estimate and any estimates that you obtained by using a script.
e. Verify that the estimated capacity complies with your licensing agreement.

Back-end model Restriction: If the source and target replication servers do not use the same policy settings, you
cannot use the Operations Center to monitor back-end capacity usage for replicated clients. For
information about how to estimate capacity usage for these clients, see technote 1656476.

a. On the Operations Center menu bar, hover over the settings icon and click Licensing.
b. Click the Back-end tab.
c. Verify that the estimated amount of data complies with your licensing agreement.

PVU model For information about how to assess compliance with PVU licensing terms, see Assessing
compliance with the PVU licensing model.

Tracking system status by using email reports

Set up the Operations Center to generate email reports that summarize system status. You can configure a mail server connection,
change report settings, and optionally create custom reports.

Before you begin

Before you set up email reports, ensure that the following requirements are met:

¢ A Simple Mail Transfer Protocol (SMTP) host server is available to send and receive reports by email. The SMTP server must
be configured as an open mail relay. You must also ensure that the IBM Spectrum Protect™ server that sends email
messages has access to the SMTP server. If the Operations Center is installed on a separate computer, that computer does
not require access to the SMTP server.

e To set up email reports, you must have system privilege for the server.

e To specify the recipients, you can enter one or more email addresses or administrator IDs. If you plan to enter an
administrator ID, the ID must be registered on the hub server and must have an email address that is associated with it. To
specify an email address for an administrator, use the EMAILADDRESS parameter of the UPDATE ADMIN command.

About this task

You can configure the Operations Center to send a general operations report, a license compliance report, and one or more
custom reports. You create custom reports by selecting a template from a set of commonly used report templates or by entering
SQL SELECT statements to query managed servers.

Procedure

To set up and manage email reports, complete the following steps:

1. On the Operations Center menu bar, click Reports.
2. If an email server connection is not yet configured, click Configure Mail Server and complete the fields. After you configure
the mail server, the general operations report and license compliance report are enabled.

180 IBM Spectrum Protect Knowledge Center Version 8.1.5


http://www.ibm.com/support/docview.wss?uid=swg21656476
http://www.ibm.com/support/knowledgecenter/SSEQVQ_8.1.5/srv.admin/t_verify_compl_pvu_lic.html

3. To change report settings, select a report, click Details, and update the form.
4. Optional: To add a custom report, click + Report, and complete the fields.
Tip: To immediately run and send a report, select the report and click Send.

Results

Enabled reports are sent according to the specified settings.
Related reference:

[ UPDATE ADMIN (Update an administrator)

Managing operations for a multisite disk solution

Use this information to manage operations for a multisite disk solution with IBM Spectrum Protect™ that includes a server and
uses data deduplication for multiple locations.

e Managing the Operations Center
The Operations Center provides web and mobile access to status information about the IBM Spectrum Protect
environment. You can use the Operations Center to monitor multiple servers and to complete some administrative tasks.
The Operations Center also provides web access to the IBM Spectrum Protect command line.

e Protecting applications, virtual machines, and systems
The server protects data for clients, which can include applications, virtual machines, and systems. To start protecting
client data, register the client node with the server and select a backup schedule to protect the client data.

e Managing data storage
Manage your data for efficiency and add supported devices and media to the server to store client data.

e Managing replication
Use replication to recover data at a disaster recovery site and to maintain the same level of files on the source and target
servers. You can manage replication at the node level. You can also protect data at the storage-pool level.

e Securing the server
Secure the IBM Spectrum Protect server and data by controlling access to servers and client nodes, encrypting data, and
maintaining secure access levels and passwords.

e Stopping and starting the server
Before you complete maintenance or reconfiguration tasks, stop the server. Then, start the server in maintenance mode.
When you are finished with the maintenance or reconfiguration tasks, restart the server in production mode.

e Planning to upgrade the server
When a fix pack or interim fix becomes available, you can upgrade the IBM Spectrum Protect server to take advantage of
product improvements. Servers and clients can be upgraded at different times. Ensure that you complete the planning
steps before you upgrade the server.

e Preparing for an outage or system update
Prepare IBM Spectrum Protect to maintain your system in a consistent state during a planned power outage or system
update.

e Implementing a disaster recovery plan
Implement a disaster recovery strategy to recover your applications if a disaster occurs and to ensure high server
availability.

e Recovering from data loss or system outages
You can use IBM Spectrum Protect to recover data that was lost when a disaster or system outage occurred. You can
recover directory-container storage pools, client data, and databases.

Managing the Operations Center

The Operations Center provides web and mobile access to status information about the IBM Spectrum Protect™ environment. You
can use the Operations Center to monitor multiple servers and to complete some administrative tasks. The Operations Center also
provides web access to the IBM Spectrum Protect command line.

e Adding and removing spoke servers
In a multiple-server environment, you can connect the other servers, called spoke servers, to the hub server.

e Starting and stopping the web server
The web server of the Operations Center runs as a service and starts automatically. You might have to stop and start the
web server, for example, to make configuration changes.

e Restarting the initial configuration wizard
You might need to restart the initial configuration wizard of the Operations Center, for example, to make configuration
changes.
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e Changing the hub server
You can use the Operations Center to remove the hub server of IBM Spectrum Protect, and configure another hub server.
e Restoring the configuration to the preconfiguration state
If certain problems occur, you might want to restore the Operations Center configuration to the preconfigured state where
the IBM Spectrum Protect servers are not defined as hub or spoke servers.

Adding and removing spoke servers

In a multiple-server environment, you can connect the other servers, called spoke servers, to the hub server.

About this task

The spoke servers send alerts and status information to the hub server. The Operations Center shows you a consolidated view of
alerts and status information for the hub server and any spoke servers.

e Adding a spoke server

After you configure the hub server for the Operations Center, you can add one or more spoke servers to the hub server.
e Removing a spoke server

You can remove a spoke server from the Operations Center.

Adding a spoke server

After you configure the hub server for the Operations Center, you can add one or more spoke servers to the hub server.

Before you begin

Communication between the spoke server and the hub server must be secured by using the Transport Layer Security (TLS)
protocol. To secure communication, add the certificate of the spoke server to the truststore file of the hub server.

Procedure

1. In the Operations Center menu bar, click Servers. The Servers page opens.

In the table on the Servers page, a server might have a status of "Unmonitored.” This status means that although an
administrator defined this server to the hub server by using the DEFINE SERVER command, the server is not yet configured
as a spoke server.

2. Complete one of the following steps:
o Click the server to highlight it, and in the table menu bar, click Monitor Spoke.
o If the server that you want to add is not shown in the table, and secure SSL/TLS communication is not required, click
+ Spoke in the table menu bar.
3. Provide the necessary information, and complete the steps in the spoke configuration wizard.
Tip: If the event-record retention period of the server is less than 14 days, the period is automatically reset to 14 days if you
configure the server as a spoke server.

Removing a spoke server

You can remove a spoke server from the Operations Center.

About this task

You might need to remove a spoke server in the following situations, for example:

® You want to move the spoke server from one hub server to another hub server.
® You want to decommission the spoke server.

Procedure

To remove the spoke server from the group of servers that are managed by the hub server, complete the following steps:
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1. From the IBM Spectrum Protect™ command line, issue the following command on the hub server:

QUERY MONITORSETTINGS

2. From the output of the command, copy the name that is in the Monitored Group field.
3. Issue the following command on the hub server, where group_name represents the name of the monitored group, and
member_name represents the name of the spoke server:

DELETE GRPMEMBER group name member name

4. Optional: If you want to move the spoke server from one hub server to another hub server, do noet complete this step.
Otherwise, you can disable alerting and monitoring on the spoke server by issuing the following commands on the spoke
server:

SET STATUSMONITOR OFF
SET ALERTMONITOR OFF

5. Optional: If the spoke server definition is used for other purposes, such as enterprise configuration, command routing,
storing virtual volumes, or library management, do not complete this step. Otherwise, you can delete the spoke server
definition on the hub server by issuing the following command on the hub server:

DELETE SERVER spoke server name

Tip: If a server definition is deleted immediately after the server is removed from the monitored group, status information
for the server can remain in the Operations Center indefinitely.

To avoid this issue, wait until the status collection interval passes before you delete the server definition. The status
collection interval is shown on the Settings page of the Operations Center.

Starting and stopping the web server

The web server of the Operations Center runs as a service and starts automatically. You might have to stop and start the web
server, for example, to make configuration changes.

Procedure

1. Stop the web server.
o MM rom the /installation_dir/ui/utils directory, where installation_dir represents the directory where the
Operations Center is installed, issue the following command:

./stopserver.sh
o ITITEMIssue the following command:
service opscenter.rc stop

o INITITTMFrom the Services window, stop the IBM Spectrum Protect™ Operations Center service.
2. Start the web server.
o MM rom the /installation_dir/ui/utils directory, where installation_dir represents the directory where the
Operations Center is installed, issue the following command:

./startserver.sh
o IEITEMIssue the following commands:
Start the server:
service opscenter.rc start
Restart the server:
service opscenter.rc restart
Determine whether the server is running:
service opscenter.rc status

o INITTTMFrom the Services window, start the IBM Spectrum Protect Operations Center service.
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Restarting the initial configuration wizard

You might need to restart the initial configuration wizard of the Operations Center, for example, to make configuration changes.

Before you begin

To change the following settings, use the Settings page in the Operations Center rather than restarting the initial configuration
wizard:

e The frequency at which status data is refreshed
e The duration that alerts remain active, inactive, or closed
e The conditions that indicate that clients are at risk

The Operations Center help includes more information about how to change these settings.

About this task

To restart the initial configuration wizard, you must delete a properties file that includes information about the hub server
connection. However, any alerting, monitoring, at-risk, or multiserver settings that were configured for the hub server are not
deleted. These settings are used as the default settings in the configuration wizard when the wizard restarts.

Procedure

1. Stop the Operations Center web server.
2. On the computer where the Operations Center is installed, go to the following directory, where installation_dir represents
the directory in which the Operations Center is installed:
o IETNNNNNTTTEN nstallation_dir/ui/Liberty/ust/servers/guiServer
o I Minstallation_dir\ui\Liberty\usr\servers\guiServer
For example:
o [T NTITEM opt/tivoli/tsm/ui/Liberty/usr/servers/guiServer
o IIITTMc:\Program Files\Tivoli\TSM\ui\Liberty\usr\servers\guiServer
. In the guiServer directory, delete the serverConnection.properties file.
. Start the Operations Center web server.
. Open the Operations Center.

[o )6, ¥ SN OV

ID.
7. On any spoke servers that were previously connected to the hub server, update the password for the monitoring
administrator ID by issuing the following command from the IBM Spectrum Protect™ command-Lline interface:

UPDATE ADMIN IBM-OC-hub server name new password

Restriction: Do not change any other settings for this administrator ID. After you specify the initial password, this password
is managed automatically by the Operations Center.

Changing the hub server

. Use the configuration wizard to reconfigure the Operations Center. Specify a new password for the monitoring administrator

You can use the Operations Center to remove the hub server of IBM Spectrum Protect™, and configure another hub server.

Procedure

1. Restart the initial configuration wizard of the Operations Center. As part of this procedure, you delete the existing hub
server connection.
2. Use the wizard to configure the Operations Center to connect to the new hub server.

Related tasks:
Restarting the initial configuration wizard

Restoring the configuration to the preconfiguration state
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If certain problems occur, you might want to restore the Operations Center configuration to the preconfigured state where the IBM
Spectrum Protect™ servers are not defined as hub or spoke servers.

Procedure

To restore the configuration, complete the following steps:

1. Stop the Operations Center web server.
2. Unconfigure the hub server by completing the following steps:
a. On the hub server, issue the following commands:

SET MONITORINGADMIN ""

SET MONITOREDSERVERGROUP ""

SET STATUSMONITOR OFF

SET ALERTMONITOR OFF

REMOVE ADMIN IBM-OC-hub_ server name

Tip: IBM-OC-hub_server name represents the monitoring administrator ID that was automatically created when
you initially configured the hub server.
b. Reset the password for the hub server by issuing the following command on the hub server:

SET SERVERPASSWORD ""

Attention: Do not complete this step if the hub server is configured with other servers for other purposes, such as
library sharing, exporting and importing of data, or node replication.
3. Unconfigure any spoke servers by completing the following steps:
a. On the hub server, to determine whether any spoke servers remain as members of the server group, issue the
following command:

QUERY SERVERGROUP IBM-OC-hub server name

Tip: IBM-OC-hub_server name represents the name of the monitored server group that was automatically created
when you configured the first spoke server. This server group name is also the same as the monitoring administrator
ID that was automatically created when you initially configured the hub server.

b. On the hub server, to delete spoke servers from the server group, issue the following command for each spoke
server:

DELETE GRPMEMBER IBM-OC-hub server name spoke server name

c. After all spoke servers are deleted from the server group, issue the following commands on the hub server:

DELETE SERVERGROUP IBM-OC-hub server name
SET MONITOREDSERVERGROUP ""

d. On each spoke server, issue the following commands:

REMOVE ADMIN IBM-OC-hub_ server name
SETOPT PUSHSTATUS NO
SET ALERTMONITOR OFF
SET STATUSMONITOR OFF

e. On each spoke server, delete the definition of the hub server by issuing the following command:
DELETE SERVER hub server name

Attention: Do not complete this step if the definition is used for other purposes, such as library sharing, exporting
and importing of data, or node replication.
. On the hub server, delete the definition of each spoke server by issuing the following command:

—

DELETE SERVER spoke server name

Attention: Do not complete this step if the server definition is used for other purposes, such as library sharing,
exporting and importing of data, or node replication.
4. Restore the default settings on each server by issuing the following commands:

SET STATUSREFRESHINTERVAL 5
SET ALERTUPDATEINTERVAL 10
SET ALERTACTIVEDURATION 480
SET ALERTINACTIVEDURATION 480
SET ALERTCLOSEDDURATION 60
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SET STATUSATRISKINTERVAL TYPE=AP INTERVAL=24
SET STATUSATRISKINTERVAL TYPE=VM INTERVAL=24
SET STATUSATRISKINTERVAL TYPE=SY INTERVAL=24
SET STATUSSKIPASFAILURE YES TYPE=ALL

5. Restart the initial configuration wizard of the Operations Center.

Related tasks:
Restarting the initial configuration wizard
Starting and stopping the web server

Protecting applications, virtual machines, and systems

The server protects data for clients, which can include applications, virtual machines, and systems. To start protecting client data,
register the client node with the server and select a backup schedule to protect the client data.

e Adding clients
After you implement a data protection solution with IBM Spectrum Protect, you can expand the solution by adding clients.
e Managing client operations
You can evaluate and resolve errors that are related to a backup-archive client by using the Operations Center, which
provides suggestions for resolving errors. For errors on other types of clients, you must examine the error logs on the client
and review the product documentation.
e Managing client upgrades
When a fix pack or interim fix becomes available for a client, you can upgrade the client to take advantage of product
improvements. Servers and clients can be upgraded at different times and can be at different levels with some restrictions.
e Decommissioning a client node
If a client node is no longer required, you can start a process to remove it from the production environment. For example, if
a workstation was backing up data to the IBM Spectrum Protect server, but the workstation is no longer used, you can
decommission the workstation.
e Deactivating data to free storage space
In some cases, you can deactivate data that is stored on the IBM Spectrum Protect server. When you run the deactivation
process, any backup data that was stored before the specified date and time is deactivated and will be deleted as it expires.
In this way, you can free space on the server.

Adding clients

After you implement a data protection solution with IBM Spectrum Protect™, you can expand the solution by adding clients.

About this task

The procedure describes basic steps for adding a client. For more specific instructions about configuring clients, see the
documentation for the product that you install on the client node. You can have the following types of client nodes:

Application client nodes
Application client nodes include email servers, databases, and other applications. For example, any of the following
applications can be an application client node:

e IBM Spectrum Protect Snapshot

e IBM Spectrum Protect for Databases

e IBM Spectrum Protect for Enterprise Resource Planning
IBM Spectrum Protect for Mail

e IBM Spectrum Protect for Virtual Environments

System client nodes
System client nodes include workstations, network-attached storage (NAS) file servers, and API clients.
Virtual machine client nodes

Virtual machine client nodes consist of an individual guest host within a hypervisor. Each virtual machine is represented as
a file space.

Procedure

To add a client, complete the following steps:
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1. Select the software to install on the client node and plan the installation. Follow the instructions in Selecting the client
software and planning the installation.

2. Specify how to back up and archive client data. Follow the instructions in Specifying rules for backing up and archiving

client data.

. Specify when to back up and archive client data. Follow the instructions in Scheduling backup and archive operations.

. To allow the client to connect to the server, register the client. Follow the instructions in Registering clients.

5. To start protecting a client node, install and configure the selected software on the client node. Follow the instructions in
Installing and configuring clients.

FoNOV)

Selecting the client software and planning the installation

Different types of data require different types of protection. Identify the type of data that you must protect and select the
appropriate software.

About this task

The preferred practice is to install the backup-archive client on all client nodes so that you can configure and start the client
acceptor on the client node. The client acceptor is designed to efficiently run scheduled operations.

The client acceptor runs schedules for the following products: the backup-archive client, IBM Spectrum Protect™ for Databases,
IBM Spectrum Protect for Enterprise Resource Planning, IBM Spectrum Protect for Mail, and IBM Spectrum Protect for Virtual
Environments. If you install a product for which the client acceptor does not run schedules, you must follow the configuration
instructions in the product documentation to ensure that scheduled operations can occur.

Procedure

Based on your goal, select the products to install and review the installation instructions.
Tip: If you install the client software now, you must also complete the client configuration tasks that are described in Installing
and configuring clients before you can use the client.

Goal

Product and description Installation instructions

Protect a file
server or
workstation

The backup-archive client backs up and .

archives files and directories from file
servers and workstations to storage. You can
also restore and retrieve backup versions
and archived copies of files.

Backup-archive client requirements

e Install UNIX and Linux backup-archive
clients

e Installing the Windows client for the first

time

Protect
applications with
shapshot backup
and restore
capabilities

IBM Spectrum Protect Snapshot protects
data with integrated, application-aware
snapshot backup and restore capabilities.
You can protect data that is stored by IBM
DB2¢® database software and SAP, Oracle,
Microsoft Exchange, and Microsoft SQL
Server applications.

e Installing and upgrading IBM Spectrum
Protect Snapshot for UNIX and Linux

e Installing and upgrading IBM Spectrum
Protect Snapshot for VMware

e Installing and upgrading IBM Spectrum
Protect Snapshot for Windows

Protect an email
application on an
IBM Domino®
server

IBM Spectrum Protect for Mail: Data
Protection for IBM® Domino automates data
protection so that backups are completed
without shutting down IBM Domino servers.

e Installation of Data Protection for IBM
Domino on a UNIX, AIX, or Linux system
(vV7.1.0)

e Installation of Data Protection for IBM
Domino on a Windows system (V7.1.0)

Protect an email
applicationon a
Microsoft

Exchange server

IBM Spectrum Protect for Mail: Data
Protection for Microsoft Exchange Server
automates data protection so that backups
are completed without shutting down
Microsoft Exchange servers.

Installing, upgrading, and migrating IBM
Spectrum Protect for Mail: Data Protection for
Microsoft Exchange Server

Protect an IBM
DB2 database

The application programming interface (API)
of the backup-archive client can be used to
back up DB2 data to the IBM Spectrum
Protect server.

Installing the IBM Spectrum Protect backup-
archive clients (UNIX, Linux, and Windows)
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Goal Product and description Installation instructions

Protect an IBM The API of the backup-archive client can be |Installing the IBM Spectrum Protect backup-

Informix® used to back up Informix data to the IBM archive clients (UNIX, Linux, and Windows)
database Spectrum Protect server.
Protect a IBM Spectrum Protect for Databases: Data | Installing Data Protection for SQL Server on
Microsoft SQL Protection for Microsoft SQL Server protects | Windows Server Core
database Microsoft SQL data.
Protect an Oracle |IBM Spectrum Protect for Databases: Data | Data Protection for Oracle installation
database Protection for Oracle protects Oracle data.
Protect an SAP IBM Spectrum Protect for Enterprise e Installing IBM Spectrum Protect for
environment Resource Planning: Data Protection for SAP Enterprise Resource Planning: Data
provides protection that is customized for Protection for SAP for DB2
SAP environments. The product is designed e Installing IBM Spectrum Protect for
to improve the availability of SAP database Enterprise Resource Planning: Data
servers and reduce administration workload. Protection for SAP for Oracle
Protect avirtual |IBM Spectrum Protect for Virtual e Installing Data Protection for Microsoft
machine Environments provides protection that is Hyper-V
tailored for Microsoft Hyper-V and VMware e Installing and upgrading Data Protection
virtual environments. You can use IBM for VMware
Spectrum Protect for Virtual Environments e Installing the IBM Spectrum Protect
to create incremental forever backups that backup-archive clients (UNIX, Linux, and
are stored on a centralized server, create Windows)

backup policies, and restore virtual
machines or individual files.

Alternatively, use the backup-archive client
to back up and restore a full VMware or
Microsoft Hyper-V virtual machine. You can
also back up and restore files or directories
from a VMware virtual machine.

Tip: To use the client for space management, you can install IBM Spectrum Protect for Space Management or IBM Spectrum
Protect HSM for Windows.

Specifying rules for backing up and archiving client data

Before you add a client, ensure that appropriate rules are specified for backup and archive operations for the client data. During
the client registration process, you assign the client node to a policy domain, which has the rules that control how and when client
data is stored.

Before you begin

Determine how to proceed:

e If you are familiar with the policies that are configured for your solution and you know that they do not require changes,
continue with Scheduling backup and archive operations.
e If you are not familiar with the policies, follow the steps in this procedure.

About this task

Policies affect how much data is stored over time, and how long data is retained and available for clients to restore. To meet
objectives for data protection, you can update the default policy and create your own policies. A policy includes the following
rules:

e How and when files are backed up and archived to server storage.
e The number of copies of a file and the length of time copies are kept in server storage.

During the client registration process, you assign a client to a policy domain. The policy for a specific client is determined by the
rules in the policy domain to which the client is assigned. In the policy domain, the rules that are in effect are in the active policy
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set.

When a client backs up or archives a file, the file is bound to a management class in the active policy set of the policy domain. A
management class is the key set of rules for managing client data. The backup and archive operations on the client use the
settings in the default management class of the policy domain unless you further customize policy. A policy can be customized by
defining more management classes and assigning their use through client options.

Client options can be specified in a local, editable file on the client system and in a client option set on the server. The options in
the client option set on the server can override or add to the options in the local client option file.

Procedure

1. Review the policies that are configured for your solution by following the instructions in Viewing policies.

2. If you need to make minor changes to meet data retention requirements, follow the instructions in Editing policies.

3. Optional: If you need to create policy domains or make extensive changes to policies to meet data retention requirements,
see Customizing policies.

Viewing policies

View policies to determine whether they must be edited to meet your requirements.

Procedure

1. To view the active policy set for a policy domain, complete the following steps:
a. On the Services page of the Operations Center, select a policy domain and click Details.
b. On the Summary page for the policy domain, click the Policy Sets tab.
Tip: To help ensure that you can recover data after a ransomware attack, apply the following guidelines:
= Ensure that the value in the Backups column is a minimum of 2. The preferred value is 3, 4, or more.
= Ensure that the value in the Keep Extra Backups column is a minimum of 14 days. The preferred value is 30 or
more days.
m Ensure that the value in the Keep Archives column is a minimum of 30 days.
If IBM Spectrum Protect™ for Space Management software is installed on the client, ensure that data is backed up
before you migrate it. On the DEFINE MGMTCLASS or UPDATE MGMTCLASS command, specify
MIGREQUIRESBKUP=YES. Then, follow the guidelines in the tip.
2. To view inactive policy sets for a policy domain, complete the following steps:
a. On the Policy Sets page, click the Configure toggle. You can now view and edit the policy sets that are inactive.
b. Scroll through the inactive policy sets by using the forward and back arrows. When you view an inactive policy set,
the settings that differentiate the inactive policy set from the active policy set are highlighted.
c. Click the Configure toggle. The policy sets are no longer editable.

Editing policies

To change the rules that apply to a policy domain, edit the active policy set for the policy domain. You can also activate a different
policy set for a domain.

Before you begin

Changes to policy can affect data retention. Ensure that you continue to back up data that is essential to your organization so that
you can restore that data if a disaster occurs. Also, ensure that your system has sufficient storage space for planned backup
operations.

About this task

You edit a policy set by changing one or more management classes within the policy set. If you edit the active policy set, the
changes are not available to clients unless you reactivate the policy set. To make the edited policy set available to clients, activate
the policy set.

Although you can define multiple policy sets for a policy domain, only one policy set can be active. When you activate a different
policy set, it replaces the currently active policy set.

To learn about preferred practices for defining policies, see Customizing policies.
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Procedure

1. On the Services page of the Operations Center, select a policy domain and click Details.
2. On the Summary page for the policy domain, click the Policy Sets tab.

The Policy Sets page indicates the name of the active policy set and lists all of the management classes for that policy set.

3. Click the Configure toggle. The policy set is editable.
4. Optional: To edit a policy set that is not active, click the forward and back arrows to locate the policy set.
5. Edit the policy set by completing any of the following actions:

Option Description

Add a management class a. In the Policy Sets table, click +Management Class.

b. To specify the rules for backing up and archiving data, complete the fields in the
Add Management Class window.

c. To make the management class the default management class, select the Make
default check box.

d. Click Add.

Delete a management class |In the Management Class column, click -.
Tip: To delete the default management class, you must first assign a different
management class as the default.

Make a management class | In the Default column for the management class, click the radio button.

the default management Tip: The default management class manages client files when another management class
class is not assigned to, or appropriate for managing, a file. To ensure that clients can always
back up and archive files, choose a default management class that contains rules for both
backing up and archiving files.

Modify a management class | To change the properties of a management class, update the fields in the table.

6. Click Save.
Attention: When you activate a new policy set, data might be lost. Data that is protected under one policy set might not be
protected under another policy set. Therefore, before you activate a policy set, ensure that the differences between the
previous policy set and the new policy set do not cause data to be lost.

7. Click Activate. A summary of the differences between the active policy set and the new policy set is displayed. Ensure that
the changes in the new policy set are consistent with your data retention requirements by completing the following steps:

a. Review the differences between corresponding management classes in the two policy sets, and consider the
consequences for client files. Client files that are bound to management classes in the active policy set will be bound
to the management classes with the same names in the new policy set.

b. Identify management classes in the active policy set that do not have counterparts in the new policy set, and
consider the consequences for client files. Client files that are bound to these management classes will be managed
by the default management class in the new policy set.

c. If the changes to be implemented by the policy set are acceptable, select the I understand that these updates can
cause data loss check box and click Activate.

Scheduling backup and archive operations

Before you register a new client with the server, ensure that a schedule is available to specify when backup and archive operations
take place. During the registration process, you assign a schedule to the client.

Before you begin

Determine how to proceed:

e If you are familiar with the schedules that are configured for the solution and you know that they do not require
modification, continue with Registering clients.
e If you are not familiar with the schedules or the schedules require modification, follow the steps in this procedure.

About this task

Typically, backup operations for all clients must be completed daily. Schedule client and server workloads to achieve the best
performance for your storage environment. To avoid the overlap of client and server operations, consider scheduling client backup
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and archive operations so that they run at night. If client and server operations overlap or are not given enough time and resources
to be processed, you might experience decreased system performance, failed operations, and other issues.

Procedure

1. Review available schedules by hovering over Clients on the Operations Center menu bar. Click Schedules.
2. Optional: Modify or create a schedule by completing the following steps:

Option Description

Modify a a. In the Schedules view, select the schedule and click Details.

schedule b. On the Schedule Details page, view details by clicking the blue arrows at the beginning of the
rows.

c. Modify the settings in the schedule, and click Save.

Create a In the Schedules view, click +Schedule and complete the steps to create a schedule.
schedule

3. Optional: To configure schedule settings that are not visible in the Operations Center, use a server command. For example,
you might want to schedule a client operation that backs up a specific directory and assigns it to a management class other
than the default.

a. On the Overview page of the Operations Center, hover over the settings icon and click Command Builder.

b. Issue the DEFINE SCHEDULE command to create a schedule or the UPDATE SCHEDULE command to modify a
schedule. For more information about the commands, see DEFINE SCHEDULE (Define a schedule for an
administrative command) or UPDATE SCHEDULE (Update a client schedule).

Related tasks:
B*Tuning the schedule for daily operations

Registering clients

Register a client to ensure that the client can connect to the server, and the server can protect client data.

Before you begin

Determine whether the client requires an administrative user ID with client owner authority over the client node. To determine
which clients require an administrative user ID, see technote 7048963.

Restriction: For some types of clients, the client node name and the administrative user ID must match. You cannot authenticate
those clients by using the Lightweight Directory Access Protocol authentication method that was introduced in V7.1.7. For details
about this authentication method, sometimes referred to as integrated mode, see Authenticating users by using an Active
Directory database.

Procedure

To register a client, complete one of the following actions.

e If the client requires an administrative user ID, register the client by using the REGISTER NODE command and specify the
USERID parameter:

register node node name password userid=node name

where node_name specifies the node name and password specifies the node password. For details, see Register a node.
e If the client does not require an administrative user ID, register the client by using the Operations Center Add Client wizard.
Complete the following steps:
a. On the Operations Center menu bar, click Clients.
b. In the Clients table, click +Client.
c. Complete the steps in the Add Client wizard:
i. Specify that redundant data can be eliminated on both the client and server. In the Client-side data
deduplication area, select the Enable check box.
ii. In the Configuration window, copy the TCPSERVERADDRESS, TCPPORT, NODENAME, and DEDUPLICATION
option values.
Tip: Record the option values and keep them in a safe place. After you complete the client registration and
install the software on the client node, use the values to configure the client.
iii. Follow the instructions in the wizard to specify the policy domain, schedule, and option set.
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iv. Set how risks are displayed for the client by specifying the at-risk setting.
v. Click Add Client.

Related reference:

[* Tcpserveraddress option
I Tepport option

* Nodename option

[* Deduplication option

Installing and configuring clients

To start protecting a client node, you must install and configure the selected software.

Procedure

If you already installed the software, start at step 2.

1. Take one of the following actions:
o To install software on an application or client node, follow the instructions.

Software Link to instructions
IBM Spectrum Protect™ backup- = Install UNIX and Linux backup-archive clients
archive client = Installing the Windows client for the first time

Tip: You can also update existing clients by using the Operations Center. For
instructions, see Scheduling client updates.

IBM Spectrum Protect for = Data Protection for Oracle installation
Databases = Installing Data Protection for SQL Server on Windows Server Core
IBM Spectrum Protect for Mail = Installation of Data Protection for IBM Domino on a UNIX, AIX, or

Linux system (V7.1.0)

= Installation of Data Protection for IBM Domino on a Windows system
(V7.1.0)

= Installing, upgrading, and migrating IBM Spectrum Protect for Mail:
Data Protection for Microsoft Exchange Server

IBM Spectrum Protect Snapshot = Installing and upgrading IBM Spectrum Protect Snapshot for UNIX and
Linux

= Installing and upgrading IBM Spectrum Protect Snapshot for VMware

= Installing and upgrading IBM Spectrum Protect Snapshot for Windows

IBM Spectrum Protect for = Installing IBM Spectrum Protect for Enterprise Resource Planning:

Enterprise Resource Planning Data Protection for SAP for DB2®

= Installing IBM Spectrum Protect for Enterprise Resource Planning:
Data Protection for SAP for Oracle

o To install software on a virtual machine client node, follow the instructions for the selected backup type.

Backup type Link to instructions
If you plan to create full VMware = Install UNIX and Linux backup-archive clients
backups of virtual machines, install = Installing the Windows client for the first time

and configure the IBM Spectrum
Protect backup-archive client.

If you plan to create incremental = IBM Spectrum Protect for Virtual Environments online product
forever full backups of virtual documentation

machines, install and configure IBM | Tip: You can obtain the software for IBM Spectrum Protect for Virtual
Spectrum Protect for Virtual Environments and the backup-archive client in the IBM Spectrum Protect
Environments and the backup- for Virtual Environments installation package.

archive client on the same client
node or on different client nodes.

2. To allow the client to connect to the server, add or update the values for the TCPSERVERADDRESS, TCPPORT, and
NODENAME options in the client options file. Use the values that you recorded when you registered the client (Registering
clients).
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o For clients that are installed on an AIX®, Linux, or Mac OS X operating system, add the values to the client system-
options file, dsm.sys.
o For clients that are installed on a Windows operating system, add the values to the dsm.opt file.
By default, the options files are in the installation directory.
3. If you installed a backup-archive client on a Linux or Windows operating system, install the client management service on
the client. Follow the instructions in Installing the client management service.
4. Configure the client to run scheduled operations. Follow the instructions in Configuring the client to run scheduled
operations.
5. Optional: Configure communications through a firewall. Follow the instructions in Configuring client/server communications
through a firewall.
6. Run a test backup to verify that data is protected as you planned. For example, for a backup-archive client, complete the
following steps:
a. On the Clients page of the Operations Center, select the client that you want to back up, and click Back Up.
b. Verify that the backup completes successfully and that there are no warning or error messages.
7. Monitor the results of the scheduled operations for the client in the Operations Center.

What to do next

To change what is getting backed up from the client, follow the instructions in Modifying the scope of a client backup.

Configuring the client to run scheduled operations

You must configure and start a client scheduler on the client node. The client scheduler enables communication between the
client and server so that scheduled operations can occur. For example, scheduled operations typically include backing up files
from a client.

About this task

The preferred method is to install the backup-archive client on all client nodes so that you can configure and start the client
acceptor on the client node. The client acceptor is designed to efficiently run scheduled operations. The client acceptor manages
the client scheduler so that the scheduler runs only when required:

e When it is time to query the server about the next scheduled operation
e When it is time to start the next scheduled operation

By using the client acceptor, you can reduce the number of background processes on the client and help to avoid memory
retention problems.

The client acceptor runs schedules for the following products: the backup-archive client, IBM Spectrum Protect™ for Databases,
IBM Spectrum Protect for Enterprise Resource Planning, IBM Spectrum Protect for Mail, and IBM Spectrum Protect for Virtual
Environments. If you installed a product for which the client acceptor does not run schedules, follow the configuration instructions
in the product documentation to ensure that scheduled operations can occur.

If your business uses a third-party scheduling tool as standard practice, you can use that scheduling tool as an alternative to the
client acceptor. Typically, third-party scheduling tools start client programs directly by using operating system commands. To
configure a third-party scheduling tool, see the product documentation.

Procedure

To configure and start the client scheduler by using the client acceptor, follow the instructions for the operating system that is
installed on the client node:

AIX® and Oracle Solaris

a. From the backup-archive client GUI, click Edit > Client Preferences.

b. Click the Web Client tab.

c. In the Managed Services Options field, click Schedule. If you also want the client acceptor to manage the web client,
click the Both option.

d. To ensure that the scheduler can start unattended, in the dsm.sys file, set the passwordaccess option to generate.

e. To store the client node password, issue the following command and enter the client node password when
prompted:

dsmc query sess
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. Start the client acceptor by issuing the following command on the command line:

/usr/bin/dsmcad

g. To enable the client acceptor to start automatically after a system restart, add the following entry to the system
startup file (typically, /etc/inittab):

tsm::once:/usr/bin/dsmcad > /dev/null 2>&1 # Client Acceptor Daemon

Linux
a. From the backup-archive client GUI, click Edit > Client Preferences.
b. Click the Web Client tab.
c¢. In the Managed Services Options field, click Schedule. If you also want the client acceptor to manage the web client,
click the Both option.
d. To ensure that the scheduler can start unattended, in the dsm.sys file, set the passwordaccess option to generate.
e. To store the client node password, issue the following command and enter the client node password when
prompted:
dsmc query sess
f. Start the client acceptor by logging in with the root user ID and issuing the following command:
service dsmcad start
g. To enable the client acceptor to start automatically after a system restart, add the service by issuing the following
command at a shell prompt:
# chkconfig --add dsmcad
MAC 0S X
a. In the backup-archive client GUI, click Edit > Client Preferences.
b. To ensure that the scheduler can start unattended, click Authorization, select Password Generate, and click Apply.
c. To specify how services are managed, click Web Client, select Schedule, click Apply, and click OK.
d. To ensure that the generated password is saved, restart the backup-archive client.
e. Use the IBM Spectrum Protect Tools for Administrators application to start the client acceptor.
Windows
a. In the backup-archive client GUI, click Utilities > Setup Wizard > Help me configure the Client Scheduler. Click Next.
b. Read the information on the Scheduler Wizard page and click Next.
c. On the Scheduler Task page, select Install a new or additional scheduler and click Next.
d. On the Scheduler Name and Location page, specify a name for the client scheduler that you are adding. Then, select
Use the Client Acceptor daemon (CAD) to manage the scheduler and click Next.
e. Enter the name that you want to assign to this client acceptor. The default name is Client Acceptor. Click Next.
f. Complete the configuration by stepping through the wizard.
g. Update the client options file, dsm.opt, and set the passwordaccess option to generate.
h. To store the client node password, issue the following command at the command prompt:

dsmc query sess

Enter the client node password when prompted.

. Start the client acceptor service from the Services Control page. For example, if you used the default name, start the
Client Acceptor service. Do not start the scheduler service that you specified on the Scheduler Name and Location
page. The scheduler service is started and stopped automatically by the client acceptor service as needed.

Configuring client/server communications through a firewall

If a client must communicate with a server through a firewall, you must enable client/server communications through the firewall.

Before you begin

If you used the Add Client wizard to register a client, find the option values in the client options file that you obtained during that
process. You can use the values to specify ports.
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About this task

Attention: Do not configure a firewall in a way that might cause termination of sessions that are in use by a server or storage agent.
Termination of a valid session can cause unpredictable results. Processes and sessions might appear to stop due to input/output
errors. To help exclude sessions from timeout restrictions, configure known ports for IBM Spectrum Protect™ components. Ensure
that the KEEPALIVE server option remains set to the default value of YES. In this way, you can help to ensure that client/server
communication is uninterrupted. For instructions about setting the KEEPALIVE server option, see KEEPALIVE.

Procedure

Open the following ports to allow access through the firewall:

TCP/IP port for the backup-archive client, command-line administrative client, and the client scheduler
Specify the port by using the tcpport option in the client options file. The tcpport option in the client options file must match
the TCPPORT option in the server options file. The default value is 1500. If you decide to use a value other than the default,
specify a number in the range 1024 - 32767.

HTTP port to enable communication between the web client and remote workstations
Specify the port for the remote workstation by setting the httpport option in the client options file of the remote
workstation. The default value is 1581.

TCP/IP ports for the remote workstation
The default value of 0 (zero) causes two free port numbers to be randomly assigned to the remote workstation. If you do
not want the port numbers to be randomly assigned, specify values by setting the webports option in the client options file
of the remote workstation.

TCP/IP port for administrative sessions
Specify the port on which the server waits for requests for administrative client sessions. The value of the client
tcpadminport option must match the value of the TCPADMINPORT server option. In this way, you can secure administrative
sessions within a private network.

Managing client operations

You can evaluate and resolve errors that are related to a backup-archive client by using the Operations Center, which provides
suggestions for resolving errors. For errors on other types of clients, you must examine the error logs on the client and review the
product documentation.

About this task

In some cases, you can resolve client errors by stopping and starting the client acceptor. If client nodes or administrator IDs are
locked, you can resolve the issue by unlocking the client node or administrator ID, and then resetting the password.

For detailed instructions about identifying and resolving client errors, see Resolving client problems.

e Evaluating errors in client error logs
You can resolve client errors by obtaining suggestions from the Operations Center or by reviewing error logs on the client.
e Stopping and restarting the client acceptor
If you change the configuration of your solution, you must restart the client acceptor on all client nodes where a backup-
archive client is installed.
e Resetting passwords
If a password for a client node or an administrator ID is lost or forgotten, you can reset the password. Multiple attempts to
access the system with an incorrect password can cause a client node or administrator ID to be locked. You can take steps
to resolve the issue.
e Modifying the scope of a client backup
When you set up client backup operations, the preferred practice is to exclude objects that you do not require. For example,
you typically want to exclude temporary files from a backup operation.

Evaluating errors in client error logs

You can resolve client errors by obtaining suggestions from the Operations Center or by reviewing error logs on the client.
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Before you begin

To resolve errors in a backup-archive client on a Linux or Windows operating system, ensure that the client management service is
installed and started. For installation instructions, see Installing the client management service. For instructions about verifying
the installation, see Verifying that the client management service is installed correctly.

Procedure

To diagnose and resolve client errors, take one of the following actions:

e If the client management service is installed on the client node, complete the following steps:
1. On the Operations Center Overview page, click Clients and select the client.
2. Click Details.
3. On the client Summary page, click the Diagnosis tab.
4. Review the retrieved log messages.
Tips:
= To show or hide the Client Logs pane, double-click the Client Logs bar.
= To resize the Client Logs pane, click and drag the Client Logs bar.

If suggestions are displayed on the Diagnosis page, select a suggestion. In the Client Logs pane, client log messages
to which the suggestion relates are highlighted.

5. Use the suggestions to resolve the problems that are indicated by the error messages.
Tip: Suggestions are provided for only a subset of client messages.
e Ifthe client management service is not installed on the client node, review the error logs for the installed client.

Stopping and restarting the client acceptor

If you change the configuration of your solution, you must restart the client acceptor on all client nodes where a backup-archive
client is installed.

About this task

In some cases, you can resolve client scheduling problems by stopping and restarting the client acceptor. The client acceptor
must be running to ensure that scheduled operations can occur on the client. For example, if you change the IP address or domain
name of the server, you must restart the client acceptor.

Procedure

Follow the instructions for the operating system that is installed on the client node:
AIX and Oracle Solaris

e To stop the client acceptor, complete the following steps:
a. Determine the process ID for the client acceptor by issuing the following command on the command line:

ps -ef | grep dsmcad
Review the output. In the following sample output, 6764 is the process ID for the client acceptor:
root 6764 1 0 16:26:35 2 0:00 /usr/bin/dsmcad
b. Issue the following command on the command line:
kill -9 PID

where PID specifies the process ID for the client acceptor.
e To start the client acceptor, issue the following command on the command line:

/usr/bin/dsmcad
Linux

e To stop the client acceptor (and not restart it), issue the following command:
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# service dsmcad stop
e To stop and restart the client acceptor, issue the following command:
# service dsmcad restart
MAC 0S X
Click Applications > Utilities > Terminal.
e To stop the client acceptor, issue the following command:
/bin/launchctl unload -w com.ibm.tivoli.dsmcad
e To start the client acceptor, issue the following command:
/bin/launchctl load -w com.ibm.tivoli.dsmcad
Windows

e To stop the client acceptor service, complete the following steps:
a. Click Start > Administrative Tools > Services.
b. Double-click the client acceptor service.
c. Click Stop and OK.

e To restart the client acceptor service, complete the following steps:
a. Click Start > Administrative Tools > Services.
b. Double-click the client acceptor service.
c. Click Start and OK.

Related reference:
[ Resolving client scheduling problems

Resetting passwords

If a password for a client node or an administrator ID is lost or forgotten, you can reset the password. Multiple attempts to access
the system with an incorrect password can cause a client node or administrator ID to be locked. You can take steps to resolve the
issue.

Procedure

To resolve password issues, take one of the following actions:

e If a backup-archive client is installed on a client node, and the password is lost or forgotten, complete the following steps:
1. Generate a new password by issuing the UPDATE NODE command:

update node node name new password forcepwreset=yes

where node_name specifies the client node and new_password specifies the password that you assign.

2. Inform the client node owner about the changed password. When the owner of the client node logs in with the
specified password, a new password is generated automatically. That password is unknown to users to enhance
security.

Tip: The password is generated automatically if you previously set the passwordaccess option to generate in the
client options file.
e If an administrator is locked out because of password issues, complete the following steps:

1. To provide the administrator with access to the server, issue the UNLOCK ADMIN command. For instructions, see
UNLOCK ADMIN (Unlock an administrator).

2. Set a new password by using the UPDATE ADMIN command:

update admin admin name new password forcepwreset=yes

where admin_name specifies the name of the administrator and new_password specifies the password that you
assign.
e Ifaclient node is locked, complete the following steps:
1. Determine why the client node is locked and whether it must be unlocked. For example, if the client node is
decommissioned, the client node is being removed from the production environment. You cannot reverse the
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decommission operation, and the client node remains locked. A client node also might be locked if the client data is
the subject of a legal investigation.

2. If you must unlock a client node, use the UNLOCK NODE command. For instructions, see UNLOCK NODE (Unlock a
client node).

3. Generate a new password by issuing the UPDATE NODE command:

update node node name new password forcepwreset=yes

where node_name specifies the name of the node and new_password specifies the password that you assign.

4. Inform the client node owner about the changed password. When the owner of the client node logs in with the
specified password, a new password is generated automatically. That password is unknown to users to enhance
security.

Tip: The password is generated automatically if you previously set the passwordaccess option to generate in the
client options file.

Modifying the scope of a client backup

When you set up client backup operations, the preferred practice is to exclude objects that you do not require. For example, you
typically want to exclude temporary files from a backup operation.

About this task

When you exclude unnecessary objects from backup operations, you get better control of the amount of storage space that is
required for backup operations, and the cost of storage. Depending on your licensing package, you also might be able to limit
licensing costs.

Procedure

How you modify the scope of backup operations depends on the product that is installed on the client node:

e For a backup-archive client, you can create an include-exclude list to include or exclude a file, groups of files, or directories
from backup operations. To create an include-exclude list, follow the instructions in Creating an include-exclude list.

To ensure consistent use of an include-exclude list for all clients of one type, you can create a client option set on the server
that contains the required options. Then, you assign the client option set to each of the clients of the same type. For details,
see Controlling client operations through client option sets.

e For a backup-archive client, you can specify the objects to include in an incremental backup operation by using the domain
option. Follow the instructions in Domain option.

e For other products, to define which objects are included in and excluded from backup operations, follow the instructions in
the product documentation.

Managing client upgrades

When a fix pack or interim fix becomes available for a client, you can upgrade the client to take advantage of product
improvements. Servers and clients can be upgraded at different times and can be at different levels with some restrictions.

Before you begin

1. Review the client/server compatibility requirements in technote 1053218. If your solution includes servers or clients at a
level that is earlier than V7.1, review the guidelines to ensure that client backup and archive operations are not disrupted.

2. Verify system requirements for the client in IBM Spectrum Protect™ Supported Operating Systems.

3. If the solution includes storage agents or library clients, review the information about storage-agent and library-client
compatibility with servers that are configured as library managers. See technote 1302789.

If you plan to upgrade a library manager and a library client, you must upgrade the library manager first.

Procedure

To upgrade the software, complete the instructions that are listed in the following table.

Software Link to instructions
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Software Link to instructions

IBM Spectrum Protect backup- e Scheduling client updates

archive client

IBM Spectrum Protect Snapshot e Installing and upgrading IBM Spectrum Protect Snapshot for UNIX and
Linux

e Installing and upgrading IBM Spectrum Protect Snapshot for VMware
e Installing and upgrading IBM Spectrum Protect Snapshot for Windows

IBM Spectrum Protect for e Upgrading Data Protection for SQL Server

Databases e Data Protection for Oracle installation

e Installing, upgrading, and migrating IBM Spectrum Protect for Mail:
Data Protection for Microsoft Exchange Server

IBM Spectrum Protect for e Upgrading IBM Spectrum Protect for Enterprise Resource Planning:

Enterprise Resource Planning Data Protection for SAP for DB2®

e Upgrading IBM Spectrum Protect for Enterprise Resource Planning:
Data Protection for SAP for Oracle

IBM Spectrum Protect for Mail e Installation of Data Protection for IBM Domino on a UNIX, AIX, or
Linux system (V7.1.0)

e Installation of Data Protection for IBM Domino on a Windows system
(V7.1.0)

e Installing, upgrading, and migrating IBM Spectrum Protect for Mail:
Data Protection for Microsoft Exchange Server

IBM Spectrum Protect for Virtual e Installing and upgrading Data Protection for VMware
Environments e Installing Data Protection for Microsoft Hyper-V

Decommissioning a client node

If a client node is no longer required, you can start a process to remove it from the production environment. For example, if a
workstation was backing up data to the IBM Spectrum Protect™ server, but the workstation is no longer used, you can
decommission the workstation.

About this task

When you start the decommission process, the server locks the client node to prevent it from accessing the server. Files that
belong to the client node are gradually deleted, and then the client node is deleted. You can decommission the following types of
client nodes:

Application client nodes
Application client nodes include email servers, databases, and other applications. For example, any of the following
applications can be an application client node:

e IBM Spectrum Protect Snapshot

IBM Spectrum Protect for Databases

IBM Spectrum Protect for Enterprise Resource Planning
IBM Spectrum Protect for Mail

e IBM Spectrum Protect for Virtual Environments

System client nodes
System client nodes include workstations, network-attached storage (NAS) file servers, and API clients.

Virtual machine client nodes
Virtual machine client nodes consist of an individual guest host within a hypervisor. Each virtual machine is represented as
a file space.

The simplest method for decommissioning a client node is to use the Operations Center. The decommission process runs in the
background. If the client is configured to replicate client data, the Operations Center automatically removes the client from
replication on the source and target replication servers before it decommissions the client.
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Tip: Alternatively, you can decommission a client node by issuing the DECOMMISSION NODE or DECOMMISSION VM command.
You might want to use this method in the following cases:

e To schedule the decommission process for the future or to run a series of commands by using a script, specify the
decommission process to run in the background.

e To monitor the decommission process for debugging purposes, specify the decommission process to run in the foreground.
If you run the process in the foreground, you must wait for the process to be completed before you continue with other
tasks.

Procedure

Take one of the following actions:

e To decommission a client in the background by using the Operations Center, complete the following steps:
1. On the Operations Center Overview page, click Clients and select the client.
2. Click More > Decommission.
e To decommission a client node by using an administrative command, complete the following steps:
1. Determine whether the client node is configured for node replication by issuing the QUERY NODE command. For
example, if the client node is named AUSTIN, run the following command:

query node austin format=detailed

Review the Replication State output field.
2. If the client node is configured for replication, remove the client node from replication by issuing the REMOVE
REPLNODE command. For example, if the client node is named AUSTIN, issue the following command:

remove replnode austin

3. Take one of the following actions:
= To decommission an application or system client node in the background, issue the DECOMMISSION NODE
command. For example, if the client node is named AUSTIN, issue the following command:

decommission node austin

= To decommission an application or system client node in the foreground, issue the DECOMMISSION NODE
command and specify the wait=yes parameter. For example, if the client node is named AUSTIN, issue the
following command:

decommission node austin wait=yes

= To decommission a virtual machine in the background, issue the DECOMMISSION VM command. For example,
if the virtual machine is named AUSTIN, the file space is 7, and the file space name is specified by the file
space ID, issue the following command:

decommission vm austin 7 nametype=fsid

If the virtual machine name includes one or more spaces, enclose the name in double quotation marks. For
example:

decommission vm "austin 2" 7 nametype=fsid

® To decommission a virtual machine in the foreground, issue the DECOMMISSION VM command and specify
the wait=yes parameter. For example, issue the following command:

decommission vm austin 7 nametype=fsid wait=yes

If the virtual machine name includes one or more spaces, enclose the name in double quotation marks. For
example:

decommission vm "austin 2" 7 nametype=fsid wait=yes

What to do next

Watch for error messages, which might be displayed in the user interface or in the command output, immediately after you run the
process.

You can verify that the client node is decommissioned:
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1. On the Operations Center Overview page, click Clients.
2. In the Clients table, in the At risk column, review the state:
o A DECOMMISSIONED state specifies that the node is decommissioned.
o A null value specifies that the node is not decommissioned.
o A PENDING state specifies that the node is being decommissioned, or the decommission process failed.
Tip: If you want to determine the status of a pending decommission process, issue the following command:

query process

3. Review the command output:
o If status is provided for the decommission process, the process is in progress. For example:

query process

Process Process Description Process Status
Number
3 DECOMMISSION NODE Number of backup objects deactivated

for node NODEl: 8 objects deactivated.

o If no status is provided for the decommission process, and you did not receive an error message, the process is
incomplete. A process can be incomplete if files that are associated with the node are not yet deactivated. After the
files are deactivated, run the decommission process again.

o If no status is provided for the decommission process, and you receive an error message, the process failed. Run the
decommission process again.

Related reference:

* DECOMMISSION NODE (Decommission a client node)

[ DECOMMISSION VM (Decommission a virtual machine)

[ QUERY NODE (Query nodes)

[* REMOVE REPLNODE (Remove a client node from replication)

Deactivating data to free storage space

In some cases, you can deactivate data that is stored on the IBM Spectrum Protect™ server. When you run the deactivation
process, any backup data that was stored before the specified date and time is deactivated and will be deleted as it expires. In
this way, you can free space on the server.

About this task

Some application clients always save data to the server as active backup data. Because active backup data is not managed by
inventory expiration policies, the data is not deleted automatically, and uses server storage space indefinitely. To free the storage
space that is used by obsolete data, you can deactivate the data.

When you run the deactivation process, all active backup data that was stored before the specified date becomes inactive. The
data is deleted as it expires and cannot be restored. The deactivation feature applies only to application clients that protect Oracle
databases.

Procedure

1. From the Operations Center Overview page, click Clients.
2. In the Clients table, select one or more clients and click More > Clean Up.
Command-line method: Deactivate data by using the DEACTIVATE DATA command.

Related reference:
* DEACTIVATE DATA (Deactivate data for a client node)

Managing data storage

Manage your data for efficiency and add supported devices and media to the server to store client data.

e Auditing a storage pool container
Audit a storage pool container to check for inconsistencies between database information and a container in a storage pool.
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e Managing inventory capacity
Manage the capacity of the database, active log, and archive logs to ensure that the inventory is sized for the tasks, based
on the status of the logs.

e Managing memory and processor usage
Ensure that you manage memory requirements and processor usage to ensure that the server can complete data processes
such as backup and data deduplication. Consider the impact on performance when you complete certain processes.

e Tuning scheduled activities
Schedule maintenance tasks daily to ensure that your solution operates correctly. By tuning your solution, you maximize
server resources and effectively use different functions available within your solution.

Related reference:
[ Storage pool types

Auditing a storage pool container

Audit a storage pool container to check for inconsistencies between database information and a container in a storage pool.

About this task

You audit a storage pool container in the following situations:

e When you issue the QUERY DAMAGED command and a problem is detected
e When the server displays messages about damaged data extents
e Your hardware reports an issue and error messages that are associated with the storage pool container are displayed

Procedure

1. To audit a storage pool container, issue the AUDIT CONTAINER command. For example, issue the following command to
audit a container, 000000000000076c.dcf:

audit container c:\tsm-storage\07\000000000000076c.dcf

2. Review the output from the ANR4891I message for information about any damaged data extents.

What to do next

If you detect problems with the storage pool container, you can restore data based on your configuration. You can repair the
contents in the storage pool by using the REPAIR STGPOOL command.

Restriction: You can repair the contents of the storage pool only if you protected the storage pool by using the PROTECT STGPOOL
command.
Related reference:

[** AUDIT CONTAINER (Verify the consistency of database information for a directory-container storage pool)
* QUERY DAMAGED (Query damaged data in a directory-container or cloud-container storage pool)

Managing inventory capacity

Manage the capacity of the database, active log, and archive logs to ensure that the inventory is sized for the tasks, based on the
status of the logs.

Before you begin

The active and archive logs have the following characteristics:

e The active log can be a maximum size of 512 GB. For more information about sizing the active log for your system, see
Planning the storage arrays.

e The archive log size is limited to the size of the file system that it is installed on. The archive log size is not maintained at a
predefined size like the active log. Archive log files are automatically deleted after they are no longer needed.

As a best practice, you can optionally create an archive failover log to store archive log files when the archive log directory is full.
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Check the Operations Center to determine the component of the inventory that is full. Ensure that you stop the server before you
increase the size of one of the inventory components.

Procedure

e Toincrease the size of the database, complete the following steps:

o Create one or more directories for the database on separate drives or file systems.
o Issue the EXTEND DBSPACE command to add the directory or directories to the database. The directories must be

accessible to the instance user ID of the database manager. By default, data is redistributed across all database
directories and space is reclaimed.
Tips:
® The time that is needed to complete redistribution of data and reclaiming of space is variable, depending on
the size of your database. Make sure that you plan adequately.
= Ensure that the directories that you specify are the same size as existing directories to ensure a consistent
degree of parallelism for database operations. If one or more directories for the database are smaller than the
others, they reduce the potential for optimized parallel prefetching and distribution of the database.
Halt and restart the server to fully use the new directories.
Reorganize the database if necessary. Index and table reorganization for the server database can help to avoid
unexpected database growth and performance issues. For more information about reorganizing the database, see
technote 1683633.

e To decrease the size of the database for V7.1 servers and later, issue the following DB2® commands from the server
instance directory:
Restriction: The commands can increase I/0 activity, and might affect server performance. To minimize performance
problems, wait until one command is completed before you issue the next command. The DB2 commands can be issued
when the server is running.

db?2
db2
db2
db2
db2
db2
db2
db2
db2
db2
db2
db2
db2
db2
db2
db2
db2
db2
db2
db2
db2
db2
db2
db2
db2
db2

connect to tsmdbl
set schema tsmdbl

ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER
ALTER

TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE
TABLESPACE

USERSPACE1 REDUCE MAX
IDXSPACE1 REDUCE MAX
LARGEIDXSPACE]l REDUCE MAX
LARGESPACE1 REDUCE MAX
REPLTBLSPACE1 REDUCE MAX
REPLIDXSPACE1 REDUCE MAX
ARCHOBJDATASPACE REDUCE MAX
ARCHOBJIDXSPACE REDUCE MAX
BACKOBJDATASPACE REDUCE MAX
BACKOBJIDXSPACE REDUCE MAX
BFABFDATASPACE REDUCE MAX
BFABFIDXSPACE REDUCE MAX
BFBFEXTDATASPACE REDUCE MAX
BFBFEXTIDXSPACE REDUCE MAX
DEDUPTBLSPACE1l REDUCE MAX
DEDUPIDXSPACEl REDUCE MAX
DEDUPTBLSPACE2 REDUCE MAX
DEDUPIDXSPACE2 REDUCE MAX
DEDUPTBLSPACE3 REDUCE MAX
DEDUPIDXSPACE3 REDUCE MAX
DEDUPTBLSPACE4 REDUCE MAX
DEDUPIDXSPACE4 REDUCE MAX
DEDUPTBLSPACES REDUCE MAX
DEDUPIDXSPACES5 REDUCE MAX

e Toincrease or decrease the size of the active log, complete the following steps:

1. Ensure that the location for the active log has enough space for the increased log size. If a log mirror exists, its

location must also have enough space for the increased log size.

2. Halt the server.
3. In the dsmserv.opt file, update the ACTIVELOGSIZE option to the new size of the active log, in megabytes.

The size of an active log file is based on the value of the ACTIVELOGSIZE option. Guidelines for space requirements
are in the following table:
Table 1. How to estimate volume and file space requirements

ACTIVELOGSize option | Reserve this much free space in the active log directory, in addition to the
value ACTIVELOGSize space

16 GB - 128 GB 5120 MB

129 GB - 256 GB 10240 MB
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ACTIVELOGSize option | Reserve this much free space in the active log directory, in addition to the
value ACTIVELOGSize space

257 GB-512 GB 20480 MB

To change the active log to its maximum size of 512 GB, enter the following server option:

activelogsize 524288

4, If you plan to use a new active log directory, update the directory name that is specified in the
ACTIVELOGDIRECTORY server option. The new directory must be empty and must be accessible to the user ID of
the database manager.

5. Restart the server.

e Compress the archive logs to reduce the amount of space that is required for storage. Enable dynamic compression of the
archive log by issuing the following command:

setopt archlogcompress yes

Restriction: Use caution when you enable the ARCHLOGCOMPRESS server option on systems with sustained high volume
usage and heavy workloads. Enabling this option in this system environment can cause delays in archiving log files from the
active log file system to the archive log file system. This delay can cause the active log file system to run out of space. Be
sure to monitor the available space in the active log file system after archive log compression is enabled. If the active log
directory file system usage nears out of space conditions, the ARCHLOGCOMPRESS server option must be disabled. You
can use the SETOPT command to disable archive log compression immediately without halting the server.

Related reference:

B+ ACTIVELOGSIZE server option

* EXTEND DBSPACE (Increase space for the database)
[ SETOPT (Set a server option for dynamic update)

Managing memory and processor usage

Ensure that you manage memory requirements and processor usage to ensure that the server can complete data processes such
as backup and data deduplication. Consider the impact on performance when you complete certain processes.

Before you begin

e Ensure that your configuration uses the required hardware and software. For more information, see IBM Spectrum Protect™
Supported Operating Systems.

e For more information about managing resources such as the database and recovery log, see Planning the storage arrays.

e Add more system memory to determine whether there is a performance improvement. Monitor memory usage regularly to
determine whether more memory is required.

Procedure

1. Release memory from the file system cache where possible.

2. To manage the system memory that is used by each server on a system, use the DBMEMPERCENT server option. Limit the
percentage of system memory that can be used by the database manager of each server. If all servers are equally
important, use the same value for each server. If one server is a production server and other servers are test servers, set
the value for the production server to a higher value than the test servers.

3. Set the user data limit and private memory for the database to ensure that private memory is not exhausted. Exhausting
private memory can result in errors, less than optimal performance, and instability.

Tuning scheduled activities

Schedule maintenance tasks daily to ensure that your solution operates correctly. By tuning your solution, you maximize server
resources and effectively use different functions available within your solution.

Procedure

1. Monitor system performance regularly to ensure that client backup and server maintenance tasks are completing
successfully. Follow the instructions in Monitoring a multisite disk solution.
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. Optional: If the monitoring information shows that the server workload increased, review the planning information. Review

whether the capacity of the system is adequate in the following cases:
o The number of clients increases
o The amount of data that is being backed up increases
o The amount of time that is available for backups changes

. Determine whether your solution is performing at the level you expect. Review the client schedules to check whether tasks

are completing within the scheduled time frame:

a. On the Clients page of the Operations Center, select the client.

b. Click Details.

c. From the client Summary page, review the Backed up and Replicated activity to identify any risks.
Adjust the time and frequency of client backup operations, if necessary.

. Schedule enough time for the following maintenance tasks to complete successfully within a 24-hour period:

a. Protect storage pools.

b. Replicate node data.

c. Back up the database.

d. Run expiration processing to remove client backups and archive file copies from server storage.
Tip: Schedule maintenance tasks to start at an appropriate time and in the correct sequence. For example, schedule
replication tasks after client backups complete successfully.

Moving clients from one server to another
To avoid running out of space on a server or to resolve workload issues, you might have to move client nodes from one
server to another.

Related concepts:

[ Performance

Related tasks:

Defining schedules for server maintenance activities
I Deduplicating data (V7.1.1)

Managing replication

Use replication to recover data at a disaster recovery site and to maintain the same level of files on the source and target servers.
You can manage replication at the node level. You can also protect data at the storage-pool level.

Replication compatibility

Before you set up replication operations with IBM Spectrum Protect, you must ensure that the source and target replication
servers are compatible for replication.

Enabling node replication

You can enable node replication to protect your data.

Protecting data in directory-container storage pools

Protect data in directory-container storage pools to reduce node replication time and to enable repair of data in directory-
container storage pools.

Modifying replication settings

Modify replication settings in the Operations Center. Change settings such as the number of replication sessions,
replication rules, the data that you want to replicate, the replication schedule, and the replication workload.

Setting different retention policies for the source server and target server

You can set policies on the target replication server that manage the replicated client-node data differently than on the
source server. For example, you can maintain a different number of versions of files on the source and the target servers.

Replication compatibility

Before you set up replication operations with IBM Spectrum Protect™, you must ensure that the source and target replication
servers are compatible for replication.

Table 1. Replication compatibility of server versions

Source replication server version Compatible versions for the target replication server
V7.1 V7.1 or later

V7.1.1 V7.1 or later

V7.1.3 V7.1.3 or later

IBM Spectrum Protect Knowledge Center Version 8.1.5 205


http://www.ibm.com/support/knowledgecenter/SSEQVQ_8.1.0/perf/c_performance.html
http://www.ibm.com/support/knowledgecenter/SSGSG7_7.1.1/com.ibm.itsm.srv.doc/t_dedup.html

Source replication server version Compatible versions for the target replication server
V7.1.4 V7.1.3 or later
V7.1.5 V7.1.3 or later
V7.1.6 V7.1.3 or later
V7.1.7 V7.1.3 or later
V7.1.8 V7.1.3 or later
V8.1 V7.1.3 or later
v8.1.1 V7.1.3 or later
Vv8.1.2 V7.1.3 or later
Vv8.1.3 V7.1.3 or later
v8.1.4 V7.1.3 or later
Vv8.1.5 V7.1.3 or later

Enabling node replication

You can enable node replication to protect your data.

Before you begin

Ensure that the source and target servers are compatible for replication.

About this task

Replicate the client node to replicate all client data, including metadata. By default, node replication is disabled when you start
the server for the first time.
Tips:

e To reduce replication processing time, protect the storage pool before you replicate client nodes. When node replication is
started, the data extents that are already replicated through storage pool protection are skipped.

e Replication requires increased amounts of memory and sufficient bandwidth to complete processing. Size the database
and its logs to ensure that transactions can complete.

Procedure

To enable node replication, complete the following steps in the Operations Center:

a. On the Servers page, click Details.

b. On the Details page, click Properties.

c. In the Replication section, select Enabled in the Outbound replication field.
d. Click Save.

What to do next

Complete the following actions:

1. To verify that replication was successful, review the Daily monitoring checklist.

2. ITITHMI{ the IBM Spectrum Protect server replicates nodes to a remote server, determine whether Aspera® Fast
Adaptive Secure Protocol (FASP®) technology can improve data throughput to the remote server. Follow the instructions in
Determining whether Aspera FASP technology can optimize data transfer in your system environment.

Related reference:
Replication compatibility

Protecting data in directory-container storage pools
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Protect data in directory-container storage pools to reduce node replication time and to enable repair of data in directory-
container storage pools.

Before you begin

Ensure that at least one directory-container storage pool exists on the target replication server. When you enable replication in the
Operations Center, you can schedule storage pool protection. To configure replication and enable storage pool protection,
complete the following steps:

1. On the Operations Center menu bar, hover over Storage and click Replication.
2. On the Replication page, click Server Pair.
3. Complete the steps in the Add Server Pair wizard.

About this task

Protecting a directory-container storage pool backs up data extents to another storage pool, and can improve performance for
node replication. When node replication is started, the data extents that are already backed up through storage pool protection
are skipped, which reduces the replication processing time. You can schedule the protection of storage pools several times a day
to keep up with changes to data.

By protecting a storage pool, you do not use resources that replicate existing data and metadata, which improves server
performance. You must use directory-container storage pools if you want to protect and back up the storage pool only.

Alternative protection strategy: As an alternative to using replication, you can protect data in directory-container storage pools by
copying the data to container-copy storage pools. Data in container-copy storage pools is stored on tape volumes. Tape copies
that are stored offsite provide additional disaster recovery protection in a replicated environment.

Procedure

1. Alternatively, to enable storage pool protection, you can use the PROTECT STGPOOL command from the source server to
back up data extents in a directory-container storage pool. For example, to protect a directory-container storage pool that
is named POOL1 issue the following command:

protect stgpool pooll

As part of the operation of the PROTECT STGPOOL command, damaged extents in the target storage pool are repaired. To
be repaired, extents must already be marked as damaged on the target server. For example, an AUDIT CONTAINER
command might identify damage in the target storage pool before the PROTECT STGPOOL command is issued.
2. Optional: If damaged extents were repaired in the target storage pool and you protect multiple source storage pools in one
target storage pool, complete the following steps to ensure a complete repair:
a. Issue the PROTECT STGPOOL command for all source storage pools to repair as much of the damage as possible.
b. Issue the PROTECT STGPOOL command again for all source storage pools. For this second operation, use the
FORCERECONCILE=YES parameter. This step ensures that any repairs from other source pools are properly
recognized for all source storage pools.

Results

If a directory-container storage pool is protected, you can repair the storage pool if damage occurs, by using the REPAIR STGPOOL
command.

Restriction: If you replicate client nodes but do not protect the directory-container storage pool, you cannot repair the storage
pool.

What to do next

Complete the following actions:

1. To view replication workload status, follow the instructions in the Daily monitoring checklist.

2. INEITHET the IBM Spectrum Protect server replicates nodes to a remote server, determine whether Aspera® Fast
Adaptive Secure Protocol (FASP®) technology can improve data throughput to the remote server. Follow the instructions in
Determining whether Aspera FASP technology can optimize data transfer in your system environment.

Related reference:
[ Repairing and recovering data in directory-container storage pools
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[ AUDIT CONTAINER (Verify the consistency of database information for a directory-container storage pool)
% PROTECT STGPOOL (Protect storage pool data)

Related information:

B+ Directory-container storage pools FAQs

[ Cloud-container storage pools FAQs

Modifying replication settings

Modify replication settings in the Operations Center. Change settings such as the number of replication sessions, replication rules,
the data that you want to replicate, the replication schedule, and the replication workload.

About this task

You might need to customize your replication settings in the following scenarios:

e Changes to data priorities

e Changes to replication rules

e Requirement for a different server to be the target server

e Scheduled processes that negatively affect server performance

Procedure

Use the Operations Center to modify replication settings.

Task Procedure

Change a replication rule. a. On the Servers page, click Details.

b. On the Details page, click Properties.

c. In the Replication section, choose the replication rule that you want
to apply: Default archive rule, Default backup rule, or Default space-
management rule.

d. Click Save.
Specify the duration that replication records are a. On the Servers page, click Details.
retained. b. On the Details page, click Properties.

c. In the Replication section, enter the number of days that replication
records must be retained in the Retain replication history field.
Alternatively, select the Do not retain check box if you do not require
replication records.

d. Click Save.

Specify a target replication server. . On the Servers page, click Details.
. On the Details page, click Properties.
. In the Replication section, specify the target server.

. Click Save.

o o T 9

QO

Cancel a replication process. . On the Servers page, click Active tasks.
b. Select the process or session that you want to cancel.

c. Click Cancel.

Setting different retention policies for the source server and target
server

You can set policies on the target replication server that manage the replicated client-node data differently than on the source
server. For example, you can maintain a different number of versions of files on the source and the target servers.

Procedure
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1. From the source replication server, validate the replication configuration and verify that the source replication server can
communicate with the target replication server by issuing the VALIDATE REPLICATION command. For example, validate the
configuration by using the name of one client node that is being replicated:

validate replication nodel verifyconnection=yes

2. From the source replication server, issue the VALIDATE REPLPOLICY command to review the differences between the
policies on the source and target replication servers. For example, to display the differences between the policies on the
source server and the target server, CVT_SRV2, issue the following command from the source server:

validate replpolicy cvt srv2

3. Update the policies on the target server if necessary.
Tip: You can use the Operations Center to modify the policies on the target server. Follow the instructions in Editing
policies.
For example, to maintain inactive versions of files for a shorter time on the target server than on the source server, reduce
the Backups setting in the management classes that apply to replicated client data.

4. Enable the target replication server to use its policies to manage the replicated client-node data by issuing the SET
DISSIMILARPOLICIES command on the source server. For example, to enable the policies on the target replication server,
CVT_SRV2, issue the following command on the source server:

set dissimilarpolicies cvt srvZ on

The next time that the replication process runs, the policies on the target replication server are used to manage the
replicated client-node data.

Tip: If you configure replication by using the Operations Center and the policies on the source and target replication servers
do not match, the policy that is specified for the source replication server is used. If you enabled the policies on the target
replication server by using the SET DISSIMILARPOLICIES command, the policy that is specified for the target replication
server is used. If the target replication server does not have the policy that is used by the node on the source replication
server, the STANDARD policy is used.

Related reference:

B+ EXPORT POLICY (Export policy information)

[ SET DISSIMILARPOLICIES (Enable the policies on the target replication server to manage replicated data)
[ VALIDATE REPLICATION (Validate replication for a client node)

[ VALIDATE REPLPOLICY (Verify the policies on the target replication server)

Securing the server

Secure the IBM Spectrum Protect™ server and data by controlling access to servers and client nodes, encrypting data, and
maintaining secure access levels and passwords.

e Security concepts
You can protect IBM Spectrum Protect from security risks by using communication protocols, securing passwords, and
providing different access levels for administrators.

e Managing administrators
An administrator who has system authority can complete any task with the IBM Spectrum Protect server, including
assigning authority levels to other administrators. To complete some tasks, you must be granted authority by being
assigned one or more authority levels.

e Changing password requirements
You can change the minimum password limit, password length, password expiration, and enable or disable authentication
for IBM Spectrum Protect.

e Securing IBM Spectrum Protect on the system
Protect the system where the IBM Spectrum Protect server runs to prevent unauthorized access.

Security concepts

You can protect IBM Spectrum Protect™ from security risks by using communication protocols, securing passwords, and providing
different access levels for administrators.

Transport Layer Security
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You can use the Secure Sockets Layer (SSL) or the Transport Layer Security (TLS) protocol to provide transport layer security for a
secure connection between servers, clients, and storage agents. If you send data between the server, client, and storage agent,
use SSL or TLS to encrypt the data.

Tip: Any IBM Spectrum Protect documentation that indicates "SSL" or to "select SSL" applies to TLS.

SSL is provided by the Global Security Kit (GSKit) that is installed with the IBM Spectrum Protect server that the server, client, and
storage agent use.

Restriction: Do not use the SSL or TLS protocols for communications with a DB2® database instance that is used by any IBM
Spectrum Protect servers.

Each server, client, or storage agent that enables SSL must use a trusted self-signed certificate or obtain a unique certificate that
is signed by a certificate authority (CA). You can use your own certificates or purchase certificates from a CA. Either certificate
must be installed and added to the key database on the IBM Spectrum Protect server, client, or storage agent. The certificate is
verified by the SSL client or server that requests or initiates the SSL communication. Some CA certificates are preinstalled in the
key databases, by default.

SSL is set up independently on the IBM Spectrum Protect server, client, and storage agent.

Authority levels

With each IBM Spectrum Protect server, different administrative authority levels are available that determine the tasks that an
administrator can complete.

After registration, an administrator must be granted authority by being assigned one or more administrative authority levels. An
administrator with system authority can complete any task with the server and assign authority levels to other administrators by
using the GRANT AUTHORITY command. Administrators with policy, storage, or operator authority can complete subsets of tasks.

An administrator can register other administrator IDs, grant levels of authority to them, rename IDs, remove IDs, and lock and
unlock them from the server.

An administrator can control access to specific client nodes for root user IDs and non-root user IDs. By default, a non-root user ID
cannot back up data on the node. Use the UPDATE NODE command to change the node settings to enable backup.

Passwords

By default, the server automatically uses password authentication. With password authentication, all users must enter a password
when they access the server.

Use Lightweight Directory Access Protocol (LDAP) to apply stricter requirements for passwords. For more information, see
Managing passwords and logon procedures (V7.1.1).

Table 1. Password authentication characteristics

Characteristic More information
Case-sensitivity Not case-sensitive.
Default password expiration 90 days.

The expiration period begins when an administrator ID or client
node is first registered to the server. If the password is not
changed within this period, the password must be changed the
next time that the user accesses the server.

Invalid password attempts You can set a limit on consecutive invalid password attempts
for all client nodes. When the limit is exceeded, the server
locks the node.

Default password length 8 characters.

The administrator can specify a minimum length. Beginning
with Version 8.1.4, the default minimum length for server
passwords changed from 0 to 8 characters.

Session security
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Session security is the level of security that is used for communication among IBM Spectrum Protect client nodes, administrative
clients, and servers and is set by using the SESSIONSECURITY parameter.

The SESSIONSECURITY parameter can be set to one of the following values:

e The STRICT value enforces the highest level of security for communication between IBM Spectrum Protect servers, nodes,
and administrators.

e The TRANSITIONAL value specifies that the existing communication protocol is used while you update your IBM Spectrum
Protect software to V8.1.2 or later. This is the default. When SESSIONSECURITY=TRANSITIONAL, stricter security settings
are automatically enforced as higher versions of the TLS protocol are used and as the software is updated to V8.1.2 or later.
After a node, administrator, or server meets the requirements for the STRICT value, session security is automatically
updated to the STRICT value, and the entity can no longer authenticate by using a previous version of the client or earlier
TLS protocols.

Note: You are not required to update backup-archive clients to V8.1.2 or later before you upgrade servers. After you
upgrade a server to V8.1.2 or later, nodes and administrators that are using earlier versions of the software will continue to
communicate with the server by using the TRANSITIONAL value until the entity meets the requirements for the STRICT
value. Similarly, you can upgrade backup-archive clients to V8.1.2 or later before you upgrade your IBM Spectrum Protect
servers, but you are not required to upgrade servers first. Communication between servers and clients is not interrupted.

For more information about the SESSIONSECURITY parameter values, see the following commands.
Table 2. Commands used to set the
SESSIONSECURITY parameter

Entity Command

Client nodes e REGISTER NODE
e UPDATE NODE

Administrators e REGISTER ADMIN
e UPDATE ADMIN

Servers e DEFINE SERVER
e UPDATE SERVER

Administrators that authenticate by using the DSMADMC command, DSMC command, or dsm program cannot authenticate by
using an earlier version after authenticating by using V8.1.2 or later. To resolve authentication issues for administrators, see the
following tips:

Tips:

e Ensure that all IBM Spectrum Protect software that the administrator account uses to log on is upgraded to V8.1.2 or later.
If an administrator account logs on from multiple systems, ensure that the server's certificate is installed on each system.

e After an administrator authenticates to a V8.1.2 or later server by using a V8.1.2 or later client, the administrator can
authenticate only on clients or servers that are using V8.1.2 or later. An administrator command can be issued from any
system.

e If necessary, create a separate administrator account to use only with clients and servers that are using V8.1.1 or earlier
software.

Enforce the highest level of security for communication with the IBM Spectrum Protect server by ensuring that all nodes,
administrators, and servers use STRICT session security. You can use the SELECT command to determine which servers, nodes,
and administrators are using TRANSITIONAL session security and should be updated to use STRICT session security.

Related tasks:
B* Securing communications

Managing administrators

An administrator who has system authority can complete any task with the IBM Spectrum Protect™ server, including assigning
authority levels to other administrators. To complete some tasks, you must be granted authority by being assigned one or more
authority levels.

Procedure

Complete the following tasks to modify administrator settings.
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Task Procedure

Add an administrator. To add an administrator, ADMIN1, with system authority and
specify a password, complete the following steps:

a. Register the administrator and specify Pa$#$twO as the
password by issuing the following command:

register admin adminl PaS$#S$twO

b. Grant system authority to the administrator by issuing
the following command:

grant authority adminl classes=system

Change administrative authority. Change the authority level for an administrator, ADMIN1.

e Grant system authority to the administrator by issuing
the following command:

grant authority adminl classes=system

e Revoke system authority for the administrator by issuing
the following command:

revoke authority adminl classes=system

Remove administrators. Remove an administrator, ADMIN1, from accessing the IBM
Spectrum Protect server by issuing the following command:

remove admin adminl

Temporarily prevent access to the server. Lock or unlock an administrator by using the LOCK ADMIN or
UNLOCK ADMIN command.

Changing password requirements

You can change the minimum password limit, password length, password expiration, and enable or disable authentication for IBM
Spectrum Protect™.

About this task

By enforcing password authentication and managing password restrictions, you protect your data and your servers from potential
security risks.

Procedure

Complete the following tasks to change password requirements for IBM Spectrum Protect servers.
Table 1. Authentication tasks for IBM Spectrum Protect servers

Task Procedure
Set a limit for invalid password attempts. a. On the Servers page in the Operations Center, select the
server.

b. Click Details, and then click the Properties tab.
c. Set the number of invalid attempts in the Invalid sign-on
attempt limit field.

The default value at installation is O.
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Task Procedure

Set a minimum length for passwords. a. On the Servers page in the Operations Center, select the
server.

b. Click Details and then click the Properties tab.

c. Set the number of characters in the Minimum password
length field.

Set the expiration period for passwords. a. On the Servers page in the Operations Center, select the
server.

b. Click Details and then click the Properties tab.

c. Set the number of days in the Password common
expiration field.

Disable password authentication. By default, the server automatically uses password
authentication. With password authentication, all users must
enter a password to access the server.

You can disable password authentication only for passwords
that authenticate with the server (LOCAL). By disabling
password authentication, you increase the security risk for the
server.

Set a default authentication method. Issue the SET DEFAULTAUTHENTICATION command. For
example, to use the server as the default authentication
method, issue the following command:

set defaultauthentication local

To update one client node to authenticate with the server,
include AUTHENTICATION=LOCAL in the UPDATE NODE
command:

update node authentication=local

Related concepts:
* Authenticating IBM Spectrum Protect users by using an LDAP server
[** Managing passwords and logon procedures (V7.1.1)

Securing IBM Spectrum Protect on the system

Protect the system where the IBM Spectrum Protect™ server runs to prevent unauthorized access.

Procedure

Ensure that unauthorized users cannot access the directories for the server database and the server instance. Keep the access
settings for these directories that you configured during implementation.

e Restricting user access to the server
Authority levels determine what an administrator can do with the IBM Spectrum Protect server. An administrator with
system authority can complete any task with the server. Administrators with policy, storage, or operator authority can
complete subsets of tasks.

e Limiting access through port restrictions
Limit access to the server by applying port restrictions.

Restricting user access to the server

Authority levels determine what an administrator can do with the IBM Spectrum Protect™ server. An administrator with system
authority can complete any task with the server. Administrators with policy, storage, or operator authority can complete subsets of
tasks.

Procedure
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1. After you register an administrator by using the REGISTER ADMIN command, use the GRANT AUTHORITY command to set
the administrator's authority level. For details about setting and changing authority, see Managing administrators.
2. To control the authority of an administrator to complete some tasks, use the following two server options:

a. You can select the authority level that an administrator must have to issue QUERY and SELECT commands with the
QUERYAUTH server option. By default, no authority level is required. You can change the requirement to one of the
authority levels, including system.

b. You can specify that system authority is required for commands that cause the server to write to an external file with
the REQSYSAUTHOUTFILE server option. By default, system authority is required for such commands.

3. You can restrict data backup on a client node to only root user IDs or authorized users. For example, to limit backups to the
root user ID, issue the REGISTER NODE or UPDATE NODE command and specify the BACKUPINITIATION=root parameter:

update node backupinitiation=root

Limiting access through port restrictions

Limit access to the server by applying port restrictions.

About this task

You might have to restrict access to specific servers, based on your security requirements. The IBM Spectrum Protect™ server can
be configured to listen on four TCP/IP ports: two that can be used for either regular TCP/IP protocols or Secure Sockets Layer
(SSL)/Transport Layer Security (TLS) protocols and two that can be used only for the SSL/TLS protocol.

Procedure

You can set the server options to specify the port that you require, as listed in Table 1.
Table 1. Server options and port access

Server option Port access

TCPPORT Specifies the port number on which the server TCP/IP communication driver is to wait for
requests for client sessions. This port listens for both TCP/IP and SSL-enabled sessions. The
default value is 1500.

TCPADMINPORT Specifies the port number on which the server TCP/IP communication driver is to wait for
requests for sessions other than client sessions. This port listens for both TCP/IP and SSL-
enabled sessions. The default is the value of TCPPORT.

Use this option to separate administrative client traffic from regular client traffic that uses the
TCPPORT and SSLTCPPORT options.

SSLTCPPORT Specifies the SSL TCP/IP port address for a server. This port listens for SSL-enabled sessions
only. A default port value is not available.

SSLTCPADMINPORT Specifies the port address on which the server TCP/IP communication driver waits for requests
for SSL-enabled sessions. A default port value is not available.

Use this option to separate administrative client traffic from regular client traffic that uses the
TCPPORT and SSLTCPPORT options.

Restrictions:
The following restrictions apply when you specify the SSL-only server ports (SSLTCPPORT and SSLTCPADMINPORT):

e When you specify the server's SSL-only port for the LLADDRESS on the DEFINE SERVER or UPDATE SERVER command, you
must also specify the SSL=YES parameter.

e When you specify the server's SSL-only port for the client's TCPPORT option, you must also specify YES for the SSL client
option.

Related reference:
Planning firewall access

Stopping and starting the server

Before you complete maintenance or reconfiguration tasks, stop the server. Then, start the server in maintenance mode. When
you are finished with the maintenance or reconfiguration tasks, restart the server in production mode.
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Before you begin

You must have system or operator privilege to stop and start the IBM Spectrum Protect™ server.

e Stopping the server
Before you stop the server, prepare the system by ensuring that all database backup operations are completed, and all
other processes and sessions are ended. In this way, you can safely shut down the server and ensure that data is protected.
e Starting the server for maintenance or reconfiguration tasks
Before you begin server maintenance or reconfiguration tasks, start the server in maintenance mode. When you start the
server in maintenance mode, you disable operations that might disrupt your maintenance or reconfiguration tasks.

Stopping the server

Before you stop the server, prepare the system by ensuring that all database backup operations are completed, and all other
processes and sessions are ended. In this way, you can safely shut down the server and ensure that data is protected.

About this task

When you issue the HALT command to stop the server, the following actions occur:

e All processes and client node sessions are canceled.
o All current transactions are stopped. (The transactions will be rolled back when the server is restarted.)

Procedure

To prepare the system and stop the server, complete the following steps:

1. Prevent new client node sessions from starting by issuing the DISABLE SESSIONS command:

disable sessions all

2. Determine whether any client node sessions or processes are in progress by completing the following steps:
a. On the Overview page of the Operations Center, view the Activity area for the total numbers of processes and

sessions that are currently active. If numbers differ significantly from the usual numbers that are displayed during
your daily storage-management routine, view other status indicators in the Operations Center to check whether
there is a problem.

. View the graph in the Activity area to compare the amount of network traffic over the following periods:

= The current period, that is, the most recent 24-hour period

= The previous period, that is, the 24 hours before the current period
If the graph for the previous period represents the expected amount of traffic, significant differences on the graph for
the current period might indicate a problem.

. On the Servers page, select a server for which you want to view processes and sessions, and click Details. If the

server is not registered as a hub or spoke server in the Operations Center, obtain information about processes by
using administrative commands. Issue the QUERY PROCESS command to query processes and obtain information
about sessions by issuing the QUERY SESSION command.

3. Wait until the client node sessions are completed or cancel them. To cancel processes and sessions, complete the following

steps:

[e]
o

On the Servers page, select a server for which you want to view processes and sessions, and click Details.
Click the Active Tasks tab, and select one or more processes, sessions, or a combination of both that you want to
cancel.

o Click Cancel.
o If the server is not registered as a hub or spoke server in the Operations Center, cancel sessions by using

administrative commands. Issue the CANCEL SESSION command to cancel a session and cancel processes by using
the CANCEL PROCESS command.

Tip: If the process that you want to cancel is waiting for a tape volume to be mounted, the mount request is
canceled. For example, if you issue an EXPORT, IMPORT, or MOVE DATA command, the command might initiate a
process that requires a tape volume to be mounted. However, if a tape volume is being mounted by an automated
library, the cancel operation might not take effect until the mount process is complete. Depending on your system
environment, this could take several minutes.

4. Stop the server by issuing the HALT command:

halt
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Starting the server for maintenance or reconfiguration tasks

Before you begin server maintenance or reconfiguration tasks, start the server in maintenance mode. When you start the server in
maintenance mode, you disable operations that might disrupt your maintenance or reconfiguration tasks.

About this task

Start the server in maintenance mode by running the DSMSERV utility with the MAINTENANCE parameter.
The following operations are disabled in maintenance mode:

e Administrative command schedules

e Client schedules

e Reclamation of storage space on the server
e Inventory expiration

e Migration of storage pools

In addition, clients are prevented from starting sessions with the server.
Tips:

e You do not have to edit the server options file, dsmserv.opt, to start the server in maintenance mode.
e While the server is running in maintenance mode, you can manually start the storage-space reclamation, inventory
expiration, and storage-pool migration processes.

Procedure

To start the server in maintenance mode, issue the following command:

dsmserv maintenance

Tip: To view a video about starting the server in maintenance mode, see Starting a server in maintenance mode.

What to do next

To resume server operations in production mode, complete the following steps:

1. Shut down the server by issuing the HALT command:

halt

2. Start the server by using the method that you use in production mode. Follow the instructions for your operating system:
o IMMEENStarting the server instance
o IMEITEMStarting the server instance
o I MStarting the server instance

Operations that were disabled during maintenance mode are reenabled.

Planning to upgrade the server

When a fix pack or interim fix becomes available, you can upgrade the IBM Spectrum Protect™ server to take advantage of product
improvements. Servers and clients can be upgraded at different times. Ensure that you complete the planning steps before you
upgrade the server.

About this task

Follow these guidelines:

e The preferred method is to upgrade the server by using the installation wizard. After you start the wizard, in the IBM
Installation Manager window, click the Update icon; do not click the Install or Modify icon.

e If upgrades are available for both the server component and the Operations Center component, select the check boxes to
upgrade both components.

Procedure
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1. Review the list of fix packs and interim fixes. See technote 1239415.

2. Review product improvements, which are described in readme files.
Tip: When you obtain the installation package file from the IBM Spectrum Protect support site, you can also access the
readme file.

3. Ensure that the version that you upgrade your server to is compatible with other components, such as storage agents and
library clients. See technote 1302789.

4. If your solution includes servers or clients at a level that is earlier than V7.1, review the guidelines to ensure that client
backup and archive operations are not disrupted. See technote 1053218.

5. Review the upgrade instructions. Ensure that you back up the server database, the device configuration information, and
the volume history file.

What to do next

To install a fix pack or interim fix, follow the instructions for your operating system:

o ITTENInstalling an IBM Spectrum Protect server fix pack
o ITITEMInstalling an IBM Spectrum Protect server fix pack
o I MInstalling an IBM Spectrum Protect server fix pack

Related information:
I:"’Upgrade and Migration Process - Frequently Asked Questions

Preparing for an outage or system update

Prepare IBM Spectrum Protect™ to maintain your system in a consistent state during a planned power outage or system update.

About this task

Ensure that you schedule activities regularly to manage, protect, and maintain the server.

Procedure

1. Cancel processes and sessions that are in progress by completing the following steps:
a. In the Operations Center, on the Servers page, select a server for which you want to view processes and sessions,
and click Details.
b. Click the Active Tasks tab, and select one or more processes, sessions, or a combination of both that you want to
cancel.
c. Click Cancel.
2. Stop the server by issuing the HALT command:

halt

Tip: You can issue the halt command from the Operations Center by hovering over the Settings icon and clicking Command
Builder. Then, select the server, type halt, and press Enter.

Implementing a disaster recovery plan

Implement a disaster recovery strategy to recover your applications if a disaster occurs and to ensure high server availability.

About this task

Determine your disaster recovery requirements by identifying the business priorities for client node recovery, the systems that you
use to recover data, and whether client nodes have connectivity to a recovery server. Use replication and storage pool protection
to protect data. You must also determine how often directory-container storage pools are protected.

e Completing recovery drills
Schedule disaster recovery drills to prepare for audits that certify the recoverability of the IBM Spectrum Protect server and
to ensure that data can be restored and operations can resume after an outage. A drill also helps you ensure that all data
can be restored and operations resumed before a critical situation occurs.

Recovering from data loss or system outages

IBM Spectrum Protect Knowledge Center Version 8.1.5 217


http://www.ibm.com/support/docview.wss?uid=swg21239415
http://www.ibm.com/support/entry/myportal/product/system_storage/storage_software/ibm_spectrum_protect_family/ibm_spectrum_protect
http://www.ibm.com/support/docview.wss?uid=swg21302789
http://www.ibm.com/support/docview.wss?uid=swg21053218
http://www.ibm.com/support/knowledgecenter/SSEQVQ_8.1.5/srv.install/t_srv_inst_fixpack-aix.html
http://www.ibm.com/support/knowledgecenter/SSEQVQ_8.1.5/srv.install/t_srv_inst_fixpack-linux.html
http://www.ibm.com/support/knowledgecenter/SSEQVQ_8.1.5/srv.install/t_srv_inst_fixpack-windows.html
https://www.ibm.com/developerworks/community/wikis/home/wiki/Tivoli%20Storage%20Manager/page/IBM%20Tivoli%20Storage%20Manager%20Upgrade%20and%20Migration%20Process%20-%20Frequently%20Asked%20Questions

You can use IBM Spectrum Protect™ to recover data that was lost when a disaster or system outage occurred. You can recover
directory-container storage pools, client data, and databases.

Before you begin

Schedule client and server workloads to achieve the best performance for your storage environment. Issue the PROTECT
STGPOOL and REPLICATE NODE commands as part of the schedule. Protect the storage pool before you replicate the client node.
When node replication is started, the data extents that are already replicated through storage pool protection are skipped, which
reduces replication processing time.

Procedure

Use the following recovery methods based on the component that you must recover.

Component to recover Procedure More information
Directory-container storage | To recover directory-container Repairing storage pools
pool storage pools, complete the

following steps:

a. Scan for damaged data
extents in the directory-
container storage pool by
using the AUDIT CONTAINER
command and specifying the
ACTION=SCANALL parameter.

b. Repair damaged data extents
in the directory-container
storage pool by using the
REPAIR STGPOOL command.
Restriction: You can repair a
storage pool only if the
storage pool is protected.

c. Remove damaged data
extents by using the AUDIT
CONTAINER command and
specifying the
ACTION=REMOVEDAMAGED
parameter.
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Component to recover Procedure More information

Client data Prerequisites: e Recovering damaged data from a
o replicated copy
e The source replication server, e SET FAILOVERHLADDRESS (Set a

the target replication server,
and the client must be at the
V7.1 level or later. If any of
the servers are at an earlier
level, automatic failover is
disabled and you must rely on
manual failover.

failover high level address)

Manually configure the client to
automatically fail over to the target
server for data recovery.

If you enabled the client for
automated client failover, you can
recover the data by using automatic
failover function. You can verify that
the usereplicationfailover option is
either not in the client options file or
is set to yes. Recover data from the
target server when the source server
is unavailable due to an outage by
using automatic failover.

Tip:

e Usethe SET
FAILOVERHLADDRESS
command to specify the IP
address for the replication
server during failover, if the
address is different from the
IP address that is specified
for the replication process.

Database Prerequisites: DSMSERV RESTORE DB (Restore the

database)
e To restore the database after

a disaster, you must have a
copy of the current device
configuration file. The device
configuration file cannot be
recreated.

e Ensure that you have a
backed up version of the
database.

Restore the IBM Spectrum Protect
database to the most current state
or to a specific point in time by using
the DSMSERV RESTORE DB server
utility.

e Restoring the database
You might have to restore the IBM Spectrum Protect database after a disaster. You can restore the database to the most
current state or to a specified point in time. You must have full, incremental, or snapshot database backup volumes to
restore the database.

e Recovering damaged data from a replicated copy
If a source replication server is unavailable, you can recover damaged data from a replicated copy that is stored on the
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target replication server.
e Repairing storage pools
If a disaster or system outage occurred, you can repair deduplicated data extents in a directory-container storage pool.

Related reference:
[ AUDIT CONTAINER (Verify the consistency of database information for a directory-container storage pool)
[+ DSMSERV RESTORE DB (Restore the database)

Restoring the database

You might have to restore the IBM Spectrum Protect™ database after a disaster. You can restore the database to the most current
state or to a specified point in time. You must have full, incremental, or snapshot database backup volumes to restore the
database.

Before you begin

If the database and recovery log directories are lost, re-create them before you issue the DSMSERV RESTORE DB server utility. For
example, use the following commands: IS BT

mkdir /tsmdb001
mkdir /tsmdb002
mkdir /tsmdb003
mkdir /activelog
mkdir /archlog
mkdir /archfaillog

| Windows |

mkdir e:\tsm\db001l

mkdir f:\tsm\db001l

mkdir g:\tsm\db001l

mkdir h:\tsm\activelog
mkdir i:\tsm\archlog
mkdir j:\tsm\archfaillog

Restrictions:

e To restore the database to its latest version, you must locate the archive log directory. If you are cannot locate the
directory, you can restore the database only to a point in time.

e You cannot use Secure Sockets Layer (SSL) for database restore operations.

e If the release level of the database backup is different from the release level of the server that is being restored, you cannot
restore the server database. For example, if you are using a Version 8.1 server and you try to restore a Version 7.1
database, an error occurs.

About this task

Point-in-time restore operations are typically used for situations such as disaster recovery or to remove the effects of errors that
can cause inconsistencies in the database. To recover the database to the time when the database was lost, recover the database
to its latest version.

Procedure

Use the DSMSERV RESTORE DB server utility to restore the database. Depending on the version of the database that you want to
restore, choose one of the following methods:

e Restore a database to its latest version. For example, use the following command:
dsmserv restore db

e Restore a database to a point in time. For example, to restore the database to a backup series that was created on 19 April
2015, use the following command:

dsmserv restore db todate=04/19/2015

What to do next
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If you restored the database and directory-container storage pools exist on the server, you must identify inconsistencies between
the database and the file system.

1. If you restored the database to a point in time and you did not delay reuse of the directory-container storage pool, you must
audit all the containers. To audit all containers, issue the following command:

audit container stgpool

2. If the server cannot identify containers on the system, complete the following steps to display a list of containers:
a. From an administrative client, issue the following command:

select container_name from containers

b. From the file system, issue the following command for the storage pool directory on the source server:
Tip: The storage pool directory is displayed in the command output:
x| Linux |

[root@source]$ 1ls -1R
| Windows |

c:\source stgpooldir>dir /s

c. Compare the containers that are listed on the file system and the server.

d. Issue the AUDIT CONTAINER command and specify the container that is missing from the server output. Specify the
ACTION=REMOVEDAMAGED parameter to delete the container.

e. To ensure that the containers are deleted on the file system, review the messages that are displayed.
Tip: The IBM Spectrum Protect server does not recognize containers that are created after the last database backup.
Delete extra files that exist on your local file system when compared to the files that exist on the IBM Spectrum
Protect server.

Related tasks:

g Replicating client node data after a database restore (V7.1.1)

Related reference:

[ AUDIT CONTAINER (Verify the consistency of database information for a directory-container storage pool)
[+ DSMSERV RESTORE DB (Restore the database)

Recovering damaged data from a replicated copy

If a source replication server is unavailable, you can recover damaged data from a replicated copy that is stored on the target
replication server.

Before you begin

The server name that you specify with the SET REPLSERVER command must match the name of an existing server definition. It
must also be the name of the server to be used as the target replication server. If the server name specified by this command does
not match the server name of an existing server definition, the command fails.

Tip:

e Use care when you change or remove a target replication server. If you change a target replication server, client-node data
that is replicated is sent to a different target replication server. If you remove a target replication server, client node data is
not replicated.

Procedure

1. Verify the replication status of the data on the target server. The replication status indicates whether the most recent
backup was replicated to the secondary server.

2. Restore data from a target replication server by setting the source replication server as the target replication server. For
example, if you want to set the source replication server as the target replication server, serverl, issue the following
command:

set replserver serverl

What to do next
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When you restore the IBM Spectrum Protect™ database on a source replication server, replication is automatically disabled.
Before you re-enable replication, determine whether copies of data that are on the target replication server are needed.

Related tasks:
[* Replicating client node data after a database restore (V7.1.1)

Repairing storage pools

If a disaster or system outage occurred, you can repair deduplicated data extents in a directory-container storage pool.

Before you begin

Identify inconsistencies between the database and the directory-container storage pool by using the AUDIT CONTAINER
command. By identifying the damaged data extents in the directory-container storage pool, you can determine what data extents
to repair.

Before you repair a storage pool, ensure that the storage pool is protected by using the PROTECT STGPOOL command.

Procedure

1. To repair a directory-container storage pool, use the REPAIR STGPOOL command. For example, to repair a storage pool,
STGPOOLY, issue the following command:

repair stgpool stgpooll

2. If the damaged storage pool is specified as a target storage pool on the PROTECT STGPOOL command for one or more
source storage pools, issue the PROTECT STGPOOL command for all source storage pools.

3. To ensure that all damaged data is identified and repaired from other source storage pools, issue the PROTECT STGPOOL
command again from all source storage pools and specify the FORCERECONCILE=YES parameter.

4. To remove objects that refer to damaged data, issue the AUDIT CONTAINER command and specify the
ACTION=REMOVEDAMAGED parameter.

5. If the damaged storage pool is a target storage pool for node replication from one or more source servers, issue the
REPLICATE NODE command again from all source servers.

6. When the damage is repaired, issue the PROTECT STGPOOL command to ensure that the storage pool is protected to
another directory-container storage pool.

What to do next

Ensure that no damaged data extents are displayed in the output by using the QUERY DAMAGED command.
Related reference:

[ Repairing and recovering data in directory-container storage pools

[+ AUDIT CONTAINER (Verify the consistency of database information for a directory-container storage pool)
I QUERY DAMAGED (Query damaged data in a directory-container or cloud-container storage pool)

[ REPAIR STGPOOL (Repair a directory-container storage pool)

Tape solution

This data protection solution provides storage to tape media, a flexible and affordable option for long-term data retention.

e Planning for a tape-based data protection solution
Plan for a data protection solution that includes disk-to-disk-to-tape and disk-to-tape backup operations to optimize
storage.

e Implementation of a tape-based data protection solution
Implement the tape-based solution, which uses disk-to-disk-to-tape backup and disk staging to optimize storage. By
implementing the tape solution, you can enable long-term data retention and achieve low-cost scalability.

e Monitoring a tape solution
After you implement an IBM Spectrum Protect tape-based solution, monitor the solution to ensure correct operation. By
monitoring the solution daily and periodically, you can identify existing and potential issues. The information that you
gather can be used to troubleshoot problems and optimize system performance.

e Managing operations for a tape solution
Use this information to manage operations for a tape implementation for an IBM Spectrum Protect server.
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Planning for a tape-based data protection solution

Plan for a data protection solution that includes disk-to-disk-to-tape and disk-to-tape backup operations to optimize storage.

Planning roadmap

Plan for the tape solution by reviewing the architecture layout in Figure 1 and then completing the roadmap tasks that follow the
diagram.
Figure 1. Tape solution

) Ideal for long-term retention () Low-cost scalability

() Disk staging to primary tape pool () Optimized for SAN

Applications, virtual machines, Offsite options
systems
. . [A1 [’;‘i Pa I
] Second copy sent offsite
Staging pool on disk Or
for client backup
LAN-free

data movement

Primary pool on fape for Remote library for offsite copy
client and inventary backup

In this data protection configuration, the server uses both disk and tape storage hardware. Storage pool staging is used, in which
client data is initially stored in disk storage pools and then later migrated to tape storage pools. For disaster recovery, tape
volumes can be stored offsite. Offsite options include physically moving a second copy offsite by a courier or electronically
vaulting copies offsite to a remote library.

Tip: The described solution does not include node replication. However, if you want to use node replication to back up a storage
pool from disk to disk, ensure that the replication operation is completed before data is migrated from disk to tape. You can also
use node replication to back up a storage pool on a local tape device to a copy storage pool on a local tape device.

To plan for a tape-based solution, complete the following tasks:

1. Meet system requirements for hardware and software.

2. Record values for your system configuration in the planning worksheets.
3. Plan for disk storage.

4. Plan for tape storage.

5. Plan for security.

Tape planning requirements

Before you implement a tape solution, review the general guidelines about system requirements. Determine whether to back up
data to disk or tape, or a combination of both.

Network bandwidth
The network must have sufficient bandwidth for the expected data transfers between the client and the server, and for the
cross-site restore operations that are required for disaster recovery. Use a storage area network (SAN) for data transfers
among the server, disk devices, and tape devices. For more information, see Hardware requirements.

Data migration
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Migrate all data from disk to tape daily. Specify a FILE device class for disk-based storage pools. Schedule migration to
control when processing occurs. To prevent automatic migration based on the migration threshold, specify a value of 100
for the HIGHMIG parameter and 0 for the LOWMIG parameter when you issue the DEFINE STGPOOL command. You must
keep at least 20% of the tape drives available for restore operations. To use up to 80% of available tape drives and improve
throughput performance, specify the MIGPROCESS parameter.

Consider the following information based on the type of data that is migrated:

e Use tape to back up data from clients that have large objects, such as databases.
Tip: Check with your tape-drive manufacturer for guidance about the size of the database that is suitable to write to
tape.

e Use disk to back up data from clients that have smaller objects.

e To back up data directly to tape, use LAN-free data movement. For more information, see Configuring LAN-free data
movement.

e Do not back up virtual machines to tape. Use a separate disk-based storage pool that does not migrate to a tape-
based storage pool. For more information about virtual machine support, see technote 1239546.

Storage pool capacity
Maintain enough storage pool capacity to allow for 2 days of client backups and a buffer of 20%. You might have to
schedule full backups over a few days to ensure that you have enough storage pool space.

Tape drives
Review the manufacturer specifications and estimate the capacity of a tape drive. Determine the amount of space that is
required for backup and migration operations. Reserve 20% of tape drives for restore operations.

Related reference:
[+ MIGRATE STGPOOL (Migrate storage pool to next storage pool)

System requirements for a tape-based solution

Hardware and software requirements are provided for a tape-based storage solution that has a data ingestion rate of 14 TB per
hour.

Review the information to determine the hardware and software requirements for your storage environment. You might have to
make adjustments based on your system size.

e Hardware requirements
Hardware requirements for your IBM Spectrum Protect™ solution are based on system size. Choose equivalent or better
components than those items that are listed to ensure optimum performance for your environment.

e Software requirements
Documentation for the IBM Spectrum Protect tape-based solution includes installation and configuration tasks for IBM®
AIX®, Linux, and Microsoft Windows operating systems. You must meet the minimum software requirements that are listed.

Hardware requirements

Hardware requirements for your IBM Spectrum Protect™ solution are based on system size. Choose equivalent or better
components than those items that are listed to ensure optimum performance for your environment.

For more information about planning disk devices, see Planning for disk storage.
For more information about planning tape devices, see Planning for tape storage.

The following table includes minimum hardware requirements for the server and storage. If you are using local partitions (LPARs)
or work partitions (WPARs), adjust the network requirements to take account of the partition sizes. The figures in the table are
based on a data ingestion rate of 14 TB per hour.

Hardware System requirements
component
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Hardware
component

System requirements

Server processor

TN processor cores, 3.42 GHz or faster.

For example, use a POWER8® processor-based server.

TN NI 1 6 processor cores, 2.0 GHz or faster.

For example, use an Intel Xeon processor.

Server memory

64 GB RAM.

Network

The following sizing manages approximately 14 TB of data per hour:

e 10 Gb Ethernet (a minimum of four ports)
® 8 Gb Fibre Channel adapter (a minimum of four ports)

The number of ports depends on the percentage of daily data ingestion to disk storage pools versus tape
storage.

Use separate Fibre Channel adapters for tape and disk data.

Storage

Disk
Based on the amount of data that you are writing to disk, specify the number of disks that you
require.

Ensure that the sequential input/output (I/0) throughput of the storage area network (SAN)
matches the I/0 throughput for the network in the previous row.

For example, if you must back up 10 TB of data in a four-hour window, the throughput is
approximately 700 MB per second. In this case, the server requires a front-end network (client-to-
server path) that supports a minimum throughput of 700 MB per second. The back-end SAN (the
server-to-storage device path) also must support a minimum throughput of 700 MB per second.

To calculate the required disk speed, use the following formulas:

(Total amount of daily data ingestion -

amount of daily data ingestion directly to tape) =+
(Number of hours for daily client backup operations) =
Megabytes of data ingestion to disk per hour

(Megabytes of data ingestion to disk per hour) =+
(3600 seconds per hour) =

Megabytes of data ingestion per second

that must be supported by the disk technology

Tape
Select the tape technology that best fits your business requirements. For example, use IBM Linear
Tape-Open (LTO) or IBM TS1150 tape drives. Ensure that you have sufficient mount points for
client backup operations and for migration. For more information about planning tape storage, see
Planning for tape storage. For a list of supported tape devices, see IBM® Support Portal for IBM
Spectrum Protect.
Tip: To optimize data movement, use LAN-free data movement.

SAN I/O adapters

Segregate disk and tape I/O. For more information about selecting an adapter, see the documentation for
Brocade hardware products and for IBM Storwize® storage solutions.

Disk
Use at least two adapters.

Tape
Use at least two adapters.

Estimating space requirements for the Operations Center
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Hardware requirements for the Operations Center are included in the preceding table, except for the database and archive log
space (inventory) that the Operations Center uses to hold records for managed clients.

If you do not plan to install the Operations Center on the same system as the IBM Spectrum Protect server, you can estimate
system requirements separately. To calculate system requirements for the Operations Center, see the system requirements
calculator in technote 1641684.

Managing the Operations Center on the IBM Spectrum Protect server is a workload that requires extra space for database
operations on both the hub server and any spoke servers. The amount of space on the hub server for the archive log is larger if the
hub server is monitoring one or more spoke servers. Review the following guidelines to estimate how much space your IBM
Spectrum Protect server requires.

Database space for the Operations Center
The Operations Center uses approximately 4.4 GB of database space for every 1000 clients that are monitored on that
server. This calculation applies to both hub servers and spoke servers within a configuration.
For example, consider a hub server with 2000 clients that also manages three spoke servers, each with 1000 clients. This
configuration has a total of 5000 clients across the four servers. Each of the spoke servers requires 4.4 GB of database
space. If the spoke servers are at IBM Spectrum Protect Version 8.1.2 or later, the hub server requires 8.8 GB of database
space for monitoring only its 2000 clients:

(4.4 GB x 2) = 8.8 GB

Database space for managed data
Managed data is the amount of data that is protected, including the amount of data for all retained versions.

e For client types that perform incremental-forever backups, the following formula can be used to estimate the total
managed data:

Front-end + (front-end x change rate x (retention - 1))

For example, if you back up 100 TB of front-end data, use a 30-day retention period, and have a 5% change rate,
calculate your total managed data by using the following figures:

100 TB + (100 TB x 0.05 x (30-1)) = 245 TB total managed data

e For client types that perform full backups every day, the following formula can be used to estimate the total
managed data:

Front-end x retention x (1 + change rate)

For example, if you back up 10 TB of front-end data, use a 30-day retention period, and have a 3% change rate,
calculate your total managed data by using the following figures:

10 TB x 30 x (1 + .03) = 309 TB total managed data
Unstructured data, average object size: 4 MB
Structured data, average object size: 128 MB

Unstructured data, number of objects =

(245 TB x 1024 x 1024) / 4 MB = 64225280

Structured data, number of objects =

(309 TB x 1024 x 1024) / 128 MB = 2531328

Total number of objects: 66756608

Managed data cost (1 KB per object) =

(66756608 KB) / (1024 x 1024) = 63.66 GB

Plan for 20% of additional space so that database systems are not at 100% capacity:

Database total physical storage requirements =
(managed data space + Operations Center space) x (1.20)

For this example, you would calculate the space by using the following figures:
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(66.33 GB + 8.4 GB) x 1.20 = 76.41 GB

Archive log space

The Operations Center uses approximately 18 GB of archive log space every 24 hours, per server, for every 1000 clients

monitored on that server. Additionally, for every 1000 clients that are monitored on spoke servers, additional archive log
space is used on the hub server. For spoke servers at V8.1.2 or later, this added amount is 1.2 GB of archive log space on
the hub server per 1000 clients monitored every 24 hours.

For example, consider a hub server with 2000 clients that also manages three spoke servers, each with 1000 clients. This
configuration has a total of 5000 clients across the four servers. You can calculate the archive log space for the hub server
by using the following formula:

((18 GB x 2)

(1.2 GB x 3)) = 39.6 GB of archive log space

These estimates are based on the default status collection interval of 5 minutes. If you reduce the collection interval from
once every 5 minutes to once every 3 minutes, the space requirements increase. The following examples show the
approximate increase in the log space requirements with a collection interval of once every 3 minutes for a configuration in
which V8.1.2 or later spoke servers are monitored:

e Hub server: In the range 39.6 GB - 66 GB
e Each spoke server: In the range 18 GB - 30 GB

Allocate archive log space so that you can support the Operations Center without affecting server operations.

Software requirements

Documentation for the IBM Spectrum Protect™ tape-based solution includes installation and configuration tasks for IBM® AIX®,
Linux, and Microsoft Windows operating systems. You must meet the minimum software requirements that are listed.

For information about software requirements for IBM lin_tape device drivers, refer to the IBM Tape Device Drivers Installation and

User's Guide.

AIX systems

Type of software

Minimum software requirements

Operating system

IBM AIX 7.1

For more information about operating system requirements, see AIX: Minimum system
requirements for AIX systems.

Gunzip utility

The gunzip utility must be available on your system before you install or upgrade the IBM
Spectrum Protect server. Ensure that the gunzip utility is installed and the path to it is set in
the PATH environment variable.

File system type

JFS2 file systems

AIX systems can cache a large amount of file system data, which can reduce memory that is
required for server and IBM DB2® processes. To avoid paging with the AIX server, use the
rbrw mount option for the JFS2 file system. Less memory is used for the file system cache
and more is available for IBM Spectrum Protect.

Do not use the file system mount options, Concurrent I/O (CIO), and Direct I/O (DIO), for file
systems that contain the IBM Spectrum Protect database, logs, or storage pool volumes.
These options can cause performance degradation of many server operations. IBM Spectrum
Protect and DB2 can still use DIO where it is beneficial to do so, but IBM Spectrum Protect
does not require the mount options to selectively take advantage of these techniques.

Other software

Korn Shell (ksh)

Linux systems

Type of software

Minimum software requirements
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Type of software Minimum software requirements

Operating system Red Hat Enterprise Linux 7 (x86_64)
Libraries GNU C libraries, Version 2.3.3-98.38 or later that is installed on the IBM Spectrum Protect
system.

Red Hat Enterprise Linux Servers:

e libaio
e libstdc++.50.6 (32-bit and 64-bit packages are required)
e numactl.x86_64

File system type Format database-related file systems with ext3 or ext4.

For storage pool-related file systems, use XFS.

Other software Korn Shell (ksh)

Windows systems

Type of software Minimum software requirements

Operating system Microsoft Windows Server 2012 R2 (64-bit) or Windows Server 2016

File system type NTFS

Other software Windows 2012 R2 or Windows 2016 with .NET Framework 3.5 is installed and enabled.

The following User Account Control policies must be disabled:

e User Account Control: Admin Approval Mode for the Built-in Administrator
account
e User Account Control: Run all administrators in Admin Approval Mode

Planning worksheets

Use the planning worksheets to record values that you use to set up your system and configure the IBM Spectrum Protect™ server.
Use the best practice default values that are listed in the worksheets.

Each worksheet helps you prepare for different parts of the system configuration by using best practice values:

Server system preconfiguration
Use the preconfiguration worksheets to plan for the file systems and directories that you create when you configure file
systems for IBM Spectrum Protect during system setup. All directories that you create for the server must be empty.
Server configuration
Use the configuration worksheets when you configure the server. Default values are suggested for most items, except
where noted.

Table 1. Worksheet for preconfiguration of a server system

Item Default value Your value Minimum directory size | More information
TCP/IP port address |1500 Not applicable. Ensure that this port
for communications is available when you
with the server install and configure

the operating system.

The port number can
be a numberin the
range 1024 - 32767.
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Item

Default value

Your value

Minimum directory size

More information

Directory for the
server instance

x| Linux |
/home/tsminst1/tsminstl

T C: \tsminst1

TIN50 GB.

Linwe | Windows Y
GB.

If you change the
value for the server
instance directory
from the default, also
modify the DB2®
instance owner value
in Table 2.

Directory for server

x| Linux J]

TN A vailable space

installation W Viindows [of that is required for the
directory: 5 GB.
| Linux | Windows |
Minimum space that is
required for the directory:
30GB
Directory for server | /usr TN A vailable space
installation that is required for the
directory: 5 GB.
Directory for server | IS /var TR A\ vailable space
installation that is required for the
directory: 5 GB.
Directory for server | INEIESE/tmp TR A vailable space
installation that is required for the
directory: 5 GB.
Directory for server | NN/ opt I A vailable space
installation that is required for the
directory: 10 GB.
Directory for the -3_ 128 GB. When you create the
active log /tsminst1/TSMalog active log during the
ITTTEMC: \tsminst1\TSMalog initial configuration of
the server, set the
size t0 128 GB.
Directory for the I T 3TB.

archive log

/tsminst1l/TSMarchlog

ITTTEMC: \tsminst1\TSMarchlog

Directories for the
database

x| Linux |
/tsminst1l/TSMdbspace00

/tsminst1l/TSMdbspace0l
/tsminst1l/TSMdbspace02
/tsminst1/TSMdbspace03

| Windows |
C:\tsminst1\TSMdbspace00

C:\tsminst1\TSMdbspace01l
C:\tsminst1\TSMdbspace02
C:\tsminst1\TSMdbspace03

For instructions about
calculating space
requirements, see
Hardware requirements.

Create four file
systems for the
database.

IBM Spectrum Protect Knowledge Center Version 8.1.5 229




Item

Default value

Your value

Minimum directory size

More information

Directories for

x| Linux |
/tsminst1/TSMfileOO

Determine the minimum

The preferred method

DB2 instance owner

storage | : total capacity for all is to define at least
/tsm!nStl/TSMﬁlem directories by using the one directory for each
[tsminst1/TSMfile02 following calculation: tape device.
/tsminst1l/TSMfile03
Daily
percentage of
INIITTZEMC: \tsminst1\TSMfile00 (ijngestid . _
. ; 3 ata that 1s written
C.\tsm!nstl\TSMf'!le01 to disk + 20% —
C:\tsminst1\TSMfile02 Minimum total
C:\tsminst1\TSMfile03 capacity
Table 2. Worksheet for IBM Spectrum Protect configuration
Item Default value Your value More information
DB2 instance owner tsminstl If you changed the value for
the server instance directory in
Table 1 from the default, also
modify the value for the DB2
instance owner.
DB2 instance owner I T b o sswOrd Select a different value for the
password T pAssWOrd instance owner password than
the default. Ensure that you
record this value in a secure
location.
Primary group for the | INCYEN T8 s msrvrs

Server name

The default value for the server
name is the system host name.

password

Server password passwOrd Select a different value for the
server password than the
default. Ensure that you record
this value in a secure location.

Administrator ID: user |admin

ID for the server

instance

Administrator ID passwOrd Select a different value for the

administrator password than
the default. Ensure that you

record this value in a secure
location.
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Item

Default value

Your value

More information

Schedule start time

23:00

The default schedule start
time begins the client
workload phase, which is
predominantly the client
backup and archive activities.
During the client workload
phase, server resources
support client operations.
Normally, these operations are
completed during the nightly
schedule window.

Schedules for server
maintenance operations are
defined to begin 10 hours after
the start of the client backup
window.

In this guide, the suggested
time to start client backup
operations is 23:00.

Table 3. Worksheet for tape configuration

Item

Default value

Your value

More information

Robotic device files

IBM® devices with an IBM tape
device driver:

° -3_/dev/smcx

.
/dev/IBMchangerX

o INITTTMChangerX

Non-IBM devices with an IBM
Spectrum Protect device driver:

o TN/ dev/IbX
o INTTTTE/dev/tsmscsi/lbX
o INTTTTMIbA.B.C.D

To manually define the library
device files, use the following
commands:

e DEFINE LIBRARY
e DEFINE DRIVE
e DEFINE PATH

For SCSI, you can use the
PERFORM LIBACTION
command to define all drives
and their paths for a single
library in one step. To use this
command to define all drives
and paths, the
SANDISCOVERY option must
be supported and enabled.

Tape drives

IBM devices with an IBM tape
device driver:

o TN/ dev/rmtX
o INTITEM/ dev/IBMtapeX
o IMTTMTapeX

Non-IBM devices with an IBM
Spectrum Protect device driver:

o TN/ dev/mtX
o

/dev/tsmscsi/mtX
o IIMTTTMMtA.B.C.D

Planning for disk storage
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Choose the most effective storage technology for IBM Spectrum Protect™ components to ensure efficient server performance and
operations.

Storage hardware devices have different capacity and performance characteristics, which determine how they can be used
effectively with IBM Spectrum Protect. For general guidance about selecting the appropriate storage hardware and setup for your
solution, review the following guidelines.

Database, active log, and archive log

e Use a solid-state disk (SSD) or a fast, 15,000 rpm disk for the IBM Spectrum Protect database and active log.
e When you create arrays for the database, use RAID level 5.
e Use separate disks for archive log and database backup storage.

Storage pool
Use RAID level 6 for storage pool arrays to add protection against double drive failures when you use large disk types.

e Planning the storage arrays
Prepare for disk storage configuration by planning for RAID arrays and volumes, according to the size of your IBM Spectrum
Protect system.

Planning for tape storage

Determine which tape devices to use and how to configure them. To optimize system performance, plan to use fast, high-capacity
tape devices. Provision enough tape drives to meet your business requirements.

e Supported tape devices and libraries
The server can use a wide range of tape devices and libraries. Select tape devices and libraries that meet your business
requirements.

e Supported tape device configurations
Review the information about local area networks (LAN) and storage area networks (SAN). To optimize data movement,
plan to configure LAN-free data movement. In addition, consider whether to use library sharing.

e Required definitions for tape storage devices
Before the IBM Spectrum Protect™ server can use a tape device, you must configure the device to the operating system and
to the server. As part of the planning process, determine which definitions are required for your tape storage devices.

e Planning the storage pool hierarchy
Plan the storage pool hierarchy to ensure that data is migrated daily from disk to tape. The migration releases space on the
disk device and moves the data to tape for long-term retention. In this way, you can take advantage of the scalability, cost
efficiency, and security features of tape storage.

e Offsite data storage
To facilitate data recovery and as part of your disaster recovery strategy, store tape copies offsite.

Supported tape devices and libraries

The server can use a wide range of tape devices and libraries. Select tape devices and libraries that meet your business
requirements.

For a list of supported devices and valid device class formats, see the website for your operating system:

o TN NS upported devices for AIX and Windows
o INETTEMSupported devices for Linux

For more information about storage devices and storage objects, see Types of storage devices.

Each device that is defined to IBM Spectrum Protect™ is associated with one device class. The device class specifies the device
type and media management information, such as recording format, estimated capacity, and labeling prefixes.

A device type identifies a device as a member of a group of devices that share similar media characteristics. For example, the LTO
device type applies to all generations of LTO tape drives.

A device class for a tape drive must also specify a library. A physical library is a collection of one or more drives that share similar
media-mounting requirements. That is, the drive can be mounted by an operator or by an automated mounting mechanism.

A library object definition specifies the library type and other characteristics that are associated with that library type.
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The following table lists the preferred library types for an IBM Spectrum Protect Version 8.1.5 tape solution.

Table 1. Library types for an IBM Spectrum Protect 8.1.5 tape solution

Library type Description More information

SCSI A SCSI library is controlled through a SCSI interface, attached either | Configuring libraries for use by a
directly to the server's host by using SCSI cabling or by a storage server
area network. A robot or other mechanism automatically handles Restrictions apply when you mix
tape volume mounts and dismounts. different generations of media and
If you create different drive types for a SCSI library, you create drives. For more information, see:
multiple logical libraries that cannot be split between different
types of drives. A SCSI library can contain drives of mixed * Mixing generations of 3592
technologies, including LTO Ultrium and digital linear tape (DLT) drives and media in a single
drives. For example: library

e Mixing LTO drives and
e The Oracle StorageTek L700 library media in a library

e The IBM® 3592 tape device

Shared Shared libraries are logical libraries that are represented by SCSI.
The library is controlled by the IBM Spectrum Protect server that is
configured as a library manager.

IBM Spectrum Protect servers that use the SHARED library type are
library clients to the library manager server. Shared libraries
reference a library manager.

Supported tape device configurations

Review the information about local area networks (LAN) and storage area networks (SAN). To optimize data movement, plan to
configure LAN-free data movement. In addition, consider whether to use library sharing.

Select the device configuration that meets your business requirements.

e | AN-based and LAN-free data movement
You can move data between clients and storage devices that are attached to a local area network (LAN), or to storage
devices that are attached to a storage area network (SAN), known as LAN-free data movement.

e Library sharing
You can optimize the efficiency of your tape solution by configuring library sharing. Library sharing allows multiple IBM
Spectrum Protect™ servers to use the same tape library and drives on a storage area network (SAN) and to improve backup
and recovery performance and tape hardware utilization.

e LAN-free data movement
IBM Spectrum Protect provides the capability for a client, through a storage agent, to directly back up and restore data to a
tape library on a SAN. This type of data movement is also known as LAN-free data movement.

e Mixed device types in libraries
IBM Spectrum Protect supports mixing different device types within a single automated library, if the library can distinguish
among the different media for the different device types. To simplify the configuration process, do not plan to mix different
device types within a library. If you must mix device types, review the restrictions.

LAN-based and LAN-free data movement

You can move data between clients and storage devices that are attached to a local area network (LAN), or to storage devices that
are attached to a storage area network (SAN), known as LAN-free data movement.

In a conventional LAN configuration, one or more tape libraries are associated with a single IBM Spectrum Protect™ server. LAN-
free data movement makes LAN bandwidth available for other uses and decreases the load on the IBM Spectrum Protect server.

In a LAN configuration, client data, email, terminal connection, application program, and device control information must be
handled by the same network. Device control information and client backup and restore data flow across the LAN.

A SAN is a dedicated storage network that can improve system performance.

By using IBM Spectrum Protect in a SAN, you benefit from the following functions:
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e Sharing storage devices among multiple IBM Spectrum Protect servers.
Restriction: A storage device with the GENERICTAPE device type cannot be shared among servers.

e Moving IBM Spectrum Protect client data directly to storage devices (LAN-free data movement) by configuring a storage
agent on the client system.

In a SAN, you can share tape drives and libraries that are supported by the IBM Spectrum Protect server, including most SCSI tape
devices.

When IBM Spectrum Protect servers share a SCSI tape, one server, the library manager, owns and controls the device. The
storage agents, along with other IBM Spectrum Protect servers that share this library are library clients. A library client requests
shared library resources, such as drives or media, from the library manager, but uses the resources independently. The library
manager coordinates the access to these resources. IBM Spectrum Protect servers that are defined as library clients use server-
to-server communications to contact the library manager and request device service. Data moves over the SAN between each
server and the storage device.

Requirement: If you define a library manager server that is shared with the IBM Spectrum Protect server, the SANDISCOVERY
option must be set to ON. By default, this option is set to OFF.

IBM Spectrum Protect servers use the following features when sharing an automated library:

Partitioning of the volume inventory
The inventory of media volumes in the shared library is partitioned among servers. Either one server owns a particular
volume, or the volume is in the global scratch pool. No server owns the scratch pool.
Serialized drive access
Only one server accesses each tape drive at a time. Drive access is serialized. IBM Spectrum Protect controls drive access
so that servers do not dismount other servers' volumes or write to drives where other servers mount their volumes.
Serialized mount access
The library autochanger completes a single mount or dismount operation at a time. The library manager completes all
mount operations to provide this serialization.

Library sharing

You can optimize the efficiency of your tape solution by configuring library sharing. Library sharing allows multiple IBM Spectrum
Protect™ servers to use the same tape library and drives on a storage area network (SAN) and to improve backup and recovery
performance and tape hardware utilization.

When IBM Spectrum Protect servers share a library, one server is set up as the library manager and controls library operations
such as mount and dismount. The library manager also controls volume ownership and the library inventory. Other servers are set
up as library clients and use server-to-server communications to contact the library manager and request resources.

Library clients must be at the same or an earlier version than the library manager server. A library manager cannot support library
clients that are at a later version. For more information, see Storage-agent and library-client compatibility with an IBM Spectrum
Protect server.

LAN-free data movement

IBM Spectrum Protect™ provides the capability for a client, through a storage agent, to directly back up and restore data to a tape
library on a SAN. This type of data movement is also known as LAN-free data movement.

Restriction: Centera storage devices cannot be targets for LAN-free operations.
Figure 1 shows a SAN configuration in which a client directly accesses a tape to read or write data.

Figure 1. LAN-free data movement
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LAN-free data movement requires the installation of a storage agent on the client system. The server maintains the database and
recovery log, and acts as the library manager to control device operations. The storage agent on the client handles the data
transfer to the device on the SAN. This implementation frees up bandwidth on the LAN that would otherwise be used for client
data movement.

Mixed device types in libraries

IBM Spectrum Protect™ supports mixing different device types within a single automated library, if the library can distinguish
among the different media for the different device types. To simplify the configuration process, do not plan to mix different device
types within a library. If you must mix device types, review the restrictions.

Libraries with this capability are models that have built-in mixed drives, or that support the addition of mixed drives. For
information about specific models, see the manufacturer's documentation. To learn about libraries that were tested on IBM
Spectrum Protect with mixed device types, see the information for your operating system:

e IBM Spectrum Protect Supported Devices for AIX®, HP-UX, Solaris, and Windows
e IBM Spectrum Protect Supported Devices for Linux

For example, you can have LTO Ultrium drives and IBM TS4500 drives in a single library that is defined to the IBM Spectrum
Protect server.

e Different media generations in a library
The IBM Spectrum Protect server allows mixed device types in an automated library, but the mixing of different generations
of the same type of drive is generally not supported. New drives cannot write to the older media formats, and old drives
cannot read new formats. LTO Ultrium drives are an exception to this rule.

e Mixed media and storage pools
You can optimize the efficiency of your tape solution by not mixing media formats in a storage pool. Instead of mixing
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formats, map each unique media format to a separate storage pool by using its own device class. This restriction also
applies to LTO formats.

Different media generations in a library

The IBM Spectrum Protect™ server allows mixed device types in an automated library, but the mixing of different generations of
the same type of drive is generally not supported. New drives cannot write to the older media formats, and old drives cannot read
new formats. LTO Ultrium drives are an exception to this rule.

If the new drive technology cannot write to media that is formatted by older generation drives, the older media must be marked
read-only to avoid problems for server operations. Also, the older drives must be removed from the library, or the definitions of the
older drives must be removed from the server. For example, the IBM Spectrum Protect server does not support the use of Oracle
StorageTek 9940A drives with 9940B drives in combination with other device types in a single library.

In general, IBM Spectrum Protect does not support mixing generations of LTO Ultrium drives and media. However, the following
mixtures are supported:

e LTO Ultrium Generation 3 (LTO-3) with LTO Ultrium Generation 4 (LTO-4)

e LTO Ultrium Generation 4 (LTO-4) with LTO Ultrium Generation 5 (LTO-5)

e LTO Ultrium Generation 5 (LTO-5) with LTO Ultrium Generation 6 (LTO-6)

e LTO Ultrium Generation 6 (LTO-6) with LTO Ultrium Generation 7 (LTO-7)

e LTO Ultrium Generation 7 (LTO-7) media with LTO Ultrium Generation 8 (LTO-8 and LTO-M8) media in a library with LTO-8
tape drives or a library with mixed LTO-8 and LTO-7 tape drives

The server supports these mixtures because the different drives can read and write to the different media. If you plan to upgrade
all drives to Generation 4 (or Generation 5, 6, 7, or 8), you must delete all existing LTO Ultrium drive definitions and the paths that
are associated with them. Then, you can define the new Generation 4 (or Generation 5, 6, 7, or 8) drives and paths.

Restrictions that apply to mixing LTO Ultrium tape drives and media

e LTO-5 drives can read only LTO-3 media. If you are mixing LTO-3 with LTO-5 drives and media in a single library, you
must mark the LTO-3 media as read-only. You must check out all LTO-3 scratch volumes.

e |TO-6 drives can read only LTO-4 media. If you are mixing LTO-4 with LTO-6 drives and media in a single library, you
must mark the LTO-4 media as read-only. You must check out all LTO-4 scratch volumes.

e LTO-7 drives can read only LTO-5 media. If you are mixing LTO-5 with LTO-7 drives and media in a single library, you
must mark the LTO-5 media as read-only. You must check out all LTO-5 scratch volumes.

e LTO-8 drives are unable to read LTO-6 media. If you are mixing LTO-6 and LTO-8 drives and media in a single library,
you must partition the library into two libraries. One library has only LTO-8 drives and media and the other has LTO-6
drives and media.

Restrictions that apply to mixed generation LTO Ultrium tape drives in a library
You must use tape cartridges that are an earlier generation than the tape drive. A later generation tape drive can read and
write data to an earlier generation tape cartridge. For an example, if a library has LTO-7 and LTO-6 tape drives, you must
use LTO-6 tape cartridges. Both the LTO-7 and LTO-6 tape drives can read and write data to LTO-6 tape cartridges.
Restrictions that apply to mixed generation LTO Ultrium tape cartridges in a library
You must use a tape cartridge that is the same generation as the tape drive, or one generation earlier. For example, if a
library has LTO-7 tape drives, you can use LTO-7 tape cartridges or mixed LTO-7 and LTO-6 tape cartridges. If this library
has LTO-7, LTO-6, and LTO-5 tape cartridges, you must change the access mode to READONLY for the LTO-5 tape
cartridges.

To learn about additional considerations when you mix LTO Ultrium generations, see Defining LTO device classes.

When you use IBM Spectrum Protect, you cannot mix drives that are 3592, TS1130, TS1140, TS1150, and later drive generations.
Use one of three special configurations. For details, see Defining 3592 device classes.

If you plan to encrypt volumes in a library, do not mix media generations in the library.

Mixed media and storage pools

You can optimize the efficiency of your tape solution by not mixing media formats in a storage pool. Instead of mixing formats,
map each unique media format to a separate storage pool by using its own device class. This restriction also applies to LTO
formats.
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Multiple storage pools and their device classes of different types can point to the same library that can support them as described
in Different media generations in a library.

You can migrate to a new generation of a media type within the same storage pool by following these steps:

1. Replace all older drives with the newer generation drives within the library. The drives should be mixed.

2. Mark the existing volumes with the older formats read-only if the new drive cannot append those tapes in the old format. If
the new drive can write to the existing media in their old format, this is not necessary, but Step 1 is still required. If it is
necessary to keep different drive generations that are read but not write compatible within the same library, use separate
storage pools for each.

Required definitions for tape storage devices

Before the IBM Spectrum Protect™ server can use a tape device, you must configure the device to the operating system and to the
server. As part of the planning process, determine which definitions are required for your tape storage devices.

Tip: You can use the PERFORM LIBACTION command to simplify the process when you add devices to SCSI and VTL library types.

Table 1 summarizes the definitions that are required for different device types.

Table 1. Required definitions for storage devices

Required definitions
Device Device types Library Drive Path Device class
Magnetic disk DISK - — - Yes 1
FILE 2 - - - Yes
TR NI CENTERA - — - Yes
T CENTERA 3
Tape e 3590 Yes Yes Yes Yes
e 3592
e DILT
e |TO
e NAS
e VOLSAFE
TR T GENERICTAPE
ECARTRIDGE 4
Removable media REMOVABLEFILE Yes Yes Yes Yes
(file system)

1. The DISK device class exists at installation and cannot be changed.

2. FILE libraries, drives, and paths are required for sharing with storage agents.

3. IEITEMThe CENTERA device type is available only for Linux x86_64 systems.

4. The ECARTRIDGE device type is for Oracle StorageTek cartridge tape drives such as 9840 and T10000 drives.

Planning the storage pool hierarchy

Plan the storage pool hierarchy to ensure that data is migrated daily from disk to tape. The migration releases space on the disk
device and moves the data to tape for long-term retention. In this way, you can take advantage of the scalability, cost efficiency,
and security features of tape storage.

Before you begin

The storage pool hierarchy helps to manage the flow of data. To understand the data flow, review Figure 1.
Figure 1. Tape solution
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The following steps correspond to the numbers in the figure:

1. The server receives data from clients (applications, virtual machines, or systems) and stores the data on primary storage
pools. Depending on the client type, the data is stored on a primary storage pool on disk or tape.

2. The data on disk and tape is backed up to a copy storage pool on tape.

3. Data in the primary storage pool on disk is migrated daily to the primary storage pool on tape.

4. Data from the copy storage pool on tape is moved offsite to support long-term retention and disaster recovery.

Procedure

To plan the storage pool hierarchy, answer the following questions:

a. Which clients should back up data to disk, and which clients should back up data to tape?

o The preferred method is to back up clients that host large objects, such as databases, to tape.

o The preferred method is to back up all other clients to disk.

o Virtual machine (VM) clients can be backed up to disk or tape. The preferred method is to back up a VM client to a
separate disk storage pool, which is not migrated to tape. If you must migrate a VM client to tape, create a smaller
disk storage pool to hold the VMware control files. This smaller disk storage pool cannot be allowed to migrate to
tape. For more information about backing up a VM client to tape, see Tape media guidelines and technote 1239546.

Tip: If many clients must back up data to a single storage pool, consider using a storage pool on disk because you can
specify many mount points. You can specify a maximum value of 999 for the MAXNUMMP parameter on the REGISTER
NODE command.

b. What are the considerations for specifying the capacity of disk-based storage pools?

At minimum, plan enough capacity to store data from a single day of backup operations. The preferred method is to plan
enough capacity to store data from two days' worth of backup operations and add a 20% buffer.

c. What are the considerations for specifying the device class for the disk-based storage pool?

The preferred method is to specify a FILE device class. Set the MOUNTLIMIT parameter to 4000. Also, ensure that the node
has a sufficiently high number of mount points, which you can specify by using the MAXNUMMP parameter on the
REGISTER NODE command.

d. Should data deduplication be specified for the disk storage pool?
No, because the data is stored on disk for only one day before the data is migrated to tape.

e. Should automatic migration of data be specified based on a migration threshold?
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No. Instead, plan to schedule daily migration by using the MIGRATE STGPOOL command. (To prevent automatic migration
based on the migration threshold, specify a value of 100 for the HIGHMIG parameter and 0 for the LOWMIG parameter
when you issue the DEFINE STGPOOL command.)

f. Should a migration delay be specified?

The preferred method is to specify migration from disk to tape daily, and not specify a migration delay, which requires
additional planning. For more information about migration delays, see Migrating files in a storage pool hierarchy.

g. How can the number of tape drives be calculated?

i. Determine the native data transfer rate of the drive by reviewing the manufacturer's documentation. To obtain an
estimate of the sustained data transfer rate in your storage environment, subtract 30% from the native data transfer
rate.

ii. Calculate the required rate of data ingestion by the server. Then, divide that figure by the sustained data transfer rate
of a single tape device. The result is the minimum number of drives to support data ingestion.

Calculate the number of mount points that are required by clients that back up data to tape, including those clients
that use multiple sessions. You can distribute the mount points over the backup window, keeping in mind that clients
are likely backing up large objects, which might use most of the window.

iv. Calculate the performance requirements and mount points that are required for maintenance tasks, such as disk-to-
tape migration and tape-to-tape copies. By backing up data to tape, you can avoid migration processing, but making
tape-to-tape copies will double the tape drive requirement.

v. Calculate the number of additional drives that might be required, for example:

= If a tape drive malfunctions, the issue impacts the number of available mount points and the ingestion rate.
Consider provisioning spare drives. For example, if you require five tape drives for normal operations, consider
provisioning two spare drives.

m Restore and retrieve operations might require additional tape drives if you plan to run the operations
simultaneously with data ingestion and maintenance operations. If necessary, provision additional tape drives
and ensure that they are unused when you start the restore or retrieve operations.

h. What alternatives are available for optimizing restore operations?
You can use collocation to improve system performance and optimize data organization. Collocation can reduce the number
of volumes that must be accessed when a large amount of data must be restored:

o For disk-based storage pools, the preferred method is to use collocation by node. The server stores the data for the
node on as few volumes as possible.

o For tape-based storage pools, the preferred method is to use collocation by group. Collocation by group results in a
reduction of unused tape capacity, which allows for more collocated data on individual tapes.

For more information about collocation, see Optimizing operations by enabling collocation of client files.

If you are an experienced system administrator, you might plan additional actions to optimize restore operations. See
Optimizing restore operations for clients, File backup techniques, and MOVE NODEDATA (Move data by node in a sequential
access storage pool).

Offsite data storage

To facilitate data recovery and as part of your disaster recovery strategy, store tape copies offsite.

Use the disaster recovery manager (DRM) function to configure and automatically generate a disaster recovery plan that contains
the information, scripts, and procedures that are required to automatically restore the server and recover client data after a
disaster. Choose from one of the following offsite data storage options as a disaster recovery strategy to protect tape copies:

Offsite vaulting from a single production site
Storage volumes, such as tape cartridges and media volumes, are vaulted at an offsite location. A courier transports the
data from the offsite storage facility to the recovery site. If a disaster occurs, the volumes are sent back to the production
site after hardware and the IBM Spectrum Protect™ server are restored.

Offsite vaulting with a recovery site
A courier moves storage volumes from the production site to an offsite storage facility. By having a dedicated recovery site,
you can reduce recovery time compared to the single production site. However, this option increases the cost of disaster
recovery because more hardware and software must be maintained. For example, the recovery site must have compatible
tape devices and IBM Spectrum Protect server software. Before the production site can be recovered, the hardware and
software at the recovery site must be set up and running.

Electronic vaulting
To use electronic vaulting as a disaster recovery strategy, the recovery site must have a running IBM Spectrum Protect
server. Critical data is vaulted electronically from the production site to the recovery site. DRM is also used for offsite
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vaulting of noncritical data. Electronic vaulting moves critical data offsite faster and more frequently than traditional courier
methods. Recovery time is reduced because critical data is already stored at the recovery site. However, because the
recovery site runs continuously, the cost of the disaster recovery strategy is more expensive than offsite vaulting.

Related concepts:
Preparing for and recovering from a disaster by using DRM

Planning for security

Plan to protect the security of systems in the IBM Spectrum Protect™ solution with access and authentication controls, and
consider encrypting data and password transmission.

e Planning for administrator roles

Define the authority levels that you want to assign to administrators who have access to the IBM Spectrum Protect solution.
e Planning for secure communications

Plan for protecting communications among the IBM Spectrum Protect solution components.
e Planning for storage of encrypted data

Determine whether your company requires stored data to be encrypted, and choose the method that best suits your needs.
e Planning firewall access

Determine the firewalls that are set and the ports that must be open for the IBM Spectrum Protect solution to work.

Planning for administrator roles

Define the authority levels that you want to assign to administrators who have access to the IBM Spectrum Protect™ solution.
You can assign one of the following levels of authority to administrators:

System
Administrators with system authority have the highest level of authority. Administrators with this level of authority can
complete any task. They can manage all policy domains and storage pools, and grant authority to other administrators.
Policy
Administrators who have policy authority can manage all of the tasks that are related to policy management. This privilege
can be unrestricted, or can be restricted to specific policy domains.
Storage
Administrators who have storage authority can allocate and control storage resources for the server.
Operator
Administrators who have operator authority can control the immediate operation of the server and the availability of
storage media such as tape libraries and drives.

The scenarios in Table 1 provide examples about why you might want to assign varying levels of authority so that administrators
can perform tasks:
Table 1. Scenarios for administrator roles

Scenario Type of administrator ID to set up

An administrator at a small company manages the server and is e System authority: 1 administrator ID
responsible for all server activities.

An administrator for multiple servers also manages the overall e System authority on all servers: 1 administrator ID for
system. Several other administrators manage their own storage the overall system administrator
pools. e Storage authority for designated storage pools: 1

administrator ID for each of the other administrators

An administrator manages 2 servers. Another person helps e System authority on both servers: 2 administrator IDs
with the administration tasks. Two assistants are responsible e Operator authority: 2 administrator IDs for the

for helping to ensure that important systems are backed up. assistants with access to the server that each person is
Each assistant is responsible for monitoring the scheduled responsible for

backups on one of the IBM Spectrum Protect servers.

Related tasks:
Managing administrators

Planning for secure communications
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Plan for protecting communications among the IBM Spectrum Protect™ solution components.

Determine the level of protection that is required for your data, based on regulations and business requirements under which your

company operates.

If your business requires a high level of security for passwords and data transmission, plan on implementing secure
communication with Transport Layer Security (TLS) or Secure Sockets Layer (SSL) protocols.

TLS and SSL provide secure communications between the server and client, but can affect system performance. To improve
system performance, use TLS for authentication without encrypting object data. To specify whether the server uses TLS 1.2 for the
entire session or only for authentication, see the SSL client option for client-to-server communication, and the UPDATE
SERVER=SSL parameter for server-to-server communication. Beginning in V8.1.2, TLS is used for authentication by default. If you
decide to use TLS to encrypt entire sessions, use the protocol only for sessions where it is necessary and add processor resources
on the server to manage the increase in network traffic. You can also try other options. For example, some networking devices
such as routers and switches provide the TLS or SSL function.

You can use TLS and SSL to protect some or all of the different possible communication paths, for example:

e QOperations Center: browser to hub; hub to spoke

e Client to server

e Server to server: node replication

Related tasks:

Configuring secure communications with Transport Layer Security

Planning for storage of encrypted data

Determine whether your company requires stored data to be encrypted, and choose the method that best suits your needs.

Table 1. Selecting a data encryption method

Business
requirement

Encryption method

Additional information

Protect data at the
client level.

IBM Spectrum Protect™

client encryption

You can encrypt data at the file level by using an include/exclude list. In this
way, you can maintain a high degree of control over which data is encrypted.
Extra computing resources are required at the client that might affect the
performance of backup and restore processes. For more information about
this method, see IBM Spectrum Protect client encryption.

Protect data in
storage pool
volumes on a tape
drive.

Application method

When you use the Application method, IBM Spectrum Protect manages the
encryption keys to protect data in storage pool volumes. You must take extra
care to secure database backups because the encryption keys are stored in
the server database. Without access to database backups and matching
encryption keys, you cannot restore your data. You cannot use this method to
encrypt database backups, exported data, or backup sets. For more
information about the Application method, see Tape encryption methods.

Protect dataon a
tape drive.

Library method

When you use the Library method, the library manages encryption keys. You
can encrypt both data in storage pools and other data on a tape drive. You
can control which volumes are encrypted by using their bar code serial
numbers. For more information about the Library method, see Tape
encryption methods.

Protect dataon a
tape drive.

System method

When you use the System method, a device driver or the AIX operating
system manages encryption. This encryption method is available only on the
AIX® operating system. You can encrypt both data in storage pools and other
data on a tape drive. For more information about the System method, see
Tape encryption methods.

Planning firewall access

Determine the firewalls that are set and the ports that must be open for the IBM Spectrum Protect™ solution to work.

Table 1 describes the ports that are used by the server, client, and Operations Center.
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Table 1. Ports that are used by the server, client, and Operations Center

Item Default Direction Description
Base port 1500 Outbound/inbound | Each server instance requires a unique port. You can specify an
(TCPPORT) alternative port number. The TCPPORT option listens for both

TCP/IP and SSL-enabled sessions from the client. You can use the
TCPADMINPORT option and ADMINONCLIENTPORT option to set
port values for administrative client traffic.

SSL-only port No default Outbound/inbound | This port is used if you want to restrict communication on the port

(SSLTCPPORT) to SSL-enabled sessions only. A server can support both SSL and
non-SSL communication by using the TCPPORT or
TCPADMINPORT options.

SMB 45 Inbound/outbound | This port is used by configuration wizards that communicate by
using native protocols with multiple hosts.

SSH 22 Inbound/outbound | This port is used by configuration wizards that communicate by
using native protocols with multiple hosts.

SMTP 25 Outbound This port is used to send email alerts from the server.

Replication No default Outbound/inbound | The port and protocol for the outbound port for replication are set

by the DEFINE SERVER command that is used to set up
replication.

The inbound ports for replication are the TCP ports and SSL ports
are specified for the source server on the DEFINE SERVER
command.

service port

Client schedule Client port: 1501 | Outbound The client listens on the port that is named and communicates

port the port number to the server. The server contacts the client if
server prompted scheduling is used. You can specify an
alternative port number in the client options file.

Long-running KEEPALIVE Outbound When the KEEPALIVE option is enabled, keepalive packets are

sessions setting: YES sent during client/server sessions to prevent the firewall software
from closing long-running, inactive connections.

Operations Center [HTTPS: 11090 Inbound These ports are used for the Operations Center web browser. You
can specify an alternative port number.

Client Client port: 9028 | Inbound If you plan to use IBM Spectrum Protect client management

management services, the client management service port must be accessible

from the Operations Center. Ensure that firewalls cannot prevent
connections. The client management service uses the TCP port of
the server for the client node for authentication by using an
administrative session.

Related tasks:

+ Collecting diagnostic information with IBM Spectrum Protect client management services

Related reference:
* ADMINONCLIENTPORT server option

* DEFINE SERVER (Define a server for server-to-server communications)

[** TCPADMINPORT server option
[ TCPPORT server option

Implementation of a tape-based data protection solution

Implement the tape-based solution, which uses disk-to-disk-to-tape backup and disk staging to optimize storage. By
implementing the tape solution, you can enable long-term data retention and achieve low-cost scalability.
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Tip: The described solution does not include node replication. However, if you want to use node replication to back up a storage
pool from disk to disk, ensure that the replication operation is completed before data is migrated from disk to tape. You can also
use node replication to back up a storage pool on a local tape device to a copy storage pool on a local tape device.

Implementation roadmap

The following steps are required to set up a tape-based solution.

. Set up the system.

. Install the server and the Operations Center.

. Configure the server and the Operations Center.
. Attach tape devices for the server.

. Configure tape libraries for use by the server.

. Set up a storage pool hierarchy.

. Install and configure clients.

. Configure LAN-free data movement.

. Select an encryption method and configure encryption.
. Set up tape storage operations.

. Complete the implementation.
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Setting up the system

To set up the system, you must first configure your disk storage hardware and the server system for IBM Spectrum Protect™.

About this task

Tip: Procedures for setting up the server and the disk storage system are described. To get started with setting up tape devices,
see Attaching tape devices for the server.

e Configuring the storage hardware
To optimize disk storage, review the guidelines for setting up disk storage with IBM Spectrum Protect. Then, provide a
connection between the server and the disk storage devices and complete other configuration tasks.

e Installing the server operating system
Install the operating system on the server system and ensure that IBM Spectrum Protect server requirements are met.
Adjust operating system settings as directed.

e Configuring multipath I/O
You can enable and configure multipathing for disk storage. Use the documentation that is provided with your hardware for
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detailed instructions.
e Creating the user ID for the server
Create the user ID that owns the IBM Spectrum Protect server instance. You specify this user ID when you create the server
instance during initial configuration of the server.
e Preparing file systems for the server
You must complete file system configuration for the disk storage to be used by the server.

Configuring the storage hardware

To optimize disk storage, review the guidelines for setting up disk storage with IBM Spectrum Protect. Then, provide a connection
between the server and the disk storage devices and complete other configuration tasks.

Before you begin

For guidelines about setting up disk storage, see Checklist for storage pools on DISK or FILE

Procedure

1. Provide a connection between the server and the storage devices by following these guidelines:
o Use a switch or direct connection for Fibre Channel connections.
o Consider the number of ports that are connected and account for the amount of bandwidth that is needed.
o Consider the number of ports on the server and the number of host ports on the disk system that are connected.
2. Verify that device drivers and firmware for the server system, adapters, and operating system are current and at the
recommended levels.
3. Configure storage arrays. Make sure that you planned properly to ensure optimal performance. For more information, see
Planning for disk storage.
4. Ensure that the server system has access to disk volumes that are created. Complete the following steps:
a. If the system is connected to a Fibre Channel switch, zone the server to see the disks.
b. Map all of the volumes to tell the disk system that this specific server is allowed to see each disk.
5. Ensure that tape and disk devices use different Host Bus Adapter (HBA) ports. Control tape and disk I/O by using the SAN.

Related tasks:
Configuring multipath I/O

Installing the server operating system

Install the operating system on the server system and ensure that IBM Spectrum Protect™ server requirements are met. Adjust
operating system settings as directed.

e Installing on AIX systems
Complete the following steps to install AIX® on the server system.
e Installing on Linux systems
Complete the following steps to install Linux x86_64 on the server system.
e Installing on Windows systems
Install Microsoft Windows Server 2012 Standard Edition on the server system and prepare the system for installation and
configuration of the IBM Spectrum Protect server.

Installing on AIX systems

Complete the following steps to install AIX® on the server system.

Procedure

1. Install AIX Version 7.1, TL4, SP2, or later according to the manufacturer instructions.
2. Configure your TCP/IP settings according to the operating system installation instructions.
3. Open the /etc/hosts file and complete the following actions:

o Update the file to include the IP address and host name for the server. For example:

192.0.2.7 server.yourdomain.com server
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10.

o Verify that the file contains an entry for localhost with an address of 127.0.0.1. For example:

127.0.0.1 localhost

. Enable AIX I/O completion ports by issuing the following command:

chdev -1 iocp0O -P

Server performance can be affected by the Olson time zone definition.

. To optimize performance, change your system time zone format from Olson to POSIX. Use the following command format

to update the time zone setting;:
chtz=local timezone,date/time,date/time

For example, if you lived in Tucson, Arizona, where Mountain Standard Time is used, you would issue the following
command to change to the POSIX format:

chtz MST7MDT,M3.2.0/2:00:00,M11.1.0/2:00:00

. Add an entry in the .profile of the instance user so that the following environment is set:

export MALLOCOPTIONS=multiheap:16

Tip: If the instance user is not available, complete this step later, when the instance user becomes available.

. Set the system to create full application core files. Issue the following command:

chdev -1 sys0O -a fullcore=true -P

. For communications with the server and Operations Center, make sure that the following ports are open on any firewalls

that might exist:
o For communications with the server, open port 1500.
o For secure communications with the Operations Center, open port 11090 on the hub server.

If you are not using the default port values, make sure that the ports that you are using are open.

. Enable TCP high-performance enhancements. Issue the following command:

no -p -o rfcl323=1

For optimal throughput and reliability, bond four 10 Gb Ethernet ports together. Use the System Management Interface Tool
(SMIT) to bond the ports together by using Etherchannel. The following settings were used during testing:

mode 8023ad

auto recovery yes Enable automatic recovery after failover

backup adapter NONE Adapter used when whole channel fails

hash_mode src_dst_port  Determines how outgoing adapter is chosen

interval long Determines interval value for IEEE
802.3ad mode

mode 8023ad EtherChannel mode of operation

netaddr 0 Address to ping

noloss failover yes Enable lossless failover after ping
failure

num retries 3 Times to retry ping before failing

retry time 1 Wait time (in seconds) between pings

use alt addr no Enable Alternate EtherChannel Address

use jumbo_ frame no Enable Gigabit Ethernet Jumbo Frames

11. Verify that user process resource limits, also known as ulimits, are set according to guidelines in Table 1. If ulimit values are

not set correctly, you might experience server instability or a failure of the server to respond.
Table 1. User limits (ulimit) values

User limit type Setting Value Command to query value
Maximum size of core files core Unlimited ulimit -Hc

created

Maximum size of a data data Unlimited ulimit -Hd

segment for a process

Maximum file size fsize Unlimited ulimit -Hf
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User limit type Setting Value Command to query value

Maximum number of open nofile 65536 ulimit -Hn
files
Maximum amount of cpu Unlimited ulimit -Ht

processor time in seconds

Maximum number of user nproc 16384 ulimit -Hu
processes

If you need to modify any user limit values, follow the instructions in the documentation for your operating system.

Installing on Linux systems

Complete the following steps to install Linux x86_64 on the server system.

Before you begin

The operating system will be installed on the internal hard disks. Configure the internal hard disks by using a hardware RAID 1
array. For example, if you are configuring a small system, the two 300 GB internal disks are mirrored in RAID 1 so that a single 300
GB disk appears available to the operating system installer.

Procedure

1. Install Red Hat Enterprise Linux Version 7.1 or later, according to the manufacturer instructions. Obtain a bootable DVD that
contains Red Hat Enterprise Linux Version 7.1 and start your system from this DVD. See the following guidance for
installation options. If an item is not mentioned in the following list, leave the default selection.

a. After you start the DVD, choose Install or upgrade an existing system from the menu.
b. On the Welcome screen, select Test this media & install Red Hat Enterprise Linux 7.1.
c. Select your language and keyboard preferences.
d. Select your location to set the correct time zone.
e. Select Software Selection and then on the next screen, select Server with GUI.
f. From the installation summary page, click Installation Destination and verify the following items:
m The local 300 GB disk is selected as the installation target.
= Under Other Storage Options, Automatically configure partitioning is selected.
Click Done.
g. Click Begin Installation. After the installation starts, set the root password for your root user account.
After the installation is completed, restart the system and log in as the root user. Issue the df command to verify your basic
partitioning. For example, on a test system, the initial partitioning produced the following result:

[root@tvapp02]# df -h

Filesystem Size Used Avail Use% Mounted on
/dev/mapper/rhel-root 50G 3.0G 48G 6% /

devtmpfs 32G 0 32G 0% /dev

tmpfs 32G 92K 32G 1% /dev/shm

tmpfs 32G  8.8M 32G 1% /run

tmpfs 32G 0 32G 0% /sys/fs/cgroup
/dev/mapper/rhel-home 220G 37M 220G 1% /home
/dev/sdal 497M 124M 373M 25% /boot

2. Configure your TCP/IP settings according to the operating system installation instructions.
For optimal throughput and reliability, consider bonding multiple network ports together. This can be accomplished by
creating a Link Aggregation Control Protocol (LACP) network connection, which aggregates several subordinate ports into a
single logical connection. The preferred method is to use a bond mode of 802.3ad, miimon setting of 100, and a
xmit_hash_policy setting of layer3+4.
Restriction: To use an LACP network connection, you must have a network switch that supports LACP.

For additional instructions about configuring bonded network connections with Red Hat Enterprise Linux Version 7, see
Create a Channel Bonding Interface.

3. Open the /etc/hosts file and complete the following actions:
o Update the file to include the IP address and host name for the server. For example:

192.0.2.7 server.yourdomain.com server
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o Verify that the file contains an entry for localhost with an address of 127.0.0.1. For example:

127.0.0.1 localhost

4. Install components that are required for the server installation. Complete the following steps to create a Yellowdog Updater
Modified (YUM) repository and install the prerequisite packages.
a. Mount your Red Hat Enterprise Linux installation DVD to a system directory. For example, to mount it to the /mnt
directory, issue the following command:

mount -t 1s09660 -o ro /dev/cdrom /mnt

b. Verify that the DVD mounted by issuing the mount command. You should see output similar to the following
example:

/dev/sr0 on /mnt type 1509660
c. Change to the YUM repository directory by issuing the following command:
cd /etc/yum/repos.d

If the repos.d directory does not exist, create it.
d. List directory contents:

ls rhel-source.repo
e. Rename the original repo file by issuing the mv command. For example:

mv rhel-source.repo rhel-source.repo.orig

—

. Create a new repo file by using a text editor. For example, to use the vi editor, issue the following command:

vi rhel7l1 dvd.repo

g. Add the following lines to the new repo file. The baseurl parameter specifies your directory mount point:

[rhel71 dvd]

name=DVD Redhat Enterprise Linux 7.1
baseurl=file:///mnt

enabled=1

gpgcheck=0

h. Install the prerequisite package ksh.x86_64, by issuing the yum command. For example:

yum install ksh.x86 64

Exception: You do not need to install the compat-libstdc++-33-3.2.3-69.el6.i686 and libstdc++.i686 libraries for
Red Hat Enterprise Linux Version 7.1.
5. When the software installation is complete, you can restore the original YUM repository values by completing the following
steps:
a. Unmount the Red Hat Enterprise Linux installation DVD by issuing the following command:

unmount /mnt

b. Change to the YUM repository directory by issuing the following command:
cd /etc/yum/repos.d

c. Rename the repo file that you created:
mv rhel71 dvd.repo rhel7l dvd.repo.orig

d. Rename the original file to the original name:

mv rhel-source.repo.orig rhel-source.repo

6. Determine whether kernel parameter changes are required. Complete the following steps:
a. Use the sysctl -a command to list the parameter values.
b. Analyze the results by using the guidelines in Table 1 to determine whether any changes are required.
c. If changes are required, set the parameters in the /etc/sysctl.conf file. The file changes are applied when the system
is started.
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Tip: Automatically adjust kernel parameter settings and eliminate the need for manual updates to these settings. On Linux,
the DB2° database software automatically adjusts interprocess communication (IPC) kernel parameter values to the
preferred settings. For more information about kernel parameter settings, search for Linux kernel parameters in the IBM
DB2 Version 11.1 product documentation.

Table 1. Linux kernel parameter optimum settings

Parameter Description
kernel.shmmni The maximum number of segments.
kernel.shmmax The maximum size of a shared memory segment (bytes).

This parameter must be set before automatically starting the
IBM Spectrum Protect™ server on system startup.

kernel.shmall The maximum allocation of shared memory pages (pages).
kernel.sem (SEMMSL)

There are four values for the kernel.sem The maximum semaphores per array.

parameter. (SEMMNS)

The maximum semaphores per system.

(SEMOPM)

The maximum operations per semaphore call.

(SEMMNI)

The maximum number of arrays.

kernel.msgmni The maximum number of system-wide message queues.
kernel.msgmax The maximum size of messages (bytes).

kernel.msgmnb The default maximum size of queue (bytes).
kernel.randomize_va_space The kernel.randomize_va_space parameter configures the

use of memory ASLR for the kernel. Disable ASLR because it
can cause errors for the DB2 software. To learn more details
about the Linux ASLR and DB2, see technote 1365583.

vm.swappiness The vm.swappiness parameter defines whether the kernel
can swap application memory out of physical random access
memory (RAM). For more information about kernel
parameters, see the DB2 product information.

vm.overcommit_memory The vm.overcommit_memory parameter influences how
much virtual memory the kernel permits allocating. For more
information about kernel parameters, see the DB2 product
information.

7. Open firewall ports to communicate with the server. Complete the following steps:
a. Determine the zone that is used by the network interface. The zone is public, by default.
Issue the following command:

# firewall-cmd --get-active-zones

public
interfaces: ens4f0

b. To use the default port address for communications with the server, open TCP/IP port 1500 in the Linux firewall.
Issue the following command:

firewall-cmd —--zone=public --add-port=1500/tcp --permanent

If you want to use a value other than the default, you can specify a number in the range 1024 - 32767. If you open a
port other than the default, you will need to specify that port when you run the configuration script.

c. If you plan to use this system as a hub, open port 11090, which is the default port for secure (https)
communications.
Issue the following command:
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firewall-cmd --zone=public --add-port=11090/tcp --permanent

d. Reload the firewall definitions for the changes to take effect.
Issue the following command:

firewall-cmd --reload

8. Verify that user process resource limits, also known as ulimits, are set according to guidelines in Table 2. If ulimit values are
not set correctly, you might experience server instability or a failure of the server to respond.

Table 2. User limits (ulimit) values

User limit type Setting Value Command to query value
Maximum size of core files core Unlimited ulimit -Hc

created

Maximum size of a data data Unlimited ulimit -Hd

segment for a process

Maximum file size fsize Unlimited ulimit -Hf
Maximum number of open nofile 65536 ulimit -Hn
files

Maximum amount of cpu Unlimited ulimit -Ht

processor time in seconds

Maximum number of user nproc 16384 ulimit -Hu
processes

If you need to modify any user limit values, follow the instructions in the documentation for your operating system.

Installing on Windows systems

Install Microsoft Windows Server 2012 Standard Edition on the server system and prepare the system for installation and
configuration of the IBM Spectrum Protect™ server.

Procedure

1. Install Windows Server 2016 Standard Edition, according to the manufacturer instructions.
2. Change the Windows account control policies by completing the following steps.
a. Open the Local Security Policy editor by running secpol.msc.
b. Click Local Policies > Security Options and ensure that the following User Account Control policies are disabled:
= Admin Approval Mode for the Built-in Administrator account
= Run all administrators in Admin Approval Mode
3. Configure your TCP/IP settings according to installation instructions for the operating system.
4. Apply Windows updates and enable optional features by completing the following steps:
a. Apply the latest Windows Server 2016 updates.
b. Install and enable the Windows 2012 R2 feature Microsoft .NET Framework 3.5 from the Windows Server Manager.
c. If required, update the FC and Ethernet HBA device drivers to newer levels.
d. Install the multipath I/O driver that is appropriate for the disk system that you are using.
5. Open the default TCP/IP port, 1500, for communications with the IBM Spectrum Protect server. For example, issue the
following command:

netsh advfirewall firewall add rule name="Backup server port 1500"
dir=in action=allow protocol=TCP localport=1500

6. On the Operations Center hub server, open the default port for secure (https) communications with the Operations Center.
The port number is 11090. For example, issue the following command:

netsh advfirewall firewall add rule name="Operations Center port 11090"
dir=in action=allow protocol=TCP localport=11090

Configuring multipath I/0

You can enable and configure multipathing for disk storage. Use the documentation that is provided with your hardware for
detailed instructions.
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e AIX systems

Complete the following steps to enable and configure multipathing for disk storage.
e Linux systems

Complete the following steps to enable and configure multipathing for disk storage.
e Windows systems

Complete the following steps to enable and configure multipathing for disk storage.

AIX systems

Complete the following steps to enable and configure multipathing for disk storage.

Procedure

1. Determine the Fibre Channel port address that you must use for the host definition on the disk subsystem. Issue the lscfg
command for every port.
o Onsmall and medium systems, issue the following commands:

lscfg -vps -1 fcsO | grep "Network Address"
lscfg -vps -1 fcsl | grep "Network Address"

o On large systems, issue the following commands:

lscfg -vps -1 fcsO | grep "Network Address"
lscfg -vps -1 fcsl | grep "Network Address"
lscfg -vps -1 fcs2 | grep "Network Address"
lscfg -vps -1 fcs3 | grep "Network Address"

2. Ensure that the following AIX® file sets are installed:
o devices.common.IBM.mpio.rte
o devices.fcp.disk.array.rte
o devices.fcp.disk.rte
3. Issue the cfgmgr command to have AIX rescan the hardware and discover available disks. For example:

cfgmgr
4. To list the available disks, issue the following command:

lsdev -Ccdisk

You should see output similar to the following:

hdisk0 Available 00-00-00 SAS Disk Drive
hdiskl Available 00-00-00 SAS Disk Drive
hdisk2 Available 01-00-00 SAS Disk Drive
hdisk3 Available 01-00-00 SAS Disk Drive
hdisk4 Available 06-01-02 MPIO IBM 2076 FC Disk
hdisk5 Available 07-01-02 MPIO IBM 2076 FC Disk

5. Use the output from the Isdev command to identify and list device IDs for each disk device.

For example, a device ID could be hdisk4. Save the list of device IDs to use when you create file systems for the IBM
Spectrum Protect™ server.

6. Correlate the SCSI device IDs to specific disk LUNs from the disk system by listing detailed information about all physical
volumes in the system. Issue the following command:

lspv -u
On an IBM® Storwize® system, the following information is an example of what is shown for each device:

hdisk4 00£8cf083fd97327 None active
332136005076300810105780000000000003004214503IBMfcp

In the example, 60050763008101057800000000000030 is the UID for the volume, as reported by the Storwize
management interface.
To verify disk size in megabytes and compare the value with what is listed for the system, issue the following command:
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bootinfo -s hdisk4

Linux systems

Complete the following steps to enable and configure multipathing for disk storage.

Procedure

1. Edit the /etc/multipath.conf file to enable multipathing for Linux hosts. If the multipath.conf file does not exist, you can
create it by issuing the following command:

mpathconf --enable

The following parameters were set in multipath.conf for testing on an IBM Storwize® system:

defaults {
user friendly names no

}

devices {
device {
vendor "IBM "
product "2145"
path grouping policy group by prio
user friendly names no
path selector "round-robin 0"
prio "alua"
path checker "tur"
failback "immediate"
no path retry 5
rr weight uniform
rr min io rg "1"
dev_loss tmo 120

}

2. Set the multipath option to start when the system is started. Issue the following commands:

systemctl enable multipathd.service
systemctl start multipathd.service

3. To verify that disks are visible to the operating system and are managed by multipath, issue the following command:

multipath -1

4. Ensure that each device is listed and that it has as many paths as you expect. You can use size and device ID information to
identify which disks are listed.

For example, the following output shows that a 2 TB disk has two path groups and four active paths. The 2 TB size confirms

that the disk corresponds to a pool file system. Use part of the long device ID number (12, in this example) to search for the
volume on the disk-system management interface.

[root@tapsrv0l codel# multipath -1
36005076802810c509800000000000012 dm-43 IBM,2145
size=2.0T features='l queue if no path' hwhandler='0' wp=rw
|-+- policy='round-robin 0' prio=0 status=active
| |- 2:0:1:18 sdcw 70:64 active undef running
| "= 4:0:0:18 sdgb 131:112 active undef running
‘—+- policy='round-robin 0' prio=0 status=enabled
|- 1:0:1:18 sdat 66:208 active undef running
"= 3:0:0:18 sddy 128:0 active undef running

a. If needed, correct disk LUN host assignments and force a bus rescan. For example:

echo "- - -" > /sys/class/scsi_host/host0/scan
echo "- - -" > /sys/class/scsi _host/hostl/scan
echo "- - -" > /sys/class/scsi host/host2/scan

You can also restart the system to rescan disk LUN host assignments.
b. Confirm that disks are now available for multipath I/O by reissuing the multipath -l command.
5. Use the multipath output to identify and list device IDs for each disk device.
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For example, the device ID for your 2 TB disk is 36005076802810c509800000000000012.

Save the list of device IDs to use in the next step.

Windows systems

Complete the following steps to enable and configure multipathing for disk storage.

Procedure

1. Ensure that the Multipath I/0 feature is installed. If needed, install additional vendor-specific multipath drivers.
2. To verify that disks are visible to the operating system and are managed by multipath I/0, issue the following command:

c:\program files\IBM\SDDDSM\datapath.exe query device

3. Review the multipath output and ensure that each device is listed and that it has as many paths as you expect. You can use
size and device serial information to identify which disks are listed.
For example, by using part of the long device serial number (34, in this example) you can search for the volume on the disk-
system management interface. The 2 TB size confirms that the disk corresponds to a storage pool file system.

DEV#: 4 DEVICE NAME: Disk5 PartO TYPE: 2145 POLICY: OPTIMIZED

SERIAL: 60050763008101057800000000000034 LUN SIZE: 2.0TB

Path# Adapter/Hard Disk State Mode Select Errors
0 Scsi Port2 Bus0/Disk5 PartO OPEN NORMAL 0 0
1 Scsi Port2 Bus0/Disk5 PartO OPEN NORMAL 27176 0
2 Scsi Port3 Bus0/Disk5 PartO OPEN NORMAL 28494 0
3 Scsi Port3 Bus0/Disk5 PartO OPEN NORMAL 0 0

4. Create a list of disk device IDs by using the serial numbers that are returned from the multipath output in the previous step.
For example, the device ID for your 2 TB disk is 60050763008101057800000000000034
Save the list of device IDs to use in the next step.

5. To bring new disks online and clear the read-only attribute, run diskpart.exe with the following commands. Repeat for each
of the disks:

diskpart
select Disk 1
online disk
attribute disk clear readonly
select Disk 2
online disk
attribute disk clear readonly
< Ll >
select Disk 49
online disk
attribute disk clear readonly
exit

Creating the user ID for the server

Create the user ID that owns the IBM Spectrum Protect™ server instance. You specify this user ID when you create the server
instance during initial configuration of the server.

About this task

You can specify only lowercase letters (a-z), numerals (0-9), and the underscore character ( _) for the user ID. The user ID and
group name must comply with the following rules:

e The length must be 8 characters or fewer.
e The user ID and group name cannot start with ibm, sql, sys, or a numeral.
e The user ID and group name cannot be user, admin, guest, public, local, or any SQL reserved word.

Procedure
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1. Use operating system commands to create a user ID.
o [N NTITEM Create a group and user ID in the home directory of the user that owns the server instance.

For example, to create the user ID tsminstl in group tsmsrvrs with a password of tsminstl, issue the following
commands from an administrative user ID:

mkgroup id=1001 tsmsrvrs
mkuser 1d=1002 pgrp=tsmsrvrs home=/home/tsminstl tsminstl
passwd tsminstl

groupadd tsmsrvrs
useradd -d /home/tsminstl -m -g tsmsrvrs -s /bin/bash tsminstl
passwd tsminstl

Log off, and then log in to your system. Change to the user account that you created. Use an interactive login
program, such as telnet, so that you are prompted for the password and can change it if necessary.

o INITTTMCreate a user ID and then add the new ID to the Administrators group. For example, to create the user ID
tsminstl, issue the following command:

net user tsminstl * /add

After you create and verify a password for the new user, add the user ID to the Administrators group by issuing the
following commands:

net localgroup Administrators tsminstl /add
net localgroup DB2ADMNS tsminstl /add

2. Log off the new user ID.

Preparing file systems for the server

You must complete file system configuration for the disk storage to be used by the server.

e Preparing file systems on AIX systems
You must create volume groups, logical volumes, and file systems for the server by using the AIX® Logical Volume Manager.
e Preparing file systems on Linux systems
You must format ext4 or xfs file systems on each of the disk LUNs to be used by the IBM Spectrum Protect server.
e Preparing file systems on Windows systems
You must format New Technology File System (NTFS) file systems on each of the disk LUNs to be used by the IBM
Spectrum Protect server.

Preparing file systems on AIX systems

You must create volume groups, logical volumes, and file systems for the server by using the AIX® Logical Volume Manager.

Procedure

1. Increase the queue depth and maximum transfer size for all of the available hdiskX disks. Issue the following commands
for each disk:

chdev -1 hdisk4 -a max transfer=0x100000
chdev -1 hdisk4 -a queue depth=32

chdev -1 hdisk4 -a reserve policy=no_reserve
chdev -1 hdisk4 -a algorithm=round robin

Do not run these commands for operating system internal disks, for example, hdiskO.

2. Create volume groups for the IBM Spectrum Protect™ database, active log, archive log, database backup, and storage pool.
Issue the mkvg command, specifying the device IDs for corresponding disks that you previously identified.
For example, if the device names hdisk4, hdisk5, and hdiské correspond to database disks, include them in the database
volume group and so on.
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System size: The following commands are based on the medium system configuration. For small and large systems, you
must adjust the syntax as required.

mkvg -S -y tsmdb hdisk2 hdisk3 hdisk4

mkvg -S -y tsmactlog hdisk5

mkvg -S -y tsmarchlog hdisk6

mkvg -S -y tsmdbback hdisk7 hdisk8 hdisk9 hdiskl0

mkvg -S -y tsmstgpool hdiskll hdisk1l2 hdiskl3 hdiskl4 ... hdisk49

3. Determine the physical volume names and the number of free physical partitions to use when you create logical volumes.
Issue the lsvg for each volume group that you created in the previous step.
For example:

lsvg -p tsmdb

The output is similar to the following. The FREE PPs column represents the free physical partitions:

tsmdb:

PV_NAME PV STATE TOTAL PPs FREE PPs FREE DISTRIBUTION
hdisk4 active 1631 1631 327..326..326..326..326
hdisk5 active 1631 1631 327..326..326..326..326
hdisk6 active 1631 1631 327..326..326..326..326

4. Create logical volumes in each volume group by using the mklv command. The volume size, volume group, and device
names vary, depending on the size of your system and variations in your disk configuration.
For example, to create the volumes for the IBM Spectrum Protect database on a medium system, issue the following
commands:

mklv -y tsmdb00 -t jfs2 -u 1 -x 1631 tsmdb 1631 hdisk2
mklv -y tsmdb0l -t jfs2 -u 1 -x 1631 tsmdb 1631 hdisk3
mklv -y tsmdb02 -t jfs2 -u 1 -x 1631 tsmdb 1631 hdisk4

5. Format file systems in each logical volume by using the crfs command.
For example, to format file systems for the database on a medium system, issue the following commands:

crfs -v jfs2 -d tsmdb00 -p rw -a logname=INLINE -a options=rbrw
-a agblksize=4096 -m /tsminstl/TSMdbspace00 -A yes

crfs -v jfs2 -d tsmdb0l -p rw -a logname=INLINE -a options=rbrw
-a agblksize=4096 -m /tsminstl/TSMdbspace0l -A yes

crfs -v jfs2 -d tsmdb02 -p rw -a logname=INLINE -a options=rbrw
-a agblksize=4096 -m /tsminstl/TSMdbspacel2 -A yes

6. Mount all of the newly created file systems by issuing the following command:

mount -a

7. List all file systems by issuing the df command. Verify that file systems are mounted at the correct LUN and correct mount
point. Also, verify the available space.
The following example of command output shows that the amount of used space is typically 1%:

tapsrv07> df -g /tsminstl/*

Filesystem GB blocks Free %Used Tused %Iused Mounted on
/dev/tsmact00 195.12 194.59 1% 4 1% /tsminstl/TSMalog

8. Verify that the user ID that you created in Creating the user ID for the server has read and write access to the directories for
the server.

Preparing file systems on Linux systems

You must format ext4 or xfs file systems on each of the disk LUNs to be used by the IBM Spectrum Protect™ server.

Procedure

1. Using the list of device IDs that you generated previously, issue the mkfs command to create and format a file system for
each storage LUN device. Specify the device ID in the command. See the following examples. For the database, format ext4
file systems:

mkfs -t extd -T largefile -m 2 /dev/mapper/36005076802810c509800000000000012
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For storage pool LUNs, format xfs file systems:

mkfs -t xfs /dev/mapper/3600507630081010578000000000002c3
You might issue the mkfs command as many as 50 times, depending on how many different devices you have.
2. Create mount point directories for file systems.

Issue the mkdir command for each directory that you must create. Use the directory values that you recorded in the
planning worksheets.

For example, to create the server instance directory by using the default value, issue the following command:

mkdir /tsminstl

Repeat the mkdir command for each file system.

3. Add an entry in the /etc/fstab file for each file system so that file systems are mounted automatically when the server is
started.
For example:

/dev/mapper/36005076802810c509800000000000012 /tsminstl/TSMdbspace00 ext4 defaults 0 0

4. Mount the file systems that you added to the /etc/fstab file by issuing the mount -a command.

5. List all file systems by issuing the df command. Verify that file systems are mounted at the correct LUN and correct mount
point. Also, verify the available space.
The following example on an IBM® Storwize® system shows that the amount of used space is typically 1%:

[root@tapsrv04 ~]# df -h /tsminstl/*

Filesystem Size Used Avail Use% Mounted on
/dev/mapper/360050763008101057800000000000003 134G 188M 132G 1% /tsminstl/TSMalog

6. Verify that the user ID that you created in Creating the user ID for the server has read and write access to the directories for
the IBM Spectrum Protect server.

Preparing file systems on Windows systems

You must format New Technology File System (NTFS) file systems on each of the disk LUNs to be used by the IBM Spectrum
Protect™ server.

Procedure

1. Create mount point directories for file systems.
Issue the md command for each directory that you must create. Use the directory values that you recorded in the planning
worksheets. For example, to create the server instance directory by using the default value, issue the following command:

md c:\tsminstl

Repeat the md command for each file system.
2. Create a volume for every disk LUN that is mapped to a directory under the server instance directory by using the Windows
volume manager.

Go to Server Manager > File and Storage Services and complete the following steps for each disk that corresponds to the
LUN mapping that was created in the previous step:

a. Bring the disk online.

b. Initialize the disk to the GPT basic type, which is the default.

c. Create a simple volume that occupies all of the space on the disk. Format the file system by using NTFS, and assign a
label that matches the purpose of the volume, such as TSMfile00. Do not assign the new volume to a drive letter.
Instead, map the volume to a directory under the instance directory, such as C:\tsminst1\TSMfile00.
Tip: Determine the volume label and directory mapping labels based on the size of the disk that is reported.

3. Verify that file systems are mounted at the correct LUN and correct mount point. List all file systems by issuing the
mountvol command and then review the output. For example:

\\?2\Volume{8ffb9678-3216-474c-a021-20e420816a92}\
C:\tsminstl\TSMdbspace00\

4. After the disk configuration is complete, restart the system.
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What to do next

You can confirm the amount of free space for each volume by using Windows Explorer.

Installing the server and Operations Center

Use the IBM® Installation Manager graphical wizard to install the components.

e Installing on AIX and Linux systems

Install the IBM Spectrum Protect™ server and the Operations Center on the same system.
e Installing on Windows systems

Install the IBM Spectrum Protect server and the Operations Center on the same system.

Installing on AIX® and Linux systems

Install the IBM Spectrum Protect™ server and the Operations Center on the same system.

Before you begin

Verify that the operating system is set to the language that you require. By default, the language of the operating system is the
language of the installation wizard.

Procedure

1. I e rify that the required RPM files are installed on your system.
See Installing prerequisite RPM files for the graphical wizard for details.

2. Before you download the installation package, verify that you have enough space to store the installation files when they
are extracted from the product package. For space requirements, see the download document at technote 4042992.

3. Go to Passport Advantage® and download the package file to an empty directory of your choice.

4. Ensure that executable permission is set for the package. If necessary, change the file permissions by issuing the following
command:

chmod a+x package name.bin
5. Extract the package by issuing the following command:
./package name.bin

where package_name is the name of the downloaded file.
6. TN E nsure that the following command is enabled so that the wizards work properly:

lsuser

By default, the command is enabled.
7. Change to the directory where you placed the executable file.
8. Start the installation wizard by issuing the following command:

./install.sh

When you select the packages to install, choose both the server and Operations Center.

What to do next

e If errors occur during the installation process, the errors are recorded in log files that are stored in the IBM Installation
Manager logs directory.

To view installation log files from the Installation Manager tool, click File > View Log. To collect these log files from the
Installation Manager tool, click Help > Export Data for Problem Analysis.

e After you install the server and before you customize it for your use, go to the IBM Spectrum Protect support site. Click
Support and downloads and apply any applicable fixes.
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e Installing prerequisite RPM files for the graphical wizard
RPM files are required for the IBM Installation Manager graphical wizard.

Installing on Windows systems

Install the IBM Spectrum Protect™ server and the Operations Center on the same system.

Before you begin

Make sure that the following prerequisites are met:

e Verify that the operating system is set to the language that you require. By default, the language of the operating system is
the language of the installation wizard.
e Ensure that the user ID that you plan to use during the installation is a user with local Administrator authority.

Procedure

1. Before you download the installation package, verify that you have enough space to store the installation files when they
are extracted from the product package. For space requirements, see the download document at technote 4042993.

2. Go to Passport Advantage® and download the package file to an empty directory of your choice.

3. Change to the directory where you placed the executable file.

4. Double-click the executable file to extract to the current directory.

5. In the directory where the installation files were extracted, start the installation wizard by double-clicking the install.bat
file. When you select the packages to install, choose both the server and Operations Center.

What to do next

e If errors occur during the installation process, the errors are recorded in log files that are stored in the IBM® Installation
Manager logs directory.

To view installation log files from the Installation Manager tool, click File > View Log. To collect these log files from the
Installation Manager tool, click Help > Export Data for Problem Analysis.

e After you install the server and before you customize it for your use, go to the IBM Spectrum Protect support site. Click
Support and downloads and apply any applicable fixes.

Configuring the server and the Operations Center

After you install the components, complete the configuration for the IBM Spectrum Protect™ server and the Operations Center.

e Configuring the server instance
Use the IBM Spectrum Protect server instance configuration wizard to complete the initial configuration of the server.

e Installing the backup-archive client
As a best practice, install the IBM Spectrum Protect backup-archive client on the server system so that the administrative
command-line client and scheduler are available.

e Setting options for the server
Review the server options file that is installed with the IBM Spectrum Protect server to verify that the correct values are set
for your system.

e Security concepts
You can protect IBM Spectrum Protect from security risks by using communication protocols, securing passwords, and
providing different access levels for administrators.

e Configuring the Operations Center
After you install the Operations Center, complete the following configuration steps to start managing your storage
environment.

e Registering the product license
To register your license for the IBM Spectrum Protect product, use the REGISTER LICENSE command.

e Defining data retention rules for your business
After you create a directory-container storage pool for data deduplication, update the default server policy to use the new
storage pool. The Add Storage Pool wizard opens the Services page in the Operations Center to complete this task.

e Defining schedules for server maintenance activities
Create schedules for each server maintenance operation by using the DEFINE SCHEDULE command in the Operations
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Center command builder.
e Defining client schedules
Use the Operations Center to create schedules for client operations.

Configuring the server instance

Use the IBM Spectrum Protect™ server instance configuration wizard to complete the initial configuration of the server.

Before you begin

Ensure that the following requirements are met:
A | Linux |

e The system where you installed IBM Spectrum Protect must have the X Window System client. You must also be running an
X Window System server on your desktop.

e The system must have the Secure Shell (SSH) protocol enabled. Ensure that the port is set to the default value, 22, and that
the port is not blocked by a firewall. You must enable password authentication in the sshd_config file in the
/etc/ssh/directory. Also, ensure that the SSH daemon service has access rights to connect to the system by using the
localhost value.

e You must be able to log in to IBM Spectrum Protect with the user ID that you created for the server instance, by using the
SSH protocol. When you use the wizard, you must provide this user ID and password to access that system.

e Ifyou changed any settings in the preceding steps, restart the server before you proceed with the configuration wizard.

TS Verify that the remote registry service is started by completing the following steps:

1. Click Start > Administrative Tools > Services. In the Services window, select Remote Registry. If it is not started, click Start.
2. Ensure that port 137, 139, and 445 are not blocked by a firewall:
a. Click Start > Control Panel > Windows Firewall.
b. Select Advanced Settings.
c. Select Inbound Rules.
d. Select New Rule.
e. Create a port rule for TCP ports 137, 139, and 445 to allow connections for domain and private networks.
3. Configure the user account control by accessing the local security policy options and completing the following steps.
a. Click Start > Administrative Tools > Local Security Policy. Expand Local Policies > Security Options.
b. If not already enabled, enable the built-in administrator account by selecting Accounts: Administrator account status
> Enable > OK.
c. If not already disabled, disable user account control for all Windows administrators by selecting User Account
Control: Run all administrators in Admin Approval Mode > Disable > OK.
d. If not already disabled, disable the User Account Control for the built-in Administrator account by selecting User
Account Control: Admin Approval Mode for the Built-in Administrator Account > Disable > OK.
4. If you changed any settings in the preceding steps, restart the server before you proceed with the configuration wizard.

About this task

The wizard can be stopped and restarted, but the server is not operational until the entire configuration process is complete.

Procedure

1. Start the local version of the wizard.
o NN NNTTTEN Open the dsmicfgx program in the /opt/tivoli/tsm/server/bin directory. This wizard can be only
run as aroot user.
o IMIITTEMClick Start > All Programs > IBM Spectrum Protect > Configuration Wizard.
2. Follow the instructions to complete the configuration. Use the information that you recorded in Planning worksheets during
IBM Spectrum Protect system setup to specify directories and options in the wizard.

IR NTTTTEM O the Server Information window, set the server to start automatically by using the instance user ID
when the system boots.

ITITTMBY using the configuration wizard, the server is set to start automatically when rebooted.

Installing the backup-archive client
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As a best practice, install the IBM Spectrum Protect™ backup-archive client on the server system so that the administrative
command-line client and scheduler are available.

Procedure

To install the backup-archive client, follow the installation instructions for your operating system.

e Install UNIX and Linux backup-archive clients
e Installing the Windows client for the first time

Setting options for the server

Review the server options file that is installed with the IBM Spectrum Protect™ server to verify that the correct values are set for
your system.

Procedure

1. Go to the server instance directory and open the dsmserv.opt file.
2. Review the values in the following table and verify your server option settings, based on system size.

Server option Value

ACTIVELOGDIRECTORY Directory path that was specified during
configuration

ACTIVELOGSIZE 131072

ARCHLOGCOMPRESS No

ARCHLOGDIRECTORY Directory path that was specified during
configuration

COMMMETHOD TCPIP

COMMTIMEOUT 3600

DEVCONFIG devconf.dat

EXPINTERVAL 0

IDLETIMEOUT 60

MAXSESSIONS 500

NUMOPENVOLSALLOWED 20

TCPADMINPORT 1500

TCPPORT 1500

VOLUMEHISTORY volhist.dat

Update server option settings if necessary, to match the values in the table. To make updates, close the dsmserv.opt file
and use the SETOPT command from the administrative command-Lline interface to set the options.
For example, to update the IDLETIMEOUT option to 60, issue the following command:

setopt idletimeout 60

3. To configure secure communications for the server, clients, and the Operations Center, verify the options in the following

table.

Server option All system sizes

SSLDISABLELEGACYTLS YES

SSLFIPSMODE NO

SSLTCPPORT Specify the SSL port number. The server TCP/IP communication driver waits for
requests on this port for SSL-enabled sessions from the client.

SSLTCPADMINPORT Specify the port address on which the server waits for requests for SSL-enabled
sessions from the command-line administrative client.

IBM Spectrum Protect Knowledge Center Version 8.1.5 259


http://www.ibm.com/support/knowledgecenter/SSEQVQ_8.1.4/client/c_inst_baunix.html
http://www.ibm.com/support/knowledgecenter/SSEQVQ_8.1.4/client/t_inst_winclient.html

Server option All system sizes

SSLTLS12 YES

If any of the option values must be updated, edit the dsmserv.opt file by using the following guidelines:

o Remove the asterisk at the beginning of a line to enable an option.

o On each line, enter only one option and the specified value for the option.

o Ifan option occurs in multiple entries in the file, the server uses the last entry.
Save your changes and close the file. If you edit the dsmserv.opt file directly, you must restart the server for the changes to
take effect.

Security concepts

You can protect IBM Spectrum Protect™ from security risks by using communication protocols, securing passwords, and providing
different access levels for administrators.

Transport Layer Security

You can use the Secure Sockets Layer (SSL) or the Transport Layer Security (TLS) protocol to provide transport layer security for a
secure connection between servers, clients, and storage agents. If you send data between the server, client, and storage agent,
use SSL or TLS to encrypt the data.

Tip: Any IBM Spectrum Protect documentation that indicates "SSL" or to "select SSL" applies to TLS.

SSL is provided by the Global Security Kit (GSKit) that is installed with the IBM Spectrum Protect server that the server, client, and
storage agent use.

Restriction: Do not use the SSL or TLS protocols for communications with a DB2® database instance that is used by any IBM
Spectrum Protect servers.

Each server, client, or storage agent that enables SSL must use a trusted self-signed certificate or obtain a unique certificate that
is signed by a certificate authority (CA). You can use your own certificates or purchase certificates from a CA. Either certificate
must be installed and added to the key database on the IBM Spectrum Protect server, client, or storage agent. The certificate is
verified by the SSL client or server that requests or initiates the SSL communication. Some CA certificates are preinstalled in the
key databases, by default.

SSL is set up independently on the IBM Spectrum Protect server, client, and storage agent.

Authority levels

With each IBM Spectrum Protect server, different administrative authority levels are available that determine the tasks that an
administrator can complete.

After registration, an administrator must be granted authority by being assigned one or more administrative authority levels. An
administrator with system authority can complete any task with the server and assign authority levels to other administrators by
using the GRANT AUTHORITY command. Administrators with policy, storage, or operator authority can complete subsets of tasks.

An administrator can register other administrator IDs, grant levels of authority to them, rename IDs, remove IDs, and lock and
unlock them from the server.

An administrator can control access to specific client nodes for root user IDs and non-root user IDs. By default, a non-root user ID
cannot back up data on the node. Use the UPDATE NODE command to change the node settings to enable backup.

Passwords

By default, the server automatically uses password authentication. With password authentication, all users must enter a password
when they access the server.

Use Lightweight Directory Access Protocol (LDAP) to apply stricter requirements for passwords. For more information, see
Managing passwords and logon procedures (V7.1.1).

Table 1. Password authentication characteristics

Characteristic More information

260 IBM Spectrum Protect Knowledge Center Version 8.1.5



http://www.ibm.com/support/knowledgecenter/SSGSG7_7.1.1/com.ibm.itsm.srv.doc/c_mgclinod_managepwlogin.html

Characteristic

More information

Case-sensitivity

Not case-sensitive.

Default password expiration

90 days.

The expiration period begins when an administrator ID or client
node is first registered to the server. If the password is not
changed within this period, the password must be changed the
next time that the user accesses the server.

Invalid password attempts

You can set a limit on consecutive invalid password attempts
for all client nodes. When the limit is exceeded, the server
locks the node.

Default password length

8 characters.

The administrator can specify a minimum length. Beginning
with Version 8.1.4, the default minimum length for server
passwords changed from O to 8 characters.

Session security

Session security is the level of security that is used for communication among IBM Spectrum Protect client nodes, administrative
clients, and servers and is set by using the SESSIONSECURITY parameter.

The SESSIONSECURITY parameter can be set to one of the following values:

e The STRICT value enforces the highest level of security for communication between IBM Spectrum Protect servers, nodes,

and administrators.

The TRANSITIONAL value specifies that the existing communication protocol is used while you update your IBM Spectrum
Protect software to V8.1.2 or later. This is the default. When SESSIONSECURITY=TRANSITIONAL, stricter security settings
are automatically enforced as higher versions of the TLS protocol are used and as the software is updated to V8.1.2 or later.
After a node, administrator, or server meets the requirements for the STRICT value, session security is automatically
updated to the STRICT value, and the entity can no longer authenticate by using a previous version of the client or earlier
TLS protocols.

Note: You are not required to update backup-archive clients to V8.1.2 or later before you upgrade servers. After you
upgrade a server to V8.1.2 or later, nodes and administrators that are using earlier versions of the software will continue to

communicate with the server by using the TRANSITIONAL value until the entity meets the requirements for the STRICT
value. Similarly, you can upgrade backup-archive clients to V8.1.2 or later before you upgrade your IBM Spectrum Protect
servers, but you are not required to upgrade servers first. Communication between servers and clients is not interrupted.

For more information about the SESSIONSECURITY parameter values, see the following commands.
Table 2. Commands used to set the
SESSIONSECURITY parameter

Entity Command

Client nodes

REGISTER NODE
UPDATE NODE

Administrators e REGISTER ADMIN
e UPDATE ADMIN

Servers e DEFINE SERVER
e UPDATE SERVER

Administrators that authenticate by using the DSMADMC command, DSMC command, or dsm program cannot authenticate by
using an earlier version after authenticating by using V8.1.2 or later. To resolve authentication issues for administrators, see the

following tips:
Tips:

e Ensure that all IBM Spectrum Protect software that the administrator account uses to log on is upgraded to V8.1.2 or later.
If an administrator account logs on from multiple systems, ensure that the server's certificate is installed on each system.
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e After an administrator authenticates to a V8.1.2 or later server by using a V8.1.2 or later client, the administrator can
authenticate only on clients or servers that are using V8.1.2 or later. An administrator command can be issued from any
system.

e If necessary, create a separate administrator account to use only with clients and servers that are using V8.1.1 or earlier
software.

Enforce the highest level of security for communication with the IBM Spectrum Protect server by ensuring that all nodes,
administrators, and servers use STRICT session security. You can use the SELECT command to determine which servers, nodes,
and administrators are using TRANSITIONAL session security and should be updated to use STRICT session security.

e Configuring secure communications with Transport Layer Security
To encrypt data and secure communications in your environment, Secure Sockets Layer (SSL) or Transport Layer Security
(TLS) is enabled on the IBM Spectrum Protect server and backup-archive client. An SSL certificate is used to verify
communication requests between the server and client.

Related tasks:
[ Securing communications

Configuring the Operations Center

After you install the Operations Center, complete the following configuration steps to start managing your storage environment.

Before you begin

When you connect to the Operations Center for the first time, you must provide the following information:

e Connection information for the server that you want to designate as a hub server
e Login credentials for an administrator ID that is defined for that server

Procedure

1. Designate the hub server. In a web browser, enter the following address:
https://hostname: secure port/oc

where:
o hostname represents the name of the computer where the Operations Center is installed
o secure_port represents the port number that the Operations Center uses for HTTPS communication on that
computer
For example, if your host name is tsm.storage.mylocation.com and you are using the default secure port for the Operations
Center, which is 11090, the address is:

https://tsm.storage.mylocation.com:11090/0oc

When you log in to the Operations Center for the first time, a wizard guides you through an initial configuration to set up a
new administrator with system authority on the server.

2. Set up secure communications between the Operations Center and the hub server by configuring the Secure Sockets Layer
(SSL) protocol.

Follow the instructions in Securing communications between the Operations Center and the hub server.

3. Optional: To receive a daily email report that summarizes system status, configure your email settings in the Operations
Center.

Follow the instructions in Tracking system status by using email reports.

e Securing communications between the Operations Center and the hub server
To secure communications between the Operations Center and the hub server, add the Transport Layer Security (TLS)
certificate of the hub server to the truststore file of the Operations Center.

Registering the product license

To register your license for the IBM Spectrum Protect™ product, use the REGISTER LICENSE command.
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About this task

Licenses are stored in enrollment certificate files, which contain licensing information for the product. The enrollment certificate
files are on the installation media, and are placed on the server during installation. When you register the product, the licenses are
stored in a NODELOCK file within the current directory.

Procedure

Register a license by specifying the name of the enrollment certificate file that contains the license. To use the Operations Center
command builder for this task, complete the following steps.

1. Open the Operations Center.

2. Open the Operations Center command builder by hovering over the settings icon il ond clicking Command Builder.
3. Issue the REGISTER LICENSE command. For example, to register a base IBM Spectrum Protect license, issue the following
command:

register license file=tsmbasic.lic

What to do next

Save the installation media that contains your enrollment certificate files. You might need to register your license again if, for
example, one of the following conditions occur:

e The server is moved to a different computer.

e The NODELOCK file is corrupted. The server stores license information in the NODELOCK file, which is in the directory from
which the server is started.

o IEITEMI you change the processor chip that is associated with the server on which the server is installed.

Defining data retention rules for your business

After you create a directory-container storage pool for data deduplication, update the default server policy to use the new storage
pool. The Add Storage Pool wizard opens the Services page in the Operations Center to complete this task.

Procedure

1. On the Services page of the Operations Center, select the STANDARD domain and click Details.
2. On the Summary page for the policy domain, click the Policy Sets tab. The Policy Sets page indicates the name of the active
policy set and lists all of the management classes for that policy set.
3. Click the Configure toggle, and make the following changes:
o Change the backup destination for the STANDARD management class to the directory-container storage pool.
o Change the value for the Backups column to No limit.
o Change the retention period. Set the Keep Extra Backups column to 30 days or more, depending on your business
requirements.
4. Save your changes and click the Configure toggle again so that the policy set is no longer editable.
5. Activate the policy set by clicking Activate.

Defining schedules for server maintenance activities

Create schedules for each server maintenance operation by using the DEFINE SCHEDULE command in the Operations Center
command builder.

About this task

Schedule server maintenance operations to run after client backup operations. You can control the timing of schedules by setting
the start time in combination with the duration time for each operation.

The following figure provides an example of how to plan maintenance operations.
Figure 1. Daily schedule of server operations for a tape solution
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The following table shows how you can schedule server maintenance processes in combination with the client backup schedule

for a tape solution.

Operation

Schedule

Client backup

Starts at 11 PM.

Storage pool backup

Starts at 6 AM.

Processing for database and disaster
recovery files

e The database backup operation starts at 10 AM, or 11 hours after the beginning
of the client backup operation. This process runs until completion.

e Device configuration information and volume history backup operations start at
5 PM, or 7 hours after the start of the database backup operation.

e Volume history deletion starts at 8 PM, or 10 hours after the start of the
database backup operation.

Preparation of files for offsite vaulting

Starts at 10 AM, at the same time as processing for the database and disaster
recovery files.

Migration from disk to tape

Starts at 12 PM, or 2 hours after the start of the database backup operation.

Inventory expiration

Starts at 2 PM, or 15 hours after the beginning of the client backup operation. This
process runs until completion.

Space reclamation

Starts at 3 PM, or 16 hours after the beginning of the client backup operation.
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Procedure

After you configure the device class for the database backup operations, create schedules for database backup and other required
maintenance operations by using the DEFINE SCHEDULE command. Depending on the size of your environment, you might need
to adjust the start times for each schedule in the example.

1. Define a device class for the backup operation before you create the schedule for database backups. Use the DEFINE
DEVCLASS command to create a device class that is named LTOTAPE:

define devclass ltotape devtype=lto library=1ltolib

2. Set the device class for automatic database backups. Use the SET DBRECOVERY command to specify the device class that
you created for the database backup in the preceding step. For example, if the device class is LTOTAPE, issue the following
command:

set dbrecovery ltotape

3. Create schedules for the maintenance operations by using the DEFINE SCHEDULE command. See the following table for
the required operations with examples of the commands.

Operation Example commands and additional information

Back up storage pools. Create a schedule to run the BACKUP STGPOOL command.

For example, issue the following command to create a backup schedule
for a primary storage pool that is named PRIMARY_POOL. The pool will
be backed up to a copy storage pool, COPYSTG:

define schedule BACKUPSTGPOOL type=administrative
cmd="backup stgpool primary pool copystg"
active=yes starttime=06:00 period=1

Back up the database. Create a schedule to run the BACKUP DB command.
For example, issue the following command to create a backup schedule
that uses the new device class:

define schedule DBBACKUP type=admin cmd="backup db
devclass=ltotape type=full numstreams=3 wait=yes
compress=yes" active=yes desc="Back up the
database."
startdate=today starttime=10:00:00 duration=45
durunits=minutes

Replicate nodes. Optionally, use node replication to protect client data by backing the
data up to a secondary server. For instructions, see Replicating client
data to another server. Ensure that node replication is completed
before migration operations begin.
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Operation

Example commands and additional information

Migrate data from disk to tape daily.

Create a schedule for storage pool migration.

For example, if a disk storage pool is named DISKPOOL and the next
storage pool is TAPEPOOL, you can schedule storage pool migration by
issuing the following command:

define schedule stgpool migration type=administrative
cmd="migrate stgpool diskpool lomig=0" active=yes
description="migrate disk storagepool to tapepool"
startdate=today starttime=12:00 duration=2
durunits=hours period=1 perunits=days

To maximize throughput, you can specify the number of parallel
processes to use for migrating files by completing the following steps:

a. For the tape storage pool, ensure that collocation is enabled. To
verify whether collocation is enabled, run the QUERY STGPOOL
command. Verify that a value of GROUP, NODE, or FILESPACE is
specified in the COLLOCATE field. If a value of GROUP, NODE, or
FILESPACE is not specified, use the UPDATE STGPOOL
command to specify COLLOCATE=GROUP, COLLOCATE=NODE, Oor
COLLOCATE=FILESPACE, depending on your system
configuration.

b. For the disk storage pool, use the DEFINE STGPOOL or UPDATE
STGPOOL command to specify a value for the MIGPROCESS
parameter. For example, if you have 12 tape drives, specify
MIGPROCESS=10. In this way, a maximum of 10 tape drives are
used for migration processes. Two drives are reserved for other
tasks, such as restore, database backup, and client backup
operations.

Prepare files for offsite vaulting.

a. Move tape volumes offsite by following the instructions in
Moving backup media.

b. Create the disaster recovery plan file by issuing the PREPARE
command on the source server:

prepare

c. Ensure that all volumes that are required for disaster recovery
are included in the recovery plan file. For more information, see
Preparing for and recovering from a disaster by using DRM.

Back up the device configuration
information.

Create a schedule to run the BACKUP DEVCONFIG command:

define schedule DEVCONFIGBKUP type=admin cmd="backup
devconfig

filenames=devconfig.dat" active=yes desc="Backup the
device

configuration file." startdate=today
starttime=17:00:00

duration=45 durunits=minutes

Back up the volume history.

Create a schedule to run the BACKUP VOLHISTORY command:

define schedule VOLHISTBKUP type=admin cmd="backup
volhistory

filenames=volhist.dat" active=yes desc="Back up the
volume

history." startdate=today starttime=17:00:00
duration=45

durunits=minutes
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Operation Example commands and additional information

Remove older versions of database | Create a schedule to run the DELETE VOLHISTORY command:

backups that are no longer required. ) )
define schedule DELVOLHIST type=admin cmd="delete

volhistory

type=dbb todate=today-6 totime=now" active=yes
desc="Remove

old database backups." startdate=today
starttime=20:00:00

duration=45 durunits=minutes

Remove objects that exceed their Create a schedule to run the EXPIRE INVENTORY command.
allowed retention.
Set the RESOURCE parameter based on the system size that you are
configuring to be equal to the number of processor cores that you
specified for your system.

For example, issue the following command to create a schedule that is
named EXPINVENTORY:

define schedule EXPINVENTORY type=admin cmd="expire
inventory

wait=yes resource=8 duration=120" active=yes
desc="Remove expired

objects." startdate=today starttime=14:00:00
duration=1

durunits=hours

Reclaim space. Create a schedule to run the RECLAIM STGPOOL command.
For example, issue the following command to create a schedule that is
named RECLAIM:

define schedule RECLAIM type=admin cmd="reclaim
stgpool
tapepool duration=60" startdate=today
starttime=15:00:00 duration=5

durunits=hours

Tip: To maximize throughput, you can specify the number of parallel
processes to use for reclaiming space. Update the tape storage pool by
using the UPDATE STGPOOL command and specify a value for the
RECLAIMPROCESS parameter. For example, if you have 12 tape drives,
specify RECLAIMPROCESS=5. Because two drives are used for each
reclamation process, the total number of drives that can be used for
reclamation is 10. Two drives are reserved for backup operations.

What to do next

After you create schedules for the server maintenance tasks, you can view them in the Operations Center by completing the
following steps:

1. On the Operations Center menu bar, hover over Servers.
2. Click Maintenance.

e Moving backup media
To recover from a disaster, you need database backup volumes, copy storage pool volumes, and additional files. To stay
prepared for a disaster, you must complete daily tasks.

Related reference:

[ UPDATE STGPOOL (Update a storage pool)

* DEFINE SCHEDULE (Define a schedule for an administrative command)
Related information:

* DEFINE STGPOOL (Define a volume in a storage pool)

Defining client schedules
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Use the Operations Center to create schedules for client operations.

Procedure

1. On the Operations Center menu bar, hover over Clients.

2. Click Schedules.

3. Click +Schedule.

4. Complete the steps in the Create Schedule wizard. Set client backup schedules to start at 22:00, based on the server
maintenance activities that you scheduled in Defining schedules for server maintenance activities.

Attaching tape devices for the server

Before the server can use a tape device, you must attach the device to your server system and install the appropriate tape device
driver.

About this task

To optimize system performance, use fast, high-capacity tape devices. Provision enough tape drives to meet your business
requirements.

Attach tape devices on their own host bus adapter (HBA), not shared with other devices types such as disk. IBM® tape drives have
some special requirements for HBAs and associated drivers.

o TR T Attaching an automated library device to your system
You can attach an automated library device to your system to store your data on tapes.
e Selecting a tape device driver
To use tape devices with IBM Spectrum Protect™ you must install the appropriate tape device driver.
o TR INTTTTEM S pecial file names for tape devices
A special file name for a tape device is required for the IBM Spectrum Protect server to work with tape, medium changer, or
removable media devices.
e Installing and configuring tape device drivers
Before you can use tape devices with IBM Spectrum Protect, you must install the correct tape device driver.

Attaching an automated library device to your system

You can attach an automated library device to your system to store your data on tapes.

About this task

Before you attach an automated library device, consider the following restrictions:

e Attached devices must be on their own Host Bus Adapter (HBA).
e An HBA must not be shared with other device types, such as a disk.
e For multiport Fibre Channel HBAs, devices must be attached on their own port. These ports must not be shared with other
device types.
e IBM® tape drives have some special requirements on HBA and associated drivers. For more information about devices, see
the website for your operating system:
o IBM Spectrum Protect™ Supported Devices for AIX®
o IBM Spectrum Protect Supported Devices for Linux and Windows

Procedure

To use the Fibre Channel (FC) adapter, complete the following steps:

1. Install the FC adapter and associated drivers.
2. Install the appropriate device drivers for attached medium changer devices.

o TR NI Sctting the library mode
For the IBM Spectrum Protect server to access a SCSI library, the tape device must be set for the appropriate mode.

Related concepts:
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Selecting a tape device driver

Selecting a tape device driver

To use tape devices with IBM Spectrum Protect™ you must install the appropriate tape device driver.

e IBM tape device drivers

IBM® tape device drivers are available for most IBM labeled tape devices.
e IBM Spectrum Protect tape device drivers

The IBM Spectrum Protect server provides tape device drivers.

Related reference:
Installing and configuring tape device drivers

IBM tape device drivers

IBM® tape device drivers are available for most IBM labeled tape devices.
You can download IBM tape device drivers from the Fix Central website:

. Go to the Fix Central website: Fix Central website.

. Click Select product.

. Select System Storage for the Product Group menu.

. Select Tape systems for the System Storage menu.

. Select Tape drivers and software for the Tape systems menu.

. Select Tape device drivers for the Tape drivers and software menu. In addition to tape drivers, you also get access to tools
such as the IBM Tape Diagnostic Tool (ITDT).

7. Select your operating system for the Platform menu.

oSk wWwN PR

For the most up-to-date list of devices and operating-system levels that are supported by IBM tape device drivers, see the IBM
Spectrum Protect™ Supported Devices website at Supported devices for AIX and Windows.

For the most up-to-date list of tape devices and operating-system levels that are supported by IBM tape device drivers, see the
IBM Spectrum Protect Supported Devices website at Supported devices for Linux.

IBM tape device drivers support only some Linux kernel levels. For information about supported kernel levels, see the Fix Central
website.

IBM Spectrum Protect tape device drivers

The IBM Spectrum Protect™ server provides tape device drivers.

An IBM Spectrum Protect tape device driver is installed with the server.
A

You can use the generic SCSI tape device driver that is provided by the IBM® AIX® operating system to work with tape devices that
are not supported by the IBM Spectrum Protect device driver. If the AIX generic SCSI tape device driver is used, the
GENERICTAPE device class must be set to the device type that is specified in the DEFINE DEVCLASS command.

For the following tape devices, you can choose whether to install the IBM Spectrum Protect tape device driver or the native device
driver for your operating system:

e ECART
e LTO (not from IBM)

All SCSI-attached libraries that contain tape drives from the list must use the IBM Spectrum Protect changer driver.
Tape device drivers that are acquired from other hardware vendors can be used if they are associated with the GENERICTAPE

device class. Generic device drivers are not supported in write-one read-many (WORM) device classes.
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You can use the IBM Spectrum Protect Passthru device driver. IBM Spectrum Protect Passthru device drivers require the Linux
SCSI generic (sg) device driver along with the Linux operating system to install the kernels.

For example, you can install the IBM Spectrum Protect Passthru device driver for the following tape devices:

e ECART
e LTO (not from IBM)

All SCSI-attached libraries that contain tape drives that are not IBM labeled from the list must also use the IBM Spectrum Protect
Passthru device driver.

You cannot use the generic SCSI tape (st) device driver that is provided by the Linux operating system. Therefore, the
GENERICTAPE device type is not supported for the DEFINE DEVCLASS command.

T You can select a Windows Hardware Qualification Lab certified native device driver instead of the IBM Spectrum Protect
device driver. The Windows Hardware Qualification Lab certified native device driver can be used only for devices that have a non-
IBM label and for non-IBM tape drives. For the Windows Hardware Qualification Lab certified native device driver, you can select
either the IBM Spectrum Protect SCSI passthru device driver or the Windows native tape device driver. If the SCSI passthru device
driver is used, the device class on the DEFINE DEVCLASS command cannot be GENERICTAPE. If the native device driver is used,
the device class must be GENERICTAPE.

Special file names for tape devices

A special file name for a tape device is required for the IBM Spectrum Protect™ server to work with tape, medium changer, or
removable media devices.

A
When a device is configured successfully, a logical file name is returned. Table 1 specifies the name of the device, also called a

special file name, that corresponds to the drive or library. You can use the SMIT operating system command to get the device
special file name. In the examples, x specifies an integer, 0 or greater.
Table 1. Device examples

Device Device example |Logical file name
Tape drives that can be used by the IBM Spectrum Protect device driver /devintx mtx

Tape drives that can be used by the IBM tape device driver /devirmtx rmtx

Tape drives that can be used by the IBM AIX® generic tape device driver /devimtx rmtx

Library devices that can be used by the IBM Spectrum Protect device driver |/dewvibx lbx

Library devices that can be used by the IBM tape device driver /devsmcx smcex

When a device is configured successfully, a logical file name is returned. Table 2 specifies the name of the device, also called the

special file name, that corresponds to the drive or library. In the examples, x specifies an integer, 0 or greater.
Table 2. Device examples

Device Device example Logical file name
Tape drives that can be used by the IBM Spectrum Protect passthru device driver  |/devtsmscsi/mtx mtx

Tape drives that can be used by the IBM lin_tape device driver /devIBMtapex IBMtapex

Library devices that can be used by the IBM Spectrum Protect passthru device /dewvtsmscsi/lbx lbx

driver

Library devices that can be used by the IBM lin_tape device driver /devIBMchangerx IBMchangerx

When a device is configured successfully, a logical file name is returned. Table 3 specifies the name of the device, also called the
special file name, that corresponds to the drive or library. In the examples, a, b, ¢, d, and x specify an integer, 0 or greater, where:

e aspecifies the target ID.

e b specifies the LUN.

e ¢ specifies the SCSI bus ID.
e dspecifies the port ID.
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Table 3. Device examples

Device Device example Converted device
name

Tape drives that are supported by the IBM Spectrum Protect device driver mta.b.c.d mta.b.c.d

Tape drives that are supported by the IBM Spectrum Protect passthru device driver | mta.b.c.d mta.b.c.d

Tape drives that are supported by the IBM device driver Tapex mta.b.c.d

Library devices that are supported by the IBM Spectrum Protect device driver lb.a.b.c.d lba.b.c.d

Library devices that are supported by the IBM Spectrum Protect passthru device lba.b.c.d lba.b.c.d

driver

Library devices that are supported by the IBM device driver Changerx lba.b.c.d

Installing and configuring tape device drivers

Before you can use tape devices with IBM Spectrum Protect™, you must install the correct tape device driver.

IBM Spectrum Protect supports all devices that are supported by IBM® tape device drivers. However, IBM Spectrum Protect does
not support all the operating-system levels that are supported by IBM tape device drivers.

e Installing and configuring IBM device drivers for IBM tape devices
Install and configure an IBM tape device driver to use an IBM tape device.
o ITEN Configuring tape device drivers on AIX systems
Review the instructions to install and configure non-IBM tape device drivers on AIX® systems.
o ITITEM Configuring tape device drivers on Linux systems
Review the following topics when you install and configure tape device drivers on Linux systems.
o I Configuring tape device drivers on Windows systems
Review the instructions to install and configure drivers for tape devices and libraries on Windows systems.

Installing and configuring IBM device drivers for IBM tape devices

Install and configure an IBM® tape device driver to use an IBM tape device.

About this task

For instructions about installing and configuring IBM tape device drivers, see the IBM Tape Device Drivers Installation and User's
Guide.

TN A fter you complete the installation procedure in the IBM Tape Device Drivers Installation and User's Guide, different
messages are issued, depending on the device driver that you are installing. If you are installing the device driver for an IBM tape
drive or library, the following messages are returned:

rmtx Available
or

smcx Available

Note the value of x, which is assigned by the IBM tape device driver. To determine the special file name of your device, issue one
of the following commands:

e Fortapedrives,1s -1 /dev/rmt*
e Fortape libraries, 1s -1 /dev/smc*

The file name might have more characters at the end to indicate different operating characteristics, but these characters are not
needed by IBM Spectrum Protect™. For IBM device drivers, use the base file name in the DEVICE parameter of the DEFINE PATH
command to assign a device to a drive (/dev/rmtx) or a library (/dev/smcx).

After you install the device driver, you can use the System Management Interface Tool (SMIT) to configure non-IBM tape drives
and tape libraries. Complete the following steps:

1. Run the SMIT program.
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2. Click Devices.

3. Click IBM Spectrum Protect Devices.

4, Click Fibre Channel SAN Attached devices.

5. Click Discover Devices Supported by IBM Spectrum Protect. Wait for the discovery process to be completed.
6. Go back to the Fibre Channel SAN Attached devices menu, and click List Attributes of a Discovered Device.

I A fter you complete the installation procedure in the IBM Tape Device Drivers Installation and User's Guide, different
messages are issued, depending on the device driver that you are installing. If you are installing the device driver for an IBM LTO
or 3592 device, the following messages are returned:

IBMtapex Available

or

IBMChangerx Available

Note the value of x, which is assigned by the IBM tape device driver. To determine the special file name of your device, issue one
of the following commands:

e Fortapedrives,1s -1 /dev/IBMtape*
e Fortape libraries, 1s -1 /dev/IBMChange*

The file name might have more characters at the end to indicate different operating characteristics, but these characters are not
needed by IBM Spectrum Protect. For IBM device drivers, use the base file name in the DEVICE parameter of the DEFINE PATH
command to assign a device to a drive (/dev/IBMtapex) or a library (/dev/IBMChangerx).

Restriction: The device type of this class must not be GENERICTAPE.

I For Windows operating systems, IBM Spectrum Protect provides two device drivers:

Passthru device driver
If the tape device manufacturer provides a SCSI device driver, install the IBM Spectrum Protect passthru device driver.
SCSI device driver for tape devices
If the tape device manufacturer does not provide a SCSI device driver, install the IBM Spectrum Protect SCSI device driver
for tape devices. The driver file name is tsmscsi64.sys.

For instructions about installing and configuring IBM tape device drivers, see the IBM Tape Device Drivers Installation and User's
Guide. After you install the IBM tape device driver, the server specifies a special file name, TapeX, for IBM tape drives, or
ChangerY, for IBM medium changers. For an IBM Spectrum Protect SCSI device driver or an IBM Spectrum Protect passthru
device driver, you can issue the Windows operating system command, regedit, to verify the device special file name and driver.
The IBM Spectrum Protect server also provides a utility to check the device for the Windows operating system. The utility, tsmdlst,
is packaged with the server package. To use the utility, complete the following steps:

1. Ensure that the host bus adapter application programming interface (API) is installed.
2. To obtain device information from the host system, type:

tsmdlst

o TR NI M ultipath I/0 access with IBM tape devices
Multipath I/0 is a technique that uses different paths to access the same physical device, for example through multiple
host bus adapters (HBA) or switches. The use of the multipath technique helps to ensure that a single point of failure does
not occur.

Related concepts:
Multipath I/O access with IBM tape devices
LA

Configuring tape device drivers on AIX systems

Review the instructions to install and configure non-IBM® tape device drivers on AIX® systems.

About this task

For instructions about installing and configuring IBM tape device drivers, see the IBM Tape Device Drivers Installation and User's
Guide.
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o TINISCSI and Fibre Channel devices
The IBM Spectrum Protect device definition menus and prompts in SMIT allow for the management of both SCSI and Fibre
Channel (FC) attached devices.

o ITEN Configuring IBM Spectrum Protect device drivers for autochangers
Use the following procedure to configure IBM Spectrum Protect device drivers for autochangers for non-IBM libraries.

o ITTEN Configuring IBM Spectrum Protect device drivers for tape drives
Use the following procedure to configure IBM Spectrum Protect device drivers for autochangers for vendor-acquired
libraries.

o I Configuring Fibre Channel SAN-attached devices
To configure a Fibre Channel SAN-attached device, complete the procedure.

SCSI and Fibre Channel devices

The IBM Spectrum Protect™ device definition menus and prompts in SMIT allow for the management of both SCSI and Fibre
Channel (FC) attached devices.

The main menu for IBM Spectrum Protect has two options:

SCSI attached devices
Use this option to configure SCSI devices that are connected to a SCSI adapter in the host.
Fibre channel system area network (SAN) attached devices
Use this option to configure devices that are connected to an FC adapter in the host. Choose one of the following attributes:

List attributes of a discovered device
Lists attributes of a device that is known to the current ODM database.

e FCPort ID:

The 24-bit FC Port ID(N(L)_Port or F(L)_Port). This is the address identifier that is unique within the
associated topology where the device is connected. In the switch or fabric environments, it can be
determined by the switch, with the upper 2 bytes, which are not zero. In a Private Arbitrated Loop, it is the
Arbitrated Loop Physical Address(AL_PA), with the upper 2 bytes being zero. Consult with your FC vendors to
find out how an AL_PA or a Port ID is assigned.

e Mapped LUN ID:

An FC to SCSI bridge (also, called a converter, router, or gateway) box. Consult with your bridge vendors about
how LUNs are mapped. You should not change LUN Mapped IDs.

e WW Name:

The worldwide name of the port to which the device is attached. It is the 64-bit unique identifier that is
assigned by vendors of FC components such as bridges or native FC devices. Consult with your FC vendors to
find out the WWN of a port.

e Product ID:
The product ID of a device. Consult with your device vendors to determine the product ID.

Discover devices supported by IBM Spectrum Protect
This option discovers devices on an FC SAN that are supported by IBM Spectrum Protect and makes them available. If a
device is added to or removed from an existing SAN environment, rediscover devices by selecting this option. Devices must
be discovered first so that current values of device attributes are shown in the List Attributes of a Discovered Device option.
Supported devices on FC SAN are tape drives, and autochangers. The IBM Spectrum Protect device driver ignores all other
device types, such as disk.

Remove all defined devices
This option removes all FC SAN-attached IBM Spectrum Protect devices whose state is DEFINED in the ODM database. If
necessary, rediscover devices by selecting the Discover Devices Supported by IBM Spectrum Protect option
after the removal of all defined devices.

Remove a device
This option removes a single FC SAN-attached IBM Spectrum Protect device whose state is DEFINED in the ODM database.
If necessary, rediscover the device by selecting the Discover Devices Supported by IBM Spectrum Protect
option after removal of a defined device.
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Configuring IBM Spectrum Protect device drivers for autochangers

Use the following procedure to configure IBM Spectrum Protect™ device drivers for autochangers for non-IBM libraries.

Procedure

Run the SMIT program to configure the device driver for each autochanger or robot:

. Select Devices.

. Select IBM Spectrum Protect Devices.

. Select Library/MediumChanger.

. Select Add a Library/MediumChanger.

. Select the IBM Spectrum Protect-SCSI-LB for any IBM Spectrum Protect supported library.

. Select the parent adapter to which you are connecting the device. This number is listed in the form: 00-0X, where X is the

slot number location of the SCSI adapter card.

7. When prompted, enter the CONNECTION address of the device that you are installing. The connection address is a two-
digit number. The first digit is the SCSI ID (the value you recorded on the worksheet). The second digit is the device's SCSI
logical unit number (LUN), which is usually zero, unless otherwise noted. The SCSI ID and LUN must be separated by a
comma (,). For example, a connection address of 4, 0 has a SCSI ID=4 and a LUN=0.

8. Click DO.

oSNk WN PR

You receive a message (logical file name) of the form 1bx Available. Note the value of X, which is a number that is
assigned automatically by the system. Use this information to complete the Device Name field on your worksheet.

For example, if the message is 1b0 Available, the Device Name field is /dev/lb0 on the worksheet. Always use the /dev/
prefix with the name provided by SMIT.

Configuring IBM Spectrum Protect device drivers for tape drives

Use the following procedure to configure IBM Spectrum Protect™ device drivers for autochangers for vendor-acquired libraries.

Procedure

Important: IBM Spectrum Protect cannot overwrite tar or dd tapes, but tar or dd can overwrite IBM Spectrum Protect tapes.
Restriction: Tape drives can be shared only when the drive is not defined or the server is not started. The MKSYSB command does
not work when both IBM Spectrum Protect and AIX® are sharing the same drive or drives. To use the operating system's native
tape device driver with a SCSI drive, the device must be configured to AIX first and then configured to IBM Spectrum Protect. See
your AIX documentation regarding these native device drivers.

Run the SMIT program to configure the device driver for each drive (including drives in libraries) as follows:

. Select Devices.

. Select IBM Spectrum Protect Devices.

. Select Tape Drive.

. Select Add a Tape Drive.

. Select the IBM Spectrum Protect-SCSI-MT for any supported tape drive.

. Select the adapter to which you are connecting the device. This number is listed in the form: 00-0X, where X is the slot

number location of the SCSI adapter card.

7. When prompted, enter the CONNECTION address of the device you are installing. The connection address is a two-digit
number. The first digit is the SCSI ID (the value you recorded on the worksheet). The second digit is the device's SCSI
logical unit number (LUN), which is usually zero, unless otherwise noted. The SCSI ID and LUN must be separated by a
comma (,). For example, a connection address of 4, 0 has a SCSI ID=4 and a LUN=0.

8. Click DO. You receive a message:

o0k WDN P

If you are configuring the device driver for a tape device (other than an IBM® tape drive), you receive a message (logical file
name) of the form mtx Available. Note the value of X, which is a number that is assigned automatically by the system.
Use this information to complete the Device Name field on the worksheet.
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For example, if the message ismt0 Available, the Device Name field is /dev/mt0 on the worksheet. Always use the /dev/
prefix with the name provided by SMIT.

Configuring Fibre Channel SAN-attached devices

To configure a Fibre Channel SAN-attached device, complete the procedure.

Procedure

. Run the SMIT program.

. Select Devices.

. Select IBM Spectrum Protect™ Devices.

. Select Fibre Channel SAN Attached devices.

. Select Discover Devices Supported by IBM Spectrum Protect. The discovery process can take some time.

. Go back to the Fibre Channel menu, and select List Attributes of a Discovered Device.

. Note the three-character device identifier, which you use when you define a path to the device to IBM Spectrum Protect.
For example, if a tape drive has the identifier mt 2, specify /dev/mt2 as the device name.

No g wWwNRE

Configuring tape device drivers on Linux systems

Review the following topics when you install and configure tape device drivers on Linux systems.

o ITITEM Configuring IBM Spectrum Protect passthru drivers for tape devices and libraries
To use the IBM Spectrum Protect Linux Passthru driver, you must complete the following steps.

o I Installing zSeries Linux Fibre Channel adapter (zfcp) device drivers
The zSeries Linux Fibre Channel adapter (zfcp) device driver is a special adapter driver on the IBM® zSeries system.

o INTTTEMInformation about your system's SCSI devices
Information about the devices seen by your system is available in the file /proc/scsi/scsi. This file contains a list of every
detected SCSI device.

o IETTEMPreventing tape labels from being overwritten
The IBM Spectrum Protect Passthru device driver uses the Linux SCSI generic device driver (sg) to control and operate tape
devices that are attached on the system. If the Linux generic SCSI tape device driver (st) is loaded to the kernel and
configures attached tape devices, conflicts can arise over how a device is managed because the generic sg driver and the st
driver can both control the same device.

Configuring IBM Spectrum Protect passthru drivers for tape devices and
libraries

To use the IBM Spectrum Protect™ Linux Passthru driver, you must complete the following steps.

Procedure

1. Verify that the device is connected to your system, and is powered on and active.
2. Verify that the device is correctly detected by your system by issuing this command:

cat /proc/scsi/scsi

w

. Ensure that both the IBM Spectrum Protect device driver package (tsmscsi) and the storage server package are installed.
4. There are two driver configuration methods available in the IBM Spectrum Protect device driver package: autoconf and
tsmscsi. Both of these methods complete the following tasks:
o Load the Linux SCSI generic driver (sg) to the kernel.
o Create necessary special files for the Passthru driver.
o Create device information files for tape devices (/dev/tsmscsi/mtinfo) and libraries (/dev/tsmscsi/lbinfo).
5. Run the configuration method that you prefer (autoconf or tsmscsi) for the IBM Spectrum Protect Passthru driver.
o To run the autoconf configuration method, issue the following command:
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autoconf

o To run the tsmscsi configuration method, complete the following steps:
a. Copy the two sample configuration files that are in the installation directory from mt.conf.smp and lb.conf.smp
to mt.conf and [b.conf, respectively.
b. Edit the mt.conf and lb.conf files. Add one stanza (as shown in the example at the start of the file) for each
SCSI target, ID, and LUN combination. Each combination of SCSI target, ID, and LUN entries correspond to a
tape drive or library you want configured. Make sure that the files meet these requirements:
= Remove the example that is at the start of the files.
= There must be a new line between each stanza.
® There must be one new line after the last stanza.
® Ensure that there are no number signs (#) in either file.
c¢. Run the tsmscsi script from the device driver installation directory.
6. Verify that the device is configured properly by viewing the text files for tape devices (/dev/tsmscsi/mtinfo) and libraries
(/dev/tsmscsi/lbinfo).
7. Determine the special file names for the tape drives and libraries:
o To determine the names for tape devices, issue the following command:

> 1ls /dev/tsmscsi/mt*
o To determine the names for libraries, issue the following command:

> 1s /dev/tsmscsi/lb*

This information helps you identify which of the /dev/tsmscsi/mtx and /dev/tsmscsi/lbx special file names to provide the
server when you issue a DEFINE PATH command.

What to do next

If you restart the host system, you must rerun the autoconf or tsmscsi script to reconfigure IBM Spectrum Protect devices. If you
restart the IBM Spectrum Protect server instance, you do not have to reconfigure devices. In general, the Linux SCSI generic driver
is preinstalled to the kernel. To verify that the driver is in the kernel, issue the following command:

> lsmod | grep sg

If the driver is not in the kernel, issue the modprobe sg command to load the sg driver into the kernel.

Installing zSeries Linux Fibre Channel adapter (zfcp) device drivers

The zSeries Linux Fibre Channel adapter (zfcp) device driver is a special adapter driver on the IBM® zSeries system.

About this task

IBM Spectrum Protect™ and IBM tape device drivers can run on zSeries platforms with Linux operating systems in 64-bit
environments, and support most original equipment manufacturer (OEM) and IBM tape devices with Fibre Channel interfaces.

For more information about the zfcp driver, see the IBM Redpaper™, Getting Started with zSeries Fibre Channel Protocol, which is
available at IBM Redbooks®.

Procedure

1. Load the qdio module.

2. Install the zfcp driver.

3. Map the Fibre Channel Protocol (FCP) and configure the zfcp driver.
4. Install and configure the IBM tape device driver.

Information about your system's SCSI devices

Information about the devices seen by your system is available in the file /proc/scsi/scsi. This file contains a list of every detected
SCSI device.
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The following device information is available: the host number, channel number, SCSI ID, Logical Unit number, vendor, firmware
level, type of device, and the SCSI mode. For example, if a system contains some StorageTek and IBM® libraries, a SAN Gateway,
and some Quantum DLT drives, the /proc/scsi/scsi file will look similar to this:

Attached devices:
Host: scsi2 Channel: 00 Id: 00 Lun: 00

Vendor: STK Model: 9738 Rev: 2003

Type: Medium Changer ANSI SCSI revision: 02
Host: scsi2 Channel: 00 Id: 01 Lun: 02

Vendor: PATHLIGHT Model: SAN Gateway Rev: 32aC

Type: Unknown ANSI SCSI revision: 03
Host: scsi2 Channel: 00 Id: 01 Lun: 02

Vendor: QUANTUM Model: DLT7000 Rev: 2560

Type: Sequential-Access ANSI SCSI revision: 02
Host: scsi2 Channel: 00 Id: 01 Lun: 04

Vendor: IBM Model: 7337 Rev: 1.63

Type: Medium Changer ANSI SCSI revision: 02

Preventing tape labels from being overwritten

The IBM Spectrum Protect™ Passthru device driver uses the Linux SCSI generic device driver (sg) to control and operate tape
devices that are attached on the system. If the Linux generic SCSI tape device driver (st) is loaded to the kernel and configures
attached tape devices, conflicts can arise over how a device is managed because the generic sg driver and the st driver can both
control the same device.

About this task

If the st driver controls devices that are used by IBM Spectrum Protect, IBM Spectrum Protect internal tape labels can be
overwritten and data can be lost. If an application uses the st driver to control devices and the non-rewind option is not specified,
tapes are automatically rewound following completion of an operation. The auto-rewind operation relocates the tape header
position to the beginning of the tape. If the tape remains loaded in the drive, the next non-IBM Spectrum Protect write operation
overwrites the IBM Spectrum Protect tape label because the label is at the beginning of the tape.

To prevent IBM Spectrum Protect labels from being overwritten, which can result in data loss, ensure that only the IBM Spectrum
Protect Passthru driver controls devices that are used by IBM Spectrum Protect. Remove the st driver from the kernel or, if the
driver is used by some applications on the system, delete the special files that correspond to IBM Spectrum Protect devices so
that the st driver can no longer control them.

If you are using the IBM tape device driver to control devices on your system, you might encounter the same issues with device
driver control conflicts. Review your IBM tape documentation to determine how to resolve this issue and prevent data loss.

Remove the st driver
If no other applications on the system use st devices, remove the st driver from the kernel. Issue the following command to
unload the st driver:

rmmod st

Delete device special files that correspond to IBM Spectrum Protect devices
If there are applications that require use of the st driver, delete the special files that correspond to IBM Spectrum Protect
devices. These special files are generated by the st driver. When they are eliminated, the st driver can no longer control the
corresponding IBM Spectrum Protect devices. Device special file names for tape drives appear in the /dev/ directory. Their
names have the form /dev/[n]st[0-1024][l][m][a].

List the st drive special file names and IBM Spectrum Protect device special file names by using the ls command. Based on
the output of the device sequences, you can find devices in the st devices list matching those in the IBM Spectrum Protect
devices list. The rm command can then be used to delete st devices.

Issue the following commands to list the st and IBM Spectrum Protect devices:

1s -1 /dev/*st*
1ls -1 /dev/tsmscsi/mt*

Delete the st devices with the rm command:

rm /dev/*st*
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Configuring tape device drivers on Windows systems

Review the instructions to install and configure drivers for tape devices and libraries on Windows systems.

o INTTTTMPreparing to use the IBM Spectrum Protect passthru driver for tape devices and libraries
To use the IBM Spectrum Protect Windows passthru device driver for tape devices and libraries, you must install the driver
and obtain the device names for the server to use.

o I Configuring the IBM Spectrum Protect SCSI driver for tape devices and libraries
If the manufacturer of a tape drive or tape library does not provide a SCSI device driver, you must install the IBM Spectrum
Protect SCSI device driver.

Preparing to use the IBM Spectrum Protect passthru driver for tape
devices and libraries

To use the IBM Spectrum Protect™ Windows passthru device driver for tape devices and libraries, you must install the driver and
obtain the device names for the server to use.

Before you begin

1. Determine whether the manufacturer of the tape device or tape library provides a device driver.
2. If the manufacturer provides a device driver package, download the package and install it.
3. Configure the SCSI device driver by following the manufacturer's instructions.

Procedure

1. Install the IBM Spectrum Protect passthru device driver.
2. Obtain the device names that the server must use by taking one of the following actions:

o On the server, run the QUERY SAN command. The output shows all devices names and their associated device serial
numbers.

o Inthe server directory, run the tsmdlst.exe utility. The output shows all devices names, their associated serial
numbers, and associated device locations.

o At the Windows system command prompt, run the regedit command. From the output, obtain the device file names
based on the device locations. The location consists of the port ID, SCSI bus ID, LUN ID, and SCSI target ID. The IBM
Spectrum Protect device file name has a format of mtA.B.C.C for tape drives and |bA.B.C.D for tape libraries, where:

= Aisthe SCSI target ID.
= Bisthe LUNID.

= Cisthe SCSI bus ID.

® Dis the port ID.

Configuring the IBM Spectrum Protect SCSI driver for tape devices and
libraries

If the manufacturer of a tape drive or tape library does not provide a SCSI device driver, you must install the IBM Spectrum
Protect™ SCSI device driver.

About this task

The IBM Spectrum Protect SCSI device driver file name is tsmscsi64.sys.

Procedure

1. Locate the device in the Device Manager console (devmgmt.msc) and select it. Tape drives are listed under Tape drives, and
medium changers are under Medium Changers.
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3

. Configure the device for use by the tsmscsi64.sys device driver:
a. Right-click the device and click Update Driver Software.
b. Click Browse my computer for driver software.

. Click Let me pick from a list of device drivers on my computer.

4. Click Next.

5

[oo I o)}

. Select the appropriate option:
a. For a tape drive, select IBM Spectrum Protect for Tape Drives.
b. For a medium changer, select IBM Spectrum Protect for Medium Changers.
. Click Next.
. Click Close.
. Verify that the device was configured correctly for the tsmscsi64 device driver:
a. Right-click on the device and click Properties.
b. Click the Driver tab and Driver Details. The Driver Details window shows the device driver that is controlling the
device.

Configuring libraries for use by a server

To us
syste

e alibrary or libraries for storage for an IBM Spectrum Protect™ server, you must first set up the devices on the server
m.

Before you begin

1. Attach devices to the server hardware. Follow the instructions in Attaching an automated library device to your system.

2
3

. Select the tape device drivers. Follow the instructions in Selecting a tape device driver.
. Install and configure the tape device drivers. Follow the instructions in Installing and configuring tape device drivers.

4. Determine the device names that are needed to define the library to the server. Follow the instructions in Special file names

Procedur

for tape devices.

e

1. Define the library and the path from the server to the library. Follow the instructions in Defining libraries.

2

w

. Define the drives in the library. Follow the instructions in Defining drives.

For SCSI libraries, you can use the PERFORM LIBACTION command to define drives and paths for a library in one step,
instead of completing both steps 2 and 3. To use the PERFORM LIBACTION command to define drives and paths for a
library, the SANDISCOVERY option must be supported and enabled.

. Define a path from the server to each drive by using the DEFINE PATH command.

4. Define a device class. Follow the instructions in Defining tape device classes.

Device classes specify the recording formats for drives and classify them according to type. Use the default value,
FORMAT=DRIVE as the recording format only if all the drives that are associated with the device class can read and write to
all of the media.

For example, you have a mix of Ultrium Generation 3 and Ultrium Generation 4 drives, but you have only Ultrium Generation
3 media. You can specify FORMAT=DRIVE because both the Generation 4 and Generation 3 drives can read from and write
to Generation 3 media.

5. Define a storage pool by using the DEFINE STGPOOL command.

Consider the following key choices for defining storage pools:
o Scratch volumes are empty volumes that are available for use. If you specify a value for the maximum number of
scratch volumes in the storage pool, the server can choose from the scratch volumes available in the library.

If you do not allow scratch volumes, you must complete the extra step of explicitly defining each volume to be used
in the storage pool. Also, specify the MAXSCRATCH=0 parameter when you define the storage pool so that scratch
volumes are not used.

o The default setting for primary storage pools is collocation by group. The default for copy storage pools and active-
data pools is disablement of collocation. The server uses collocation to keep all files that belong to a group of client
nodes, a single client node, a client file space, or a group of client file spaces on a minimal number of volumes. If
collocation is disabled for a storage pool and clients begin storing data, you cannot easily change the data in the pool
so that it is collocated.

IBM Spectrum Protect Knowledge Center Version 8.1.5 279



6. Check in and label library volumes. Follow the instructions in Checking volumes into an automated library and Labeling tape
volumes.

Ensure that enough volumes in the library are available to the server. Keep enough labeled volumes on hand so that you do
not run out during an operation such as client backup. Label extra scratch volumes for any potential recovery operations
that you might have later.

The procedures for checking in and labeling volumes are the same whether the library contains drives of a single device
type, or drives of multiple device types. You can use the CHECKIN LIBVOLUME command to check in volumes that are
already labeled. Or, if you want to label and check in volumes with one step, issue the LABEL LIBVOLUME command.

Libraries with multiple device types: If your library has drives of multiple device types, and you defined two libraries to the
IBM Spectrum Protect server, the two defined libraries represent one physical library. You must check in tape volumes
separately to each defined library. Ensure that you check in volumes to the correct IBM Spectrum Protect library.

What to do next

Verify your device definitions to ensure that everything is configured correctly. Use a QUERY command to review information about
each storage object.

When you review the results of the QUERY DRIVE command, verify that the device type for the drive is what you expect. If a path
is not defined, the drive device type is listed as UNKNOWN and if the wrong path is used, GENERIC_TAPE or another device type is
shown. This step is especially important when you are using mixed media.

Optionally, configure library sharing. Follow the instructions in Configuring library sharing.

e Defining tape devices
Before you can back up or migrate data to tape, you must define a tape device to the IBM Spectrum Protect.

e Configuring library sharing
Multiple IBM Spectrum Protect servers can share storage devices by using a storage area network (SAN). You set up one
server as the library manager and the other servers as library clients.

Related reference:

[* CHECKIN LIBVOLUME (Check a storage volume into a library)

[ LABEL LIBVOLUME (Label a library volume)

* PERFORM LIBACTION (Define or delete all drives and paths for a library)
Related information:

* DEFINE STGPOOL (Define a volume in a storage pool)

Defining tape devices

Before you can back up or migrate data to tape, you must define a tape device to the IBM Spectrum Protect™.

e Defining libraries and drives
A tape library can include one or more tape drives. Learn how to define libraries, drives, and paths to the IBM Spectrum
Protect server.

e Defining tape device classes
A device class defines a set of characteristics that are used by a set of volumes that can be created in a storage pool. You
must define a device class for a tape device to ensure that the server can use the device.

Defining libraries and drives

A tape library can include one or more tape drives. Learn how to define libraries, drives, and paths to the IBM Spectrum Protect™
server.

e Defining libraries
Before you can use a drive, you must define the library to which the drive belongs.

e Defining drives
To inform the server about a drive that can be used to access storage volumes, issue the DEFINE DRIVE command,
followed by the DEFINE PATH command.
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Defining libraries

Before you can use a drive, you must define the library to which the drive belongs.

Procedure

1. Define the library by using the DEFINE LIBRARY command.

For example, if you have an IBM TS3500 tape library, you can define a library that is named ROBOTMOUNT by using the
following command:

define library robotmount libtype=scsi

If you require library sharing or LAN-free data movement, see the following information:
o Configuring library sharing
o Configuring LAN-free data movement
2. Define a path from the server to the library by using the DEFINE PATH command. When you specify the DEVICE parameter,
enter the device special file name. This name is required by the server to communicate with tape drives, medium changer,

and removable media devices. For more information about device special file names, see Special file names for tape
devices. NN

define path serverl robotmount srctype=server desttype=library
device=/dev/1b0

define path serverl robotmount srctype=server desttype=library
device=/dev/tsmscsi/1b0

define path serverl robotmount srctype=server desttype=library
device=1b0.0.1.0

e Defining SCSI libraries on a SAN
For a library type of SCSI on a SAN, the server can track the library's serial number. With the serial number, the server can
confirm the identity of the device when you define the path or when the server uses the device.

Related information:
* DEFINE LIBRARY (Define a library)
* DEFINE PATH (Define a path)

Defining drives

To inform the server about a drive that can be used to access storage volumes, issue the DEFINE DRIVE command, followed by
the DEFINE PATH command.

Before you begin

A drive object represents a drive mechanism within a library that uses removable media. For devices with multiple drives,
including automated libraries, you must define each drive separately and associate it with a library. Drive definitions can include
such information as the element address for drives in SCSI, how often a tape drive is cleaned, and whether the drive is online.

IBM Spectrum Protect™ supports tape drives that can be stand-alone or that can be part of an automated library. The preferred
method is to configure the tape solution by using automated libraries.

About this task

When you issue the DEFINE DRIVE command, you must provide some or all of the following information:

Library name

The name of the library in which the drive is located.
Drive name

The name that is assigned to the drive.
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Serial number
The serial number of the drive. The serial number parameter applies only to drives in SCSI. With the serial number, the
server can confirm the identity of the device when you define the path or when the server uses the device.

You can specify the serial number if you choose. The default is to enable the server to obtain the serial number from the
drive itself at the time that the path is defined. If you specify the serial number, the server confirms that the serial number
is correct when you define the path to the drive. When you define the path, you can set the AUTODETECT=YES parameter to
enable the server to correct the serial number if the number that it detects does not match what you entered when you
defined the drive. As a best practice, specify the AUTODETECT=YES parameter to automatically update the serial number
for the drive in the database when the path is defined.

Depending on the capabilities of the drive, the server might not be able to automatically detect the serial number. In this
case, the server does not record a serial number for the device, and is not able to confirm the identity of the device when
you define the path or when the server uses the device. See Impacts of device changes on the SAN.

Element address
The element address of the drive. The ELEMENT parameter applies only to drives in SCSI libraries. The element address is a
number that indicates the physical location of a drive within an automated library. The server needs the element address to
connect the physical location of the drive to the drive's SCSI address. The server can obtain the element address from the
drive when you define the path, or you can specify the element number when you define the drive. As a best practice,
specify the ELEMENT=AUTODETECT parameter for the server to automatically detect the element number when the path to
the drive is defined.

Depending on the capabilities of the library, the server might not be able to automatically detect the element address. In
this case, you must supply the element address when you define the drive, if the library has more than one drive. To obtain
the element address, go to the IBM® Support Portal for IBM Spectrum Protect.

Tip: IBM tape device drivers and non-IBM tape device drivers generate different device files and formats:

e For IBM, device names begin with rmt followed by an integer, for example, /dev/rmt0.
e For IBM Spectrum Protect tape device drivers, tape device names begin with mt followed by an integer, for example
/dev/mtO.

You must use the correct device file when you define a path.

Procedure

1. Assign a drive to a library by issuing the DEFINE DRIVE command.
2. To make the drive usable by the server, issue the DEFINE PATH command.

For examples about configuring libraries, paths, and drives, see Example: Configure a SCSI or virtual tape library with a
single drive device type and Example: Configure a SCSI or virtual tape library with multiple drive device types.

Defining tape device classes

A device class defines a set of characteristics that are used by a set of volumes that can be created in a storage pool. You must
define a device class for a tape device to ensure that the server can use the device.

Before you begin

You must define libraries and drives to the server before you define device classes.

About this task

For a list of supported devices and valid device class formats, see the IBM Spectrum Protect™ Supported Devices website for your
operating system:

o NN NITTITMS upported devices for AIX and Windows
o ITITEMSupported devices for Linux

You can define multiple device classes for each device type. For example, you might want to specify different attributes for
different storage pools that use the same type of tape drive. Variations might be required that are not specific to the device, but
rather to how you want to use the device (for example, mount retention or mount limit).
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Guidelines:

e One device class can be associated with multiple storage pools, but each storage pool is associated with only one device
class.

e SCSI libraries can include tape drives of more than one device type. When you define the device class in this environment,
you must declare a value for the FORMAT parameter.

For more information, see Mixed device types in libraries.

Procedure

To define a device class, use the DEFINE DEVCLASS command with the DEVTYPE parameter, which assigns a device type to the
device class.

Results

If you include the DEVCONFIG option in the dsmserv.opt file, the files that you specify with that option are automatically updated
with the results of the DEFINE DEVCLASS, UPDATE DEVCLASS, and DELETE DEVCLASS commands.

e Defining LTO device classes
To prevent problems when you mix different generations of LTO drives and media in a single library, review the restrictions.
Also, review the restrictions for LTO drive encryption.

e Defining 3592 device classes
Device class definitions for 3592, TS1130, TS1140, TS1150, and later devices include parameters for faster volume-access
speeds and drive encryption. To prevent problems when mixing different generations of 3592 and TS1130 and later drives
in a library, review the guidelines.

Related reference:

* DEFINE DEVCLASS (Define a device class)

Related information:

I* QUERY DEVCLASS (Display information on one or more device classes)
* UPDATE DEVCLASS (Update a device class)

Defining LTO device classes

To prevent problems when you mix different generations of LTO drives and media in a single library, review the restrictions. Also,
review the restrictions for LTO drive encryption.

e Mixing LTO drives and media in a library
When you mix different generations of LTO drives and media, you must consider the read/write capabilities of each
generation. The preferred method is to configure a different device class for each generation of media.

e Mount limits in LTO mixed-media environments
In a mixed-media library, in which multiple device classes point to the same library, compatible drives are shared between
storage pools. Ensure that you set an appropriate value for the MOUNTLIMIT parameter in each of the device classes.

e Enabling and disabling drive encryption for LTO Generation 4 or later tape drives
IBM Spectrum Protect™ supports the three types of drive encryption that are available with LTO Generation 4 or later
drives: Application, System, and Library. These methods are defined through the hardware.

Mixing LTO drives and media in a library

When you mix different generations of LTO drives and media, you must consider the read/write capabilities of each generation.
The preferred method is to configure a different device class for each generation of media.

About this task

If you are considering mixing different generations of LTO media and drives, review the following restrictions:
Table 1. Read/write capabilities for different generations of LTO drives

Generatio
Generatio | Generatio | Generatio | Generatio | Generatio | Generatio | Generatio n M8 Generatio
Drives n1media | n2media | n3 media | n4 media | n 5 media | n 6 media | n 7 media media n 8 media
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Generatio

Generatio | Generatio | Generatio | Generatio | Generatio | Generatio | Generatio n M8 Generatio
Drives n1media | n2media | n3 media | n4 media | n5 media | n 6 media | n 7 media media n 8 media
Generation | Read/write n/a n/a n/a n/a n/a n/a n/a n/a
1 access
Generation | Read/write | Read/write n/a n/a n/a n/a n/a n/a n/a
2 access access
Generation | Read-only | Read/write | Read/write n/a n/a n/a n/a n/a n/a
3 access access access
Generation n/a Read-only | Read/write | Read/write n/a n/a n/a n/a n/a
4 access access access
Generation n/a n/a Read-only | Read/write | Read/write n/a n/a n/a n/a
5 access access access
Generation n/a n/a n/a Read-only | Read/write | Read/write n/a n/a n/a
6 access access access
Generation n/a n/a n/a n/a Read Read/write | Read/write n/a n/a
7 access access access
Generation n/a n/a n/a n/a n/a n/a Read/write | Read/write | Read/write
8 access access access

Example

If you are mixing different types of drives and media, configure different device classes: one for each type of media. To specify the
media type, use the FORMAT parameter in each of the device class definitions. (Do not specify FORMAT=DRIVE.) For example, if
you are mixing Ultrium Generation 5 and Ultrium Generation 6 drives, specify FORMAT=ULTRIUM5C (or ULTRIUMS5) for the Ultrium
Generation 5 device class, and FORMAT=ULTRIUM6C (or ULTRIUM®) for the Ultrium Generation 6 device class.

In this example, both device classes can point to the same library with Ultrium Generation 5 and Ultrium Generation 6 drives. The
drives are shared between the two storage pools. One storage pool uses the first device class and Ultrium Generation 5 media
exclusively. The other storage pool uses the second device class and Ultrium Generation 6 media exclusively. Because the two
storage pools share a single library, Ultrium Generation 5 media can be mounted on Ultrium Generation 6 drives as they become
available during mount point processing.

If you mix older read-only media generations with newer read/write media in a single library, you must mark the read-only media
as read-only and check out all read-only scratch media. For example, if you are mixing Ultrium Generation 4 with Ultrium
Generation 6 drives and media in a single library, you must mark the Generation 4 media as read-only. In addition, you must check
out all Generation 4 scratch volumes.

Mount limits in LTO mixed-media environments

In a mixed-media library, in which multiple device classes point to the same library, compatible drives are shared between storage
pools. Ensure that you set an appropriate value for the MOUNTLIMIT parameter in each of the device classes.

For example, in a mixed media library that contains Ultrium Generation 1 and Ultrium Generation 2 drives and media, Ultrium
Generation 1 media can be mounted in Ultrium Generation 2 drives.

Consider the example of a mixed library that consists of the following drives and media:

e Four LTO Ultrium Generation 1 drives and LTO Ultrium Generation 1 media
e Four LTO Ultrium Generation 2 drives and LTO Ultrium Generation 2 media

You created the following device classes:

e LTO Ultrium Generation 1 device class LTO1CLASS specifying FORMAT=ULTRIUM1C
e LTO Ultrium Generation 2 device class LTO2CLASS specifying FORMAT=ULTRIUM2C

You also created the following storage pools:

e LTO Ultrium Generation 1 storage pool LTO1POOL based on device class LTO1CLASS
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e LTO Ultrium Generation 2 storage pool LTO2POOL based on device class LTO2CLASS

The number of mount points available for use by each storage pool is specified in the device class by using the MOUNTLIMIT
parameter. The MOUNTLIMIT parameter in the LTO2CLASS device class must be set to 4 to match the number of available drives
that can mount only LTO7 media. The MOUNTLIMIT parameter in the LTO1CLASS device class must be set to a value that is
greater than the number of available drives (5 or possibly 6) to adjust for the fact that Ultrium Generation 1 media can be mounted
in Ultrium Generation 7 drives. The optimal value for MOUNTLIMIT depends on workload and storage pool access patterns.

Monitor and adjust the MOUNTLIMIT setting to suit changing workloads. If the MOUNTLIMIT for LTO1POOL is set too high, mount
requests for the LTO2POOL might be delayed or fail because the Ultrium Generation 2 drives are used to satisfy Ultrium
Generation 1 mount requests. In the worst scenario, too much competition for Ultrium Generation 2 drives might cause mounts
for Generation 2 media to fail with the following message:

ANR8447E No drives are currently available in the library.

If the MOUNTLIMIT value for LTO1POOL is not set high enough, mount requests that might be satisfied by LTO Ultrium Generation
2 drives are delayed.

Restriction: Restrictions apply when you mix Ultrium Generation 1 with Ultrium Generation 2 or Generation 3 drives because of
how mount points are allocated. For example, processes that require multiple mount points that include both Ultrium Generation
1 and Ultrium Generation 2 volumes might try to reserve Ultrium Generation 2 drives only, even when one mount can be satisfied
by an available Ultrium Generation 6 drive. Processes that behave in this manner include the MOVE DATA and BACKUP STGPOOL
commands. These processes wait until the required number of mount points can be satisfied with Ultrium Generation 2 drives.
Related reference:

[ BACKUP STGPOOL (Back up primary storage pool data to a copy storage pool)

[ DEFINE DEVCLASS (Define a device class)

* MOVE DATA (Move files on a storage pool volume)

Enabling and disabling drive encryption for LTO Generation 4 or later
tape drives

IBM Spectrum Protect™ supports the three types of drive encryption that are available with LTO Generation 4 or later drives:
Application, System, and Library. These methods are defined through the hardware.

About this task

The DRIVEENCRYPTION parameter on the DEFINE DEVCLASS command specifies whether drive encryption is allowed for IBM
and HP LTO Generation 4 or later, Ultrium 4, and Ultrium 4C formats. This parameter ensures IBM Spectrum Protect compatibility
with hardware encryption settings for empty volumes. You cannot use this parameter for storage pool volumes that are full or are
filling.

IBM Spectrum Protect supports the Application method of encryption with IBM and HP LTO-4 or later drives. Only IBM LTO-4 or
later supports the System and Library methods. The Library method of encryption can be used only if your system hardware (for
example, IBM TS3500) supports it.

Restriction: You cannot use drive encryption with write-once, read-many (WORM) media.

The Application method is defined through the hardware. To use the Application method, in which IBM Spectrum Protect
generates and manages encryption keys, set the DRIVEENCRYPTION parameter to ON. This action enables data encryption for
empty volumes. If the parameter is set to ON and the hardware is configured for another encryption method, backup operations
fail.

Procedure

The following simplified example shows the steps that you would take to enable and disable data encryption for empty volumes in
a storage pool:

1. Define a library by issuing the DEFINE LIBRARY command:

define library 3584 libtype=SCSI

2. Define a device class, LTO_ENCRYPT, by issuing the DEFINE DEVCLASS command and specifying IBM Spectrum Protect as
the key manager:
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define devclass lto encrypt library=3584 devtype=lto driveencryption=on
3. Define a storage pool by issuing the DEFINE STGPOOL command:
define stgpool lto encrypt pool lto encrypt

4. To disable encryption on new volumes, set the DRIVEENCRYPTION parameter to OFF. The default value is ALLOW. Drive
encryption for empty volumes is allowed if another method of encryption is enabled.

Related concepts:
Tape encryption methods

Defining 3592 device classes

Device class definitions for 3592, TS1130, TS1140, TS1150, and later devices include parameters for faster volume-access
speeds and drive encryption. To prevent problems when mixing different generations of 3592 and TS1130 and later drives in a
library, review the guidelines.

e Mixing generations of 3592 drives and media in a single library
For optimal performance, do not mix generations of 3592 media in a single library. Media problems can result when
different drive generations are mixed. For example, IBM Spectrum Protect™ might not be able to read a volume's label.

e Controlling data-access speeds for 3592 volumes
You can optimize the storage capacity and improve data-access speeds when you create volumes. By partitioning data into
storage pools that have volumes, you can specify the scale capacity percentage to provide maximum storage capacity, or to
provide fast access to the volume.

e Enabling and disabling 3592 Generation 2 and later drive encryption
With IBM Spectrum Protect, you can use the following types of drive encryption with drives that are 3592 Generation 2 and
later: Application, System, and Library. These methods are defined through the hardware.

Mixing generations of 3592 drives and media in a single library

For optimal performance, do not mix generations of 3592 media in a single library. Media problems can result when different drive
generations are mixed. For example, IBM Spectrum Protect™ might not be able to read a volume's label.

About this task

The following table shows read/write interoperability for drive generations.

Generation 1

Generation 2

Generation 3

Generation 4

Generation 5

Drives format format format format format
Generation 1 Read/write access [n/a n/a n/a n/a

Generation 2 Read/write access | Read/write access |n/a n/a n/a

Generation 3 Read-only access Read/write access |Read/write access |n/a n/a

Generation 4 n/a Read only Read/write access |Read/write access |n/a

Generation 5 n/a n/a Read access Read/write access |Read/write access

If you must mix generations of drives in a library, review the example and restrictions to help prevent problems.

Table 1. Mixing generations of drives

Library type

Example and restrictions
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Library type Example and restrictions

SCSI Define a new storage pool and device class for the latest drive generation. For example, suppose that
you have a storage pool and device class for 3592-2. The storage pool contains all the media that
were written in Generation 2 format. Suppose that the value of the FORMAT parameter in the device
class definition is set to 3952-2 (not DRIVE). You add Generation 3 drives to the library. Complete the
following steps:

1. In the new device-class definition for the Generation 3 drives, set the value of the FORMAT
parameter to 3592-3 or 3592-3C. Do not specify DRIVE.

2. In the definition of the storage pool that is associated with Generation 2 drives, update the
MAXSCRATCH parameter to O, for example:

update stgpool genpool2 maxscratch=0

This method allows both generations to use their optimal format and minimizes potential media
problems that can result from mixing generations. However, it does not resolve all media issues. For
example, competition for mount points and mount failures might result. (To learn more about mount
point competition in the context of 3592 drives and media, see Defining 3592 device classes.)

Restriction: The following list describes media restrictions:

e CHECKIN LIBVOL: The issue is using the CHECKLABEL=YES option. If the label is written in a
Generation 3 or later format, and you specify the CHECKLABEL=YES option, drives of previous
generations fail by using this command. To avoid the issue, specify CHECKLABEL=BARCODE.

e LABEL LIBVOL: When the server tries to use drives of a previous generation to read the label
that is written in a Generation 3 or later format, the LABEL LIBVOL command fails unless
OVERWRITE=YES is specified. Verify that the media that is being labeled with
OVERWRITE=YES does not have any active data.

e CHECKOUT LIBVOL: When IBM Spectrum Protect verifies the label (CHECKLABEL=YES) as a
Generation 3 or later format, and read drives of previous generations, the command fails. To
avoid this issue, specify CHECKLABEL=NO.

Related reference:

[* CHECKIN LIBVOLUME (Check a storage volume into a library)

[ CHECKOUT LIBVOLUME (Check a storage volume out of a library)
| ABEL LIBVOLUME (Label a library volume)

[ UPDATE STGPOOL (Update a storage pool)

Controlling data-access speeds for 3592 volumes

You can optimize the storage capacity and improve data-access speeds when you create volumes. By partitioning data into
storage pools that have volumes, you can specify the scale capacity percentage to provide maximum storage capacity, or to
provide fast access to the volume.

About this task

To reduce media capacity, specify the SCALECAPACITY parameter when you define the device class by using the DEFINE
DEVCLASS command or when you update the device class by using the UPDATE DEVCLASS command.

Specify a percentage value of 20, 90, or 100. A value of 20 percent provides the fastest access time, and 100 percent provides the
largest storage capacity. For example, if you specify a scale capacity of 20 for a 3592 device class without compression, a 3592
volume in that device class would store 20 percent of its full capacity of 300 GB, or about 60 GB.

Scale capacity takes effect only when data is first written to a volume. Updates to the device class for scale capacity do not affect
volumes that already have data written to them until the volume is returned to scratch status.

Related reference:

* DEFINE DEVCLASS (Define a device class)
Related information:

[ UPDATE DEVCLASS (Update a device class)
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Enabling and disabling 3592 Generation 2 and later drive encryption

With IBM Spectrum Protect™, you can use the following types of drive encryption with drives that are 3592 Generation 2 and later:
Application, System, and Library. These methods are defined through the hardware.

About this task

The DRIVEENCRYPTION parameter on the DEFINE DEVCLASS command specifies whether drive encryption is allowed for drives
that are 3592 Generation 2 and later. Use this parameter to ensure IBM Spectrum Protect compatibility with hardware encryption
settings for empty volumes. You cannot use this parameter for storage pool volumes that are full or are filling.

e To use the Application method, in which IBM Spectrum Protect generates and manages encryption keys, set the
DRIVEENCRYPTION parameter to ON. This enables the encryption of data for empty volumes. If the parameter is set to ON
and if the hardware is configured for another encryption method, backup operations fail.

e To use the Library or System methods of encryption, set the parameter to ALLOW. This specifies that IBM Spectrum Protect
is not the key manager for drive encryption, but allows the hardware to encrypt the volume's data through one of the other
methods. Specifying this parameter does not automatically encrypt volumes. Data can be encrypted only by specifying the
ALLOW parameter and configuring the hardware to use one of these methods.

The DRIVEENCRYPTION parameter is optional. The default value is to allow the Library or System methods of encryption.

Procedure

The following simplified example shows how to encrypt data for empty volumes in a storage pool, by using IBM Spectrum Protect
as the key manager:

1. Define a library by issuing the DEFINE LIBRARY command. For example, issue the following command:

define library 3584 libtype=SCSI

2. Define a device class, 3592_ENCRYPT, by issuing the DEFINE DEVCLASS command and specifying the value ON for the
DRIVEENCRYPTION parameter. For example, issue the following command:

define devclass 3592 encrypt library=3584 devtype=3592 driveencryption=on
3. Define a storage pool. For example, issue the following command:

define stgpool 3592 encrypt pool 3592 encrypt

What to do next

To disable any method of encryption on new volumes, set the DRIVEENCRYPTION parameter to OFF. If the hardware is configured
to encrypt data through either the Library or System method and DRIVEENCRYPTION is set to OFF, backup operations fail.

Configuring library sharing

Multiple IBM Spectrum Protect™ servers can share storage devices by using a storage area network (SAN). You set up one server
as the library manager and the other servers as library clients.

Before you begin

Ensure that your systems meet licensing requirements for library sharing. An entitlement for IBM Spectrum Protect for SAN is
required for each IBM Spectrum Protect server that is configured as a library client or a library manager in a SAN environment.

About this task

With LAN-free data movement, IBM Spectrum Protect client systems can directly access storage devices that are defined to an
IBM Spectrum Protect server. Storage agents are installed and configured on the client systems to perform the data movement.

To set up library sharing, you must define one IBM Spectrum Protect server as the library manager for your shared library
configuration. Then, you define other IBM Spectrum Protect servers as library clients that communicate and request storage
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resources from the library manager. The library manager server must be at the same version or a later version as the server or
servers that are defined as library clients.

Procedure

To complete the following steps to share library resources on a SAN among IBM Spectrum Protect servers, complete the following
steps:

1. Set up server-to-server communications.

To share a storage device on a SAN, define servers to each other by using the cross-define function. Each server must have
a unique name.

2. Define a shared library and set up tape devices on the server systems.

Use the procedure that is described in Configuring libraries for use by a server to define a library for use in the shared
environment. Modify the procedure to define the library as shared, by specifying the SHARED=YES parameter for the
DEFINE LIBRARY command.

w

. Define the library manager server.

. Define the shared library on the server that is the library client.

5. From the library manager server, define paths from the library client to each drive that the library client can access. The
device name must reflect the way that the library client system recognizes the tape device. A path from the library manager
to each tape drive must be defined in order for the library client to use the drive.

IN

To avoid problems, ensure that all drive path definitions that are defined for the library manager are also defined for each
library client.

For example, if the library manager defines three tape drives, the library client must also define three tape drives. To limit
the number of tape drives that a library client can use at a time, use the MOUNTLIMIT parameter of the device class on the
library client.

6. Define device classes for the shared library.

The preferred method is to make the device class names the same on both servers to avoid confusion when you define
multiple device classes with the same device type and library parameters. Some operations, such as database backup, use
the device class name to identify the data for backup.

The device class parameters that are specified on the library manager override the parameters that are specified for the
library client. If the device class names are different, the library manager uses the parameters that are specified in a device
class that matches the device type that is specified for the library client.

7. Define a storage pool for the shared library.
8. Repeat the steps to configure another server as a library client.

o IR Example: Library sharing for AIX and Linux servers
To learn how to set up a SCSI library sharing environment for servers that run on AIX® or Linux systems, review the sample
procedure.

e Example: Library sharing for Windows servers
To learn how to set up a library sharing environment for servers that run on Windows systems, review the sample
procedure.

Related reference:

* DEFINE DEVCLASS (Define a device class)
Related information:

[** DEFINE LIBRARY (Define a library)

* DEFINE STGPOOL (Define a volume in a storage pool)
L aX | Linux |

Example: Library sharing for AIX and Linux servers

To learn how to set up a SCSI library sharing environment for servers that run on AIX® or Linux systems, review the sample
procedure.

About this task
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In this example, a library manager server named ASTRO and a library client named JUDY are configured. To help clarify where
each step is performed, the commands are preceded by the server name from which the command is issued. Most commands are
issued from the library client.

For SCSI libraries, define the library by specifying the libtype=scsi parameter.

Procedure

1. To set up ASTRO as the library manager server, define a shared SCSI library named SANGROUP. For example:

astro> define library sangroup libtype=scsi shared=yes

Then complete the rest of the steps as described in Example: Configure a SCSI or virtual tape library with a single drive
device type to configure the library.
Tip: You can use the PERFORM LIBACTION command to define drives and paths for a library in one step.

2. Define ASTRO as the library manager server by issuing the DEFINE SERVER command.

judy> define server astro serverpassword=secret hladdress=192.0.2.24
lladdress=1777 crossdefine=yes

3. Define the shared library SANGROUP by issuing the DEFINE LIBRARY command. You must use the library manager server
name in the PRIMARYLIBMANAGER parameter, and use LIBTYPE=SHARED.

judy> define library sangroup libtype=shared primarylibmanager=astro

Ensure that the library name is the same as the library name on the library manager.

4. Define paths from the library manager, ASTRO, to two drives in the shared library by issuing the DEFINE PATH command.
T

astro> define path judy drivea srctype=server desttype=drive
library=sangroup device=/dev/rmt6

astro> define path judy driveb srctype=server desttype=drive
library=sangroup device=/dev/rmt7

astro> define path judy drivea srctype=server desttype=drive
library=sangroup device=/dev/IBMtapeb

astro> define path judy driveb srctype=server desttype=drive
library=sangroup device=/dev/IBMtape7

5. Define all device classes that are associated with the shared library. INGCZSEN
judy> define devclass tape library=sangroup devtype=lto

judy> define devclass tape library=sangroup devtype=lto

The following parameters for the device class definition must be the same on the library client and the library manager:
o LIBRARY
o DRIVEENCRYPTION
o WORM
o FORMAT
6. Define a storage pool that is named BACKTAPE for the shared library to use. Issue the DEFINE STGPOOL command.

judy> define stgpool backtape tape maxscratch=50

What to do next

Repeat the procedure to define more library clients to your library manager.
Related reference:

[** DEFINE DEVCLASS (Define a device class)
Related information:

[** DEFINE DRIVE (Define a drive to a library)
* DEFINE LIBRARY (Define a library)

[** DEFINE PATH (Define a path)

* DEFINE STGPOOL (Define a volume in a storage pool)
| Windows |
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Example: Library sharing for Windows servers

To learn how to set up a library sharing environment for servers that run on Windows systems, review the sample procedure.

About this task

In this example, a library manager server named ASTRO and a library client named JUDY are configured.
For SCSI libraries, define the library by specifying the libtype=scsi parameter.

o NI MSetting up the library manager server
You must set up the library manager server in order to configure the IBM Spectrum Protect servers to share SAN-connected
devices.

o INITTTTMSetting up the library client servers
You must set up one or more library client servers to configure the IBM Spectrum Protect servers to share SAN-connected
devices.

Setting up the library manager server

You must set up the library manager server in order to configure the IBM Spectrum Protect™ servers to share SAN-connected
devices.

Procedure

The following procedure is an example of how to set up an IBM Spectrum Protect server that is named ASTRO as a library
manager:

1. Ensure that the library manager server is running:

a. Start the Windows Services Management Console (services.msc).

b. Select the service. For example, TSM Serverl.

c. If the service is not running, right-click the service name and click Start.
2. Obtain the library and drive information for the shared library device:

a. Run the tsmdlst.exe utility. The utility is in the \Program Files\Tivoli\TSM\server directory.
3. Define a library whose library type is SCSI. For example:

define library sangroup libtype=scsi shared=yes

This example uses the default for the library's serial number, which is to have the server obtain the serial number from the
library itself at the time that the path is defined. Depending on the capabilities of the library, the server might not be able to
automatically detect the serial number. In this case, the server does not record a serial number for the device, and is not
able to confirm the identity of the device when you define the path or when the server uses the device.

4. Define the path from the server to the library.

define path astro sangroup srctype=server desttype=library
device=1b0.0.0.2

If you did not include the serial number when you defined the library, the server now queries the library to obtain this
information. If you did include the serial number when you defined the library, the server verifies what you defined and
issues a message if there is a mismatch.

5. Define the drives in the library.

define drive sangroup drivea
define drive sangroup driveb

This example uses the default for the drive's serial number, which is to have the server obtain the serial number from the
drive itself at the time that the path is defined. Depending on the capabilities of the drive, the server might not be able to
automatically detect the serial number. In this case, the server does not record a serial number for the device, and is not
able to confirm the identity of the device when you define the path or when the server uses the device.
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This example also uses the default for the drive's element address, which is to have the server obtain the element number
from the drive itself at the time that the path is defined.

The element address is a number that indicates the physical location of a drive within an automated library. The server
needs the element address to connect the physical location of the drive to the drive's SCSI address. You can have the
server obtain the element number from the drive itself at the time that the path is defined, or you can specify the element
number when you define the drive.

Depending on the capabilities of the library, the server might not be able to automatically detect the element address. In
this case, you must supply the element address when you define the drive. Element numbers for many libraries are
available at IBM® Support Portal for IBM Spectrum Protect.

6. Define the path from the server to each of the drives.

define path astro drivea srctype=server desttype=drive library=sangroup
device=mt0.1.0.2

define path astro driveb srctype=server desttype=drive library=sangroup
device=mt0.2.0.2

If you did not include the serial number or element address when you defined the drive, the server now queries the drive or
the library to obtain this information.

7. Define at least one device class.

define devclass tape devtype=dlt library=sangroup

8. Check in the library inventory. The following example checks all volumes into the library inventory as scratch volumes. The
server uses the name on the bar code label as the volume name.

checkin libvolume sangroup search=yes status=scratch
checklabel=barcode

9. Set up a storage pool for the shared library with a maximum of 50 scratch volumes.

define stgpool backtape tape
description='storage pool for shared sangroup' maxscratch=50

Related reference:

[* CHECKIN LIBVOLUME (Check a storage volume into a library)
[** DEFINE DEVCLASS (Define a device class)

Related information:

[** DEFINE DRIVE (Define a drive to a library)

* DEFINE LIBRARY (Define a library)

[** DEFINE PATH (Define a path)

* DEFINE STGPOOL (Define a volume in a storage pool)
| Windows |

Setting up the library client servers

You must set up one or more library client servers to configure the IBM Spectrum Protect™ servers to share SAN-connected
devices.

Before you begin

Ensure that a library manager server is defined.

About this task

You must define the library manager server. Use the following procedure as an example of how to set up an IBM Spectrum Protect
server that is named JUDY as a library client.

Procedure

1. Ensure that the library manager server is running:
a. Start the Windows Services Management Console (services.msc).
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b. Select the service. For example, TSM Serverl.
c. If the service is not running, right-click and select Start.
2. Obtain the library and drive information for the shared library device:
a. Run the tsmdlst.exe utility. The utility is in the \Program Files\Tivoli\TSM\server directory.
3. Define the shared library, SANGROUP, and identify the library manager. Ensure that the library name is the same as the
library name on the library manager.

define library sangroup libtype=shared primarylibmanager=astro

4. Define the paths from the library client server to each of the drives by issuing commands on the administrative client:

define path judy drivea srctype=server desttype=drive library=sangroup
device=mt0.1.0.3
define path judy driveb srctype=server desttype=drive library=sangroup
device=mt0.2.0.3

5. Define at least one device class by issuing commands from the library client:

define devclass tape devtype=dlt mountretention=1 mountwait=10
library=sangroup

Set the parameters for the device class the same on the library client as on the library manager. Making the device class
names the same on both servers is also a good practice, but is not required.

The device class parameters that are specified on the library manager server override those specified for the library client.
This is true whether or not the device class names are the same on both servers. If the device class names are different, the
library manager uses the parameters specified in a device class that matches the device type specified for the library client.

If a library client requires a setting that is different from what is specified in the library manager's device class (for example,
a different mount limit), complete the following steps:

a. Create an additional device class on the library manager server. Specify the parameter settings that you want the
library client to use.
b. Create a device class on the library client with the same name and device type as the new device class you created
on the library server.
6. Define the storage pool, BACKTAPE, that will use the shared library:

define stgpool backtape tape
description='storage pool for shared sangroup' maxscratch=50

7. Repeat this procedure to define additional servers as library clients.

Related reference:

* DEFINE DEVCLASS (Define a device class)
Related information:

[ DEFINE LIBRARY (Define a library)
B+ DEFINE PATH (Define a path)
* DEFINE STGPOOL (Define a volume in a storage pool)

Setting up a storage pool hierarchy

As part of the implementation process, you must set up a storage pool hierarchy. Set up at least one primary storage pool on disk
and one primary storage pool on tape. Ensure that data is migrated from disk to tape daily.

Before you begin

1. Ensure that you reviewed the information in Planning the storage pool hierarchy.

2. Ensure that appropriate rules, also known as policies, are specified for backing up client data. Follow the instructions in
Specifying rules for backing up and archiving client data.

3. Ensure that a policy is assigned to each node. For instructions about assigning a policy when you register a node, see
Registering clients.

Procedure

To set up a storage pool hierarchy, complete the following steps:
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1. Define a primary storage pool for the tape device by issuing the DEFINE STGPOOL command.

For example, define a primary storage pool, TAPEL, with a device class of LTO, and enable group collocation. Set the
maximum number of scratch volumes that the server can request for this storage pool to 999. Issue the following
command:

define stgpool tapel lto pooltype=primary collocate=group
maxscratch=999

2. Define the drives, paths, and libraries for the primary storage pool on tape. Follow the instructions in Defining tape devices.
3. Define a primary storage pool for the disk device by issuing the DEFINE STGPOOL command.

For example, define a storage pool, DISK1, with a device class of FILE. Ensure that data can be migrated to the tape storage
pool, TAPE1, but prevent automatic migration by specifying 100 for the HIGHMIG parameter and O for the LOWMIG
parameter. Prevent reclamation by specifying 100 for the RECLAIM parameter. Enable node collocation. Set the maximum
number of scratch volumes that the server can request for this storage pool to 9999. Use the MIGPROCESS parameter to
specify the number of migration processes. The value of the MIGPROCESS parameter should equal the number of drives in
the library minus the number of drives that are reserved for restore operations. Issue the following command:

define stgpool diskl file pooltype=primary nextstgpool=tapel
highmig=100 lowmig=0 reclaim=100 collocate=node maxscratch=9999 migprocess=5

For more information about how to set up migration from disk to tape, see Migrating disk storage pools.

What to do next

A storage pool hierarchy includes only primary storage pools. After you set up the storage pool hierarchy, complete the following
steps:

1. Create a copy storage pool on a tape device. For instructions, see DEFINE STGPOOL (Define a copy storage pool assigned to
sequential access devices).

2. Back up the tape-based primary storage pool to the copy storage pool by using the BACKUP STGPOOL command. For
instructions, see BACKUP STGPOOL (Back up primary storage pool data to a copy storage pool).

3. To ensure that data can be recoved in a disaster, set up a procedure for moving tape volumes from the copy storage pool to
an offsite location. For instructions, see Preparing for and recovering from a disaster by using DRM.

Related reference:

[* CHECKIN LIBVOLUME (Check a storage volume into a library)
Related information:
* DEFINE STGPOOL (Define a volume in a storage pool)

Protecting applications and systems

The server protects data for clients, which can include applications, virtual machines, and systems.

e Adding clients
Following the successful setup of your IBM Spectrum Protect™ server, install and configure client software to begin backing
up data.

Configuring LAN-free data movement

You can configure the IBM Spectrum Protect™ client and server so that the client, through a storage agent, can move data directly
to storage on a SAN. This function, called LAN-free data movement, is provided by the IBM Spectrum Protect for SAN product.

Procedure

To configure LAN-free data movement, complete the following steps. For details, see the documentation for IBM Spectrum
Protect for SAN.

1. Verify the network connection.

2. Establish communications among the client, storage agent, and the server.
3. Install and configure software on client systems.

4. Configure devices on the server for the storage agent to access.
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5. Configure IBM Spectrum Protect policies for LAN-free data movement for the client.

6. If you are using shared FILE storage, install and configure IBM® TotalStorage SAN File System or IBM Spectrum Scale™.
WM Restriction: If an IBM Spectrum Scale volume is formatted by an AIX® server, the Windows system uses TCP/IP to
transfer data and not the storage area network.

7. Define paths from the storage agent to drives.

8. Start the storage agent and verify the LAN-free configuration.

What to do next

To help you tune the use of your LAN and SAN resources, you can control the path that data transfers take for clients with the
capability of LAN-free data movement. Control the path by using the UPDATE NODE command. For each client, you can select one
of the following settings for data read and write operations. Specify data read operations by using the DATAREADPATH parameter
and data write operations by using the DATAWRITEPATH parameter. The parameter is optional. The default value is ANY.

LAN (LAN path only)
Specify the LAN value if either of the following conditions is true:

e You want to back up or restore a small amount of data.
e The client does not have SAN connectivity.

LANFREE (LAN-free path only)
Specify the LANFREE value if the client and server are on the same SAN, and any of the following conditions are true:

e You want to back up or restore a large amount of data.
e You want to offload the server processing load to the client.
e You want to relieve LAN congestion.

ANY (Any available path)
A LAN-free path is used if one is available. If a LAN-free path is unavailable, the data is moved by using the LAN.

e Validating your LAN-free configuration
After you configure an IBM Spectrum Protect client for LAN-free data movement, you can verify the configuration and
server definitions by using the VALIDATE LANFREE command.

Tape encryption methods

Deciding on the encryption method to use depends on how you want to manage your data.

It is critical to secure client data, especially when that data is sensitive. To ensure that data in onsite and offsite volumes is
protected, IBM tape encryption technology is available.

IBM tape technology supports different methods of drive encryption for the following devices:

e IBM 3592 Generation 2 and Generation 3
e IBM Linear Tape-Open (LTO) Generation 4 and Generation 5

The methods of drive encryption that you can use with IBM Spectrum Protect™ are set up at the hardware level. IBM Spectrum
Protect cannot control or change which encryption method is used in the hardware configuration. If the hardware is set up for the
Application method, IBM Spectrum Protect can turn encryption on or off depending on the DRIVEENCRYPTION value on the
device class.

To encrypt all data in a particular logical library or to encrypt data on more than just storage pool volumes, use the Library or
System method. If the encryption key manager is set up to share keys, the Library and System methods can share the encryption
key, which allows the two methods to be interchanged. IBM Spectrum Protect cannot share or use encryption keys between the
Application method and either the Library or the System methods of encryption.

Table 1. Encryption methods
Encryption method Description
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Encryption method

Description

Application encryption

With application-managed encryption, you can create
dedicated storage pools that contain encrypted volumes only.
This way, you can use storage pool hierarchies and policies to
manage the way data is encrypted.

Encryption keys are managed by the application, in this case,
IBM Spectrum Protect. IBM Spectrum Protect generates and
stores the keys in the server database. Data is encrypted
during write operations, when the encryption key is passed
from the server to the drive. Data is decrypted for read
operations.

To encrypt storage pool volumes and eliminate some
encryption processing on your system, enable the Application
method. Use application-managed encryption only for storage
pool volumes. Other volumes, such as backup-set tapes,
export volumes, and database backups, are not encrypted by
using the Application method.

Requirement: When application encryption is enabled, you
must take extra care to secure database backups because the
encryption keys that are used to encrypt and decrypt data are
stored in the server database. To restore your data, you must
have the correct database backup and corresponding
encryption keys to access your information. Ensure that you
back up the database frequently and safeguard the backups to
prevent data loss or theft. Anyone who has access to both the
database backup and the encryption keys has access to your
data.

Library encryption

With library-managed encryption, you can control which
volumes are encrypted by using their serial numbers. You can
specify a range or set of volumes to encrypt.

Encryption keys are managed by the library. Keys are stored in
an encryption key manager and provided to the drive. If you set
up the hardware to use library-managed encryption, you can
use this method by issuing the DEFINE DEVCLASS command
and specifying the DRIVEENCRYPTION=ALLOW parameter.

Restriction: Only certain IBM libraries support IBM LTO-4 and
later encryption. For details, see Configuring tape drive
encryption.

System encryption

System-managed encryption is available only on the AIX®
operating system. Encryption keys that are provided to the
drive are managed by the device driver or operating system and
stored in an encryption key manager. If the hardware is set up
to use system encryption, you can use this method by issuing
the DEFINE DEVCLASS command and specifying the
DRIVEENCRYPTION=ALLOW parameter.

To determine whether a volume is encrypted and which method was used, issue the QUERY VOLUME command and specify the

FORMAT=DETAILED parameter.

e Configuring tape drive encryption

You can use drive encryption to protect tapes that contain critical or sensitive data, for example, tapes that contain
confidential financial information. Drive encryption can be useful when you move tapes from the IBM Spectrum Protect

server environment to an onsite or offsite location.

Controlling tape storage operations
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Device class definitions for tapes include parameters that allow you to control storage operations.

e How IBM Spectrum Protect fills volumes
The DEFINE DEVCLASS command has an optional ESTCAPACITY parameter that indicates the estimated capacity for
sequential volumes that are associated with the device class. IBM Spectrum Protect™ uses the estimated capacity of
volumes to determine the estimated capacity of a storage pool, and the estimated percent utilized.
e Specifying the estimated capacity of tape volumes
IBM Spectrum Protect also uses estimated capacity to determine when to begin the reclamation of storage pool volumes.
e Specifying recording formats for tape media
You can specify the recording format that is used by IBM Spectrum Protect to write data to tape media. If you plan to mix
generations of drives, or different drive types, within a library, you must specify a recording format for each drive generation
and each drive type. In this way, the server can differentiate between the drive generations and drive types.
e Associating library objects with device classes
A library contains the drives that can be used to mount the volume. Only one library can be associated with a device class.
However, multiple device classes can reference the same library.
e Controlling media-mount operations for tape devices
By using device class definitions, you can control the number of mounted volumes, the amount of time a volume remains
mounted, and the amount of time that the IBM Spectrum Protect server waits for a drive to become available.
e Preempting operations
The server can preempt server or client operations for a higher priority operation when a mount point is in use and no
others are available, or access to a specific volume is required. When an operation is preempted, it is canceled.
e Impacts of device changes on the SAN
The SAN environment can shift dramatically due to device or cabling changes. The dynamic nature of the SAN can cause
static definitions to fail or become unpredictable.
o I MDisplaying device information
You can display information about devices that are connected to the server by using the device information utility (tsmdlst).
e Write-once, read-many tape media
Write-once, read-many (WORM) media help to prevent accidental or deliberate deletion of critical data. However, IBM
Spectrum Protect imposes certain restrictions and guidelines to follow when you use WORM media.
o I M Troubleshooting problems with devices
You can troubleshoot errors that occur when you configure or use devices with IBM Spectrum Protect.

How IBM Spectrum Protect fills volumes

The DEFINE DEVCLASS command has an optional ESTCAPACITY parameter that indicates the estimated capacity for sequential
volumes that are associated with the device class. IBM Spectrum Protect™ uses the estimated capacity of volumes to determine
the estimated capacity of a storage pool, and the estimated percent utilized.

If the ESTCAPACITY parameter is not specified, IBM Spectrum Protect uses a default value that is based on the recording format
that is specified for the device class by using the FORMAT parameter.

If you specify an estimated capacity that exceeds the actual capacity of the volume in the device class, IBM Spectrum Protect
updates the estimated capacity of the volume when the volume becomes full. When IBM Spectrum Protect reaches the end of the
volume, it updates the capacity to match the amount that is written to the volume.

You can either accept the default estimated capacity for the device class, or explicitly specify an estimated capacity. An accurate
estimated capacity value is not required, but is useful. IBM Spectrum Protect uses the estimated capacity of volumes to
determine the estimated capacity of a storage pool, and the estimated percent that is used. You might want to change the
estimated capacity if on or both of the following conditions are true:

e The default estimated capacity is inaccurate because of data compression.
® You have volumes of nonstandard size.

Related reference:

[* DEFINE DEVCLASS (Define a device class)
Related information:

* UPDATE DEVCLASS (Update a device class)

Specifying the estimated capacity of tape volumes

IBM Spectrum Protect™ also uses estimated capacity to determine when to begin the reclamation of storage pool volumes.
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About this task

For tape device classes, the default values selected by the server depend on the recording format that is used to write data to the
volume. You can either accept the default for a device type or specify a value.

To specify estimated capacity for tape volumes, use the ESTCAPACITY parameter when you define the device class or update its
definition.
Related reference:

* DEFINE DEVCLASS (Define a device class)
Related information:

[** UPDATE DEVCLASS (Update a device class)

Specifying recording formats for tape media

You can specify the recording format that is used by IBM Spectrum Protect™ to write data to tape media. If you plan to mix
generations of drives, or different drive types, within a library, you must specify a recording format for each drive generation and
each drive type. In this way, the server can differentiate between the drive generations and drive types.

About this task

To specify a recording format, use the FORMAT parameter when you define the device class or update its definition.

If all drives associated with that device class are identical, specify FORMAT=DRIVE. The server selects the highest format that is
supported by the drive on which a volume is mounted.

If some drives associated with the device class support a higher density format than others, specify a format that is compatible
with all drives.

If drives in a single SCSI library use different tape technologies (for example, DLT and LTO Ultrium), specify a unique value for the
FORMAT parameter in each device class definition.

For a configuration example, see Example: Configure a SCSI or virtual tape library with multiple drive device types.

The recording format that the server uses for a volume is selected when data is first written to the volume. Updating the FORMAT
parameter does not affect media that already contain data until those media are rewritten from the beginning. This process might
happen after a volume is reclaimed or deleted, or after all of the data on the volume expires.

Related reference:

* DEFINE DEVCLASS (Define a device class)
Related information:

[ UPDATE DEVCLASS (Update a device class)

Associating library objects with device classes

A library contains the drives that can be used to mount the volume. Only one library can be associated with a device class.
However, multiple device classes can reference the same library.

About this task

To associate a device class with a library, use the LIBRARY parameter when you define a device class or update its definition.

Related reference:

* DEFINE DEVCLASS (Define a device class)
Related information:

[ UPDATE DEVCLASS (Update a device class)

Controlling media-mount operations for tape devices

By using device class definitions, you can control the number of mounted volumes, the amount of time a volume remains
mounted, and the amount of time that the IBM Spectrum Protect™ server waits for a drive to become available.
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e Controlling the number of simultaneously mounted volumes
When you set a mount limit for a device class, you must consider the number of storage devices that are connected to your
system. You must also consider whether you use the simultaneous-write function, whether you associate multiple device
classes with a single library, and the number of processes that run at the same time.

e Controlling the amount of time that a volume remains mounted
You can control the amount of time that a mounted volume remains mounted after its last I/O activity. If a volume is used
frequently, you can improve performance by setting a longer mount retention period to avoid unnecessary mount and
dismount operations.

e Controlling the amount of time that the server waits for a drive
You can specify the maximum amount of time, in minutes, that the IBM Spectrum Protect server waits for a drive to become
available for the current mount request.

Controlling the number of simultaneously mounted volumes

When you set a mount limit for a device class, you must consider the number of storage devices that are connected to your
system. You must also consider whether you use the simultaneous-write function, whether you associate multiple device classes
with a single library, and the number of processes that run at the same time.

About this task

When you select a mount limit for a device class, consider the following issues:
e How many storage devices are connected to your system?

Do not specify a mount limit value that is greater than the number of associated available drives in your installation. If the
server tries to mount as many volumes as specified by the mount limit and no drives are available for the required volume,
an error occurs and client sessions might end. (This restriction does not apply when the DRIVES parameter is specified.)

If you are sharing library resources on a SAN among IBM Spectrum Protect™ servers, you must limit the number of tape
drives that a library client can use at a time. To allow multiple library client servers use a library simultaneously specify the
MOUNTLIMIT parameter when you define or update the device class on the library client. For more information about
configuring library sharing, see Configuring library sharing.

e Are you using the simultaneous-write function to primary storage pools, copy storage pools, and active-data pools?

Specify a mount limit value that provides enough mount points to support writing data simultaneously to the primary
storage pool and all associated copy storage pools and active-data pools.

e Are you associating multiple device classes with a single library?

A device class that is associated with a library can use any drive in the library that is compatible with the device class'
device type. Because you can associate more than one device class with a library, a single drive in the library can be used
by more than one device class. IBM Spectrum Protect ensures that two operations cannot use the same drive
simultaneously by using two different device classes.

e How many IBM Spectrum Protect processes do you want to run at the same time, by using devices in this device class?

IBM Spectrum Protect automatically cancels some processes to run other, higher priority processes. If the server is using
all available drives in a device class to complete higher priority processes, lower-priority processes must wait until a drive
becomes available. For example, IBM Spectrum Protect cancels the process for a client that backs up directly to tape if the
drive is needed for a server migration or tape reclamation process. IBM Spectrum Protect cancels a tape reclamation
process if the drive is needed for a client restore operation. For more information, see Preempting operations.

If processes are often canceled by other processes, consider whether you can make more drives available for IBM
Spectrum Protect use. Otherwise, review your scheduling of operations to reduce the contention for drives.

This consideration also applies to the simultaneous-write function. You must have enough drives available to allow for a
successful simultaneous-write operation.

To specify the maximum number of volumes that can be simultaneously mounted, use the MOUNTLIMIT parameter when
you define the device class or update its definition.

Related reference:
[* DEFINE DEVCLASS (Define a device class)

IBM Spectrum Protect Knowledge Center Version 8.1.5 299


https://www.ibm.com/support/knowledgecenter/SSEQVQ_8.1.5/srv.reference/r_cmd_devclass_define.html

Related information:
[** UPDATE DEVCLASS (Update a device class)

Controlling the amount of time that a volume remains mounted

You can control the amount of time that a mounted volume remains mounted after its last I/O activity. If a volume is used
frequently, you can improve performance by setting a longer mount retention period to avoid unnecessary mount and dismount
operations.

About this task

If mount operations are being handled by manual, operator-assisted activities, you might want to specify a long mount retention
period. For example, if only one operator supports your entire operation on a weekend, then define a long mount retention period
so that the operator is not being asked to mount volumes every few minutes.

To control the amount of time a mounted volume remains mounted, use the MOUNTRETENTION parameter when you define the
device class or update its definition. For example, if the mount retention value is 60, and a mounted volume remains idle for 60
minutes, the server dismounts the volume.

While IBM Spectrum Protect™ has a volume mounted, the drive is allocated to IBM Spectrum Protect and cannot be used for
anything else. If you need to free the drive for other uses, you can cancel IBM Spectrum Protect operations that are using the drive
and then dismount the volume. For example, you can cancel server migration or backup operations. For information on how to
cancel processes and dismount volumes, see Managing server requests for volumes

Related reference:

[* DEFINE DEVCLASS (Define a device class)
Related information:
* UPDATE DEVCLASS (Update a device class)

Controlling the amount of time that the server waits for a drive

You can specify the maximum amount of time, in minutes, that the IBM Spectrum Protect™ server waits for a drive to become
available for the current mount request.

About this task

To control the wait time for a drive to become available for a mount request, use the MOUNTWAIT parameter when you define or
update a device class.

Related reference:

* DEFINE DEVCLASS (Define a device class)
Related information:

[ UPDATE DEVCLASS (Update a device class)

Preempting operations

The server can preempt server or client operations for a higher priority operation when a mount point is in use and no others are
available, or access to a specific volume is required. When an operation is preempted, it is canceled.

You can use the QUERY MOUNT command to see the status of the volume for the mount point.

By default, preemption is enabled on the server. To disable preemption, specify the NOPREEMPT option in the server options file.
If you specify this option, the BACKUP DB command, and the export and import commands are the only operations that can
preempt other operations.

e Mount point preemption
If a high-priority operation requires a mount point that is in a specific device class and all the mount points in the device
class are in use, the high-priority operation can preempt a mount point from a lower-priority operation.

e Volume access preemption
If a high-priority operation requires access to a specific volume and that volume is in use, the high-priority operation can
preempt the lower-priority operation for that volume.
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Related reference:
[** BACKUP DB (Back up the database)
* QUERY MOUNT (Display information on mounted sequential access volumes)

Mount point preemption

If a high-priority operation requires a mount point that is in a specific device class and all the mount points in the device class are
in use, the high-priority operation can preempt a mount point from a lower-priority operation.

Mount points can be preempted only when the device class of the operation preempting and the operation that is being
preempted is the same.

The following high-priority operations can preempt other operations for a mount point.

e Database backup operations

e Retrieve, restore, or HSM recall operations that are initiated by clients
Restore operations by using a remote data mover

Export operations

e Import operations

e QOperations to generate backup sets

The following server operations cannot preempt other operations or be preempted:

e Auditavolume

e Restore data from a copy or active-data pool
e Prepare a recovery plan file

e Store data by using a remote data mover

The following operations can be preempted and are listed in order of priority, from highest priority to lowest priority. The server
selects the lowest priority operation to preempt, for example, identify duplicates.

e Replicate nodes

e Back up data to a copy storage pool

e Copy active data to an active data pool

Move data on a storage pool volume

Migrate data from disk to sequential media

Migrate data from sequential media to sequential media

e Back up, archive, or HSM migrate operations that are initiated by clients
e Reclaim volumes in a sequential-access storage pool

e Identify duplicates

Volume access preemption

If a high-priority operation requires access to a specific volume and that volume is in use, the high-priority operation can preempt
the lower-priority operation for that volume.

For example, if a restore request requires access to a volume in use by a reclamation operation and a drive is available, the
reclamation operation is canceled.

The following high-priority operations can preempt operations for access to a specific volume:

e Database backup operations

Retrieve, restore, or HSM recall operations that are initiated by clients
Restore operations by using a remote data mover

Export operations

e Import operations

e QOperations to generate backup sets

The following operations cannot preempt other operations or be preempted:

e Audit volume
e Restore data from a copy or active-data pool
e Prepare arecovery plan
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e Store data by using a remote data mover

The following operations can be preempted, and are listed in order of priority, from highest priority to lowest priority. The server
selects the lowest priority operation to preempt, for example, identify duplicates.

e Replicate nodes

e Back up data to a copy storage pool

Copy active data to an active data pool

Move data on a storage pool volume

Migrate data from disk to sequential media

e Migrate data from sequential media to sequential media

e Back up, archive, or HSM migrate data that is initiated by client
e Reclaim volumes in a sequential-access storage pool

e Identify duplicates

Impacts of device changes on the SAN

The SAN environment can shift dramatically due to device or cabling changes. The dynamic nature of the SAN can cause static
definitions to fail or become unpredictable.

Device IDs that are assigned by the SAN and known to the server or storage agent can be altered due to bus resets or other
environmental changes. For example, the server might know a device X as rmt0 (on AIX®), based on the original path specification
to the server and original configuration of the LAN. However, some event in the SAN, for example, the addition of new device Y,
causes device X to be assigned rmt1. When the server tries to access device X by using rmt0, either the access fails or the wrong
target device is accessed. The server attempts to recover from changes to devices on the SAN by using device serial numbers to
confirm the identity of devices it contacts.

When you define a drive or library, you have the option of specifying the serial number for that device. If you do not specify the
serial number when you define the device, the server obtains the serial number when you define the path for the device. In either
case, the server then has the device serial number in its database and can use it to confirm the identity of a device for operations.

When the server uses drives and libraries on a SAN, the server attempts to verify that the correct device is used. The server
contacts the device by using the device name in the path that you defined for it. The server then requests the serial number from
the device, and compares that serial number with the serial number that is stored in the server database for that device.

If the serial number does not match, the server begins the process of discovery on the SAN, attempting to find the device with the
matching serial number. If the server finds the device with the matching serial number, it corrects the definition of the path in the

server's database by updating the device name in that path. The server issues a message with information about the change that

is made to the device. Then, the server proceeds to use the device.

To determine when device changes on the SAN affect the IBM Spectrum Protect™ server, you can monitor the activity log for
messages. The following messages are related to serial numbers:

e ANR8952 through ANR8958
e ANR8961 through ANR8968
e ANR8974 through ANR8975

Restriction: Some devices cannot report their serial numbers to applications such as the IBM Spectrum Protect server. If the
server cannot obtain the serial number from a device, the server cannot help the system to recover from a device location change

on the SAN.
| Windows |

Displaying device information

You can display information about devices that are connected to the server by using the device information utility (tsmdlst).

Before you begin

e Ensure that the HBA APl is installed. The HBA API is required to run the device information utility.
e Ensure that the tape device driver is installed and configured.

Procedure
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1. From a command prompt, change to the server subdirectory of the server installation directory, for example, C:\Program

Files\Tivoli\TSM\server.

2. Run the tsmdlst.exe executable file.

Related reference:
* QUERY SAN (Query the devices on the SAN)
B+ tsmdlst (Display information about devices)

Write-once, read-many tape media

Write-once, read-many (WORM) media help to prevent accidental or deliberate deletion of critical data. However, IBM Spectrum
Protect™ imposes certain restrictions and guidelines to follow when you use WORM media.

You can use the following types of WORM media with IBM Spectrum Protect:

WORM-

IBM® 3592, all supported generations

IBM LTO-3 and all supported generations

HP LTO-3 and all supported generations

Quantum LTO-3 and all supported generations

Quantum SDLT 600, Quantum DLT V4, and Quantum DLT S4
StorageTek VolSafe

Sony AIT50 and AIT100

A storage pool can consist of either WORM or RW media, but not both.
To avoid wasting tape after a restore or import operation, do not use WORM tapes for database backup or export
operations.

WORM-capable drives

To use WORM media in a library, all the drives in the library must be WORM-capable. A mount will fail if a WORM cartridge is
mounted in a read/write (RW) drive.

Check-in of WORM media

The type of WORM media determines whether the media label needs to be read during check-in.

Restrictions on WORM media

You cannot use prelabeled WORM media with the LTO or ECARTRIDGE device class.

Mount failures with WORM media

If WORM tape media are loaded into a drive for a read-write (RW) device-class mount, it will cause a mount failure.
Similarly, if RW tape media are loaded into a drive for a WORM device-class mount, the mount will fail.

Relabeling WORM media

You cannot relabel a WORM cartridge if it contains data. This applies to Sony AIT WORM, LTO WORM, SDLT WORM, DLT
WORM, and IBM 3592 cartridges. The label on a VolSafe volume should be overwritten only once and only if the volume
does not contain usable, deleted, or expired data.

Removing private WORM volumes from a library

If you perform an action on a WORM volume (for example, if you delete file spaces) and the server does not mark the
volume as full, the volume is returned to scratch status. If a WORM volume is not marked as full and you delete it from a
storage pool, the volume remains private. To remove a private W